# FORENSIC BIOLOGY
## PROTOCOLS FOR FORENSIC STR ANALYSIS

**Approving Authority:**
Eugene Y. Lien, Technical Leader – Nuclear DNA Operations

<table>
<thead>
<tr>
<th>Procedures</th>
<th>Effective Date</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Guidelines for DNA Casework</td>
<td>4/1/2014</td>
<td></td>
</tr>
<tr>
<td>DNA Extraction</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chelex Extraction from Blood and Buccal Swabs</td>
<td>7/16/2012</td>
<td>*</td>
</tr>
<tr>
<td>Chelex Extraction from Solid Tissue (e.g., Fetus Samples)</td>
<td>7/16/2012</td>
<td>*</td>
</tr>
<tr>
<td>Chelex Extraction from Epithelial Cells (Amylase Positive Samples)</td>
<td>7/16/2012</td>
<td>*</td>
</tr>
<tr>
<td>Chelex Extraction from Semen Stains or Swabs (Non-Differential)</td>
<td>7/16/2012</td>
<td>*</td>
</tr>
<tr>
<td>Chelex Extraction from Semen Stains or Swabs (Differential)</td>
<td>7/16/2012</td>
<td>*</td>
</tr>
<tr>
<td>Chelex Extraction from Hair</td>
<td>3/24/2010</td>
<td></td>
</tr>
<tr>
<td>Organic Extraction</td>
<td>4/1/2014</td>
<td></td>
</tr>
<tr>
<td>High Sensitivity DNA Extraction</td>
<td>4/1/2014</td>
<td></td>
</tr>
<tr>
<td>Extraction of Exogenous DNA from Nails</td>
<td>12/28/2012</td>
<td></td>
</tr>
<tr>
<td>MagAttract DNA Extraction from Bloodstains and Exemplars</td>
<td>4/1/2014</td>
<td></td>
</tr>
<tr>
<td>Reduced Volume MagAttract DNA Extraction from Other Casework Samples</td>
<td>4/1/2014</td>
<td></td>
</tr>
</tbody>
</table>

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
<table>
<thead>
<tr>
<th>Procedures</th>
<th>Effective Date</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNA Extraction of Bone Samples</td>
<td>11/28/2012</td>
<td></td>
</tr>
<tr>
<td>Microcon DNA Fast Flow Concentration and Purification</td>
<td>4/1/2014</td>
<td></td>
</tr>
<tr>
<td>Estimation of DNA Quantity Using the RotorGene™</td>
<td>4/1/2014</td>
<td></td>
</tr>
<tr>
<td>General Guidelines for Fluorescent STR Analysis</td>
<td>7/16/2012</td>
<td>*</td>
</tr>
<tr>
<td><strong>Identifiler Kit</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Generation of Amplification Sheets</td>
<td>3/24/2010</td>
<td></td>
</tr>
<tr>
<td>Amplification – Sample Preparation</td>
<td>12/28/2012</td>
<td></td>
</tr>
<tr>
<td>STR Analysis</td>
<td>7/16/2012</td>
<td>*</td>
</tr>
<tr>
<td>STR Data Conversion and Archiving</td>
<td>3/24/2010</td>
<td></td>
</tr>
<tr>
<td>GeneScan Analysis</td>
<td>3/24/2010</td>
<td></td>
</tr>
<tr>
<td>Genotyper Analysis</td>
<td>3/24/2010</td>
<td></td>
</tr>
<tr>
<td><strong>Yfiler Kit</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amplification</td>
<td>4/1/2014</td>
<td></td>
</tr>
<tr>
<td>Capillary Electrophoresis</td>
<td>4/1/2014</td>
<td></td>
</tr>
<tr>
<td><strong>PowerPlex Y Kit</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amplification</td>
<td>12/28/2012</td>
<td></td>
</tr>
<tr>
<td>Capillary Electrophoresis</td>
<td>7/16/2012</td>
<td>*</td>
</tr>
<tr>
<td>Analysis</td>
<td>7/16/2012</td>
<td>*</td>
</tr>
<tr>
<td><strong>MiniFiler Kit</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amplification</td>
<td>7/16/2012</td>
<td>*</td>
</tr>
<tr>
<td>Capillary Electrophoresis</td>
<td>12/28/2012</td>
<td></td>
</tr>
<tr>
<td><strong>STR Analysis with GeneMapper ID</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quality Flags</td>
<td>3/24/2010</td>
<td></td>
</tr>
<tr>
<td>Editing Codes</td>
<td>4/1/2014</td>
<td></td>
</tr>
<tr>
<td>Rerun Codes</td>
<td>4/1/2014</td>
<td></td>
</tr>
<tr>
<td>Analysis Method Editor</td>
<td>4/1/2014</td>
<td></td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>4/1/2014</td>
<td></td>
</tr>
<tr>
<td>References – Allelic Ladders, Controls, and Size Standards</td>
<td>4/1/2014</td>
<td></td>
</tr>
<tr>
<td>Default Table and Plot Settings</td>
<td>4/1/2014</td>
<td></td>
</tr>
<tr>
<td>STR Results Interpretation</td>
<td>4/1/2014</td>
<td></td>
</tr>
<tr>
<td>Additional Interpretations of Y-STR Results and Complex Y-STR Results</td>
<td>3/24/2010</td>
<td>*</td>
</tr>
<tr>
<td>Population Frequencies for STR’s</td>
<td>4/1/2014</td>
<td></td>
</tr>
<tr>
<td><strong>Forensic Statistical Tool (FST)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sample Comparisons</td>
<td>4/1/2014</td>
<td>*</td>
</tr>
<tr>
<td>Paternity Analysis</td>
<td>1/12/2012</td>
<td></td>
</tr>
<tr>
<td>References</td>
<td>3/24/2010</td>
<td></td>
</tr>
<tr>
<td>DNA-VIEW For Paternity and Kinship Analysis</td>
<td>3/24/2010</td>
<td></td>
</tr>
<tr>
<td>Appendix</td>
<td>4/1/2014</td>
<td></td>
</tr>
</tbody>
</table>

*denotes edited for LIMS implementation on 7-16-2012
## General Guidelines for DNA Casework

### Laboratory organization

1. To minimize the potential for carry-over contamination, the laboratory is organized so that the areas for DNA extraction, PCR set-up, and handling amplified DNA are physically isolated from each other. Each of the three areas is in a separate room.

2. Based on need, microcentrifuge tube racks have been placed in sample handling areas. These racks should only leave their designated area to transport samples to the next designated area. Immediately after transporting samples, the racks should be cleaned and returned to their designated area.

3. Dedicated equipment such as pipetters should not leave their designated areas. Only the samples in designated racks should move between areas.

4. Analysts in each work area must wear appropriate personal protective equipment (PPE). Contamination preventive equipment (CPE) must be worn where available. All PPE and CPE shall be donned in the bio-vestibules.

### Work Place Preparation

1. Apply 10% bleach followed by water and/or 70% Ethanol to the entire work surface, cap opener, pipettes, and computer keyboard/mouse (when appropriate).

2. Obtain clean racks and cap openers, and irradiated microcentrifuge tubes, and irradiated water from storage. **Arrange work place to minimize crossover.**

3. Position gloves nearby with 10% Bleach/70% Ethanol/water in order to facilitate frequent glove changes and cleaning of equipment.

### Microcentrifuge tube and pipette handling

1. Microcentrifuge tubes, Microcon collection tubes, Dolphin tubes, and M48 tubes must be irradiated prior to use.

2. Avoid splashes and aerosols. Centrifuge all liquid to the bottom of a closed microcentrifuge tube before opening it.
3. Avoid touching the inside surface of the tube caps with pipetters, gloves, or lab coat sleeves.

4. Use the correct pipetter for the volume to be pipetted. For pipetters with a maximum volume of 20µL or over, the range begins at 10% of its maximum volume (i.e., a 100µL pipette can be used for volumes of 10-100µL). For pipetters with a maximum volume of 10µL or under, the range begins at 5% of its maximum volume (i.e., a 10µL pipette can be used for volumes of 0.5-10µL).

5. Filter pipette tips must be used when pipetting DNA and they should be used, whenever possible, for other reagents. Use the appropriate size filter tips for the different pipetters; the tip of the pipette should never touch the filter.

6. Always change pipette tips between handling each sample.

7. Never “blow out” the last bit of sample from a pipette. Blowing out increases the potential for aerosols, this may contaminate a sample with DNA from other samples. The accuracy of liquid volume delivered is not critical enough to justify blowing out.

8. Discard pipette tips if they accidentally touch the bench paper or any other surface.

9. Wipe the outside of the pipette with 10% bleach solution followed by a 70% ethanol solution if the barrel goes inside a tube.

**Sample handling**

1. Samples that have not yet been amplified should never come in contact with equipment in the amplified DNA work area. Samples that have been amplified should never come in contact with equipment in the unamplified work area.
2. The DNA extraction and PCR setup of evidence samples should be performed at a separate time from the DNA extraction and PCR setup of exemplars. This precaution helps to prevent potential cross-contamination between evidence samples and exemplars.

3. Use disposable bench paper to prevent the accumulation of human DNA on permanent work surfaces. 10% bleach followed by 70% ethanol should always be used to decontaminate all work surfaces before and after each procedure.

4. Limit the quantity of samples handled in a single run to a manageable number. This precaution will reduce the risk of sample mix-up and the potential for sample-to-sample contamination.

5. Change gloves frequently to avoid sample-to-sample contamination. Change them whenever they might have been contaminated with DNA and whenever exiting a sample handling area.

6. Make sure the necessary documentation is completely filled out, and that the analyst’s ID is properly associated with the notations.

**Body fluid identification**

1. The general laboratory policy is to identify the stain type (i.e., blood, semen, or saliva) before individualization is attempted on serious cases such as sexual assaults, homicides, robberies, and assaults. However, circumstances may exist when this will not be possible. For example, on most property crime cases when a swab of an item is submitted for testing, the analyst will cut the swab directly for individualization rather than testing the swab for body fluid identification.

2. A positive screening test for blood followed by the detection of a real-time PCR quantitation value greater than or equal to 0.1 pg/µL is indicative of the presence of human blood.
3. High Copy Number (HCN) testing is performed when the samples have a quantitation value $\geq 10.0$ pg/µL for YFiler (at least 100 pg per amp), $\geq 5.0$ pg/µL for PowerPlex Y (at least 100 pg per amp), $\geq 20$ pg/µL for Identifiler 28 cycles (at least 100 pg per amp) or $\geq 10$ pg/µL for Minifiler (at least 100pg per amp).

High Sensitivity DNA testing (Identifiler 31 cycles) can be performed if samples have a quantitation value of less than 7.5 pg/µL (or 20 pg/µL) and greater than 1 pg/µL.

DNA Extraction Guidelines

Slightly different extraction procedures may be required for each type of specimen. Due to the varied nature of evidence samples, the user may need to modify procedures.

1. All tube set-ups must be witnessed/confirmed prior to starting the extraction (NOTE: For differential extractions, the tube set-up should be witnessed after the incubation step.)

2. Use Kimwipes or a tube opener to open tubes containing samples; only one tube should be uncapped at a time.

3. When pouring or pipetting Chelex solutions, the resin beads must be distributed evenly in solution. This can be achieved by shaking or vortexing the tubes containing the Chelex stock solution before aliquoting.

4. For pipetting Chelex, the pipette tip used must have a relatively large bore – 1 mL pipette tips are adequate.

5. Be aware of small particles of fabric, which may cling to the outside of tubes.

6. With the exception of the Mitochondrial DNA Team, two extraction negative controls (E-neg) must be included with each batch of extractions to demonstrate extraction integrity. The first E-Neg will typically be subjected to a micro-con and will be consumed to ensure that an E-neg associated with each extraction set will be extracted concurrently with the samples, and run using the same instrument model and under the same or more sensitive injection conditions as the samples. The second E-Neg will ensure that the samples in that extraction set can be sent on for further testing in another team or in a future kit. In the Mitochondrial DNA Team, only one extraction negative control is needed.

Refer to the end of this section for flow charts.
The extraction negative control contains all solutions used in the extraction process but no biological fluid or sample. For samples that will be amplified in Identifiler (28 or 31 cycles), PowerPlex Y, YFiler or MiniFiler, the associated extraction negative should be re-quantified to confirm any quantitation value of 0.2 pg/µL or greater.

7. If a sample is found to contain less than 20 pg/µL of DNA, then the sample should not be amplified in Identifiler (28 cycles); if a sample is found to contain less than 10 pg/µL of DNA, then the sample should not be amplified in YFiler; if a sample is found to contain less than 5 pg/µL of DNA, then the sample should not be amplified in PowerPlex Y; if a sample is found to contain less than 10 pg/µL of DNA, then the sample should not be amplified in MiniFiler.

Samples that cannot be amplified may be re-extracted, reported as containing insufficient DNA, concentrated using a Microcon-100 (see Section 3 of the STR manual), or possibly submitted for High Sensitivity testing. The interpreting analyst shall consult with a supervisor to determine how to proceed. Other DNA samples may also be concentrated and purified using a Microcon-100 if the DNA is suspected of being degraded or shows inhibition or background fluorescence during quantitation. Samples that are 1 pg/µL to 20 pg/µL may be submitted for high sensitivity testing with a supervisor’s permission.

8. After extraction, the tubes containing the unamplified DNA should be transferred to a box and stored in the appropriate refrigerator or freezer. The tubes should not be stored in the extraction racks.

9. All tubes must have the complete case number, sample identifier and IA initials on the side of the tube. This includes aliquots submitted for quantitation.
HSC and PC – EXTRACTION NEGATIVE FLOW
AUTOSOMAL STR TESTING

All Extractions for Autosomal STR Testing to start with an "ENegTand an "ENeg2"

"ENeg1" to be aliquotted for quantitation, amp‘ed, and run alongside the samples in "ID28 Normal”

"ENeg1" Fails

All Samples fail. Samples to be re-extracted.

"ENeg1" Passes

All Samples pass.

"ENeg2" to be microconcentrated to 20μL.

Run the Microconcentrated "ENeg2" in "ID28 Normal" Parameters

FAIL

Samples in the same extraction set cannot be microconcentrated for Identifier.

PASS

- Samples in same set can be microconcentrated and run in "ID28 Normal" Parameters.
- "ENeg2" will be used if additional testing using another methodology or kit is required.

IMPORTANT NOTE:
If samples need to be tested for Y-STR’s, they should be recut, re-extracted, and processed in accordance to the Y-STR flowchart. ENeg2 can be used under certain circumstances for Y-STR Testing. Consult with your supervisor or manager who will ensure that the additional testing will not conflict with the other samples within the same extraction set.
HYBRID – EXTRACTION NEGATIVE FLOW
AUTOSOMAL STR TESTING

All Extractions for Autosomal STR Testing to start with an "ENeg1" and an "ENeg2"

- "ENeg2" to remain untouched
- "ENeg1" to be aliquotted for quantitation, amplified, and run alongside the samples in "ID38 High"

"ENeg1" Passes

All Samples Fail, Samples to be re-extracted

"ENeg2" Fail

Run the Microconned "ENeg1" in "ID31 High" Parameters

FAIL

Refer to the STR Results Interpretation procedure for guidance

PASS

- Samples in same set can be microconned and run in "ID31 High" Parameters
- If any extract needs to go to Y-STR, "ENeg2" will be used as per Y-STR protocols
Y-STR TESTING (HSC, PC, and HYBRID)

EXTRACTION NEGATIVE FLOW

All Extractions for Y-STR Testing to start with an "ENeg1" and an "ENeg2"

- "ENeg2" to remain untouched.
- "ENeg1" to be aliquoted for quantitation, amped, and run alongside the samples in "Normal."

"ENeg1" Passes

5uL of "ENeg1" amped and run in "ID Normal"

"ENeg1" Passes

Any samples can be run in "ID Normal"

Run the Microconed "ENeg1" in "Y-STR Re-run" Parameters

FAIL

PASS

- Samples in same set can be microconned and run in any Y-STR Parameter.
- "ENeg2" is left untouched and can be used under certain circumstances (ex: If "ENeg1" Microcon Re-run fails, then "ENeg2" can be run Microcon in "Normal" to determine pass or fail).

"ENeg1" Fails

All Samples fail. Samples to be re-extracted.

"ENeg1" Fails in ID28

No samples in the same extraction set can be sent to ID

No samples in the same extraction set can be microconned and run in "Y-STR Re-run" parameters

ARCHIVED 05/21/14
Document Control Coordinator
X-TEAM – EXTRACTION NEGATIVE FLOW
AUTOSOMAL STR TESTING

- Organic extractions for Autosomal STR Testing to start with an “ENeg1,” “ENeg2,” and an “ENeg3.” All other extractions for Autosomal STR Testing to start with an “ENeg1” and an “ENeg2.”

- “ENeg2” and “ENeg3” to remain untouched.
- “ENeg1” to be aliquoted for quantitation, amplified, and run alongside the samples in “ID28 Normal.”

- “ENeg1” Passes

  All Samples pass

  All Samples fail. Samples to be re-extracted. No samples within this set may be microconned.

- “ENeg1” Fails

  If a sample needs to be Microconned

- Samples in the same extraction set cannot be microconned for identifier.

  Samples in same set can be microconned and run in “ID28 Normal” Parameters.
  “ENeg2” will be used if a sample from the same extraction set is going additional Autosomal Testing.
  “ENeg3” will be used if a sample from the extraction set is going to Mitochondrial DNA Testing.

  Run the Microconned “ENeg1” in “ID28 Normal” Parameters.
X-TEAM – EXTRACTION NEGATIVE FLOW
Y-STR TESTING

"ENeg2" to be amp’d, and run "High"

"ENeg2" Passes

"ENeg2" Fails

Run "ENeg2" in "Normal"; No samples within this set may be microconned.

"ENeg2" Passes

"ENeg2" Fails

No samples in the same extraction set can be sent to Y-STRs.

Samples in same extraction set can be run in Y-STR "Normal" and/or "High"; Additionally, samples from the within the same set may be microconned.

If sample(s) need to be microconned, then "ENeg2" to be Microconned to 20uL

Microconned "ENeg2" to be amp’d, and run "High"

"ENeg2" Passes

"ENeg2" Fails

Run Microconned "ENeg2" in "Normal"

"ENeg2" Passes

"ENeg2" Fails

No samples in the same extraction set can be microconned for Y-STRs

IMPORTANT NOTE:
X-Team samples from the same extraction set may be run in autosomal and Y-STR or Mini-STR only, not both. If both Y-STR and Mini-STR testing is needed, re-extract sample for the appropriate kit.
X-TEAM – EXTRACTION NEGATIVE FLOW
MINI-STR TESTING

"ENeg2" to be amp'ed, and run.

"ENeg2" Passes

Samples in same extraction set can be run in Mini-STR.

"ENeg2" Fails

No samples in the same extraction set can be sent to Mini-STRs.

If sample(s) need to be microconned, then "ENeg2" to be microconned to 20uL

Microconned "ENeg2" to be amp'ed and run.

"ENeg2" Passes

Samples in same extraction set can be microconned and run in Mini-STR.

"ENeg2" Fails

No samples in the same extraction set can be microconned for Mini-STRs.

IMPORTANT NOTE:
X-Team samples from the same extraction set may be run in autosomal and Y-STR or Mini-STR only, not both. If both Y-STR and Mini-STR testing is needed, re-extract sample for the appropriate kit.
Controls for PCR analysis

The following controls must be processed alongside the sample analysis:

1. A positive control is a DNA sample where the STR alleles for the relevant STR loci are known. The positive control tests the success and the specificity of the amplification, and during the detection and analysis stage the correct allele calling by the software.

2. An extraction negative control consists of all reagents used in the extraction process and is necessary to detect DNA contamination of these reagents. **Note:** Since the Y STR system only detects male DNA, one cannot infer from a clean Y STR extraction negative the absence of female DNA. Therefore, an extraction negative control originally typed in Y STRs must be retested if the samples are amped in Identifiler.

3. Samples that were extracted together should all be amplified together, so that every sample is run parallel to its associated extraction negative control.

4. An amplification negative control consists of only amplification reagents without the addition of DNA, and is used to detect DNA contamination of the amplification reagents.

Failure of any of the controls does not automatically invalidate the test. Under certain circumstances it is acceptable to retest negative and positive controls. See STR Results Interpretation Procedure for rules on retesting of control samples.

Concordant analyses and “duplicate rule”

The general laboratory policy is to confirm DNA results either by having concordant DNA results within a case, or (for 28-cycle systems) by duplicating the DNA results with a separate aliquot, amplification, and electrophoresis plate. The most common situations are confirmation of a match or exclusion within a case and repeating DNA testing when a low amount of DNA is amplified. Concordant and duplicate analyses are also used to detect sample mix-up and confirm the presence of DNA mixtures.

1. For evidence samples, the following guidelines apply:

   a. Identical DNA profiles among at least two items (two evidence samples or one evidence sample plus an exemplar) within a case are considered internally concordant results (“duplicate rule”).
b. If a sample does not match any other sample in the case, it must be duplicated by a second amplification. If the only result was obtained using Y-STRs, this must be duplicated in the Y system.

c. If after the first DNA analysis there is an indication that the sample consists of a mixture of DNA, several scenarios must be considered. Further analysis steps have to be decided based on the nature of each case. Consult with your supervisor if you encounter a situation that is not represented in the following examples:

1) If all alleles in a mixture are consistent with coming from any of the known or unknown samples in the case, e.g. a victim and a semen source, no further concordance testing is needed. Further testing could be performed if needed (e.g., to obtain a CODIS profile).

2) If two or more mixtures in a case are consistent with each other and display the same allele combinations, they are considered duplicated.

3) If one or more alleles cannot be accounted for by other contributors in the case, the presence of the foreign component must be confirmed by a second amplification.

4) If there is only one sample in a case and this happens to be a mixed sample, the results need to be confirmed by a second amplification.

d. Inconclusive samples (as defined in the STR Results Interpretation Procedure) that cannot be used for comparison do not require duplication.

e. Duplicate Identifiler 28 amplifications may be required when there is less than 1000 pg of DNA in the total extraction volume (e.g., calculate total yield by multiplying DNA concentration by the 200 uL in a Chelex extraction); any duplicate amplification done for this reason should be performed as soon as possible after extraction to minimize loss of DNA in the extract. However, if the sample meets the concordance policy as described in Sections a-d above, a duplicate amplification is not required.

f. Another method to satisfy this policy is if two different kits with overlapping loci are used. At least two (2) autosomal loci must be duplicated to confirm results. (For example, using Cofiler/Profiler Plus or Identifiler/MiniFiler on the same evidence sample.)
2. For exemplar samples, duplication is designed to rule out false exclusions based on sample mix-up, and also to streamline testing. Duplication must start with a second independent extraction, with the exemplar cut and submitted for extraction at a different time. The two resulting extracts must be aliquotted for amplification separately at different times, and aliquotted for electrophoresis separately and run on separate plates. If there is no additional exemplar material available for extraction, the duplication may begin at the amplification stage.

To streamline testing, all suspect and victim exemplars may be duplicated.

The following guidelines apply for required duplications:

a. If the DNA profile of a victim’s exemplar does not match any of the DNA profiles of evidence samples in the case, including mixtures, the victim’s exemplar must be duplicated to eliminate the possibility of an exemplar mix-up. *This is because it is highly likely that an exemplar mix-up would generate a false exclusion.*

b. Duplication of a victim’s DNA profile is not necessary in a negative case (no alleles detected in evidence samples).

c. Since duplicate exemplar analyses are performed to confirm the exclusion, a partial DNA profile (at least one complete locus) that demonstrates an exclusion is sufficient.

d. If the DNA profile of a victim’s exemplar matches any of the DNA profiles of evidence in the case, or is present in a mixture, the exemplar does not have to be duplicated. *This is because it is highly unlikely that a sample mix-up would generate a false inclusion.*

e. Nonvictim elimination exemplars (such as consensual partners, homeowners, business employees) will not be routinely duplicated. Duplication may be performed for specific cases, if necessary.
h. If the DNA profile of a suspect’s exemplar does not match any of the DNA profiles in the case, or in the local database, the exemplar does not have to be duplicated. This is meant to streamline the process similar to convicted offender testing.

- If the DNA profile of a suspect’s exemplar matches any of the DNA profiles in the case, or in the local database, the suspect’s exemplar has to be duplicated to eliminate the possibility of an exemplar mix-up. This is meant to streamline the process similar to convicted offender testing.

- Pseudo exemplars do not have to be duplicated, regardless if the DNA profile matches any of the DNA profiles in the case.

3. For evidence samples or exemplar samples analyzed in DNA systems containing overlapping loci, the DNA results for the overlapping loci must be consistent. If no or partial results were obtained for some of the overlapping loci, this amplification is still valid if consistent results were obtained for at least one overlapping locus (Amelogenin is not considered an overlapping locus in this context). If the partial amplification confirms a match or an exclusion of an exemplar or another evidence sample, it does not have to be repeated.

4. Partial profiles can satisfy the duplication policy. Consistent DNA typing results from at least one overlapping locus in a different amplification is considered a concordant analysis.

5. For Y-STR testing, the sample does not have to be reamplified if the internal duplication rule applies or if the Y-STR results are concordant with the autosomal results: confirming an exclusion or inclusion, confirming the presence of male DNA, confirming the number of semen donors. Based on the case scenario it might be necessary to reamplify in order to confirm the exact Y-STR allele calls. There might not be sufficient autosomal data to establish concordance.
Exogenous DNA Policy

Exogenous DNA is defined as the addition of DNA/biological fluid to evidence or controls subsequent to the crime. Sources of exogenous DNA could be first responders, EMT’s, crime scene technicians, MLI’s, ME’s, ADA’s, NYPD personnel, or laboratory personnel.

1. Medical treatment and decontamination of hazardous materials are the first priority. Steps should be taken to minimize exogenous DNA as much as possible.

2. The source of any exogenous DNA should be identified so that samples can be properly interpreted. It may be possible to identify the source by:
   a. Examining other samples from the same batch for similar occurrences.
   b. Examining samples from different batches, handled or processed at approximately the same time for possible similar occurrences (such as from dirty equipment or surfaces).
   c. Processing elimination samples to look for exogenous DNA occurring in the field or by laboratory personnel.

Samples should be routinely compared to case specific elimination samples, personnel databases, and the local CODIS database for possible matches. Mixtures may have to be manually compared.

If a negative or positive control contains exogenous DNA, all the associated samples are deemed inconclusive and their alleles are not listed in the report. The samples should be re-extracted or re-amplified, if possible.

3. If a clean result cannot be obtained or the sample cannot be repeated then the summary section of the reports should state “The following sample(s) can not be used for comparison due to quality control reasons.”

4. Once exogenous DNA has been discovered, the first step is to try to find an alternate sample.
a. As appropriate, a new extraction, amplification, or electrophoresis of the same sample can serve as an alternate for the affected sample. For this type of alternate sample the discovery of exogenous DNA is not noted in the report. However all case notes related to the discovery of exogenous DNA are retained in the case file for review by the quality assurance group, forensic biology staff, attorneys and outside experts. A form is created that identifies the source of the exogenous DNA by Lab Type ID Number, if known, and stating which samples were affected.

b. If there are other samples from the crime scene which would serve the same purpose, they could be used as an alternate sample. For example, in a blood trail or a blood spatter, another sample from the same source should be used. Another swab or underwear cutting should be used for a sexual assault. In this scenario, the sample containing the exogenous DNA should be listed in the summary section of the report as follows: “The [sample] cannot be used for comparison because it appears to contain DNA consistent with a {NYPD member, OCME [laboratory] member, medical responder}. Instead please see [alternate sample] for comparison”. No names for the possible source(s) of the exogenous DNA are listed in the report. All case notes related to the event are retained in the case file for review by attorneys and their experts. A form is created that identifies the source of the exogenous DNA by Lab Type ID Number, if known, and stating which samples were affected.

5. If an alternate sample cannot be found then only samples containing a partial profile of the exogenous DNA can be interpreted. Interpreting samples containing a full profile of the exogenous DNA could lead to erroneous conclusions due to the masking effect of significant amounts of DNA.

a. If a sample has a single source of DNA and this DNA appears to be exogenous DNA then the following should be listed in the summary section of the report: “The [sample] will not be used for comparison because it appears to contain DNA consistent with a {NYPD member, OCME [laboratory] member, medical responder}.” No names for the possible source(s) of exogenous DNA are listed in the report. All case notes related to the event are retained in the case file for review by the quality assurance group, forensic biology staff, attorneys, and outside experts. A form is created that identifies the source of the exogenous DNA by Lab Type ID Number and stating which samples were contaminated.
b. If a sample contains a mixture of DNA and **ALL** of the alleles from the source of the exogenous DNA appear in the mixture then the following should be listed in the summary section of the report. **“The [sample] contains a mixture of DNA. The mixture is consistent with a {NYPD member, OCME [laboratory] member, medical responder} and at least [#] other individual(s).”** The [sample] will not be used for comparison.**”** No names for the possible source(s) of exogenous DNA are listed in the report. All case notes related to the event are retained in the case file for review by the quality assurance group, forensic biology staff, attorneys, and outside experts. A form is created that identifies the source of the exogenous DNA by Lab Type ID Number and stating which samples were affected.

**Unresolved discrepancies**

Legitimate differences of opinions or disputes concerning the interpretation of results may occur. If differences of opinion cannot be resolved by the analyst, supervisor, and/or manager, then the appropriate Technical Leader will be the final arbiter.

**DNA storage**

1. Store evidence and unamplified DNA in a separate refrigerator or freezer from the amplified DNA.

2. During analysis, all evidence, unamplified DNA, and amplified DNA should be stored refrigerated or frozen. Freezing is generally better for long term storage.

3. Amplified DNA is discarded after the Genotyper analysis is completed.

4. DNA extracts are retained refrigerated for a period of time, then frozen for long-term storage.
CHELEX DNA EXTRACTION FROM BLOOD AND BUCCAL SWABS

Sample sizes for Chelex extraction should be approximately 3μL of liquid blood or saliva, 1/3 of a swab, or a 3x3mm cutting of a bloodstain.

1. Remove the extraction rack from the refrigerator. Extract either evidence or exemplars. Obtain two tubes for the extraction negatives and label them.

2. Have a witness confirm the names and order of the samples.

3. Obtain reagents and record lot numbers.

4. Pipet 1 mL of sterile deionized water into each of the tubes in the extraction rack.

5. Mix the tubes by inversion or vortexing.

6. Incubate in a shaker (at approx. 1000 rpm) at room temperature for 15 to 30 minutes.

7. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g (13,200 rpm).

8. Carefully remove supernatant (all but 30 to 50 μL). If the sample is a bloodstain or swab, leave the substrate in the tube with pellet.

9. Add 175 μL of 5% Chelex (from a well-resuspended Chelex solution) using a P1000 μL Pipetman.

10. Incubate at 56°C for 15 to 30 minutes.

11. Vortex at high speed for 5 to 10 seconds.

12. Incubate at 100°C for 8 minutes using a screw-down rack.

13. Vortex at high speed for 5 to 10 seconds.

14. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g (13,200 rpm).

15. Pipet aliquots of neat and/or diluted extract (using TE+4) into microcentrifuge tubes for real-time PCR analysis to determine human DNA concentration (refer to Section 4 of the STR manual).

16. Store the extracts at 2 to 8°C or frozen.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
17. In the LIMS system, navigate to the Data Entry page, assign the samples to a storage unit (cryobox), and indicate which samples are completed.

18. Have a supervisor review the assay.
Sample sizes for this Chelex extraction should be approximately a 3x3mm cutting of tissue.

1. Remove the extraction rack from the refrigerator. Extract either evidence or exemplars. Obtain tubes for the extraction negatives and label them. Have a witness confirm the order of the samples.
2. Obtain reagents and record lot numbers.
3. Pipet 1 mL of sterile deionized water into each of the tubes in the extraction rack. Mix the tubes by inversion or vortexing.
4. Incubate at room temperature for 15 to 30 minutes. Mix occasionally by inversion or vortexing.
5. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g (13,200 rpm).
6. Carefully remove supernatant (all but 30 to 50 μL).
7. To each tube add: 200 μL of 5% Chelex (from a well-resuspended Chelex solution).
   1 μL of 20 mg/mL Proteinase K
8. Mix using pipette tip.
9. Incubate at 56°C for 60 minutes.
10. Vortex at high speed for 5 to 10 seconds.
11. Incubate at 100°C for 8 minutes using a screw down rack.
12. Vortex at high speed for 5 to 10 seconds.
13. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g (13,200 rpm).
14. As needed, pipet aliquots of a neat, 1/100 dilution and a 1/10,000 dilution (using TE+) into microcentrifuge tubes for real-time PCR analysis to determine human DNA concentration (refer to Section 4 of the STR manual).
15. Store the extracts at 2 to 8°C or frozen.
16. In the LIMS system, navigate to the Data Entry page, assign the samples to a storage unit (cryobox), and indicate which samples are completed.
17. Have a supervisor review the assay.

Revision History:
March 24, 2010 – Initial version of procedure.
July 16, 2012 – Revised procedure to accommodate LIMS.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
CHELEX DNA EXTRACTION FROM EPITHELIAL CELLS

DATE EFFECTIVE 04-04-2013
APPROVED BY EUGENE LIEN
PAGE 1 OF 2

(FOR AMYLASE POSITIVE STAINS OR SWABS, CIGARETTE BUTTS, SCRAPINGS)

Sample sizes for this Chelex extraction should be approximately a 5x5mm cutting or 50% of the scrapings recovered from an item.

1. Remove the extraction rack from the refrigerator. Extract either evidence or exemplars. Obtain tubes for the extraction negatives and label them.
2. Have a witness confirm the order of the samples.
3. To each tube add: 200 µL of 5% Chelex (from a well-resuspended Chelex solution). 1 µL of 20 mg/mL Proteinase K
   (Note: For very large cuttings, the reaction can be scaled up to 4 times this amount. This must be documented. Scaling up any higher requires permission from the supervisor and/or IA of the case. The final extract may need to be Microcon concentrated.)
4. Mix using pipette tip.
5. Incubate at 56°C for 60 minutes.
6. Vortex at high speed for 5 to 10 seconds.
7. Incubate at 100°C for 8 minutes using a screw down rack.
8. Vortex at high speed for 5 to 10 seconds.
9. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g (13,200 rpm).
10. As needed, pipet aliquots of neat and/or diluted extract (using TE+) into microcentrifuge tubes for real-time PCR analysis to determine human DNA concentration (refer to the “Estimation of DNA Quantity Using the RotorGene” procedure in the STR manual).
11. Store the remainder of the supernatant at 2 to 8°C or frozen.
12. In the LIMS system, navigate to the Data Entry page, assign the samples to a storage unit (cryobox), and indicate which samples are completed.
13. Have a supervisor review the assay.

Revision History:
March 24, 2010 – Initial version of procedure.
July 16, 2012 – Information added to accommodate LIMS.
April 4, 2013 – The wording regarding the concentration of the aliquots needed for the RotorGene was changed to allow more flexibility.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>APPROVED BY</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>04-04-2013</td>
<td>EUGENE LIEN</td>
<td>2 OF 2</td>
</tr>
</tbody>
</table>

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
NOTE: For very large cuttings 200 uL of Chelex might not be enough to provide enough suspension of the sample. The reaction can be scaled up and reconcentrated using Microcon concentrators.

Sample sizes for non-differential Chelex extractions depend on the circumstances of the case. Regularly 1/3 of a swab or a 3x3mm cutting of a stain should be used. For cases where semen is present but no sperm cells were detected, the sample size can be increased.

1. Remove the extraction rack from the refrigerator. Obtain tubes for the extraction negatives and label them.
2. Have a witness confirm the order of the samples.
3. Obtain reagents and record lot numbers.
4. To each tube add: 200 µL of 5% Chelex (from a well-resuspended Chelex solution). 1 µL of 20 mg/mL Proteinase K 7 µL of 1 M DTT
5. Use the pipette tip when adding the DTT to thoroughly mix the contents of the tubes.
6. Incubate at 56°C for approximately 2 hours.
7. Vortex at high speed for 10 to 30 seconds.
8. Incubate at 100°C for 8 minutes using a screw down rack.
9. Vortex at high speed for 10 to 30 seconds.
10. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g (13,200 rpm).
11. As needed, pipet aliquots of neat and/or diluted extract (using TE-4) into microcentrifuge tubes for real-time PCR analysis to determine human DNA concentration (refer to the “Estimation of DNA Quantity Using the RotorGene” procedure in the STR manual).
12. Store the extracts at 2 to 8°C or frozen.
13. In the LIMS system, navigate to the Data Entry page, assign the samples to a storage unit (cryobox), and indicate which samples are completed.
14. Have a supervisor review the assay.

Revision History:
March 24, 2010 – Initial version of procedure.
July 16, 2012 – Information added to accommodate LIMS.
April 4, 2013 – The wording regarding the concentration of the aliquots needed for the RotorGene was changed to allow more flexibility.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Approximately 1/3 of a swab or a 3x3mm cutting of a stain should be used for this type of extraction.

1. Remove the extraction rack from the refrigerator.

2. Pipet 1 mL of PBS into each tube, including tubes for extraction negative controls, in the extraction rack.

3. Mix by inversion or vortexing.

4. Incubate at room temperature overnight or for a minimum of 1 hour using a shaking platform (at approx. 1000 rpm).

5. Have a witness confirm the order of the samples.

6. Vortex or sonicate the substrate or swab for at least 2 minutes to agitate the cells off of the substrate or swab. At this point, label the extraction negative controls with the date and time.

7. Label new tubes to hold the swab or substrate remains. Sterilize tweezers with 10% bleach, distilled water, and 70% ethanol before the removal of each sample. Remove the swab or other substrate from the sample tube, one tube at a time, using sterile tweezers and close tube. Place swab or substrate in the sterile labeled substrate remains fraction tube.

8. Spin in a microcentrifuge for 5 minutes at 10,000 to 15,000 x g (13,200 rpm).

9. Without disturbing the pellet, remove and discard all but 50 μL of the supernatant.

10. Resuspend the pellet in the remaining 50 μL by stirring with a sterile pipette tip.

11. To the approximately 50 μL of resuspended cell debris pellet, add 150 μL sterile deionized water (final volume of 200 μL).

12. Add 1 μL of 20 mg/mL Proteinase K. Vortex briefly to resuspend the pellet.

13. Incubate at 56°C for about 60 minutes to lyse epithelial cells, but for no more than 75 minutes, to minimize sperm lysis.
14. During the incubation step do the following:
   a. Label a new tube for each sample, including an epithelial cell extraction negative control. Mark each tube as an epithelial cell fraction.
   b. Add 50 μL of 20% Chelex (from a well-resuspended Chelex solution) to each epithelial cell fraction tube.
   c. Close tubes.

15. Spin the extract in a microcentrifuge at 10,000 to 15,000 x g (13,200 rpm) for 5 minutes.

16. Add 150 μL of the supernatant from each sample and the extraction negatives to its respective epithelial cell fraction sample tube. Store at 4°C or on ice until step 20.

17. Wash the sperm pellet with Digest Buffer as follows:
   a. Resuspend the pellet in 0.5 mL Digest Buffer.
   b. Vortex briefly to resuspend pellet.
   c. Spin in a microcentrifuge at 10,000 to 15,000 x g (13,200 rpm) for 5 minutes.
   d. Remove all but 50 μL of the supernatant and discard the supernatant.
   e. Repeat steps a-d for a total of 5 times.

18. Wash the sperm pellet once with sterile dH₂O as follows:
   a. Resuspend the pellet in 1 mL sterile dH₂O.
   b. Vortex briefly to resuspend pellet.
   c. Spin in a microcentrifuge at 10,000 to 15,000 x g (13,200 rpm) for 5 minutes.
   d. Remove all but 50 μL of the supernatant and discard the supernatant.

19. Resuspend the pellet by stirring with a sterile pipette tip.

20. To the approximately 50 μL resuspended sperm fraction and to the tubes containing the substrate remains and the sperm fraction extraction negative, add 150 μL of 5% Chelex, 1 μL of 20 mg/mL Proteinase K, and 7 μL of 1M DTT. Mix gently.

21. Vortex both the epithelial cell and sperm fractions. The following steps apply to all fractions.

22. Incubate at 56°C for approximately 60 minutes.
23. Vortex at high speed for 5 to 10 seconds.

24. Incubate at 100°C for 8 minutes using a screw down rack.

25. Vortex at high speed for 5 to 10 seconds.

26. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g (13,200 rpm).

27. As needed, pipet aliquots of neat and/or diluted extract (using TE\(^{-4}\)) into microcentrifuge tubes for real-time PCR analysis to determine human DNA concentration (refer to the “Estimation of DNA Quantity Using the RotorGene” procedure in the STR manual).

28. Store the extracts at 2 to 8°C or frozen.

29. In the LIMS system, navigate to the Data Entry page, assign the samples to a storage unit (cryobox), and indicate which samples are completed.

30. Have a supervisor review the assay.

Revision History:
March 24, 2010 – Initial version of procedure.
July 16, 2012 – Information added to accommodate LIMS.
April 4, 2013 – The wording regarding the concentration of the aliquots needed for the RotorGene was changed to allow more flexibility.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Refer to the following sections of the Protocols for Forensic Mitochondrial DNA Analysis:

- Hair Examination
- Mitochondrial and Nuclear DNA Hair Extraction
- Mideo Macro/Microscopic Digital Imaging
A. Sample Preparation

**Liquid/dry blood, bone marrow, oral swab and tissue sample preparation**
Stained substrates and oral swabs should be cut into small pieces (3 x 3 mm). Tissues should be minced into small pieces in a weigh boat using a sterile scalpel or razor blade. Place samples in 1.5mL microcentrifuge tubes or conical tubes when appropriate. See table below for various sample types.

Proceed to Section B: Sample Incubation

<table>
<thead>
<tr>
<th>Sample type</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Liquid blood</td>
<td>100 to 500 µL</td>
</tr>
<tr>
<td>Bone marrow</td>
<td>0.5 x 0.5 cm to 1.5 x 1.5 cm</td>
</tr>
<tr>
<td>Oral swab</td>
<td>1/4 to a whole swab</td>
</tr>
<tr>
<td>Blood stain</td>
<td>0.5 x 0.5 cm to 1.5 x 1.5 cm</td>
</tr>
<tr>
<td>Soft tissue</td>
<td>0.5 x 0.5 cm to 1.5 x 1.5 cm</td>
</tr>
<tr>
<td>Paraffin embedded tissue</td>
<td>0.3 x 0.3 cm to 1.0 x 1.0 cm</td>
</tr>
</tbody>
</table>

**Bone preparation**
Before extraction, a bone or tooth specimen should be cleaned entirely of soft tissue and dirt using a range of methods, such as scraping, rinsing and sonication. A combination of sterile scalpels, sterile toothbrushes and running water should be used to clean the specimen. For a sonication bath, the sample is placed in a conical tube and covered with a 5% Terg-a-zyme solution. For additional cleaning, the sonication step may be repeated multiple times by decanting the liquid and replacing with fresh Terg-a-zyme solution. After cleaning, the sample is usually rinsed with distilled water and dried using a 56°C incubator (drying time may vary from a few hours to overnight).

**Note:** Terg-a-zyme is an enzyme-active powdered detergent. A 5% solution should be made fresh prior to bone preparation and cleaning. Refer to Appendix A in the Quality Assurance Manual. Once prepared, the reagent will only be effective for up to 16 hours.
1. Photograph bone or tooth sample after cleaning. Measure and weigh specimen prior to sampling.

2. If several bones are available, generally compact bone is preferred, such as humerus, femur, or tibia.

**WARNING**

Protective eyewear, lab coats, cut resistant gloves, sleeve protectors, and HEPA-filtered facial masks should be worn when cutting bone. Avoid breathing bone dust. All cutting of bone must be done under a biological hood.

3. Using an autopsy saw or a Dremel tool equipped with a 409 or 420 cutting wheel, cut the bone specimen into approximately 5x5x5mm size pieces. Take enough cuttings for an end weight of approximately 2g. For older or compromised bones, several aliquots of 2g can be extracted and combined during the Microcon step. For tooth samples, the whole root should be taken. Note: The cutting wheel should be disposed of after each use and the Dremel and hood should be completely wiped down with bleach and ethanol.

4. Place bone cuttings in 50mL conical tubes labeled with the FB case number, ME#, PM item #, initials, and date.

5. Cover bone cuttings with 5% Terg-a-zyme solution and sonicate samples for 30-45 minutes. Note: Ensure water level in the sonicator is 1-2 inches from the top.

6. Decant the Terg-a-zyme and wash with distilled water until no detergent bubbles remain.

7. If necessary, repeat with fresh changes of 5% Terg-a-zyme and water washes until the dirt has been removed.

8. Place the clean cuttings in a weigh boat on a small Kim Wipe. Cover with another weigh boat. Label the weight boat with the FB case number, ME#, PM item #, initials, and date.

9. Seal with evidence tape.

10. Dry in a 56°C incubator for a few hours or overnight. After sufficient drying, weigh bone cuttings. The bone sample must be completely dry before milling.
Sample milling with the SPEX Certiprep 6750 Freezer Mill

All freezer mill parts that come into contact with bone specimens, such as the cylinders, metal end plugs and impactors, should be cleaned, dried and sterilized prior to use. See Step 22 for appropriate cleaning procedure.

1. Assemble specimen vials in the following order: metal bottom, plastic cylinder, impactor, and metal top.

2. Place under UV light for a minimum of 15 minutes.

3. Label metal bottoms with a case identifier using a blue ink Sharpie.

4. Add bone cuttings to specimen vial around impactor using decontaminated forceps. Cover with metal top. **Note: Shake specimen vial and ensure that the impactor can move back and forth.**

5. Wipe down inside of mill with a wet paper towel. **Do not use bleach or ethanol.**

6. Plug in mill and switch ON.

7. Obtain liquid nitrogen from tank by filling transfer container. Be aware that the liquid nitrogen tank may be empty when the detector level reads anywhere from “¼” to “empty”.

**WARNING**

Liquid nitrogen can be hazardous. Use cryogenic gloves, protective eyewear/face shield and lab coats when handling. Avoid liquid nitrogen splashes to face and hands.

8. Open the freezer mill lid. Add liquid nitrogen slowly into the mill up to the FILL LINE to avoid splashing and boiling over.

9. Place the specimen vial into the round chamber. If processing more than one bone sample it is possible to save pre-cooling time by placing up to two vials in the mesh container inside the mill.

10. Change cycle number to match total number of samples plus two (n + 2).
11. Adjust mill settings as follows:

<table>
<thead>
<tr>
<th>Cycle</th>
<th>set to # of samples + 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td></td>
</tr>
<tr>
<td>T1 (milling)</td>
<td>2.0 min</td>
</tr>
<tr>
<td>T2 (pause)</td>
<td>2.0 min</td>
</tr>
<tr>
<td>T3 (pre-cool)</td>
<td>15.0 min</td>
</tr>
<tr>
<td>Rate</td>
<td>Bones – 8-10</td>
</tr>
<tr>
<td></td>
<td>Teeth – 6-8</td>
</tr>
</tbody>
</table>

12. Close cover slowly to avoid any liquid nitrogen splashes and press RUN to start the mill. Pre-cooling will begin followed by the milling cycle.

13. During the 2-minute pause phase, it is now possible to open the mill and remove the finished sample using cryogenic gloves.

14. Place one of the pre-cooled specimens waiting in the dock in the round chamber.

15. If liquid nitrogen level is below the FILL LINE, refill. A loud noise during milling means that the liquid nitrogen level is low. If liquid nitrogen is not refilled, damage to the mill, mill parts, and cylinder can occur.

16. Close the lid and press RUN again. Repeat from Step 11 until all samples are processed.

17. Inspect each sample after removal from the mill. If sample is sufficiently pulverized, remove the metal top using the Spex Certi-Prep opening device. Note: Samples may be reinserted into the mill for additional grinding.

18. Using decontaminated tweezers, remove impactor from vial and submerge in 10% bleach.

19. Empty bone dust into labeled 50mL Falcon tube. Ensure complete dust transfer by tapping bottom of cylinder. Weigh bone dust and document.

20. Soak metal end parts and plastic cylinder in 10% Bleach.

21. When milling is complete, switch mill to OFF and unplug. Leave cover open for liquid nitrogen to evaporate. The next day, lower cover and place in storage until next use.
22. **Mill Parts -Clean Up**: Mill parts must be cleaned immediately after processing. If this is not possible, steps a-b must be completed before leaving overnight.
   a. Rinse off with 10% bleach.
   b. Soak all parts in 0.1% SDS.
   c. Brush parts with a new toothbrush to remove any residual bone dust.
   d. Rinse with water.
   e. Soak parts in 10% bleach and brush each part in bleach individually.
   f. Rinse with water.
   g. Separate the plastic cylinders from the metal parts.
   h. Rinse in 100% ethanol. **ONLY** the metal top, metal bottom, and compactor can be rinsed in 100% ethanol. **DO NOT** rinse the plastic cylinder in ethanol as it will cause the plastic cylinder to break.
   i. Use isopropanol to remove any identifying marks made with a Sharpie on the tops or bottoms of the cylinders.
   j. Dry and expose the parts to UV light for a minimum of 2 hours. The UV light in a biological hood or a StrataLinker can be used.

23. Proceed to Section B: Sample Incubation.

**Laser Microdissection of Products of Conception**

1. Initial processing

The product of conception (POC) can be received in different stages of preparation.

a) POC scrapings in saline buffer: Remove tissue from liquid either by filtration or centrifugation:
   - Transfer liquid to 50mL falcon tube
   - Spin sample in a bench top Eppendorf or IEC Centra CL3R at 1000 RPM for 5 minutes
   - Discard liquid supernatant

Submit sample to the Histology department for tissue processing according to the OCME Histology Procedure Manual section E. Then proceed as for b).
b) POC fixated and embedded in paraffin blocks:

Contact histology department and ask them to prepare microscope slides from the paraffin block using the following precautions:

- Use disposable blades for the microtome and discard after each case.
- Clean working surface on microtome by wiping with 10% bleach and alcohol before and after each case.
- Use individual floating chambers for each case.
- Use uncharged microscope slides

The slides then should be stained with hematoxylin and eosin-phloxine (H&E technique) as described in the OCME-Histology Procedure Manual. But again during the staining procedure, separate sets of jars have to be used for each case.

c) Stained or unstained microscope slides from POC blocks:

If the slides are unstained, ask the histology department to stain them as described above. Otherwise proceed with the microdissection technique. **Attention:** For slides that were prepared by a histology laboratory outside of the OCME, foreign DNA not from the mother and the fetus might be present on the slide.

2. PixCell IIe Laser Capture Microdissection

A trained pathologist has to be present to distinguish decidual tissue from chorionic villi and operate the laser. After the slide has been placed on the microscope platform the pathologist will visually identify the area of interest, mark this area for the laser, and activate the laser. The laser setting is specified in the Arcturus instrument manual. The Forensic Biology Criminalist needs to be present during the complete procedure to maintain chain of custody of the evidence.

An area of chorionic villi and an area of maternal tissue should be collected on separate CapSure caps. The caps can be stored and transported in 50 ml Falcon tubes. A third unused CapSure cap should be extracted as an extraction negative control.
Use new scalpel and clean forceps to remove the film from the cap and transfer the film to a fresh 1.5mL microcentrifuge tube containing 500μL of organic extraction buffer, DTT, SDS and Proteinase K as described below.

B. Sample Incubation

1. Process an extraction negative with every batch of extractions.

2. Prepare the master mix in microcentrifuge tube or conical tube and mix thoroughly by swirling or vortexing very briefly.

For liquid blood, dry blood and bone marrow samples:

<table>
<thead>
<tr>
<th></th>
<th>1 Sample</th>
<th>5 Samples</th>
<th>10 Samples</th>
<th>15 Samples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organic extraction buffer</td>
<td>400 µL</td>
<td>2.0 mL</td>
<td>4.0 mL</td>
<td>6.0 mL</td>
</tr>
<tr>
<td>20% SDS</td>
<td>10µL</td>
<td>50 µL</td>
<td>100 µL</td>
<td>150 µL</td>
</tr>
<tr>
<td>Proteinase K (20 mg/mL)</td>
<td>13.6 µL</td>
<td>68 µL</td>
<td>136 µL</td>
<td>204 µL</td>
</tr>
<tr>
<td><strong>Total Incubation Volume per sample:</strong></td>
<td>400 µL</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For bone samples:

<table>
<thead>
<tr>
<th></th>
<th>Per bone (~2g dust)</th>
<th>1 sample (N+ 2)</th>
<th>3 samples (N+ 2)</th>
<th>5 samples (N+ 2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organic Extraction Buffer</td>
<td>2370 µL</td>
<td>7.11 mL</td>
<td>11.85 mL</td>
<td>16.59 mL</td>
</tr>
<tr>
<td>20% SDS</td>
<td>300 µL</td>
<td>900 µL</td>
<td>1.5 mL</td>
<td>2.1 mL</td>
</tr>
<tr>
<td>1.0 M DTT</td>
<td>120 µL</td>
<td>360 µL</td>
<td>600 µL</td>
<td>840 µL</td>
</tr>
<tr>
<td>Proteinase K (20 mg/mL)</td>
<td>210 µL</td>
<td>630 µL</td>
<td>1.05 mL</td>
<td>1.47 mL</td>
</tr>
<tr>
<td><strong>Total Incubation Volume per sample:</strong></td>
<td>3000 µL</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
For teeth samples:

<table>
<thead>
<tr>
<th></th>
<th>Per tooth</th>
<th>1 sample (N+2)</th>
<th>3 samples (N+2)</th>
<th>5 samples (N+2)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Organic Extraction Buffer</strong></td>
<td>790 µL</td>
<td>2.37 mL</td>
<td>3.95 mL</td>
<td>5.53 mL</td>
</tr>
<tr>
<td><strong>20% SDS</strong></td>
<td>100 µL</td>
<td>300 µL</td>
<td>500 µL</td>
<td>700 µL</td>
</tr>
<tr>
<td><strong>1.0 M DTT</strong></td>
<td>40 µL</td>
<td>120 µL</td>
<td>200 µL</td>
<td>280 µL</td>
</tr>
<tr>
<td><strong>Proteinase K (20 mg/mL)</strong></td>
<td>70 µL</td>
<td>210 µL</td>
<td>350 µL</td>
<td>490 µL</td>
</tr>
</tbody>
</table>

Total Incubation Volume per sample: 1000 µL

For tissues and paraffin embedded tissue (e.g., microdissection) samples:

<table>
<thead>
<tr>
<th></th>
<th>Per tissue</th>
<th>1 sample (N+2)</th>
<th>3 samples (N+2)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Organic extraction buffer</strong></td>
<td>395 µL</td>
<td>1185 µL</td>
<td>1975 µL</td>
</tr>
<tr>
<td><strong>20% SDS</strong></td>
<td>50 µL</td>
<td>150 µL</td>
<td>250 µL</td>
</tr>
<tr>
<td><strong>1.0 M DTT</strong></td>
<td>20 µL</td>
<td>60 µL</td>
<td>100 µL</td>
</tr>
<tr>
<td><strong>Proteinase K (20 mg/mL)</strong></td>
<td>33 µL</td>
<td>105 µL</td>
<td>175 µL</td>
</tr>
</tbody>
</table>

Total Incubation Volume per sample: 500 µL

3. Add the appropriate incubation volume of master mix to each sample tube and vortex tube. Vortex tubes briefly. Make certain the substrate, tissue, or swab is totally submerged. **Note: Reagent volumes may be adjusted in order to accommodate the size or nature of a particular sample.**

4. Place tubes in a shaking 56°C heat block and incubate overnight.

5. Proceed to Section C: Phenol Chloroform Extraction and Microcon® cleanup.
C. Phenol Chloroform and Microcon Clean up

Set Up
Remove the Phenol:Chloroform:Isoamyl Alcohol (25:24:1) (PCIA) from the refrigerator.

Obtain organic waste jug for disposal of any tubes or pipette tips that come in contact with PCIA.

**WARNING**
Phenol Chloroform is toxic. Protective eyewear, mask, lab coat, and nitrile gloves should be worn when handling. All work must be conducted under a chemical fume hood.

*For samples possibly needing mtDNA or High Sensitivity DNA testing:* Place one Microcon® collection tube and one 1.5 mL microcentrifuge tube for each sample, including the extraction negative, in the StrataLinker for at least 15 minutes. **Note:** Irradiate multiple tubes (4-6) per bone sample to accommodate the total volume of incubation buffer.

1. Vortex and centrifuge the incubated microcentrifuge tube samples at high speed for 1 minute. Vortex and centrifuge bone dust, incubated in 50 mL conical tubes, for 5-10 minutes at 1000 RPM in Eppendorf Centrifuge Model 5810.

2. Obtain and label one prepared Eppendorf Phase Lock Gel (PLG) tube per sample, including the extraction negative. PLG tubes make phase separation easier and are optional.

**NOTE:** For bone samples, label as many tubes to accommodate the total volume of incubation buffer per sample. For example, if you incubated 2g of bone dust with 3 mL of incubation buffer, you will need 6 PLG tubes.

**NOTE:** See section D for PLG tube preparation instructions.

3. Centrifuge PLG tubes at maximum speed for 30 seconds.

4. Label Microcon® filters for each sample. Prepare the Microcon® concentrators by adding 100 µL of TE⁻⁴ to the filter side (top) of each concentrator. Set aside until step 11.
5. Add a volume of Phenol:Chloroform:isoamyl Alcohol 25:24:1 (PCIA) to the PLG tube which is equal to the volume of incubation buffer (typically 400 µL) to be added from the sample. **Note: When pipetting PCIA, you must penetrate the top buffer layer and only aliquot the desired amount from the lower, clear organic layer. Place used pipette tips in the organic waste bottle.**

6. Have someone witness your sample tubes, PLG tubes, and Microcon® tubes.

7. Pipet the sample supernatant (typically 400 µL) to the PLG tube already containing PCIA. For bone dust samples, pipet several aliquots of the supernatant into multiple PLG tubes. **Note: Do not disturb bone pellet.**

8. Shake the PLG tube vigorously by hand or by inversion to form a milky colored emulsion. **Note: Do NOT vortex the PLG tube.**

9. Centrifuge samples for 2 minutes at maximum speed to achieve phase separation. (On Eppendorf Centrifuge Model 5415D, spin at 16.1 RCF or 13.2 RPM).

10. If the sample is discolored, contains particles in the aqueous phase, or contains a lot of fatty tissue, transfer the top layer (aqueous phase) to a new PLG tube and repeat Steps 7-9. **Note: The aqueous layer from bone and teeth will usually be discolored. Only repeat the phenol-chloroform clean-up steps if any dust or particles are present in the aqueous layer. If it is not necessary to repeat the clean-up step, go to Step 11.**

11. Carefully transfer the aqueous phase (top layer) to the prepared Microcon® concentrator. Be careful not to let the pipette tip touch the gel. **Note: Discard used PLG tubes into the organic waste bottle.**

12. Spin the Microcon® concentrators for 12-24 minutes at 500 x g, which is approximately 2500 RPM. (On Eppendorf Centrifuge Model 5415D, spin at 0.6 RCF or 2600 RPM). **Note: Ensure that all fluid has passed through filter. If it has not, spin for additional time, in 8-minute increments. If fluid still remains, transfer sample to a new filter and microcon again.**

13. Discard the wash tubes and place the concentrators into a new collection tube.

14. Add 400 µL of TE⁻⁴ to the filter side of each Microcon® concentrator.
15. Spin again for **12 minutes at 500 x g**. (On Eppendorf Centrifuge Model 5415D, spin at 0.6 RCF or 2600 RPM). **Note:** Ensure that all fluid has passed through filter. If it has not, spin for additional time, in 8-minute increments. If fluid still remains, transfer sample to a new filter and microcon again.

16. Add **40 µL of TE<sup>-4</sup>** to the filter side of each **Microcon® concentrator**. **Note:** For bone samples, add only 10-20 µL of TE<sup>-4</sup> to each filter side to ensure smallest elution volume.

17. Invert sample reservoir and place into a new labeled collection tube. **(For samples possibly needing mtDNA or High Sensitivity DNA testing, invert sample reservoirs into irradiated collection tubes).** Spin at 1000 x g, which is approximately 3500 RPM, for 3 minutes. (On Eppendorf Centrifuge Model 5415D, spin at 1.2 RCF or 3600 RPM).

18. Measure the approximate volume recovered and record the value. **Note:** Combine bone elutants before measuring volume.

19. Discard sample reservoir and adjust sample volume depending on the starting amount and expected DNA content as follows using TE<sup>-4</sup>. **Note:** Samples may be microcon’ed again to further concentrate low DNA content samples.

<table>
<thead>
<tr>
<th>Sample type</th>
<th>Final Volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>High DNA content (Large amounts of blood, fresh tissue, bone marrow, oral swabs, and dried bloodstains)</td>
<td>400 µL</td>
</tr>
<tr>
<td>Medium DNA content (Small amounts of blood, fresh tissue, bone marrow, oral swabs, and dried bloodstains); differential lysis samples</td>
<td>200 µL</td>
</tr>
<tr>
<td>Low DNA content (Formalin fixed tissue, dried bone, teeth, samples from decomposed or degraded remains, some reference samples)</td>
<td>100 µL</td>
</tr>
</tbody>
</table>
20. Transfer samples to newly labeled 1.5mL microcentrifuge tubes for storage. *(For samples possibly needing mtDNA or High Sensitivity DNA testing, transfer samples to irradiated 1.5 mL microcentrifuge tubes).* Record the approximate final volume.

21. As needed, pipet aliquots of neat and/or diluted extract (using TE\(^{-4}\)) into microcentrifuge tubes for real-time PCR analysis to determine human DNA concentration (refer to Section 4 of the STR manual).

22. Store the extracts at 2 to 8°C or frozen.

23. In the LIMS system, navigate to the Data Entry page, assign the samples to a storage unit (cryobox), and indicate which samples are complete.

24. Have a supervisor review the assay.

**NOTE:** See Microcon® troubleshooting (in the appropriate section of the STR manual) as needed.

### D. Preparation of Phase Lock Gel (PLG) tubes

Make sure the plasticware being used is resistant to phenol and chloroform.

1. Without putting pressure on the plunger, twist off the orange cap and discard. Attach the gray dispensing tip (supplied) to the syringe and tighten securely. *(NOTE: Use of gray tip is optional for a smoother application of PLG. Less force is necessary when gray tip is NOT used.)*

2. Apply firm pressure on the plunger to dispense PLG until it reaches the end of gray tip. Add heavy PLG based on Table below. *NOTE: 325μL = 3.25 cc corresponds to 3 lines on the syringe.*

<table>
<thead>
<tr>
<th>Tube size</th>
<th>PLG heavy</th>
<th>Tube size</th>
<th>PLG heavy</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5mL</td>
<td>100μL</td>
<td>15mL</td>
<td>3mL</td>
</tr>
<tr>
<td>1.5mL</td>
<td>325μL</td>
<td>50mL</td>
<td>5mL</td>
</tr>
<tr>
<td>2.0mL</td>
<td>325μL</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
3. Pellet the PLG by spinning the tubes prior to use. See table below.

<table>
<thead>
<tr>
<th>Tube size</th>
<th>Centrifuge model</th>
<th>Speed</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5 to 2.0mL</td>
<td>Eppendorf 5415C</td>
<td>14 x 1000 RPM</td>
<td>30s</td>
</tr>
<tr>
<td></td>
<td>Eppendorf 5415D</td>
<td>13.2 x 1000 RPM/16.1 x 1000RCF</td>
<td></td>
</tr>
<tr>
<td>15 and 50mL</td>
<td>Sigma 4-15 C</td>
<td>1500 RCF</td>
<td>2m</td>
</tr>
</tbody>
</table>

Revision History:
March 24, 2010 – Initial version of procedure.
July 16, 2012 – Revised procedure to accommodate LIMS.
April 1, 2014 – Updated procedure to reflect use of DNA Fast Flow Microcons (Removed Microcon 100)
A. Preparation

1. Extraction sets consist of 9 samples and one or two extraction negatives. Additional extractions may continue sequentially during incubations.

2. Name the extraction set by its date and time using the following format: “082010.1000”. An “E” may precede the date and time of the extraction.

3. The documentation will automatically calculate the requisite amount of reagents needed for the extraction.

4. Follow the procedures for Work Place Preparation (refer to the General Guidelines Procedure of this manual).

B. Digestion

1. Self-Witnessing Step: Confirm the sample names and their order on the documentation with the names on the sample tubes.

2. Obtain reagents and record lot numbers.

3. Prepare digestion buffer in an UV irradiated tube (1.5 mL, 2.0 mL Dolphin, or 15 mL).

4. Prepare the digestion buffer according to the calculated volumes on the documentation. The volume for one sample is shown below.

<table>
<thead>
<tr>
<th>Stock Solution</th>
<th>Concentration</th>
<th>1 sample</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>0.05% SDS</strong> (or 0.01% SDS when using Poly A RNA at a later step)</td>
<td><strong>0.05%</strong> (or 0.01%)</td>
<td>192 µL</td>
</tr>
<tr>
<td>Proteinase K <strong>20 mg/mL</strong></td>
<td>0.80 mg/mL</td>
<td>8 µL</td>
</tr>
</tbody>
</table>
5. Vortex solution well. Add 200 µL of the digestion buffer to each sample. Open only one sample tube at a time using the cap opener. Ensure that the swabs are submerged in the digestion fluid. If necessary, add an additional 200 µL of the digest buffer (including the Proteinase K) to the sample in order to submerge a large sample, and be sure to document the deviation.

6. Record the temperatures of the heat shakers. Temperatures must be within ± 3°C of the set temperature.

7. Incubate on the heat shaker at 56°C for 30 minutes with shaking at 1400 rpm.

8. Incubate on the heat shaker at 99°C for 10 minutes with no shaking (0 rpm).

9. Place sample in cold block at 4°C for 10 minutes with no shaking (0 rpm).

10. Centrifuge the samples at full speed, briefly.

11. During the digestion period label the Microcon® DNA Fast Flow and elution tubes, and print labels for storage tubes.

C. Purification and Concentration

1. Prepare Microcon® DNA Fast Flow tubes and label the membrane tube and filtrate tube cap.

2. Witness step: Confirm the sample names and order on the documentation with the names on the sample and Microcon® tubes.

3. Pre-coat the Microcon® membrane with Fish Sperm DNA in an irradiated microcentrifuge tube or 15 mL tube:

   a. Fish Sperm DNA Preparation

      i. Add 1 uL of stock Fish Sperm DNA solution (1mg/mL) to 199uL of water for each sample on the test batch.
ii. Aliquot 200 uL of this Fish Sperm DNA solution to each Microcon® tube. Avoid touching the membrane. The volume for one sample is shown below. Refer to the documentation for calculated value.

<table>
<thead>
<tr>
<th>Reagent</th>
<th>1 sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>Water</td>
<td>199 µL</td>
</tr>
<tr>
<td>Fish Sperm DNA (1mg/mL)</td>
<td>1 µL</td>
</tr>
</tbody>
</table>

NOTE: For samples with 400 µL of digest solution, make a 20 µL solution of 1 uL of Fish Sperm DNA (1mg/mL) with 19 µL of water. Mix well and add this solution to the membrane. Ensure that the entirety of the membrane is covered. In this manner, all of the digest may be added to the Microcon® membrane for a total volume of 420 uL.

4. Filtration

a. Add the entirety of each extract to its pretreated Microcon® membrane. If this is a purification/concentration assay of a sample that has already been extracted and the sample volume is lower than 200µL, raise the sample volume to 200µL with dH2O. Aspirate all of the solution from the sample tube by placing the pipet within the swab. The sample tubes may be discarded.

Centrifuge the Microcon® tube at 2400 rpm for 12 minutes. An additional 3 minutes may be required to ensure that all the liquid is filtered. However, do not centrifuge too long such that the membrane is dry. If the filtrate does not appear to be moving through the membrane, elute the filtrate and continue centrifuging the eluant into a fresh microcon with a pretreated membrane.

If indicated on the evidence examination schedule or by a supervisor, or if the filtrate is not clear, perform a second wash step applying 400 µL of water onto the membrane and centrifuging again at 2400 rpm for 12 minutes or until the all the liquid is filtered. However, do not centrifuge to dryness. This process may be repeated, as necessary. Document the additional washes.

All samples undergoing extraction with 0.05% SDS must be purified and concentrated a second time by repeating this section (Section C).
b. Visually inspect each Microcon® membrane tube. If it appears that more than 5 µL remains above the membrane, centrifuge that tube for 3 more minutes at 2400 rpm.

5. Elution
   a. Open only one Microcon® tube and its fresh collection tube at a time.
   b. Add 20 µL 0.1X TE to the Microcon® and invert the Microcon® over the new collection tube. Avoid touching the membrane.
   c. Centrifuge at 3400 rpm for 3 minutes.
   d. Transfer the eluant to an irradiated and labeled 1.5 mL tube. Measure and record the approximate volume. The total volume should not exceed 30 uL and should not be less than 20 uL. Adjust the final volume to 20 uL using 0.1X TE (if less). Discard the Microcon® membrane.
   e. If the eluant appears to be a dark color or is not clear, it may be necessary to purify the sample again. Prepare a fresh Microcon® tube and repeat steps 4-5.
   f. Store the extracts at 2 to 8°C or frozen.
   g. In the LIMS system, navigate to the Data Entry page, assign the samples to a storage unit (cryobox), and indicate which samples are completed.
   h. Have a supervisor review the assay.

Revision History:
March 24, 2010 – Initial version of procedure.
September 27, 2010 – Added language to Step 4 of Section C – Purification and Concentration.
January 30, 2012 – Added the use of 3% Trehalose in 0.1X TE as an elution buffer during the concentration/purification step.
July 16, 2012 – Revised procedure to accommodate LIMS.
December 28, 2012 – YM100 microcons were discontinued by the manufacturer. The manufacturer is now producing the DNA Fast Flow Microcons. All references to the YM100’s have been revised to the “DNA Fast Flow.” Spin times in Section C, Step 4 have been revised for the new microcons.
April 1, 2014 – Removed the option to use PolyA RNA in Step C.3; removed the use of Trehalose and irradiated water in Step C.5.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
A. Preparation

1. Extraction sets consist of 10 samples and two Extraction Negatives. Additional extractions may continue sequentially during incubations.

2. Follow the procedures for Work Place Preparation in the General Guidelines Section of this manual.

B. Digestion

1. From evidence exam, each nail (or group of nails) should be placed in an irradiated tube.

2. Add 200 µL of irradiated 25 mM EDTA/PBS solution to each sample.

3. Sonicate the samples for one hour at room temperature.

4. Label a new set of irradiated microcentrifuge tubes with the sample identifiers.

5. Remove the supernatants from the samples and place in the labeled irradiated microcentrifuge tubes.

C. Extraction

1. Prepare the digestion buffer according to the calculated volumes. The volumes for one sample are shown below:

<table>
<thead>
<tr>
<th>Stock Solution</th>
<th>Concentration</th>
<th>1 sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0% SDS</td>
<td>1.0% (0.96%) µL</td>
<td>2.3 (2.25) µL</td>
</tr>
<tr>
<td>Proteinase K</td>
<td>0.80 mg/mL</td>
<td>9 µL</td>
</tr>
<tr>
<td>20 mg/mL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Irradiated water</td>
<td>N/A</td>
<td>13.7 uL</td>
</tr>
</tbody>
</table>
2. Prepare Microcon® DNA Fast Flow tubes and label the membrane tube and filtrate tube cap with the sample identifiers. Prepare and label the Microcon® collection tubes, sample storage microcentrifuge tubes as well as post-sonication nail collection tubes. The identifier for the post sonication nail collection tubes should include “PS” as a suffix. For example, the post sonication tube for left nail ring finger could be “nail L4 PS”.

3. **Witness step:** Confirm the sample names on the documentation with the names on all labeled tubes.

4. Vortex solution well. Add 25 µL of the nail digestion buffer to each sample. Open only one sample tube at a time using the cap opener.

5. Record the temperatures of the heat shakers. Temperatures must be within ± 3°C of the set temperature.

6. Incubate on the heat shaker at 56ºC for 30 minutes with shaking at 1400 rpm.

7. Incubate on the heat shaker at 99ºC for 10 minutes with no shaking (0 rpm).

8. After removing from the shaker, centrifuge the samples at full speed, briefly. Allow the samples to cool for a few minutes while preparing for next steps or chill for 10 minutes at 4°C.

9. During the digestion period remove the nails using clean tweezers and dry them in a hood. When dry, place the nails in the labeled, post-sonication nail collection tube.

D. **Purification and Concentration**

1. **Self-witness step:** Confirm the sample names on the documentation with the names on the sample and Microcon® tubes.
## EXTRATION OF EXOGENOUS DNA FROM NAILS

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>APPROVED BY</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>12-28-2012</td>
<td>EUGENE LIEN</td>
<td>3 OF 5</td>
</tr>
</tbody>
</table>

2. Pre-coat the Microcon® membrane with Fish Sperm DNA or a 1/1000 dilution of Poly A RNA prepared as follows in an irradiated microcentrifuge tube or 15 mL tube:

a. Fish Sperm DNA Preparation

i. Add 1 uL of stock Fish Sperm DNA solution (1mg/mL) to 199uL of water for each sample on the test batch.

ii. Aliquot 200 uL of this Fish Sperm DNA solution to each Microcon® tube. Avoid touching the membrane. The volume for one sample is shown below. Refer to the extraction documentation for calculated value.

b. Poly A RNA Preparation

i. Make a 1/10 dilution of 1mg/mL of Poly A RNA as follows: add 2 µL of Poly A RNA to 18 µL of irradiated water and mix the solution well. This is a final concentration of 100µg/mL.

ii. Using the 1/10 dilution, make a 1/100 dilution with 2 uL of 100ug/mL Poly A RNA in 198 uL of irradiated water and mix the solution well. The solution has a final concentration of 1 ng/uL.

iii. Add 1 µL of the 1ng/uL Poly A RNA solution to 199uL of water for each sample on the test batch.
iv. Aliquot 200 uL of this Poly A RNA solution to each Microcon® tube. Avoid touching the membrane. The volume for one sample is shown below. Refer to the extraction documentation for calculated value.

<table>
<thead>
<tr>
<th>Reagent</th>
<th>1 sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>Water</td>
<td>199 µL</td>
</tr>
<tr>
<td>Fish Sperm DNA (1mg/mL) or Poly A RNA (1ng/µL)</td>
<td>1 µL</td>
</tr>
</tbody>
</table>

NOTE: For samples with 400 µL of digest solution make a 20 µL solution of 1 uL of Fish Sperm DNA (1mg/mL) or 1 µL of Poly A RNA (1 ng/µL) with 19 µL of water. Mix well and add this solution to the membrane. Ensure that the entirety of the membrane is covered. In this manner, all of the digest may be added to the Microcon® membrane for a total volume of 420 µL.

3. Filtration

a. Add the entirety of each extract to its pretreated Microcon® membrane. The sample tubes may be discarded.

b. Centrifuge the Microcon® tube at 2400 rpm for 12 minutes.

c. Repeat this wash step two more times applying 400uL of water onto the membrane and centrifuging again at 2400 rpm for 12 minutes for a total of three washes to remove any residual EDTA.

d. Visually inspect each Microcon® membrane tube after the third wash. If it appears that more than 5 µL remains above the membrane, centrifuge that tube for 3 more minutes at 2400 rpm.
4. Elution

a. Open only one Microcon® tube and its fresh collection tube at a time.

b. Add 20 µL of irradiated water to the Microcon® and invert the Microcon® over the new collection tube. Avoid touching the membrane.

c. Centrifuge at 3400 rpm for 3 minutes.

d. Transfer the eluant to an irradiated and labeled 1.5 mL tube. Measure and record the approximate volume. The total volume should not exceed 30 uL and should not be less than 20 uL. Adjust the final volume to 20 uL (if necessary) with irradiated water. Discard the Microcon® membrane.

e. If the eluant appears to be a dark color or is not clear, it may be necessary to purify the sample again. Prepare a fresh Microcon® tube and repeat steps 3-4.

f. As needed, pipette aliquots of neat and/or diluted extracts (using TE(-4)) into microcentrifuge tubes for real-time PCR analysis to determine human DNA concentration.

g. Store the extracts at 2 to 8°C or frozen.

h. In the LIMS system, navigate to the Data Entry page, assign the samples to a storage unit (cryobox), and indicate which samples are completed.

i. Have a supervisor review the assay.
CAUTION: DO NOT ADD BLEACH OR ACIDIC SOLUTIONS DIRECTLY TO THE SAMPLE-PREPARATION WASTE. Buffers MW1 and MTL contain guanidine hydrochloride/guanidine thiocyanate which can form highly reactive compounds when combined with bleach. If liquid containing these buffers spill, clean with suitable laboratory detergent and water. If the spilt liquid contains potentially infectious agents, clean with suitable laboratory detergent and water first and then with 1% sodium hypochlorite followed by water.

Sample size for the extraction should be approximately 1/3 of a swab or a 3x3 mm cutting of the stain. This extraction is not applicable to cigarette butts.

All bloodstain and exemplar cuttings should be placed in 2.0mL screw cap sample tubes.

A. Setting up M48 Test Batch and Saving Sample Name List

1. Open file on the M48 computer. Save this document by going to File → Save As and save the document to the “SampleName” folder on the desktop with “File Name” in MMDDYY.HHMM format and the “Save As Type” set to CSV (comma delimited)(* .csv).

2. Click “Save”.

3. A window stating “The selected file type does not support workbooks that contain multiple sheets” will open. Click “OK”.

4. A second window asking “Do you want to keep the workbook in this format?” opens. Click “Yes”.

5. Close the Excel Worksheet.

B. Sample Preparation and Incubation

1. Remove the extraction rack from the refrigerator. Extract either evidence or exemplars. Do not extract both together.

2. Sample preparation should be performed under a hood.

3. Obtain two empty 2.0 mL screw top sample tubes for the extraction negatives and manually label one as Extraction Negative 1 and the other as Extraction Negative 2.
4. Have a witness verify your samples. This will be your “Extraction” witness.

5. For large runs, prepare master mix for N+2 samples as follows, vortex briefly, and add 200uL to each of the tubes in the extraction rack and the pre-prepared extraction negative tubes. For smaller runs, you may add Proteinase K and G2 Buffer to each tube individually:

<table>
<thead>
<tr>
<th>Reagent</th>
<th>1 sample</th>
<th>6 samples</th>
<th>12 samples</th>
<th>18 samples</th>
<th>24 samples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digestion Buffer (Buffer G2)</td>
<td>190 µL</td>
<td>1520 µL</td>
<td>2660 µL</td>
<td>3800 µL</td>
<td>4940 µL</td>
</tr>
<tr>
<td>QIAgen Proteinase K</td>
<td>10 µL</td>
<td>80 µL</td>
<td>140 µL</td>
<td>200 µL</td>
<td>260 µL</td>
</tr>
</tbody>
</table>

6. Shake at 1000 rpm at 56°C for a minimum of 30 minutes. Record the Thermomixer temperature.

C. BioRobot M48 Software and Platform Set-up


2. Click the “Start” button. **Note: The door and container interlock must be closed to proceed.**

3. “F Trace MTL” protocol should be selected. If not, click on the arrow in the middle of the screen and then select “New Dev” → “gDNA” → and “F Trace MTL”.

4. Click on the “select” button and select “1.5 ml” for the size of the elution tubes.

5. Select the number of samples 6, 12, 18, 24, 30, 36, 42, or 48.

6. Set sample volume to 200 µL (cannot and should not change).

7. Set elution volume to 200 µL.

8. The next prompt asks to ensure the drop catcher is clean. In order to check this, click on “manual operation” and select “Drop Catcher Cleaning”. The arm of the robot will move to the front of the machine, and the drop catcher (a small plastic tray) will be right in front of you. Remove and clean with 70% ethanol.
the catcher is clean, replace the tray, close the door, and click “OK” in the window.

9. Make sure that the chute to the sharps container bin is clear for the tips to be discarded. Click “Next”. 

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
10. The next prompt has software that calculates the number of tips necessary for the run and asks, “Do you want to reset any of the tip racks?” Click “Yes tip rack …” for all tip racks and ensure that the tips were actually replaced and that the pipette tips are correctly seated in the rack and flush with the robotic platform. If no tip racks need to be reset, click “No”.

Tips needed for a run:

<table>
<thead>
<tr>
<th># Samples</th>
<th>6</th>
<th>12</th>
<th>18</th>
<th>24</th>
<th>30</th>
<th>36</th>
<th>42</th>
<th>48</th>
</tr>
</thead>
<tbody>
<tr>
<td># Tips</td>
<td>30</td>
<td>42</td>
<td>54</td>
<td>66</td>
<td>78</td>
<td>90</td>
<td>102</td>
<td>114</td>
</tr>
</tbody>
</table>

After you are finished, click “Next”

11. Obtain stock bottles of reagents and record lot numbers. Fill the reagent reservoirs as stated below. All reagents are stored in their respective plastic reservoirs in the metal rack, labeled with the lot number of the reagent that they contain, and covered with Parafilm, EXCEPT the magnetic resin. The resin is stored between runs in its original stock bottle to prevent evaporation. Vortex the magnetic resin solution well, both in the stock bottle and in the reservoir, before adding it to the metal rack. If you notice crystallization in any of the solutions, discard the solution, rinse the container out with distilled water, and start again with fresh reagent.

12. Remove the Parafilm and lids from the reagents, and fill the reservoirs to the appropriate level using solutions from the working solution bottles using the same lot as labeled on the reservoir. If not enough of the same lot of a solution remains, discard the remaining solution from the reservoir, rinse and re-label the reservoir with the new lot number. When filling the reservoirs add approximately 10% to the volumes recommended below to account for the use of the large bore pipette tips:

Note: Bottles of MW1 require the addition of ethanol prior to use. See bottle for confirmation of ethanol addition and instructions for preparation if needed.
MAGATTRACT DNA EXTRACTION FROM BLOODSTAINS AND EXEMPLARS

<table>
<thead>
<tr>
<th># of samples</th>
<th>Large reservoir Sterilized Water (mL)</th>
<th>Large reservoir Ethanol (mL)</th>
<th>Large reservoir Buffer MW1 (mL)</th>
<th>Large reservoir Buffer MTL (mL)</th>
<th>Small reservoir Buffer MW2 (mL)</th>
<th>Elution buffer (TE^4) (mL)</th>
<th>Small reservoir Magnetic Resin (mL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>10.0</td>
<td>11.8</td>
<td>7.2</td>
<td>5.9</td>
<td>3.5</td>
<td>2.5</td>
<td>1.5</td>
</tr>
<tr>
<td>12</td>
<td>18.4</td>
<td>22.6</td>
<td>12.9</td>
<td>10.3</td>
<td>5.9</td>
<td>3.7</td>
<td>1.7</td>
</tr>
<tr>
<td>18</td>
<td>26.9</td>
<td>33.4</td>
<td>18.6</td>
<td>14.7</td>
<td>8.4</td>
<td>6.9</td>
<td>1.9</td>
</tr>
<tr>
<td>24</td>
<td>35.3</td>
<td>44.2</td>
<td>24.3</td>
<td>19.0</td>
<td>10.8</td>
<td>6.1</td>
<td>2.1</td>
</tr>
<tr>
<td>30</td>
<td>43.7</td>
<td>55.0</td>
<td>30.0</td>
<td>23.4</td>
<td>16.2</td>
<td>7.3</td>
<td>2.3</td>
</tr>
<tr>
<td>36</td>
<td>52.2</td>
<td>65.8</td>
<td>35.7</td>
<td>27.8</td>
<td>15.7</td>
<td>8.5</td>
<td>2.5</td>
</tr>
<tr>
<td>42</td>
<td>60.6</td>
<td>76.6</td>
<td>41.4</td>
<td>32.1</td>
<td>18.2</td>
<td>9.7</td>
<td>2.7</td>
</tr>
<tr>
<td>48</td>
<td>69.0</td>
<td>87.4</td>
<td>49.0</td>
<td>36.5</td>
<td>20.6</td>
<td>10.9</td>
<td>2.9</td>
</tr>
</tbody>
</table>

Place each reservoir into the metal rack in the following locations. The plastic reservoirs only fit into the rack one way. Check the directions of the notches which should point into the robot:

<table>
<thead>
<tr>
<th>Size reservoir</th>
<th>Rack Position</th>
<th>Software Tag</th>
<th>Reagent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large reservoir</td>
<td>L4</td>
<td>Rea_4</td>
<td>Sterilized Water</td>
</tr>
<tr>
<td>Large reservoir</td>
<td>L3</td>
<td>Rea_3</td>
<td>Ethanol (100%)</td>
</tr>
<tr>
<td>Large reservoir</td>
<td>L2</td>
<td>Rea_2</td>
<td>Wash Buffer 1 (Buffer MW1)</td>
</tr>
<tr>
<td>Large reservoir</td>
<td>L1</td>
<td>Rea_1</td>
<td>Lysis and Binding Buffer (Buffer MTL)</td>
</tr>
<tr>
<td>Small reservoir</td>
<td>S6</td>
<td>ReaS6</td>
<td>(empty)</td>
</tr>
<tr>
<td>Small reservoir</td>
<td>S5</td>
<td>ReaS5</td>
<td>(empty)</td>
</tr>
<tr>
<td>Small reservoir</td>
<td>S4</td>
<td>ReaS4</td>
<td>(empty)</td>
</tr>
<tr>
<td>Small reservoir</td>
<td>S3</td>
<td>ReaS3</td>
<td>Wash Buffer 2 (Buffer MW2)</td>
</tr>
</tbody>
</table>
13. Flip up the “container interlocks” and place the metal reservoir holder onto the left side of the robotic platform in the proper position. **DO NOT force the holder into place and be careful not to hit the robotic arm.** After correctly seating the metal holder, flip down the “container interlocks” and press “next”.

14. Click “Next” when you are prompted to write a memo.

15. Place the sample preparation trays on the robot. One tray for every 6 samples. Click “Next”.

16. Place empty, unlabeled 1.5mL elution tubes in the 65 degree (back) hot block, located on the right side of the robotic platform. Click “Next”.

17. Print labels for 1.5 mL screw top tubes for final sample collection in the robot.

18. Place labeled, empty 1.5 mL sample collection tubes in the 8 degree (front) cold block for collection of final samples.

19. At this point, the samples should be near the end of the incubation period (From Section B, Step 6). Spin all tubes in a microcentrifuge for 1 minute at 10,000 to 15,000 x g.

20. **Have a witness confirm the order and labels of both the sample tubes and the labeled 1.5 mL final sample collection tubes. The robot setup witness should also verify that all plasticware is in the correct position and correctly seated in the platform. This will be your “Robot Setup” witness.**

21. Remove caps and place the samples for extraction on the robot. Discard the caps. **For empty positions, add a 2.0 mL sample tube filled with 200 uL of sterile water.**

22. Click “Yes” when asked to input sample names.
D. **Importing Sample Names**

1. At the sample input page, click “Import”.

2. The Open window will appear. “Look in:” should automatically be set to a default of “SampleName”. If not, the correct pathway to the folder is My Computer\C:\Program Files\GenoM-48\Export\SampleName. (The SampleName folder on the desktop is a shortcut to this file.)

3. Select your sample name file and click “Open”. Verify that your sample names have imported correctly. Do not be concerned if a long sample name is not completely displayed in the small window available for each sample.

4. Manually type in the word “Blank” for all empty white fields.

5. Click “Next”.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
E. Verifying Robot Set-Up and Starting the Purification

1. In addition to confirming the position of all plasticware and samples, check the following conditions before proceeding:

   - All plasticware (tips, sample plates, tubes) is seated properly in the robotic platform ✓
   - Metal reservoir rack is seated properly, UNDER the interlocks ✓
   - Interlocks are down ✓
   - Sample tubes, elution tubes and sample collection tubes have been added to the platform in multiples of 6 as follows:
     - Empty 1.5 mL tubes are filling empty positions for both sets of elution tubes in the cold and hot blocks ✓
     - 2.0 mL sample tubes filled with 200 uL of sterile H₂O are in empty positions of the sample rack ✓

2. After confirming the position and set-up of the plasticware click “Confirm”.

3. Click “OK” after closing the door.

4. Click “Go” to start the extraction.

5. The screen will display the start time, remaining time, and the completion time.

6. Monitor the extraction until the transfer of DNA sample from the sample tubes to the first row of sample plate wells to ensure proper mixing of magnetic resin and DNA sample.

7. At the end of the extraction, a results page will be displayed indicating the pass/fail status of each set of six samples.
F. Saving Extraction Report Page

1. At the results page click the “Export” button at the bottom center of the screen. The Save As window will appear. “Save In:” should be set to the “Report” folder on the desktop. This is a shortcut to the following larger pathway: My Computer\C:\Program Files\GenoM-48\Export\Report.

2. In “File Name:”, name the report in the format, MMDDYY.HHMM. Set “Save As Type:” to Result Files (*.csv). For instance an extraction performed at 4:30pm on 5/14/06 would be saved as 051406.1630.csv.

3. Click “Save”.

4. Drag a copy of the result file into the appropriate LIMS SHARE folder.

5. Proceed with clean-up and sterilization.

G. Post-Extraction Clean Up and UV Sterilization

1. Remove samples (from the 8 degree (front) cold block) from the robotic platform and cap with newly labeled screw caps.

2. Discard used pipette tips, sample tubes, and sample preparation plate(s). Remove reservoir rack.

3. Replace the lid on the magnetic resin reservoir and vortex remaining resin thoroughly. Transfer the Magnetic resin to the stock bottle immediately with a 1000uL pipettman. Rinse the reagent container with de-ionized water followed by ethanol and store to dry.

4. Cover all other reagents and seal with Parafilm for storage. MAKE SURE RESERVOIRS ARE LABELED WITH THE LOT NUMBER OF THE REAGENT THEY CONTAIN and that the lot numbers have been recorded.

5. Wipe down the robotic platform and waste chute with 70% ethanol. DO NOT USE SPRAY BOTTLES.

6. Replace tips on the instrument that were used during run. There are three racks, and all racks should be full. Ensure that the pipette tips are correctly seated in the rack and flush with the robotic platform.
7. Click “Next”.

8. When prompted, “Do you want to perform a UV sterilization of the worktable?”, click “Yes”.

9. Select 1 Hour for the time of “UV sterilization” then click “yes” to close the software upon completion. **THE UV STERILIZATION MUST BE PERFORMED FOR AT LEAST 15 MINUTES BETWEEN RUNS.** The UV light can be manually turned off.

10. Store the extracts at 2 to 8°C or frozen.

11. In the LIMS system, navigate to the Data Entry page, assign the samples to a storage unit (cryobox), and import instrument data.

12. As needed, pipet aliquots of neat and/or diluted extract into microcentrifuge tubes for real-time PCR analysis to determine human DNA concentration (refer to Section 4 of the STR manual).

13. Have a supervisor review the run.

14. **COMPLETE THE M48 USAGE LOG WITH THE PURPOSE, PROGRAM, PLATE, AND ANY COMMENTS ARISING FROM THE RUN.**
H. BioRobot M48 Platform Diagram

Figure 1. Diagram of Robotic Platform of the QIAGEN BioRobot M48.

- **A** (1-4) Large Reagent Reservoir Positions
- **B** (1-3) Small Reagent Reservoir Positions
- **C** (1-3) Tube Racks 1, 2, and 3
- **D** (1-8) Sample Plate Holders
- **E** Hot Elution Block (65 degrees)
- **G** Cold Final Elution Block (8 degrees)
- **G** (1-2) Sample Tube Racks
- **H** Waste Disposal Chute
I. Troubleshooting

<table>
<thead>
<tr>
<th>ERROR</th>
<th>CAUSE/REMEDY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resin/sample is being drawn up into pipette tips unequally</td>
<td><strong>Report problem to QA.</strong> Resin buffer has evaporated. O-rings are leaking and need service.</td>
</tr>
<tr>
<td>Crystallization around 1st row of wells in sample plate</td>
<td>Forgot to fill empty sample tubes with 200uL of sterile H2O.</td>
</tr>
<tr>
<td>BioRobot M48 cannot be switched on</td>
<td>BioRobot M48 is not receiving power.</td>
</tr>
<tr>
<td></td>
<td>Check that the power cord is connected to the workstation and to the wall.</td>
</tr>
<tr>
<td>Computer cannot be switched on</td>
<td>Computer is not receiving power.</td>
</tr>
<tr>
<td></td>
<td>Check that the power cord is connected to the computer and to the wall power outlet.</td>
</tr>
<tr>
<td>BioRobot M48 shows no movement when a protocol is started</td>
<td>BioRobot M48 is not switched on.</td>
</tr>
<tr>
<td></td>
<td>Check that the BioRobot M48 is switched on.</td>
</tr>
<tr>
<td>BioRobot M48 shows abnormal movement when a protocol is started</td>
<td>The pipettor head may have lost its home position.</td>
</tr>
<tr>
<td></td>
<td>In the QIAsoft M software, select “Manual Operation/ Home”.</td>
</tr>
<tr>
<td>Aspirated liquid drips from disposable tips</td>
<td>Dripping is acceptable when ethanol is being handled. For other liquids: air is leaking from the syringe pump.</td>
</tr>
<tr>
<td></td>
<td><strong>Report problem to QA.</strong> O-rings require replacement or greasing.</td>
</tr>
<tr>
<td></td>
<td>If the problem persists, contact QIAGEN Technical Services</td>
</tr>
</tbody>
</table>

Revision History:
March 24, 2010 – Initial version of procedure.
July 16, 2012 – Revised procedure to accommodate LIMS.
April 1, 2014 – Added caution statement about reactivity of chemicals to page 1. In Step G.9, added UV Sterilization must be performed for at least 15 minutes between runs.
CAUTION: DO NOT ADD BLEACH OR ACIDIC SOLUTIONS DIRECTLY TO THE SAMPLE- PREPARATION WASTE. Buffers MW1 and MTL contain guanidine hydrochloride/ guanidine thiocyanate which can form highly reactive compounds when combined with bleach. If liquid containing these buffers spill, clean with suitable laboratory detergent and water. If the spilt liquid contains potentially infectious agents, clean with suitable laboratory detergent and water first and then with 1% sodium hypochlorite followed by water.

Sample size for the extraction should be approximately 1/3 of a swab or a 3x3 mm cutting of the stain. **This extraction is applicable for all casework samples EXCEPT semen samples.**

All bloodstain cuttings should be placed in 2.0mL screw cap sample tubes.

A. **Setting up M48 Test Batch and Saving Sample Name List**

1. Open file on the M48 computer. Save this document by going to File → Save As and save the document to the “SampleName” folder on the desktop with “File Name” in MMDDYY.HHMM format and the “Save As Type” set to CSV (comma delimited) (*.csv).

2. Click “Save”.

3. A window stating “The selected file type does not support workbooks that contain multiple sheets” will open. Click “OK”.

4. A second window asking “Do you want to keep the workbook in this format?” opens. Click “Yes”.

5. Close the Excel Worksheet.

B. **Sample Preparation and Incubation**

1. Remove the extraction rack from the refrigerator. Extract either evidence or exemplars. Do not extract both together.

2. Sample preparation should be performed under a hood.

3. Obtain two empty 2.0 mL screw top sample tubes for the extraction negatives and manually label one as Extraction Negative 1 and the other as Extraction Negative 2.
4. Have a witness verify your samples. This will be your “Extraction” witness.
5. For large runs, prepare master mix for N+2 samples as follows, vortex briefly, and add 200µL to each of the tubes in the extraction rack and the pre-prepared extraction negative tubes. For smaller runs, you may add Proteinase K and G2 Buffer to each tube individually:

<table>
<thead>
<tr>
<th>Reagent</th>
<th>1 sample</th>
<th>6 samples</th>
<th>12 samples</th>
<th>18 samples</th>
<th>24 samples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digestion Buffer (Buffer G2)</td>
<td>190 µL</td>
<td>1520 µL</td>
<td>2660 µL</td>
<td>3800 µL</td>
<td>4940 µL</td>
</tr>
<tr>
<td>QIAgent Proteinase K</td>
<td>10 µL</td>
<td>80 µL</td>
<td>140 µL</td>
<td>200 µL</td>
<td>260 µL</td>
</tr>
</tbody>
</table>

**NOTE:** If Buffer does not cover the substrate (such as those from a scraping), an extra 200 µL of buffer may be added to the tube once. If this is the case, the sample will be split and the sample name will have to be changed. The imported sample names on the instrument must also be updated.

6. Shake at 1000 rpm at 56°C for a minimum of 30 minutes. Record the thermomixer temperature.

C. **BioRobot M48 Software and Platform Set-Up**


2. Click the “Start” button. **Note: The door and container interlock must be closed to proceed.**

3. “Trace TD v1.1C1” protocol should be selected for casework samples. If not selected, click on the arrow in the middle of the screen and then select “Forensic” → “gDNA” → and “Trace TD v1.1C1”

4. Click on the “select” button and select “1.5 mL” for the size of the elution tubes.

5. Select the number of samples: 6, 12, 18, 24, 30, 36, 42, or 48.
6. Set sample volume to 200 µL (cannot and should not change).

7. Set elution volume to 50 µL.

8. The next prompt asks to ensure the drop catcher is clean. In order to check this, click on “manual operation” and select “Drop Catcher Cleaning”. The arm of the robot will move to the front of the machine, and the drop catcher (a small plastic tray) will be right in front of you. Remove and clean with ethanol. When the catcher is clean, replace the tray, close the door, and click “OK” in the window.

9. Confirm that there is a means of collection for the tips that will be discarded during the run. Click “Next”.

10. The next prompt has software that calculates the number of tips necessary for the run and asks, “Do you want to reset any of the tip racks?” Click “Yes tip rack ...” for all tip racks and ensure that the tips were actually replaced and that the pipette tips are correctly seated in the rack and flush with the robotic platform. If no tip racks need to be reset, click “No”.

<table>
<thead>
<tr>
<th># samples</th>
<th>6</th>
<th>12</th>
<th>18</th>
<th>24</th>
<th>30</th>
<th>36</th>
<th>42</th>
<th>48</th>
</tr>
</thead>
<tbody>
<tr>
<td># tips</td>
<td>30</td>
<td>42</td>
<td>54</td>
<td>66</td>
<td>78</td>
<td>90</td>
<td>102</td>
<td>114</td>
</tr>
</tbody>
</table>

After you are finished, click “Next”.

11. Obtain stock bottles of reagents and record lot numbers. Fill the reagent reservoirs as stated below. All reagents are stored in their respective plastic reservoirs in the metal rack, labeled with the lot number of the reagent that they contain, and covered with Parafilm, EXCEPT the magnetic resin. The resin is disposed of after every extraction. Vortex the magnetic resin solution well, both in the stock bottle and in the reservoir, before adding it to the metal rack (see step 13 for preparation of MagAttract Resin). If you notice crystallization in any of the solutions, discard the solution, rinse the container out, and start again with fresh reagent.
12. Remove the Parafilm and lids from the reagents, and fill the reservoirs to the appropriate level using solutions from the working solution bottles, using the same lot as labeled on the reservoir. If not enough of the same lot of a solution remains, discard the remaining solution from the reservoir, rinse and re-label the reservoir with the new lot number. When filling the reservoirs, add approximately 10% to the volumes recommended below to account for the use of the large bore pipette tips.

<table>
<thead>
<tr>
<th># of samples</th>
<th>Large reservoir Sterilized Water (mL)</th>
<th>Large reservoir Ethanol (mL)</th>
<th>Large reservoir Buffer MW1 (mL)</th>
<th>Large reservoir Buffer MTL (mL)</th>
<th>Small reservoir Sterile Water (mL)</th>
<th>Elution Buffer (TE(^4)) (mL)</th>
<th>Small reservoir Poly A RNA - Magnetic Resin (mL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>10.0</td>
<td>11.8</td>
<td>7.2</td>
<td>5.9</td>
<td>3.5</td>
<td>1.6</td>
<td>1.5</td>
</tr>
<tr>
<td>12</td>
<td>18.4</td>
<td>22.6</td>
<td>12.9</td>
<td>10.3</td>
<td>5.9</td>
<td>1.9</td>
<td>1.7</td>
</tr>
<tr>
<td>18</td>
<td>26.9</td>
<td>33.4</td>
<td>18.6</td>
<td>14.7</td>
<td>8.4</td>
<td>2.2</td>
<td>1.9</td>
</tr>
<tr>
<td>24</td>
<td>35.3</td>
<td>44.2</td>
<td>24.3</td>
<td>19.0</td>
<td>10.8</td>
<td>2.5</td>
<td>2.1</td>
</tr>
<tr>
<td>30</td>
<td>43.7</td>
<td>55.0</td>
<td>30.0</td>
<td>23.4</td>
<td>13.3</td>
<td>2.8</td>
<td>2.3</td>
</tr>
<tr>
<td>36</td>
<td>52.2</td>
<td>65.8</td>
<td>35.7</td>
<td>27.8</td>
<td>15.7</td>
<td>3.1</td>
<td>2.5</td>
</tr>
<tr>
<td>42</td>
<td>60.6</td>
<td>76.4</td>
<td>41.4</td>
<td>32.1</td>
<td>18.2</td>
<td>3.4</td>
<td>2.7</td>
</tr>
<tr>
<td>48</td>
<td>69.0</td>
<td>87.4</td>
<td>47.0</td>
<td>36.5</td>
<td>20.6</td>
<td>3.7</td>
<td>2.9</td>
</tr>
</tbody>
</table>

Note: Bottles of MW1 require the addition of ethanol prior to use. See bottle for confirmation of ethanol addition and instructions for preparation if needed.
13. Refer to the table below for amounts of 1000ng/μL Poly A RNA stock solution to add for resin preparation:

<table>
<thead>
<tr>
<th>Samples</th>
<th>Volume of 1000ng/μL stock PolyA RNA solution added to resin (μL)</th>
<th>Volume of Untreated MagAttract Resin (μL)</th>
<th>Total Volume of RNA Treated MagAttract Resin (μL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>6 samples</td>
<td>4.4</td>
<td>1497.8</td>
<td>1502.2</td>
</tr>
<tr>
<td>12 samples</td>
<td>5.0</td>
<td>1697.5</td>
<td>1702.5</td>
</tr>
<tr>
<td>18 samples</td>
<td>5.6</td>
<td>1897.2</td>
<td>1902.8</td>
</tr>
<tr>
<td>24 samples</td>
<td>6.2</td>
<td>2096.5</td>
<td>2103.1</td>
</tr>
<tr>
<td>30 samples</td>
<td>6.8</td>
<td>2296.6</td>
<td>2303.4</td>
</tr>
<tr>
<td>36 samples</td>
<td>7.4</td>
<td>2496.3</td>
<td>2503.7</td>
</tr>
<tr>
<td>42 samples</td>
<td>7.9</td>
<td>2696.0</td>
<td>2703.9</td>
</tr>
<tr>
<td>48 samples</td>
<td>8.5</td>
<td>2895.7</td>
<td>2904.2</td>
</tr>
</tbody>
</table>

14. The treated resin may be prepared directly in the reservoir or in a 15mL conical tube and then added to the appropriate reservoir for addition to the platform in the amount dictated by the protocol.

Place reservoirs into the metal rack in the following locations. The plastic reservoirs only fit into the rack one way. Check the directions of the notches which should point into the robot:

<table>
<thead>
<tr>
<th>Size Reservoir</th>
<th>Rack Position</th>
<th>Software Tag</th>
<th>Reagent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large reservoir</td>
<td>L4</td>
<td>Rea_4</td>
<td>Sterilized Water</td>
</tr>
<tr>
<td>Large reservoir</td>
<td>L3</td>
<td>Rea_3</td>
<td>Ethanol (100%)</td>
</tr>
<tr>
<td>Large reservoir</td>
<td>L2</td>
<td>Rea_2</td>
<td>Wash Buffer 1 (Buffer MW1)</td>
</tr>
<tr>
<td>Large reservoir</td>
<td>L1</td>
<td>Rea_1</td>
<td>Lysis and Binding Buffer (Buffer MTL)</td>
</tr>
<tr>
<td>Small reservoir</td>
<td>S6</td>
<td>ReaS6</td>
<td>(empty)</td>
</tr>
<tr>
<td>Small reservoir</td>
<td>S5</td>
<td>ReaS5</td>
<td>(empty)</td>
</tr>
</tbody>
</table>

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
15. Flip up the “container interlocks” and place the metal reservoir holder onto the left side of the robotic platform in the proper position. **DO NOT force the holder into place and be careful not to hit the robotic arm.** After correctly seating the metal holder, flip down the “container interlocks” and press “next”.

16. Click “Next” when you are prompted to write a memo.

17. Place the sample preparation trays on the robot. One tray for every 6 samples. Click “Next”.

18. Place empty, unlabeled 1.5mL elution tubes in the 65 degree (back) hot block, located on the right side of the robotic platform. Click “Next”.

19. Print labels for 1.5 mL screw top tubes for final sample collection in the robot.

20. Place labeled, empty 1.5 mL sample collection tubes in the 8 degree (front) cold block for collection of final samples.

21. If an extra 200 µL of buffer was added to a tube to cover the substrate, that tube must be split into two separate tubes at this point.

To do so, remove 200 µL from the original tube and place into a new tube. The original tube is renamed by adding an “a” to the end (e.g., “SampleNamea”, “SampleName_a”, etc.); the new tube is named with the original sample name with a “b” at the end (e.g., “SampleNameb”, “SampleName_b”, etc.). The tubes should remain adjacent to each other and the sample positions may need to be shifted to accommodate.
22. At this point, the samples should be near the end of the incubation period (From Section B, Step 6). After incubation, spin the samples down briefly and pretreat with Poly A RNA prior to placing on the robot. To each sample lysate add 250ng of Poly A RNA. A dilution of the stock Poly A RNA solution may be prepared for a final concentration of 250ng/μL and 1μL of this dilution should be added to each sample lysate. Prepare the 250ng/μL solution by adding 15μL of the stock 1000ng/μL Poly A RNA solution to 45μL of irradiated water.

NOTE: For cigarette butts, if the sample submitted is a strip of the filter paper, the lysate must be transferred to a new labeled 2.0mL screw cap tube prior to adding the Poly A RNA. Discard the cigarette strip. This is important to avoid the clogging of the M48 tips.

23. Spin all tubes in a microcentrifuge for 1 minute at 10,000 to 15,000 x g. When they are ready, have a witness confirm the order and labels of both the sample tubes and the labeled 1.5 mL final sample collection tubes. The robot setup witness should also verify that all plasticware is in the correct position and correctly seated in the platform. This will be your “Robot Setup” witness.

24. Remove caps and place the samples for extraction on the robot. Discard the caps. For empty positions, add a 2.0 mL sample tube filled with 200 μL of sterile water.

25. Click “Yes” when asked to input sample names.

D. Importing Sample Names

1. At the sample input page, click “Import”.

2. The Open window will appear. “Look in:” should automatically be set to a default of “SampleName”. If not, the correct pathway to the folder is My Computer\C:\Program Files\GenoM-48\Export\SampleName. (The SampleName folder on the desktop is a shortcut to this file.)
3. Select your sample name file and click “Open”. Verify that your sample names have imported correctly. Do not be concerned if a long sample name is not completely displayed in the small window available for each sample.

4. Manually type in the word “Blank” for all empty white fields.

5. Click “Next”.

E. Verifying Robot Set-Up and Starting the Purification

1. In addition to confirming the position of all plasticware and samples, check the following conditions before proceeding:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>All plasticware (tips, sample plates, tubes) is seated properly in the robotic platform</td>
<td>✔️</td>
</tr>
<tr>
<td>Metal reservoir rack is seated properly UNDER the interlocks</td>
<td>✔️</td>
</tr>
<tr>
<td>Interlocks are down</td>
<td>✔️</td>
</tr>
<tr>
<td>Sample tubes, elution tubes and sample collection tubes have been added to the platform in multiples of 6 as follows:</td>
<td></td>
</tr>
<tr>
<td>Empty 1.5 mL tubes are filling empty positions for both sets of elution tubes in the cold and hot blocks</td>
<td>✔️</td>
</tr>
<tr>
<td>2.0 mL sample tubes filled with 200uL of sterile H2O are in empty positions of the sample rack</td>
<td>✔️</td>
</tr>
</tbody>
</table>

2. After confirming the position and set-up of the plasticware click “Confirm”.

3. Click “OK” after closing the door.

4. Click “Go” to start the extraction.

5. The screen will display the start time, remaining time, and the completion time.
6. Monitor the extraction until the transfer of DNA sample from the sample tubes to the first row of sample plate wells to ensure proper mixing of magnetic resin and DNA sample.

7. At the end of the extraction, a results page will be displayed indicating the pass/fail status of each set of six samples.

F. Saving Extraction Report Page

1. At the results page click the “Export” button at the bottom center of the screen. The Save As window will appear. “Save In:” should be set to the “Report” folder on the desktop. This is a shortcut to the following larger pathway: My Computer\C:\Program Files\GenoM-48\Export\Report.

2. In “File Name:”, name the report in the format MMDDYY.HHMM. Set “Save As Type:” to Result Files (*.csv). For instance, an extraction performed at 4:30pm on 5/14/06 would be saved as 051406.1630.csv.

3. Click “Save”.

4. Drag a copy of the result file into the appropriate LIMS SHARE folder.

5. Proceed with clean-up and sterilization.

G. Post-Extraction Clean Up and UV Sterilization

1. Remove samples (from the 8 degree (front) cold block) from the robotic platform and cap with newly labeled screw caps.

2. Wipe down the robotic platform and waste chute with Ethanol. **DO NOT USE SPRAY BOTTLES.** Discard used pipette tips, sample tubes, and sample preparation plate(s).

3. Replace the lid on the magnetic resin reservoir and vortex remaining resin thoroughly. Discard the Magnetic resin immediately with a 1000uL pipette man. Rinse the reagent container with de-ionized water followed by ethanol and store to dry.
4. Cover all other reagents and seal with Parafilm for storage. **MAKE SURE RESERVOIRS ARE LABELED WITH THE LOT NUMBER OF THE REAGENT THEY CONTAIN** and that the lot numbers have been recorded.

5. Replace tips on the instrument that were used during run. There are three racks, and all racks should be full. Ensure that the pipette tips are correctly seated in the rack and flush with the robotic platform.

6. Click “Next”.

7. When prompted, “Do you want to perform a UV sterilization of the worktable?”, click “Yes”. **THE UV STERILIZATION MUST BE PERFORMED FOR AT LEAST 15 MINUTES BETWEEN RUNS.** The UV light can be manually turned off.

8. Select 1 Hour for the time of “UV sterilization” then click “yes” to close the software upon completion.

9. Store the extracts at 2 to 8 °C or frozen.

10. In the LIMS system, navigate to the Data Entry page, assign the samples to a storage unit (cryobox), and import instrument data.

11. Have a supervisor review the run, and submit samples at 1/10 and/or 1/100 dilutions as needed for real-time PCR analysis to determine human DNA concentration (refer to Section 4 of the STR manual).

12. **COMPLETE THE M48 USAGE LOG WITH THE PURPOSE, PROGRAM, PLATE, AND ANY COMMENTS ARISING FROM THE RUN.**
H. BioRobot M48 Platform Diagram

![BioRobot M48 Platform Diagram]

Figure 1. Diagram of Robotic Platform of the QIAGEN BioRobot M48.

- **A** (1-4): Large Reagent Reservoir Positions
- **B** (1-3): Small Reagent Reservoir Positions
- **C** (1-3): Tube Racks 1, 2, and 3
- **D** (1-8): Sample Plate Holders
- **E**: Hot Elution Block (65 degrees)
- **F**: Cold Final Elution Block (8 degrees)
- **G** (1-2): Sample Tube Racks
- **H**: Waste Disposal Chute
I. Troubleshooting

<table>
<thead>
<tr>
<th>Error</th>
<th>Cause/ Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resin/sample is being drawn up into pipette tips unequally</td>
<td><strong>Report problem to QA.</strong> Resin buffer has evaporated. O-rings are leaking and need service.</td>
</tr>
<tr>
<td>Crystallization around 1st row of wells in sample plate</td>
<td>Forgot to fill empty sample tubes with 200uL of sterile H2O</td>
</tr>
<tr>
<td>BioRobot M48 cannot be switched on</td>
<td>BioRobot M48 is not receiving power. Check that the power cord is connected to the workstation and to the wall</td>
</tr>
<tr>
<td>Computer cannot be switched on</td>
<td>Computer is not receiving power. Check that the power cord is connected to the computer and to the wall power outlet.</td>
</tr>
<tr>
<td>BioRobot M48 shows no movement when a protocol is started</td>
<td>BioRobot M48 is not switched on. Check that the BioRobot M48 is switched on.</td>
</tr>
<tr>
<td>BioRobot M48 shows abnormal movement when a protocol is started</td>
<td>The pipettor head may have lost its home position. In the QIAsoft M software, select “Manual Operation/ Home”.</td>
</tr>
<tr>
<td>Aspirated liquid drips from disposable tips.</td>
<td>Dripping is acceptable when ethanol is being handled. For other liquids: air is leaking from the syringe pump. <strong>Report problem to QA.</strong> O-rings require replacement or greasing. If the problem persists, contact QIAGEN Technical Services</td>
</tr>
</tbody>
</table>

Revision History:
March 24, 2010 – Initial version of procedure.
September 24, 2010 – “Total Volume of RNA Treated MagAttract Resin (uL)” in table on Page 5 (in Step C.12) were corrected.
April 30, 2012 – Step C.21 was added and additional instructions were added to Step B.5 so that if the Buffer doesn’t cover the substrate, extra buffer may be added and the sample can be split.
July 16, 2012 – Revised procedure to accommodate LIMS.
April 1, 2014 – Added caution statement about reactivity of chemicals to page 1. In Step G.7, added UV Sterilization must be performed for at least 15 minutes between runs.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
BONE PROCESSING

A. Cleaning

1. Before extraction, a bone or tooth specimen should be cleaned entirely of soft tissue and dirt using a range of methods, such as scraping (cut glove required), rinsing and sonications. A combination of sterile scalpels, sterile toothbrushes and running water should be used to clean the specimen.

2. Once excess material is removed, use a toothbrush and water to scrub away cement and dirt-like material from bone.

3. Rinse bone with water and place in a labeled weigh boat with Kimwipes. Seal the weigh boat and place in the 56°C incubator for a minimum of 3 hours (until completely dry).

4. In comments section of exam sheet, record that cleaning was performed along with initials and date.

B. Consumption guidelines

Some bones will be consumed due to weight.

For bones up to ~1.0g: Bone will be consumed and must be documented under “comments” on exam sheet.

For bones ~1.0g to 1.50g: Consumption will be determined by the nature of the bone and whether significant weight will be lost during the processing steps. If the nature of the bone will make the weight drop below the availability to be re-tested (at least 0.50g) then the bone should be consumed and noted in “comments” of exam sheet.

Factors to consider: spongy, brittle, non-compact bone or where embedded cement and dirt-like material are contributing a portion of the overall weight.
C. Cutting/ Sonication

Protective eyewear, lab coats, cut resistant gloves, sleeve protectors, and HEPA-filtered facial masks should be worn when cutting bone. Avoid breathing bone dust. All cutting of bone must be done under a biological hood.

Bones that are too small to be cut should proceed to the sonication step.

1. Prior to sampling, document the description/appearance, weight after cleaning and measurements of the bone/tooth. Initial and date that examination/cutting was performed.

2. Prepare Tergazyme solution: fill a 50mL conical tube with 3g of Tergazyme powder and fill to the 50mL mark with dH₂O. Suspend the powder with inversion and transfer to Erlenmeyer flask with stir bar. Place on heat/stir plate (use minimal heat). Solution is ready for use when reagent has completely dissolved and solution is clear.

Once prepared, Tergazyme solution will only be effective for up to 16 hours.

3. Using a cordless Dremel tool, cut 0.65g to 0.80g of bone in ~¼ inch square pieces.

0.50g of dust is optimal for large volume extraction procedure. Due to the nature of each bone, a larger portion may need to be cut to account for loss during the sonication and milling procedures (ex: spongy or brittle bone, non-compact bone and/or bone containing dirt/cement-like material). Bones that do not have enough volume for more than one extraction should be consumed, even if the total bone weight is over the 0.50g recommended for cutting.

4. Place the bone pieces in a new, labeled 50mL conical tube. Label new conical tube with FB case number, PM item# and (v) initials.

5. Cover bone cuttings with 5% Tergazyme solution. Place labeled 50mL conical tubes into a tube rack. Secure tube to tube rack with tape and put tube rack into the sonicator water bath. Place weighted ring over the top of the rack to submerge and sonicate for 30-45 minutes. Ensure water level in the sonicator is 1-2 inches from the top.
6. Bones that are not being consumed should be placed in a new, labeled 50mL conical tube. Label new conical tube with FB case number, ME#, PM item #, (v) initials. (Original container should be discarded.)

7. Once sonication is complete, place a paper towel over the drain of a clean sink and decant the Tergazyme solution. Add water to the tube and gently shake. Decant water from the tube and repeat until the water runs clear and the Tergazyme solution is removed.

Note: Some bone pieces may need to go through the sonication process twice. Repeat only when necessary. Bleach out sink when finished.

8. Place the clean cuttings in a weigh boat on a few small Kimwipes. Cover with additional Kimwipes and another weigh boat. Label the weigh boat with the FB case number, PM item# and (v) initials. Seal weigh boats with evidence tape.

9. Dry in a 56°C incubator for a few hours or overnight. After sufficient drying, weigh bone cuttings. The bone sample must be completely dry before milling.

D. Milling

Some small bone fragments may not be suitable for milling. Consider going straight to extraction after cleaning if the fragment may not yield an attainable clump of dust after milling.

1. Obtain mill parts and label end cap with the FB# (only use blue sharpie)

2. Weigh the dry bone pieces and record weight on exam sheet under “weight of fragments to be milled”

3. Transfer bone pieces to assembled mill tube containing impactor using decontaminated forceps. Cover with metal top. The top plug should be placed on to the tube with the rounded side facing out.

Shake specimen vial and ensure that the impactor can move back and forth.
4. Open freezer mill lid. Add liquid nitrogen slowly into the mill up to the FILL LINE to avoid splashing and boiling over. **Cryogloves and eye protection are required and the liquid nitrogen must be at the fill mark or damage can occur.**

5. **Programming and use of the 6870 freezer mill** (see Step 6 for programming and use of the 6750 freezer mill):
   a. Adjust mill settings as follows:
   
<table>
<thead>
<tr>
<th>Cycle</th>
<th>set to # of samples + 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td></td>
</tr>
<tr>
<td>T1 (milling)</td>
<td>2.0 min</td>
</tr>
<tr>
<td>T2 (pause)</td>
<td>2.0 min</td>
</tr>
<tr>
<td>T3 (pre-cool)</td>
<td>15.0 min</td>
</tr>
<tr>
<td>Rate</td>
<td>Bones – 8-10</td>
</tr>
<tr>
<td></td>
<td>Teeth – 6-8</td>
</tr>
</tbody>
</table>

   b. Place mill tubes into the mill with four in the chamber and the remaining in the basket.
   
   c. Place the basket into the mill.
   
   d. Slowly close the mill to avoid splashing.
   
   e. Lock the mill shut and turn on the power switch located in the back left side of the mill.
   
   f. Touch the screen to prompt you to the pre-set settings from the main screen.
   
   g. Look over the settings; freezer mill settings should be as outlined in the table from Step 5 above. If the settings need to be changed press the settings button on the screen and make changes.
   
   h. Change cycle number to match total number of samples plus two (n + 2).
i. When mill has been programmed, press the start button. The screen should change and status should change from “Standby” to “Pre-cool”. Allow the mill to run the cycle. You will hear the mill running when on the “run” status. When the sound ends, the cycle is over and the mill needs to be opened and samples removed.

j. Place the next 4 mill tubes in the mill chamber from the basket and add more liquid nitrogen to bring to full level.

The liquid nitrogen level must be checked after each cycle and filled back to level if needed to avoid damage to mill.

6. Programming and use of the 6750 freezer mill is the same as listed above in Step 5. The 6750 freezer mill, however, can only mill one mill tube at a time while holding two other mill tubes in the chamber.

7. Inspect each sample after removal from the mill. If sample is sufficiently pulverized, remove the metal top using the Spex Certi-Prep opening device. **Samples may be reinserted into the mill for additional grinding, if necessary.**

8. Using decontaminated tweezers, remove impactor from vial and submerge in a 4L Nalgene bucket of 10% bleach.

9. Transfer the bone dust to a tared and labeled 50mL conical tube (label conical tube with FB case number and sample name). Ensure complete dust transfer by tapping bottom of cylinder. Record the weight of the dust under “dust weight (g).”

10. Place remaining mill parts in the 4L Nalgene bucket of 10% bleach, all parts should be submerged.

11. Place tubes of bone dust in designated area for pending extraction.
12. When finished milling, flip mill switch off and leave mill open for liquid nitrogen to evaporate.

**Cleaning mill parts:** Mill parts must be cleaned immediately after processing.

a. Separate all mill parts and scrub individually with toothbrush using 10% bleach.
b. Rinse with water and place mill parts in a bucket containing 0.1% SDS.
c. Brush parts with a new toothbrush in the SDS solution.
d. Rinse parts with water again and place in a bucket containing 10% bleach.
e. Rinse all parts with water.
f. Separate the plastic cylinders from the metal parts.
g. Rinse metal parts in 200 proof ethanol. **DO NOT** rinse the plastic cylinder in ethanol as it will cause the plastic cylinder to degrade.
h. Expose all the parts to UV light for a minimum of 2 hours-overnight. The UV light in a biological hood or a StrataLinker can be used. All parts exposed to bone dust need to be placed face up towards the UV light. The mill tubes need to be standing up.

13. Continue to Large Volume Demineralization Extraction Procedure.
LARGE VOLUME DEMINERALIZATION EXTRACTION PROCEDURE WITH QIAGEN M48 LOW ELUTION

A. Extraction Sample Set-up

1. Set up work area; obtain samples, conical tubes for controls, and reagents (0.5M EDTA and 20mg/mL ProK).

2. Label two extraction negative control tubes.

3. Have a witness confirm the order of your sample set. This will be your “Bone Incubation” witness.

4. Add 9mL 0.5M EDTA and 200 µL ProK to each tube.

5. Vortex thoroughly and parafilm all samples.

6. Place samples in shaker and incubate at 56°C at a speed of 124 RPM overnight. Shaker should default at these settings.

Programming/using the shaker:

To program the shaker use the “Select” button to highlight the fields on the right of the control panel. Once field is highlighted the up and down arrows can be used to set field to the appropriate number. Once samples are in the shaker, close the cover and select the “Start” button. Samples should begin shaking at set RPM’s. Before opening the cover to remove samples, press the “Stop” button and allow samples to come to a stop. If shaker starts to beep after opening or closing cover hit the “Select” button once. (This beep is signaling that temperature has dropped from the setting that was selected.)

B. Clean-up

1. Remove tubes from shaker and set temperature to 60°C, speed at 124 RPM.
2. Add 1.0mL of 1.0M KOH to each tube. Dispose of all KOH tips in the amber hazardous waste bottle labeled “potassium hydroxide”.

   *Eye protection must be worn when handling 1.0M KOH. Avoid contact of reagent with metal part of pipette when aliquotting from reagent container.*

3. Vortex thoroughly and place on shaker once it has reached 60°C for 5min.

4. Vortex all samples and place in large centrifuge at 2500 RPM for 3-5min.

5. Label 10K Amicon tubes (tops and sides) the same way the extraction sample set is labeled.

6. **Have a witness confirm the order of your samples ensuring that they are correctly set up for transfer to the correctly labeled Amicon tube. This will be your “Bone Clean-up” witness.**

7. Transfer the supernatant portion of the samples to Amicons. Throw away incubation tubes in the hazardous waste trash.

8. Spin Amicons in large centrifuge at 4000-4500 RPM for an initial 45-60min. **The Eppendorf centrifuge will only reach 4000 RPM.**

9. Continue spinning until samples are at or below the 500µL mark on the Amicon tube.

10. Once under 500µL, remove the top of the Amicon tube, pull out the filter portion and drain out the liquid in the bottom of the Amicon into a sink with running water.

11. Replace the filter in the tube. Add 5mL sterile water to each Amicon.

12. Spin again at 4000-4500 RPM for 10-15 until sample is at or below the 500µL mark on the Amicon tube.

13. Repeat steps 10-12 one more time for a total of 2 sterile water washes.
14. Label stratalinked M48 tubes the same way the incubation and Amicon tubes were labeled.

15. **Have a witness confirm the order sample set to ensure that the Amicon sample will be transferred to the correctly labeled M48 tube. This will be your “M48 tube set-up” witness.**

16. Using a 200µL pipette and sterile water, bring the volume of the sample in the Amicon tube up to 500µL.

17. Using the pipette tip, move it across the bottom of the Amicon filter to re-suspend sample with sterile water. Tilt the Amicon so sample collects to one side and draw up the sample, placing it into the labeled M48 tube. Throw away Amicon tubes when finished in the biohazard trash.

18. **Samples should be processed on the M48 within 48 hrs of extraction clean-up. If M48 processing cannot be done immediately after extraction, keep samples in a freezer until procedure can be done.**

C. **M48 large volume-low elution procedure**

NOTE: G2 and Proks are NOT added to the samples and the samples are not incubated. No new controls are introduced for this procedure.

1. Open file on the M48 computer. Save this sheet by going to File→Save As and save the sheet to the “SampleName” folder on the desktop with “File Name:” in MMDDYYHHMM format and “Save As Type:” set to CSV (Comma delimited)(*.csv). Use the original extraction date and time.

2. Click “Save”. A window stating “The selected file type does not support workbooks that contain multiple sheets” will open. Click “OK”.

3. A second window asking “Do you want to keep the workbook in this format?” opens. Click “Yes”.

4. Open instrument program on computer and set program to “**Large volume v1.1**”.

5. Click on the “select” button and select “1.5 ml” for the size of the elution tubes.
6. Select the number of samples 6, 12, 18, 24, 30, 36, 42, or 48.

7. Set sample volume to 500uL

8. Set elution volume to 50uL

9. The next prompt asks to ensure the drop catcher is clean. In order to check this, click on “manual operation” and select “Drop Catcher Cleaning”. The arm of the robot will move to the front of the machine, and the drop catcher (a small plastic tray) will be right in front of you. Remove and clean with 70% ethanol. When the catcher is clean, replace the tray, close the door, and click “OK” in the window.

10. Make sure that the chute to the sharps container bin is clear for the tips to be discarded. Click “Next”.

11. The software will calculate the number of tips necessary for the run. Place tips in the tip rack(s) if necessary. When filling racks, make sure that the pipette tips are correctly seated in the rack and flush with the robotic platform. Tips are located in three racks. These racks may be filled one at a time, BUT you must fill a whole rack at a time. After a rack is filled, reset the tip rack by clicking on “Yes tip rack...”, If no new tips are being added to the robot click “No”.

Tips needed for a run:

<table>
<thead>
<tr>
<th># Samples</th>
<th>6</th>
<th>12</th>
<th>18</th>
<th>24</th>
<th>30</th>
<th>36</th>
<th>42</th>
<th>48</th>
</tr>
</thead>
<tbody>
<tr>
<td># Tips</td>
<td>30</td>
<td>42</td>
<td>54</td>
<td>66</td>
<td>78</td>
<td>90</td>
<td>102</td>
<td>114</td>
</tr>
</tbody>
</table>

12. After you are finished, click “Next”.

13. Obtain stock bottles of reagents and **record lot numbers**. Fill the reagent reservoirs as stated below. All reagents are stored in their respective plastic reservoirs in the metal rack, labeled with the lot number of the reagent that they contain, and covered with Parafilm, **EXCEPT** the magnetic resin. The resin is disposed of after every extraction. Vortex the magnetic resin solution well, both in the stock bottle and in the reservoir, before adding it to the metal rack (see step 13 for preparation of MagAttract Resin). If you notice crystallization in any of the solutions, discard the solution, rinse the container out, and start again with fresh reagent.
14. Remove the Parafilm and lids from the reagents, and fill the reservoirs to the appropriate level using solutions from the working solution bottles using the same lot as labeled on the reservoir. If not enough of the same lot of a solution remains, discard the remaining solution from the reservoir, rinse and re-label the reservoir with the new lot number. When filling the reservoirs add approximately 10% extra to the volumes recommended below to account for the use of the large bore pipette tips:

<table>
<thead>
<tr>
<th># of samples</th>
<th>Large reservoir Sterilized Water (mL)</th>
<th>Large reservoir Ethanol (mL)</th>
<th>Large reservoir Buffer MW1 (mL)</th>
<th>Large reservoir Buffer MTL (mL)</th>
<th>Small reservoir Sterile Water (mL)</th>
<th>Elution buffer (TE(^4)) (mL)</th>
<th>Small reservoir Poly A RNA - Magnetic Resin (mL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>10.0</td>
<td>11.8</td>
<td>12.2</td>
<td>5.1</td>
<td>3.5</td>
<td>1.6</td>
<td>1.5</td>
</tr>
<tr>
<td>12</td>
<td>18.4</td>
<td>22.6</td>
<td>12.9</td>
<td>10.3</td>
<td>5.9</td>
<td>1.9</td>
<td>1.7</td>
</tr>
<tr>
<td>18</td>
<td>26.9</td>
<td>33.4</td>
<td>14.7</td>
<td>14.7</td>
<td>8.4</td>
<td>2.2</td>
<td>1.9</td>
</tr>
<tr>
<td>24</td>
<td>35.3</td>
<td>44.2</td>
<td>24.3</td>
<td>24.3</td>
<td>19.0</td>
<td>10.8</td>
<td>2.5</td>
</tr>
<tr>
<td>30</td>
<td>43.7</td>
<td>55.0</td>
<td>30.0</td>
<td>23.4</td>
<td>13.3</td>
<td>2.8</td>
<td>2.3</td>
</tr>
<tr>
<td>36</td>
<td>51.2</td>
<td>63.8</td>
<td>35.7</td>
<td>27.8</td>
<td>15.7</td>
<td>3.1</td>
<td>2.5</td>
</tr>
<tr>
<td>42</td>
<td>60.6</td>
<td>76.6</td>
<td>41.4</td>
<td>32.1</td>
<td>18.2</td>
<td>3.4</td>
<td>2.7</td>
</tr>
<tr>
<td>48</td>
<td>69.0</td>
<td>87.4</td>
<td>47.0</td>
<td>36.5</td>
<td>20.6</td>
<td>3.7</td>
<td>2.9</td>
</tr>
</tbody>
</table>

Note: Bottles of MW1 require the addition of ethanol prior to use. See bottle for confirmation of ethanol addition and instructions for preparation if needed.

15. Follow software instructions to prepare reagent rack. Software will indicate the reagent, reagent position in the rack and amount of reagent to use.
Refer to the table below for amounts of 1000ng/uL Poly A RNA stock solution to add for resin preparation:

<table>
<thead>
<tr>
<th>Samples</th>
<th>Volume of 1000ng/uL stock PolyA RNA solution added to resin (uL)</th>
<th>Volume of Untreated MagAttract Resin (uL)</th>
<th>Total Volume of RNA Treated MagAttract Resin (uL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>6 samples</td>
<td>4.4</td>
<td>1497.8</td>
<td>1502.2</td>
</tr>
<tr>
<td>12 samples</td>
<td>5.0</td>
<td>1697.5</td>
<td>1702.5</td>
</tr>
<tr>
<td>18 samples</td>
<td>5.6</td>
<td>1897.2</td>
<td>1902.8</td>
</tr>
<tr>
<td>24 samples</td>
<td>6.2</td>
<td>2096.9</td>
<td>2103.1</td>
</tr>
<tr>
<td>30 samples</td>
<td>6.8</td>
<td>2296.3</td>
<td>2303.4</td>
</tr>
<tr>
<td>36 samples</td>
<td>7.4</td>
<td>2496.3</td>
<td>2503.7</td>
</tr>
<tr>
<td>42 samples</td>
<td>7.9</td>
<td>2696.0</td>
<td>2703.9</td>
</tr>
<tr>
<td>48 samples</td>
<td>8.5</td>
<td>2895.7</td>
<td>2903.9</td>
</tr>
</tbody>
</table>

The pretreated resin may be prepared in a 15mL conical tube and then added to the appropriate reservoir for addition to the platform in the amount dictated by the protocol. Vortex the magnetic resin in the container before pipetting into M48 reagent container and vortex the M48 reagent container once the PolyA dilution has been added.

Place reservoirs into the metal rack in the following locations. The plastic reservoirs only fit into the rack one way. Check the directions of the notches which should point into the robot:

<table>
<thead>
<tr>
<th>Size Reservoir</th>
<th>Rack Position</th>
<th>Software Tag</th>
<th>Reagent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large reservoir</td>
<td>L4</td>
<td>Rea_4</td>
<td>Sterilized Water</td>
</tr>
<tr>
<td>Large reservoir</td>
<td>L3</td>
<td>Rea_3</td>
<td>Ethanol (100%)</td>
</tr>
<tr>
<td>Large reservoir</td>
<td>L2</td>
<td>Rea_2</td>
<td>Wash Buffer 1 (Buffer MW1)</td>
</tr>
<tr>
<td>Large reservoir</td>
<td>L1</td>
<td>Rea_1</td>
<td>Lysis and Binding Buffer (Buffer MTL)</td>
</tr>
<tr>
<td>Small reservoir</td>
<td>S6</td>
<td>ReaS6</td>
<td>(empty)</td>
</tr>
<tr>
<td>Small reservoir</td>
<td>S5</td>
<td>ReaS5</td>
<td>(empty)</td>
</tr>
<tr>
<td>Small reservoir</td>
<td>S4</td>
<td>ReaS4</td>
<td>(empty)</td>
</tr>
</tbody>
</table>
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.

16. Flip up the “container interlocks” and place the metal reservoir holder onto the left side of the robotic platform in the proper position. **DO NOT force the holder into place and be careful not to hit the robotic arm.** After correctly seating the metal holder, flip down the “container interlocks” and press “next”.

17. Click “Next” when you are prompted to write a memo.

18. Place the sample preparation trays on the robot. One tray for every 6 samples. Click “Next”.

19. Place empty, unlabeled 1.5mL elution tubes in the 65 degree (back) hot block, located on the right side of the robotic platform. Make sure tubes are in places for any blank samples. Click “Next”.

20. Print labels for 1.5 mL screw top tubes for final sample collection in the robot.

21. Place labeled, empty 1.5 mL sample collection tubes in the 8 degree (front) cold block for collection of final samples. Make sure tubes are in place for any blank samples.

22. **Make PolyA dilution (add 30µL of PolyA to 90µL of irradiated water) and add 2.5µL of PolyA dilution to each M48 sample tube.**

23. Vortex samples and centrifuge if needed. Do not obtain a pellet in M48 tube from over centrifuging. If pellet occurs, vortex slightly to re-suspend before placing sample on M48 instrument.

24. Fill “Blanks” with 500uL sterile H2O.
25. Make sure all of the lot numbers are recorded. When they are ready, have a witness confirm the order and labels of both the sample tubes and the labeled 1.5 mL final sample collection tubes. The robot setup witness should also verify that all plastic ware is in the correct position and correctly seated in the platform. This will be your “Robot Setup” witness.

26. Click “Yes” when asked to input sample names.

D. Importing Sample Names

1. At the sample input page, click “Import”.

2. The Open window will appear. “Look in:” should automatically be set to a default of “SampleName”. If not, the correct pathway to the folder is My Computer\C:\Program Files\GenoM-48\Export\SampleName. (The SampleName folder on the desktop is a shortcut to this file.)

3. Select your sample name file and click “Open”. Verify that your sample names have imported correctly. Do not be concerned if a long sample name is not completely displayed in the small window available for each sample.

4. Manually type in the word “Blank” for all empty white fields.

5. Click “Next”.

E. Verifying Robot Set-Up and Starting the Purification

1. In addition to confirming the position of all plasticware and samples, check the following conditions before proceeding:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>All plasticware (tips, sample plates, tubes) is seated properly in the robotic platform</td>
<td>✔</td>
</tr>
<tr>
<td>Metal reservoir rack is seated properly, UNDER the interlocks</td>
<td>✔</td>
</tr>
<tr>
<td>Interlocks are down</td>
<td>✔</td>
</tr>
<tr>
<td>Sample tubes, elution tubes and sample collection tubes have been added to the platform in multiples of 6 as follows:</td>
<td>✔</td>
</tr>
</tbody>
</table>
1. Empty 1.5 mL tubes are filling empty positions for both sets of elution tubes in the cold and hot blocks

2. 2.0 mL sample tubes filled with 500uL of sterile H2O are in empty positions of the sample rack

2. After confirming the position and set-up of the plastic ware click “Confirm”.

3. Click “OK” after closing the door.

4. Click “Go” to start the extraction. Check that the bag attached to the waste chute is open and clear.

5. The screen will display the start time, remaining time, and the completion time.

6. Monitor the extraction until the transfer of DNA sample from the sample tubes to the first row of sample plate wells to ensure proper mixing of magnetic resin and DNA sample.

7. At the end of the extraction, a results page will be displayed indicating the pass/fail status of each set of six samples.

F. Saving Extraction Report Page

1. At the end of the extraction, a results page will be displayed indicating the pass/fail status of each set of six samples. **DO NOT** click “Next” until you have exported the results. To export results, click on the “Export” button. The Save As window will appear. “Save In:” should be set to the “Report” folder on the desktop. This is a shortcut to the following larger pathway: My Computer\C:\Program Files\GenoM-48\Export\Report.

2. In “File Name:”, name the report in the format, MMDDYY.HHMM. Set “Save As Type;” to Result Files (*.csv). Use the original extraction data and time. For instance, an extraction performed at 4:30pm on 5/14/06 would be saved as 051406.1630.csv.

3. Click “Save”.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
4. Drag a copy of the result file into the appropriate LIMS SHARE folder.

5. Proceed with clean-up and sterilization.

G. Post-Extraction Clean Up and UV Sterilization

1. Remove samples (from the 8 degree (front) cold block) from the robotic platform and cap with newly labeled screw caps.

2. Wipe down the robotic platform and waste chute with Ethanol. **DO NOT USE SPRAY BOTTLES.** Discard used pipette tips, sample tubes, and sample preparation plate(s).

3. Replace the lid on the magnetic resin reservoir and vortex remaining resin thoroughly. Discard the Magnetic resin immediately with a 1000uL pipetteMAN. Rinse the reagent container with de-ionized water followed by ethanol and store to dry.

4. Cover all other reagents and seal with Parafilm for storage. **MAKE SURE RESERVOIRS ARE LABELED WITH THE LOT NUMBER OF THE REAGENT THEY CONTAIN and that the lot numbers have been recorded.**

5. Replace tips on the instrument that were used during run. There are three racks, and all racks should be full. Ensure that the pipette tips are correctly seated in the rack and flush with the robotic platform.

6. Click “Next”.

7. When prompted, “Do you want to perform a UV sterilization of the worktable?” click “Yes”.

8. Select 1 Hour for the time of “UV sterilization” then click “yes” to close the software upon completion.

9. Store the extracts at 2 to 8°C or frozen.

10. In the LIMS system, navigate to the Data Entry page, assign the samples to a storage unit (cryobox), and import instrument

11. Have a supervisor review the run, and submit samples at neat and/or 1/100 dilutions, as needed for real-time PCR analysis to determine human DNA concentration (refer to Section 4 of the STR manual).
12. COMPLETE THE M48 USAGE LOG WITH THE PURPOSE, PROGRAM, PLATE, AND ANY COMMENTS ARISING FROM THE RUN.

H. BioRobot M48 Platform Diagram

![Diagram of Robotic Platform of the QIAGEN BioRobot M48.]

**Figure 1.** Diagram of Robotic Platform of the QIAGEN BioRobot M48.

- **A** (1-4) Large Reagent Reservoir Positions
- **B** (1-3) Small Reagent Reservoir Positions
- **C** (1-3) Tube Racks
- **D** (1-8) Sample Plate Holders
- **E** Hot Elution Block (65°C)
- **F** Cold Final Elution Block (8°C)
- **G** (1-2) Sample Tube Racks
- **H** Waste Disposal Chute

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
I. Troubleshooting

<table>
<thead>
<tr>
<th>Error</th>
<th>Cause/Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resin/sample is being drawn up into pipette tips unequally</td>
<td>Report problem to QA. Resin buffer has evaporated. O-rings are leaking and need service.</td>
</tr>
<tr>
<td>Crystallization around 1st row of wells in sample plate</td>
<td>Forgot to fill empty sample tubes with 500uL of sterile H₂O</td>
</tr>
<tr>
<td>BioRobot M48 cannot be switched on</td>
<td>BioRobot M48 is not receiving power. Check that the power cord is connected to the workstation and to the wall.</td>
</tr>
<tr>
<td>Computer cannot be switched on</td>
<td>Computer is not receiving power. Check that the power cord is connected to the computer and to the wall power outlet.</td>
</tr>
<tr>
<td>BioRobot M48 shows no movement when a protocol is started</td>
<td>BioRobot M48 is not switched on. Check that the BioRobot M48 is switched on.</td>
</tr>
<tr>
<td>BioRobot M48 shows abnormal movement when a protocol is started</td>
<td>The pipettor head may have lost its home position. In the QIAsoft M software, select “Manual Operation/ Home”.</td>
</tr>
<tr>
<td>Aspirated liquid drips from disposable tips.</td>
<td>Dripping is acceptable when ethanol is being handled. For other liquids: air is leaking from the syringe pump. Report problem to QA. O-rings require replacement or greasing. If the problem persists, contact QIAGEN Technical Services</td>
</tr>
</tbody>
</table>

Revision History:
November 28, 2010 – Initial version of procedure.
Note: When using the High Sensitivity DNA Extraction Procedure, the Microcon procedure in Section C of that Procedure must be used.

In order to allow for duplicate amplifications, the final volume should be between 20 µL and 50 µL. See Table 1 for minimum sample concentration requirements. Refer to the LIMS manual for Forensic Biology for specific procedures within the LIMS system.

1. Fill out the Microcon documentation. Label a sufficient number of blue Microcon DNA Fast Flow sample reservoirs and insert each into a labeled collection tubes.

2. Pre-coat the Microcon® membrane with Fish Sperm DNA in an irradiated microcentrifuge tube or 15 mL tube:
   a. Fish Sperm DNA Preparation
      i. Add 1 µL of stock Fish Sperm DNA solution (1mg/mL) to 199µL of irradiated water for each sample on the microcon sheet.
      
      | Reagent                      | 1 sample |
      |------------------------------|----------|
      | Irradiated Water             | 199 µL   |
      | Fish Sperm DNA (1mg/mL)      | 1 µL     |

      ii. Aliquot 200 µL of this Fish Sperm DNA solution to each Microcon® tube. Avoid touching the membrane. The volume for one sample is shown below. Refer to the microcon documentation for the calculated value.

      NOTE: For samples with 400 µL of digest solution, make a 20 µL solution of 10 µL of Fish Sperm DNA (1mg/mL). Mix well and add this solution to the membrane. Ensure that the entirety of the membrane is covered. In this manner, all of the digest may be added to the Microcon® membrane for a total volume of 420 µL.

3. Process 50 µL of TE⁻⁴ solution as a Microcon negative control. Make sure to use the same lot that will be used to dilute the samples, and don’t forget to label the final negative control tube with the Microcon date and time.

4. Spin each DNA sample briefly. Have a witness confirm the order of the samples and Microcons.
5. Add each sample (0.4 mL maximum volume) to the buffer in the reservoir. Don’t transfer any Chelex beads, or in case of an organic extraction sample, any organic solvent! Seal with attached cap. Avoid touching the membrane with the pipette tip!

6. Return the original extraction tubes to their storage location. Do not discard the empty tubes.

7. Place the Microcon assembly into a variable speed microcentrifuge. Make sure all tubes are balanced! To prevent failure of device, do not exceed recommended g-forces.

8. Spin at 500 x g (2400 RPM, Eppendorf) for 12 minutes at room temperature.

** FOR CONCENTRATION ONLY, SKIP STEP 9 AND PROCEED TO STEP 10 **

9. FOR PURIFICATION of the DNA sample add 200 µL of TE–4 solution and repeat Steps 7-8. Do this as often as necessary to generate a clear extract, and then continue with Step 10. When performing multiple wash steps it is necessary to empty the bottom collection tube intermittently.

NOTE: When purifying samples with a low DNA concentration it may be advantageous to use several wash steps and to also reduce the volume to achieve both, a cleaner sample and an increased DNA concentration.

10. Remove assembly from centrifuge. Visually inspect each Microcon membrane tube. If it appears that more than 20 µL remains above the membrane, centrifuge that tube for 3 more minutes at 2400 rpm. This process may be repeated as necessary.

11. Open the attached cap using a tube opener and add 20 µL TE–4. Avoid touching the membrane with the pipette tip! Separate the collection tube from the sample reservoir.

12. Place sample reservoir upside down in a new labeled collection tube, then spin for 3 minutes at 1000 x g (3400 RPM Eppendorf). Make sure all tubes are balanced!
13. Remove from centrifuge and separate sample reservoir. Measure resulting volume using an adjustable Micropipette, record volume on worksheet; adjust volume to desired level using TE⁻⁴.

A. Clean-up for high DNA concentrations: reconstitute to starting volume.
B. Low DNA samples (clean-up and/or concentration): adjust to 20-50 μL (depending on amplification system)

14. Transfer the DNA extracts and the Microcon negative control to newly labeled 1.5mL Eppendorf tubes and store extract for later use. Note storage location on the documentation.

15. Calculate resulting concentration or submit to real-time PCR analysis to find the new DNA concentration.

**ATTENTION:** Do not store the DNA in the Microcon vials! The lids are not tight enough to prevent evaporation.

**Troubleshooting:**

Lint, bone dust and other particles can clog the membrane. If the liquid does not go down, collect the sample from the filter and redistribute the supernatant to multiple filters or a new filter. Pipet off the clear supernatant without disturbing the particle pellet. Microcon negative controls should be treated accordingly.

If the problem persists, the specific Microcon lot number might be faulty. Notify the QA Unit and try a different lot number.
TABLE 1:

<table>
<thead>
<tr>
<th>Sample Type</th>
<th>Identifiler™ 28 cycles</th>
<th>Identifiler™ 31 cycles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Desired Template</td>
<td>100.00 pg</td>
<td>^20.00 pg</td>
</tr>
<tr>
<td>Template volume for amp</td>
<td>5 µL</td>
<td>5 µL</td>
</tr>
<tr>
<td>Minimum Sample Concentration in 200 µL</td>
<td>20 pg/µL</td>
<td>^4 pg/µL</td>
</tr>
<tr>
<td>Minimum Sample Concentration in 200 µL prior to Microconning* to 50 µL</td>
<td>5 pg/µL</td>
<td>N/A</td>
</tr>
<tr>
<td>Minimum Sample Concentration in 200 µL prior to Microconning** to 20 µL</td>
<td>0.40 to ^0.10 pg/µL</td>
<td></td>
</tr>
<tr>
<td>For LCN samples: Minimum Sample Concentration in 20 µL</td>
<td>20.00 pg/µL</td>
<td>4.00 to ^1.00 pg/µL</td>
</tr>
</tbody>
</table>

* Sample concentration prior to processing with a Microcon DNA Fast Flow and elution to 50 µL
** Sample concentration prior to processing with a Microcon DNA Fast Flow and elution to 20 µL
^ Samples with less than 20 pg per amplification may be amplified upon referral with the LCN supervisor

Revision History:

March 24, 2010 – Initial version of procedure.

September 27, 2010 – Inserted note to direct the High Sensitivity/Hybrid Team to follow the Microcon YM100 procedure in Section C of the High Sensitivity DNA Extraction procedure.

July 16, 2012 – Specific worksheets were removed and replaced with generic terminology to accommodate LIMS.

December 28, 2012 – YM100 microcons were discontinued by the manufacturer. The manufacturer is now producing the DNA Fast Flow Microcons. All references to the YM100’s have been revised to the “DNA Fast Flow,” including the title of this procedure. Spin times in Steps 8 and 10 have been revised for the new microcons.

April 1, 2014 – Removed the option to use PolyA RNA in Step 2; removed the use of Trehalose and irradiated water.

ARCHIVED 05/21/14

Document Control Coordinator
Note: For oral or buccal swab exemplars, quantitation need not be performed. Rather, 2 µL of a 0.1 dilution of extract can be submitted directly to amplification for each sample.

A. Work Place Preparation

1. Retrieve clean racks, cap openers, Rotorgene 0.1 mL tubes and caps, microcentrifuge tubes, and irradiated GIBCO™ ULTRA PURE™ distilled water from storage or the Stratalinker.

2. Apply 10% bleach followed by water and/or 70% Ethanol to the entire work surface. Cap openers, racks, and pipettes may be cleaned in a similar manner. For LCN samples, all Rotorgene setup steps should be carried out under a hood.
   a. For LCN samples, the 1.5 mL microcentrifuge tubes and water aliquots in 1.5 mL tubes must be irradiated for 30 and 45 minutes, respectively.
   b. Rotorgene tubes and caps are used as packaged.

B. Sample Dilution

If necessary, dilute the sample extracts (as with HCN samples).

1. Label microcentrifuge dilution tubes with sample name and dilution.

2. Place each dilution tube directly behind the corresponding extract tube in a rack.

3. Add the appropriate amount of diluant (irradiated water or TE) to each dilution according to Table 1.
   a. Sexual assault semen and saliva samples, scrapings and other samples that are extracted with the “Chelex other” or M48 method, and bone samples should be measured with a neat and a 1/100 dilution.
   b. Blood and buccal samples and all burglary samples may be measured with a 1/10 dilution only. This will capture most concentrations. If necessary, a second measurement may be taken with either a neat or a 1/100 dilution.
   c. LCN samples should be measured with a neat dilution. If necessary, a 1/10 dilution may be made if one suspects inhibition.
   d. Pipet tips do not need to be changed to add water/TE to empty tubes. Close all caps.
4. Open only one sample and its corresponding dilution tube at one time.

5. Thoroughly mix each extract, prior to aliquotting.

6. Immediately following each dilution, return the original sample extract tube to its cryobox. Return the original samples to 4°C storage.

7. Once the dilutions are completed, evidentiary samples may join exemplar dilutions on the benchtop.

**TABLE 1:**

<table>
<thead>
<tr>
<th></th>
<th>Submission 1</th>
<th>Submission 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Dilution 1</td>
<td>Water or TE</td>
</tr>
<tr>
<td>HCN Semen and saliva (amylase positive samples)</td>
<td>Neat</td>
<td>5 µL</td>
</tr>
<tr>
<td>HCN Scrapings or “other” extractions</td>
<td>Neat</td>
<td>5 µL</td>
</tr>
<tr>
<td>HCN exemplars Bone</td>
<td>Neat</td>
<td>5 µL</td>
</tr>
<tr>
<td>HCN exemplars Blood or Saliva</td>
<td>1/10</td>
<td>2 µL</td>
</tr>
<tr>
<td>HCN Blood Samples</td>
<td>1/10</td>
<td>2 µL</td>
</tr>
<tr>
<td>Touched objects and/or LCN Samples</td>
<td>Neat</td>
<td>N/A</td>
</tr>
</tbody>
</table>

In order to conserve, neat LCN samples may be taken from the extract tube and added to the quantitation tube directly (no neat submission tube is necessary). However, 1/10 dilutions should be prepared in advance as specified above.

**C. Remove reagents for the master mix from the reagent freezer/refrigerator**

1. Retrieve MgCl₂, 10X PCR buffer, BSA, dNTPs, TAQ GOLD, unlabeled “EB1” and “EB2” primers, and SYBR Green I from the freezer, irradiated GIBCO™
ULTRA PURE™ distilled water from the refrigerator, and DMSO from the cabinet.
2. Store reagents, except DMSO and water, in a Nalgene cooler on the bench.

3. Record lot numbers of reagents.

4. Just before initiating “sample preparation”, place MgCl₂, 10X PCR buffer, BSA, dNTPs, and unlabeled “EB1” and “EB2” primers on a 48-position microcentrifuge rack in order to thaw these reagents.

D. Standard Curve Preparation

1. Retrieve 1600 pg/µL standard DNA from the freezer and record lot #.

2. Ensure that the contents of the 1600 pg/µL standard DNA tube are thawed and removed from the cap, by centrifuging the tube.

3. Label tubes as follows: 400, 100, 25, 6.25, 1.56, 0.39, and NTC (no template control or 0 pg/µL).

4. Add 15 µL of irradiated water to tubes 400, 100, 25, 6.25, 1.56, 0.39, and the NTC. Pipet tips do not need to be changed to add water to empty tubes. Close all caps.

5. 0.25 Serial dilution

   In order to mix each dilution thoroughly, either pipet the dilution up and down several times or vortex each dilution and subsequently centrifuge the tube at no more than 3000 rpm for 3 seconds.

   a. Open only two consecutive standard DNA tubes at once starting with the 1600 and the 400 pg/µL tubes.
   b. Mix the DNA solution in the 1600 pg/µL. Take 5 µL of standard DNA at 1600 pg/µL and add to the 400 pg/µL tube, and thoroughly mix the contents.
   c. With a new pipet tip, take 5 µL of standard DNA at 400 pg/µL and add to the 100 pg/µL tube, and thoroughly mix the contents.
   d. With a new pipet tip, take 5 µL of standard DNA at 100 pg/µL and add to the 25 pg/µL tube, and thoroughly mix the contents.
   e. With a new pipet tip, take 5 µL of standard DNA at 25 pg/µL and add to the 6.25 pg/µL tube, and thoroughly mix the contents.
f. With a new pipet tip, take 5 µL of standard DNA at 6.25 pg/µL and add to the 1.56 pg/µL tube, and thoroughly mix the contents.

g. With a new pipet tip, take 5 µL of standard DNA at 1.56 pg/µL and add to the 0.39 pg/µL tube, and thoroughly mix the contents.

h. Do not add anything to the NTC tube.

**E. Sample Preparation**

1. Remove 1500 pg/µL calibrator from freezer and record lot number.

   a. Vortex the calibrator thoroughly and centrifuge the tube at 3000 rpm for approximately 3 seconds.

   b. Make three 0.166 dilution (1/6) of the calibrator with 4 µL of the calibrator and 20 µL of irradiated water.

2. Vortex all samples including the standards, NTC, calibrator, and the dilution and/or extract tubes.

3. Centrifuge all samples briefly for 3 seconds at no greater than 3000 rpm; this will prevent the DNA from aggregating at the bottom of the tube.

4. **Witness Step:**
   Arrange samples in order according to the sample documentation in a 96 well rack.

   a. Place samples in exactly the same place on the rack as they will appear vertically positioned in the rotor.

   b. Label the top of the sample tubes with rotor well identifier or tube labels.

   c. Have a witness confirm the sample locations.

**F. Master Mix preparation**

1. Remove the SYBR Green I from the Nalgene cooler and prepare a 1/100 dilution. Take 2 µL of SYBR Green I in 198 µL of irradiated water, vortex, and tap the tube on the bench to consolidate the reagent at the bottom of the tube.

2. Mix each reagent before adding.

   a. After each reagent has thawed, vortex each reagent, with the exception of TAQ GOLD.
b. Centrifuge reagents in the table top centrifuge at 3000rpm for approximately 3 seconds.

3. Add each reagent in the order as it appears on the documentation. Thoroughly mix each tube reagent by pipetting up and down, or vortexing briefly. If vortexing, afterwards tap the tube on the bench to prevent the reagent from being trapped in the cap.

4. For total reagent volumes above 20 µL, use a P200 even for multiple dispenses as opposed to one dispense with a P1000. To ensure accurate pipetting, aspirate and dispense the reagent as specified on the run sheet.

5. After adding each reagent, place the reagent back in the Nalgene cooler, or for water and DMSO, in the opposite corner of the 48 well microcentrifuge rack.

6. Thoroughly mix the master mix by vortexing. Tap the tube on the bench to prevent the reagent from being trapped in the cap and/or centrifuge briefly for approximately 3 seconds.

7. Add 23 µL of master mix to the appropriate number of Rotorgene tubes. Fill tubes in a vertical fashion (positions 1-16 or A1 to A8, and B1-B8 in older rotors). After adding master mix to 16 tubes, re-vortex the master mix and ensure all of the master mix is consolidated by tapping the tube on the bench and centrifuging briefly for approximately 3 seconds. Use a new pipette tip.

See Table 2 below for reagent concentrations; calculated amounts for n+10%n samples will display rounded values for pipetting.
TABLE 2:

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Concentration</th>
<th>μL for 1 Rx</th>
</tr>
</thead>
<tbody>
<tr>
<td>Irradiated GIBCO™ ULTRA PURE™ distilled water</td>
<td></td>
<td>8.3 (8.26)</td>
</tr>
<tr>
<td>10X PCR Buffer</td>
<td>10mM Tris/50mM KCl</td>
<td>2.5</td>
</tr>
<tr>
<td>25 mM MgCl₂</td>
<td>275 µM</td>
<td>2.8 (2.75)</td>
</tr>
<tr>
<td>5 mg/mL BSA</td>
<td>0.525µg/µL</td>
<td>4.0</td>
</tr>
<tr>
<td>2.5 mM dNTPs</td>
<td>200 µM each</td>
<td>2.0</td>
</tr>
<tr>
<td>DMSO</td>
<td>8%</td>
<td>2.0 (1.96)</td>
</tr>
<tr>
<td>1/100 dilution of 10,000X SYBR Green I</td>
<td>100X</td>
<td>0.3 (0.28)</td>
</tr>
<tr>
<td>20 pmol/µL Primer EB1</td>
<td>0.4 µM</td>
<td>0.5</td>
</tr>
<tr>
<td>20 pmol/µL Primer EB2</td>
<td>0.4 µM</td>
<td>0.5</td>
</tr>
<tr>
<td>5U/µL ABI Taq Gold</td>
<td>1.25U</td>
<td>0.3 (0.25)</td>
</tr>
<tr>
<td>Total volume</td>
<td></td>
<td>23.00</td>
</tr>
</tbody>
</table>

*Reagent amounts are calculated using two significant figures. However, for the purposes of manual addition, only one significant digit is shown.

G. Sample Addition

1. In order to avoid the creation of aerosols, thoroughly mix the contents of each tube by pipetting up and down repeatedly.

2. Add 2 µL of each sample, including the standards, NTC, the calibrator dilution, and the sample dilutions and/or extracts, to each tube with master mix.
   a. If necessary, in order to conserve sample, only 1 µL of sample may be measured. Note this on the sample documentation and double the resultant value to accurately reflect the sample’s concentration per microliter.
   b. Every four reaction tubes, place caps on the tubes. (The caps are attached in sets of four.)
c. Number the first cap in every set of four as they will appear in the rotor. (1 for 1, 2 for 2, etc. For the older rotors, 1 for A1, 5 for A5, 9 for B1 etc.) **DO NOT** label the tube itself, as this may interfere with fluorescent detection.

3. Create an Excel sheet and save it in the appropriate folder on the network.

4. Enter run information in the Rotorgene usage log.

5. Open the machine. Remove the circular rotor from the instrument by either pressing in the middle silver stem in the RG6000 or unscrewing the center piece in the RG3000. Remove either the silver clip from the RG6000 rotor or the silver ring from the RG3000 rotor. Add tubes to the rotor. Ensure that tube 1 is in position 1, etc. or in older rotors, 1 is in position A1 etc.

6. Ensure that all positions on the rotor are filled (using blanks if necessary).

7. In the RG6000, add the silver clip to the rotor, lock into the Rotorgene, and close machine. In the RG3000, add the silver ring and screw the rotor into the Rotorgene, locking the rotor in place. Ensure the silver ring is in place and sitting securely in the rotor on all sides. Close machine.

**H. Software Operation**

1. Open Excel and the relevant sample sheet, and then collapse the window.

2. Open Rotorgene 6 software on the desktop.

3. Click File, New, Casework, and click “new”

4. In the wizard
   a. Ensure that the “Rotorgene 72 well rotor” is highlighted
   b. Make sure that the box next to “locking ring attached”, is checked.
   c. Click “Next.”
   d. Type initials for Operator and add any notes (extraction date/time)
   e. Reaction volume should be “25 µL”
   f. Sample layout should be “1, 2, 3…”
   g. Click “Next.”
h. In the RG3000s, click “Calibrate”. In the RG6000, click “gain optimisation”.
   i. “Perform Calibration before 1st acquisition”
   ii. Click on “calibrate acquiring” (RG3000) or “optimize acquiring” (RG6000).
   iii. “This will remove your existing setting for auto gain calibration?”
       The window appears, click YES. A green gain window will open.
       Click “ok”, then “close”.
   iv. Note selecting “calibrate all” will attempt to calibrate for all
       channels known by the software whereas “calibrate acquiring” will
       instead only calibrate those that have been used in the thermal
       profile defined in the run such as FAM or Green.
   v. Click next in wizard and “start run”.

5. “Save as” the RG#, date and time (for example, “RG1Q112904.1400” for a run on
   RG1 on Nov 29, 2004 at 2:00pm) in Log Archive folder.

6. Sample sheet window
   a. Expand the Excel sample sheet window. Copy all of the control and
      sample names.
   b. Paste the control and sample names in the appropriate rows in the
      Rotorgene sample window by right clicking and selecting paste.
   c. Setting
      i. Given concentration format: 123,456.78 unit pg/µL
      ii. Type category
         1) Standards: std
         2) Zero standard: NTC
         3) Samples and calibrator: unk
      iii. In all wells with standard, calibrator or sample, select “YES”
   d. Hit “Finish”

See below for cycling parameters that should not be changed:

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Duration</th>
<th>Cycles</th>
</tr>
</thead>
<tbody>
<tr>
<td>95°C</td>
<td>10 min</td>
<td></td>
</tr>
<tr>
<td>94°C</td>
<td>15 sec</td>
<td>35</td>
</tr>
<tr>
<td>68°C</td>
<td>60 sec</td>
<td></td>
</tr>
<tr>
<td>72°C</td>
<td>30 sec</td>
<td></td>
</tr>
<tr>
<td>72°C</td>
<td>15 sec</td>
<td></td>
</tr>
</tbody>
</table>

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the
Forensic Biology network. All printed versions are non-controlled copies.
The run will approximately require 1 hour and 40 minutes for completion.

7. Following the initial heating to activate the TAQ and the gain calibration, the raw data will appear on the screen. With this information, one can monitor the progress of the run. Fluorescence for the highest standard should be apparent from ~ cycle 15.

8. Previous run files may be examined while the computer is collecting data.
   a. Collapse the window.
   b. Double click on the Rotorgene icon on the desktop.
   c. The computer will prompt that another version of the software is running and ask if you want to run an analysis version only. Click yes.

I. Clean Up

1. Return water, dNTPs, MgCl₂, 10X PCR buffer, BSA, DMSO, EB1 primer, EB2 primer, TAQ GOLD and water tubes with any remaining reagents to the working reagents box.

2. Dispose of all dilution tubes of the standard, calibrator, and SYBR Green I. Sample aliquots may be stored until assay success is confirmed.

J. Sample and Data Storage

1. Store extracts in a cryobox in the DNA refrigerator. For LCN, the extracts should be stored in the DNA refrigerator in the pre-amp room in the designated area.

2. Ensure that the data from the assay is in the folder labeled “RG data” under the appropriate Rotorgene folder.

3. To transfer over the Rotorgene data to the network:
   a. After the run is done, save and exit out of the Rotorgene software.
   b. In the Log Archive, go to the appropriate run folder.
   c. Copy the run into the appropriate Rotorgene “RG data” folder on the network.
K. Analysis

1. Analysis may be performed on the instrument computer or any computer that has access to the software.

2. Open Rotorgene software on the desktop. If the computer is not connected to an instrument, when the software indicates that the computer cannot connect to the instrument on serial port COM1, select “run in virtual mode”.

3. Click “Open” and click on the run to be analyzed in the “RG data” folder.

4. Click “Analysis” on the toolbar.
   a. Select “Quantitation”, “Show”.
      i. Three windows will open with the standard curve, the samples, and fluorescence.
      ii. If a “Calculate Automatic Threshold” window opens up, click ok.
      iii. Ensure that “dynamic tube” and “slope correct” are selected on the tool bar.
      iv. Select the tab “more settings”.
         1) Ensure that the NTC threshold is set to 10%.
         2) The box under the “reaction efficiency threshold” should NOT be selected however.
         3) Click “OK”.
   b. Check if any sample curve crosses the threshold at an early cycle due to background fluorescence. The sample in question would have no value, but the normalized data would display a curve that crosses the threshold both at an early and at a later cycle.
<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>APPROVED BY</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>04-01-2014</td>
<td>NUCLEAR DNA TECHNICAL LEADER</td>
<td>12 OF 19</td>
</tr>
</tbody>
</table>

In order to avoid disabling the dynamic tube normalization setting, move the threshold to the right, ignoring the first few cycles, so that the sample does not cross the threshold. This can be achieved by the following:

i. In the normalized data windowpane, on the lower right side, under CT calculation, change the number for “Eliminate Cycles before:” from 0 to 1-5. Chose the smallest number where the threshold does not cross the data curve in question.

ii. Alternatively, select the grid immediately to the right of “Eliminate cycles before”. This allows manual manipulation of the starting cycle number of the threshold.

iii. Reanalyze the data by selecting “auto find threshold”.

c. One may also manually manipulate the vertical position of the threshold on the standard curves.

i. Select the grid to the right of the threshold value and then click on the red threshold line and adjust the line. Moving this line vertically will make the threshold cross the standards’ curves at different cycles and thus will change the efficiency, Ct, and sample values.

ii. Position the line to optimize the distance between the Ct values of the standards and thus the calibrator values, while maintaining a passing efficiency value.

5. Save the RG data project.

**L. Report**

1. On the “Quant results” screen, (by right clicking the table heading with the mouse and un-checking certain columns) only pick the following columns: No., Name, Ct., and Calc. Conc.

2. If the No. column shows the well location instead of the number, select “Samples” from toolbar. Under “format”, select “Toggle Sample ID Display”. Click “OK”.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
3. Select “Reports” from toolbar  
   a. Select “Quantitation, cycling A FAM”  
   b. Select “full report” double click  
   c. Generate report  

4. Supervisors must initial all pages of the report after reviewing the assay and incorporate them into the case record.  

M. Assay Interpretation  

Standards and Controls  

1. Check the raw data for cycling. (If the raw data graph is not seen, click on “Cycling A.FAM” in the tool bar and then “Arrange”). If the fluorescence is below 80 RFUs, yet the reaction efficiency is acceptable (see 5), determine if the SYBR Green I was thawed more than once. If not, notify QC in order to test stock. The assay still passes as long as conditions 2b and 3 are fulfilled.  

2. Confirm that the following settings are correct:  
   a. standard curve imported “no”  
   b. Start normalizing from cycle “1”  
   c. noise slope correction “yes”  
   d. reaction efficiency threshold “disabled”  
   e. normalization method “dynamic tube normalization”  
   f. digital filter “light”  
   g. no template control threshold “10%”  

3. Slope optimum: -3.322  

4. R² value optimum: 0.999  

5. Reaction efficiencies should range from 0.80 to 1.15. Efficiencies are rounded down. (For example, 0.799 fails.)  

6. Two of the three calibrator values must be between 400 pg/µL and 100 pg/µL.
7. **No template controls or zero standards should be < 0.1 pg/µL.**

   If the no template control is > 0.1 pg/µL, LCN samples may be amplified since there may not be sufficient sample to retest. However, HCN samples must be re-quantitated.

8. **The difference between the average Ct values of each consecutive duplicate standard concentration should be approximately two cycles.**

9. **At least one of each duplicate standard concentration should be apparent (“clicked on”).** (If #10 is exercised, at least one of each duplicate standard concentration should be apparent for 5 of the 7 remaining standards.) If one duplicate of a standard does not yield the expected Ct value, but the other duplicate is within the expected range, the aberrant standard may be excluded from the standard curve calculation. Unselect the sample on the right side of the screen, and reanalyze.

10. Similarly, if both replicates of a standard are not within the expected range, they may both be excluded from the standard curve calculation, and if all the other parameters of the assay are satisfactory, the assay passes. **However, no more than two standard pairs may be absent.**

11. The assay fails if the reaction efficiency, calibrator and/or non-template control values are unacceptable.

12. For LCN samples in order to preserve sample, if the quantitation assay fails twice, proceed to amplification without a third quantitation.

13. Initiate retesting of all samples in a failed run. Although a quantitation assay may fail, the resultant values may be used to estimate the need for further dilutions for the re-quantitation assay.
TABLE 3:

<table>
<thead>
<tr>
<th>Required Settings</th>
<th>Required Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>Start normalizing from cycle</td>
<td>1*</td>
</tr>
<tr>
<td>Noise slope correction</td>
<td>yes</td>
</tr>
<tr>
<td>Reaction Efficiency threshold</td>
<td>Disabled</td>
</tr>
<tr>
<td>Normalization Method</td>
<td>Dynamic tube Normalization</td>
</tr>
<tr>
<td>Digital Filter</td>
<td>Light</td>
</tr>
<tr>
<td>No template control threshold</td>
<td>10%</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* May change if a sample curve crosses the threshold early (refer to Section M.4.b.ii. of this section).

N. Creating a Rotorgene Summary Page for LIMS Import

1. On the Rotorgene Software (main screen after analysis), go to the “Quant. Results - Cycling FAM” table (lower left window).

2. Maximize the screen. By right-clicking the table heading with the mouse and un-checking certain columns, eliminate all columns except the following:
   - No
   - Name
   - Ct
   - Calc. Conc.

3. Then, right-click mouse and select “Export to Excel”.

4. Save the data with the run name in the appropriate folder on the network.
O. LIMS import

1. In the Data Entry screen for the LIMS system, import the associated .csv file that was previously created and saved to the network.

2. Have a supervisor review the imported results.

3. The interpretation value for each sample will be manually entered by the reviewer.

P. Sample Interpretation

1. Samples that are 1000 pg/µL and above should be requantitated at a 1/100 or a 1/1000 dilution.

2. For amplification with Identifiler™, YFiler, or MiniFiler, if the extraction negative is > 0.2 pg/µL it should be re-quantitated. If it fails again, the sample set must be re-extracted prior to amplification.

**TABLE 4:**

<table>
<thead>
<tr>
<th>Amplification System</th>
<th>Extraction Negative Control Threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>YFiler</td>
<td>0.20 pg/µL in 10 µL</td>
</tr>
<tr>
<td>Identifiler™ 28/31 cycles</td>
<td>0.20 pg/µL in 5 µL</td>
</tr>
<tr>
<td>MiniFiler</td>
<td>0.20 pg/µL in 10 µL</td>
</tr>
</tbody>
</table>
3. If a sample appears to be inhibited, i.e. the curve initially increases and then plateaus, note this in the interpretation column.

4. If a sample displays background fluorescence, indicate such samples in the interpretation column.

5. If a sample displays low background fluorescence, i.e. approximately 10% or less of the total fluorescence, indicate this in the interpretation column.

6. The neat and the value calculated from the 1/100 dilutions of the samples should differ by no more than a factor of 2.5. If the dilutions are not within a factor of 2.5, the samples should be re-quantitated.

7. Table 5 (next page) summarizes which concentration should be selected, if any, for amplification.

### TABLE 5:

<table>
<thead>
<tr>
<th>Samples</th>
<th>Resolution</th>
</tr>
</thead>
</table>
| N = x pg/uL  
1/100 = within +/- 2.5x | Select neat value |
| N = x pg/uL  
1/100 = +/- >2.5x  
No indication of inhibition or background fluorescence | Re-quant samples. |
| N = >1000 pg/uL  
1/100 = <100 pg/uL | Select dilution |
| N = >1000 pg/uL  
Dilution >0000 pg/uL | Requant sample at a greater dilution |
<p>| N = &lt; 20 pg/uL, NO inhibition or fluorescence dilution within +/- 2.5 fold | Not suitable for amplification with Identifiler 28 |
| N = &lt; 10 pg/uL, NO inhibition or fluorescence dilution within +/- 2.5 fold | Not suitable for amplification with MiniFiler |
| N = &lt; 10 pg/uL, NO inhibition or fluorescence dilution within +/- 2.5 fold | Not suitable for amplification with YFiler |
| N = &lt;1 pg/uL, NO inhibition or fluorescence dilution within +/- 2.5 fold | Not suitable for amplification with Identifiler 31 |</p>
<table>
<thead>
<tr>
<th>Samples</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>N = *, **, or Δ</td>
<td>Select dilution</td>
</tr>
<tr>
<td>Dilution NO *, **, or Δ and yields sufficient DNA for HCN amplification</td>
<td></td>
</tr>
<tr>
<td>N = **, dilution **</td>
<td>Select dilution</td>
</tr>
<tr>
<td>N = * or Δ dilution * or Δ</td>
<td>Send to analyst</td>
</tr>
<tr>
<td>N= &lt;7.5 pg/μL, NO *, **, or Δ Dilution not within 2.5 fold</td>
<td>Not suitable for amplification with YFiler, Identifiler 28 or MiniFiler no further testing</td>
</tr>
<tr>
<td>N = * or Δ 1/100 Dilution &lt;0.1 pg/μL</td>
<td>Re-quantitate at 1/10 dilution</td>
</tr>
<tr>
<td>1/10 dilution only = **</td>
<td>Amplify if sufficient DNA for HCN DNA testing.</td>
</tr>
<tr>
<td>1/10 dilution only = * or Δ</td>
<td>In sample quant dictates a greater than 1/10 dilution factor for amp, proceed with amp. Otherwise, send to analyst.</td>
</tr>
<tr>
<td>Any value less than 0.1 pg/μL</td>
<td>Do not interpret</td>
</tr>
</tbody>
</table>

**Table 5 Key:**

N: neat
x: quantitation value
Δ: sample appears to be inhibited
*: sample displays background fluorescence
**: sample displays low background fluorescence

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
References:

Nicklas, J. A., Buel, E. Development of an Alu-based, Real-Time PCR Method for Quantitation of Human DNA in Forensic Samples

Nicklas, J. A., Buel, E. Development of an Alu-based, QSY 7-Labeled Primer PCR Method for Quantitation of Human DNA in Forensic Samples

Revision History:
March 24, 2010 – Initial version of procedure.
July 16, 2012 – Paperwork Preparation section was removed and LIMS Import section was inserted.
April 1, 2014 – Procedure revised to include information for YFiler; note added that quantitation is not necessary for oral or buccal swab exemplars.
Batch processing

1. Exemplars and evidence samples must be handled separately at all times. These samples must never be together on the same sample tray.

2. For the ABI 3130xl, an exemplar and evidence plate may be in the same instrument. Two separate plates are the equivalent of two consecutive runs.

3. Samples from one amplification set should be processed together, so that the samples are accompanied by the appropriate controls.

4. Use the correct documentation for the specific sample type and make sure the sample preparation set-up is witnessed properly.

5. Controls must be run using the same instrument model and under the same, or more sensitive, injection conditions as the samples to ensure that no exogenous DNA is present. Therefore, samples that must be run at higher injection parameters must have an associated control run concurrently with the samples, or have previously passed under the same, or more sensitive, injection parameters. Controls do not have to be run at the same injection parameters as the samples if it previously passed at a higher injection parameter.

   NOTE: Each run that is performed must have at least one correct positive control.

Sample handling

1. Prior to loading on the capillary, the amplified samples are stored at 4°C in the amplified DNA area. The tubes containing the amplified product must never leave the amplified DNA area.

2. Amplified samples that have been loaded on an instrument should be stored until the electrophoresis results are known. After it has been determined that the amplified samples do not require repeated testing, they may be discarded.
Instrument and computer maintenance

1. Be gentle with all instrument parts and instruments. Keep everything clean.

2. It is good practice to monitor initial instrument performance. This enables the user to detect problems such as leaks, air bubbles or calibration issues.

3. Hard disks should be regularly defragmented to improve system performance.

4. Data files and other non-essential files from the computer hard disk should be deleted at least once a week to improve performance.

5. Notify the Quality Assurance Unit if any problems are noted.

Revision History:
March 24, 2010 – Initial version of procedure.
July 16, 2012 – Specific worksheets were removed and replaced with generic terminology to accommodate LIMS.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
GENERAL INFORMATION

The Identifiler Kit is a PCR Amplification Kit manufactured, sold, and trademarked by Applied Biosystems (ABI). The YM1 Kit is a PCR Amplification Kit manufactured in-house that test for four (4) Y-STR Loci.

Target DNA template amounts are as follows:
- Identifiler, 28 amplification cycles (ID28) – 500 pg in sample aliquot of 5 µL
- Identifiler, 31 amplification cycles (ID31) – 100 pg in sample aliquot of 5 µL
- YM1 – 2000 pg in sample aliquot of 26 µL

To calculate the amount of template DNA and diluant to add, the following formula is used:

\[
\text{Amt of DNA extract (µL)} = \frac{\text{Target Amount (pg)}}{(\text{sample concentration (pg/µL)})(\text{dilution factor})}
\]

The amount of diluant to add to the reaction (µL) =

Volume of sample aliquot (µL) - amount of DNA extract (µL)

GENERATION OF AMPLIFICATION SHEETS

To determine the appropriate system for amplification of samples, refer to Table 1.

<table>
<thead>
<tr>
<th>RG value at 1:10 dilution pg/µL</th>
<th>RG value neat pg/µL</th>
<th>Amplification Sheet</th>
<th>Dilution</th>
</tr>
</thead>
<tbody>
<tr>
<td>LCN extraction</td>
<td>≥ 4.0* to 20 pg/µL</td>
<td>Amplify with ID for 31 cycles*</td>
<td>Neat = 1</td>
</tr>
<tr>
<td>≥ 0.4 pg/µL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LCN/HSC extraction</td>
<td>≥ 20 pg/µL</td>
<td>Amplify with ID for 28 cycles</td>
<td>As appropriate</td>
</tr>
<tr>
<td>≥ 2.0 pg/µL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HSC extraction</td>
<td>≥ 7.5 pg/µL</td>
<td>Amplify with YM1 or Microcon and amplify with ID 28</td>
<td>As appropriate</td>
</tr>
<tr>
<td>≥ 0.7 pg/µL</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Samples providing less than 20 pg per amplification can only be amplified with the permission of a supervisor.
A. HSC Team Amp Macro (Evidence samples) for paperwork preparation for amplification with Identifiler 28 Cycles and YM1

1. Open the “RGAMP Macro HSC” and the “RG summary sheet” Excel files for samples ready to be amplified. The “RG summary sheet” is saved as the assay name.
   a. If a window opens stating “…RGAmp Macro HSC.xls” contains macros. Macros may contain viruses…”, click “Enable Macros”.
   b. If a window opens stating “Macros are disabled because the security level is set to High…”., do the following: Select Tools in the toolbar. Click Macro, Security, and set the level to Low. The file must be closed and reopened.

2. Copy the sample information (without the standards or calibrators) from the “summary sheet” of the “RG summary sheet” file including the tube label, sample name, Ct value, the calculated concentration, the target date, and the IA, and paste special as values into the corresponding columns of the “RG value” sheet of the “RGAMP Macro HSC” file.

3. In the last column, entitled “Type”, enter the type of amplification according to the following abbreviations next to the samples to be amplified:
   a. “V” for ID28 Evidence
   b. “Y” for YM1 Evidence

Selecting neat samples versus diluted samples can be done here.

4. Check the sample names to ensure that commas are only located after the full sample name and before the dilution value (i.e. FB01-1234_vag_SF, 0.1).

5. Hit Ctrl+R or click the “Split dilutions & sample info” button to run the dilution macro. A window asking “Do you want to replace the contents of the destination cell?” will appear. Click “OK”.

The dilution macro will separate the dilution factors from the samples names to facilitate the calculation of the neat concentration of the samples.

   a. If the dilution column does not contain the correct dilutions, the file must be closed and reopened. Check for commas in the wrong location in the sample names.
6. Hit Ctrl+G or click the “Sort samples” button to run the sample sorting macro.
   
a. The macro will filter and eliminate all values that are less than 20 pg/µL or 7.5 pg/µL for Identifiler 28 or YM1, respectively. The macro will also sort the samples by system/type and sample concentration in the “Sort” sheet.
   
b. Inspect the samples sorted in the appropriate columns according to system/type and sample concentration.

   For Identifiler 28 samples, proceed to Step 7.
   For YM1 samples, proceed to Step 8.

7. For Identifiler 28 samples:
   
a. Samples with concentrations between or equal to 20 pg/µL and 100 pg/µL (less than or equal to 500 pg amplified) may be automatically amplified in duplicate; see the concordant analysis policy (section 1).

   If you have not done so already, select the samples that require amplification now (i.e. amplifying neat sample versus diluted sample).

   b. Copy and Paste Special as values all samples to be amplified from the appropriate columns on the “Sort” sheet to the associated columns on the “Samples” sheet.

   NOTE:
   - Samples <100pg/µL will be sorted into a different section. Copy them into the amp sheet as well.
   - If applicable, copy the Identifiler duplication samples (for samples <100pg/µL) to the “Identifiler 28 Evidence Dup” sections. This amplification sheet may be used for automatic duplication of samples, depending on the team.

   Proceed to step 9.
8. **For YM1 samples:**

   a. Copy and Paste Special as values all samples to be amplified from the appropriate columns on the “Sort” sheet to the associated columns on the “Samples” sheet.

   b. For samples being sent on for YM1 amplification from P30 values, on the “Samples” sheet, change the Calculated Values column to the appropriate letter associated with the P30 value and sample type:

<table>
<thead>
<tr>
<th>Orifice swab, P30 value, 2ng subtract</th>
<th>Stains P30 value, 0.05 A subtract</th>
<th>Type this letter in the Calculated Value column</th>
</tr>
</thead>
<tbody>
<tr>
<td>HIGH</td>
<td>HIGH</td>
<td>A</td>
</tr>
<tr>
<td>1.1 - 3.0</td>
<td>1.1 - 3.0</td>
<td>B</td>
</tr>
<tr>
<td>&gt;0 - 1.0</td>
<td>&gt;0 - 1.0</td>
<td>C</td>
</tr>
</tbody>
</table>

   For Non-Differential semen or differential swab/substrate remain samples:

   For vaginal swab samples sent for Amylase Positive Extractions, two concentrations must be sent for amplification:

<table>
<thead>
<tr>
<th>Amounts sent to amplification</th>
<th>Type this letter in the Calculated Value column</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNA Target</td>
<td>TE^4</td>
</tr>
<tr>
<td>40</td>
<td>16</td>
</tr>
<tr>
<td>36</td>
<td>0</td>
</tr>
</tbody>
</table>

   c. For samples being sent on for YM1 amplification from Quantification values, the amplification sheet should calculate the appropriate DNA and TE^4 target amount on the amplification sheet.

9. If there are more than 28 samples for amplification, the overflow samples will automatically be transferred into a second amplification sheet (i.e. “ID2”, “ID DUP2” or “YM1 2”).
10. When all samples to be amplified have been organized on the “Samples” sheet, click on the appropriate amplification sheet(s) and check all entries for errors.

All changes, except for the amount of extract submitted during low and high sample submission, should be made in the “Samples” sheet.

11. Save the entire macro workbook in the appropriate folder.

Saving Amplification Sheets on the Network for Additional Samples

1. Partially full or completed amplification sheets may be saved as independent sheets for subsequent sample additions by clicking the “Samples” and amp sheet tab (via holding the ctrl button down). Both sheets should now be highlighted white. Right click and select “move or copy”.

2. In this window, select “(new book)” in the “to book” window and check “create a copy”. Click “OK”. Go to file, Save As and save into the appropriate folder.

3. Samples may be manually added to these sheets by the rotation supervisor from the Aliquot Request form or copied and Paste Special from re-quantification sheets or consolidated from additional amplification sheets of the same type at the end of each Rotorgene run.

4. If any samples need to be submitted to amplification with a DNA amount other than the optimal amount, the rotation supervisor can change the amount of DNA submitted by changing the value in the DNA column in the amplification sheet.

Be aware that once the DNA amount is manually added to the amplification sheet, the sheet will not be able to calculate the value from the quantification value.

All other changes should be done in the “Samples” sheet.

5. When a macro amplification sheet is full the rotation supervisor will add tube labels and fill in the amplification date and time in the appropriate blue cell in the “Samples” sheet. This should automatically populate the appropriate cells in the Amplification sheet.

Any changes to the amplification sheet should be done in the “Samples” sheet.
6. Save the sheet as the time and date of the amplification as follows: “ID041207.1100” for Identifiler28 amplifications, or “YV041207.1100” for YM1 amplifications, performed on April 12, 2007 at 11:00am in the appropriate folder.

7. A supervisor should review all entries were entered correctly before printing the Amplification sheet.

B. RG Amp Macro X (exemplar samples) for Paperwork Preparation for Amplification with Identifiler 28 and YM1

1. Open the “RGampMacro X”.

2. For ID 28 samples, open the “RG summary sheet” Excel file for samples ready to be amped. Copy the information from the “summary sheet” of the “RG summary sheet” file including the tube label, sample name, Ct value, the calculated concentration, the target date, and the IA, and paste special as values into the corresponding columns of the “RG values” sheet of the “RGampMacro X” file.

3. In the last column, entitled “type”, the following information is already added:

   “IDX” for ID28 exemplars

4. Click the “Separate dilutions and sample info” button to run the dilution macro. A window asking “Do you want to replace the contents of the destination cell?” will appear. Click “OK”.

   a. If the macro will not run, follow the instructions in the box and select tools, macro, security, and low. The file must be closed and reopened.

   b. The dilution macro will separate the dilution factors from the sample names to facilitate the calculation of the neat concentration of the samples.

5. Click the “Sort samples” button to run the sample sorting macro.

   a. The macro will filter and eliminate all values that are less than 20 pg/µL for Identifiler 28.

   b. Inspect the samples sorted in the appropriate columns and select the samples that require amp. For instance, determine whether you will be using the calculated concentration derived from the neat sample or the dilution.
c. Samples may be added or deleted to or from the columns following the macro’s execution.

To delete a sample do the following:
   i. On the “sort” sheet in the “RGampMacro X” file, locate the columns relevant to the amplification system and sample type.
   ii. Select the cells relevant to the sample you would like to delete.
   iii. Select edit and clear contents.
   iv. Do not simply delete, always use the “clear contents” function.

To add a sample, do the following:
   i. Copy sample info from the “RG values revised” sheet in the “RGampMacro X” file: the tube label, sample name, Ct value, the calculated concentration, the target date, and the IA.
   ii. Paste special these values into the appropriate columns of the “sort” sheet in the “RGampMacro X” file.

6. Copy and paste all samples to be amped from the appropriate column on the “sort” sheet to the associated column on the “samples” sheet. This is the sheet on which you are building your amp.

7. Ensure that all samples to be amped have been organized correctly on the “samples” sheet and select the appropriate amplification worksheet tab.

The sheet will calculate the dilution factor necessary for the samples as well as the amount of sample and TE-4 or irradiated water to add.

8. Save the macro sheet in the appropriate folder.

9. For YM1 samples, copy all information directly from the aliquot request form. Paste special as values into the “paste Ys” tab of the “RGampMacro X”.

10. Once all samples are added, click on the “YM1” tab.

   The sheet will calculate the dilution factor necessary for the samples as well as the amount of sample and TE-4 or irradiated water to add.

11. Save the macro sheet in the appropriate folder.
C. Aliquot Request and Amp Sheets for HCN evidence and exemplar samples only

Aliquot request sheets have been created for evidence and exemplar submission.

1. Open the correct aliquot request sheet. The sheet can be found in M:\FBIOLOGY_MAIN\Amp Sheets\ALIQUOT REQUEST FORMS\(either EVIDENCE or EXEMPLAR)
2. Fill out the next empty line. Type the case information in 3130 format.
3. Refer to the calculation in this section of the Manual to determine the volume of extract to be aliquotted, based on DNA concentration and target for amplification. If you want to amp your sample at a condition different than normal (reamp high, low/opt/high, etc.) indicate this in the “Sample Information” section.
4. Save the sheet.
5. The person that aliquots the samples will type their initials and the date they aliquot the samples in the last column. That person will email all analysts listed on the sheet indicating that samples have been aliquotted. It is up to the analyst to fill out the extract tracking form with the aliquotting information.
6. The rotation supervisor is responsible for preparing amplification sheets, determining when the samples will be aliquotted and that information that is typed onto the amp sheets is correct.

D. RG Amp Macro HI (High Sensitivity samples) for Paperwork preparation for Amplification with Identifiler 28 and 31

1. Open the current version of the “RGAMP MACRO HI” Excel workbook and the “RG summary sheet” Excel files for samples ready to be amp. These files can be found in the “TEMPLATES IN USE” folder on the High Sensitivity Data drive. The RG Summary Sheets are saved as the assay name in the “Rotorgene” folder on the FBiology Main drive.

2. Copy the information for samples and controls only from the “summary sheet” of the “RG summary sheet” file including the tube label (if applicable), sample name, Ct value, the calculated concentration, the target date, and the IA. Paste special as values into the corresponding columns of the “RG value” sheet of the “RG Amp macro” file. The standards and calibrators need not be copied.
3. In the column entitled “type” enter the type of amplification according to the following abbreviations:
   a. “X” for exemplars
   b. “V” for evidence

4. Note whether any sample has a comma in its name. If not, add a comma after one sample’s name so that the macro will work. Click the “Separate Dilution and Sample Info” button to run the dilution macro. A window asking “Do you want to replace the contents of the destination cell?” will appear. Click “OK”.
   a. If the macro will not run, follow the instructions in the box and select tools, macro, security, and low. The file must be closed and reopened.
   b. The dilution macro will separate the dilution factors from the sample name to facilitate the calculation of the neat concentration of the sample.

5. Click the “Sort Samples” button to run the sample sorting macro.
   a. The sort macro will filter values according to the following specifications which differ depending upon the amount of template DNA.
      i. The macro eliminates all values that are less than 1 pg/µL.
      ii. Values between 1 pg/µL and 20 pg/µL are sorted for LCN amplification with Identifiler for 31 cycles.
      iii. All values greater than 20 pg/µL are sorted for HCN amplification with Identifiler for 28 cycles.
      iv. Note, for samples with greater than 100 pg/µL and less than 124 pg/µL, the macro will indicate to add 5 µL of template DNA. (In order to avoid pipetting less than 1 µL, slightly more than 500 pg of DNA will be added to the reaction.)
b. The extraction negatives will be sorted independently so that they may be inspected and placed at the top of the list with the associated samples when setting up the amp sheets.

c. Samples will be sorted into groups for ID31 evidence and exemplar amp, and ID28 evidence amp. Samples amplified with Identifiler for 31 cycles are amplified in triplicate concurrently whereas samples amplified with Identifiler for 28 cycles are amplified in duplicate in two separate amplifications.

6. Select samples for amplification and copy and paste those samples to the appropriate column on the “samples” sheet. The sample information is then automatically populated into the amplification and 3130run sheets. Samples may also be added or deleted to or from the amp sheets as described below. For example, samples with less than 4 pg/µL or 20 pg/amp require supervisor approval for LCN amplification, and depending upon the case, may not be amplified. Refer to the amplification guidelines and the RG interpretation manual to select samples and the appropriate dilutions to use for amplification calculations.

To delete a sample do the following:

a. Go to the “sort” sheet in the RG AMP MACRO HI file and locate the columns relevant to the amplification system and sample type.

b. Select the cells relevant to the sample you would like to delete.

c. Select edit and clear contents.

d. Do not simply delete, always use the “clear contents” function.

To add a sample, do the following:

a. Copy the tube label, sample name, Ct value, the calculated concentration, the target date, and the IA from the “RG values revised” sheet in the “RG AMP MACRO HI” file.

b. Paste special as values into the appropriate columns for the amplification system of the “samples” sheet in the “RG AMP MACRO HI” file.

c. Alternatively, a sample may be manually added by typing the sample information into the appropriate column in the “samples” sheet.
7. Select the appropriate amplification worksheet, verify the sample information and calculations, and type the name of the amplification in cell B1 as follows: \text{month}\text{date}\text{year}\text{.time} for example, 011106.1000.

   a. The sheet will automatically calculate the number of samples that are to be amplified. This will populate cell B2 of the worksheet.
   b. The sheet will also calculate the amount of reagents required, and the dilution factor necessary for the samples. Verify these calculations.

8. Save the sheet in the amplification sheets folder (as \text{Amo}nth\text{date}\text{year}\text{.time}) and review.

9. Print the amplification sheet. Have the sheet reviewed by a supervisor prior to set-up.

E. RG Amp Macro PC (Property Crimes Samples) for Paperwork Preparation for Amplification with Identifiler 28:

1. Open the “RG Amp MacroPC xls” and the “RG summary sheet” Excel files for samples ready to be amplified. The “RG summary sheet” is saved as the assay name.
   a. If a window opens stating “…RG Amp MacroPC” contains macros. Macros may contain viruses…,” click “Enable Macros”.
   b. If a window opens stating “Macros are disabled because the security level is set to High…,” do the following: Select Tools in the toolbar. Click Macro, Security, and set the level to Low. The file must be closed and reopened.

2. Copy the sample information (without the standards or calibrators) from the “summary sheet” tab of the “RG summary sheet” file including the tube label, sample name, Ct value, the calculated concentration, the target date, and the IA, and paste special as values into the corresponding columns of the “RG value” sheet of the “RG Amp MacroPC” file.

3. In the last column, entitled “Type”, enter a “V” for Evidence.

The decision to sort neat samples versus diluted samples can be done at this point.
4. Check the sample names to ensure that commas are only located after the full sample name and before the dilution value (i.e. FB01-1234_bottle_swab, 0.1).

5. Press Ctrl+R or click the “Split dilutions and sample info” button to run the dilution macro. A window asking “Do you want to replace the contents of the destination cell?” will appear. Click “OK”.

The dilution macro will separate the dilution factors from the samples names to facilitate the calculation of the neat concentration of the samples.

6. If the macro does not sort, this may be because no samples containing dilutions are available to sort. In this case, clear the Dilution column and try sorting again.

7. Press Ctrl+G or click the “Sort samples” button to run the sample sorting macro.
   a. The macro will filter and eliminate all values that are less than 20.0 pg/µL for Identifiler 28.
   b. Samples will be sorted into four columns: Negative Controls, ID28 samples, ID28 Immediate Dups, and ID28 Negative.

8. For Identifiler 28 samples (Property Crimes):
   a. **ALL** samples will be amplified twice; once as an initial amplification and the second time as a duplicate amplification.

   If you have not done so already, select the samples that require amplification now (i.e. amplifying neat sample versus diluted sample).

   b. Copy and Paste Special as values all samples to be amplified from the appropriate columns on the “Sort” sheet to the associated columns on the “Samples” sheet.

   c. Note: Extraction Negatives do not need to be duplicated.

9. If there are more than 28 samples for amplification, the overflow samples will spill into the highlighted area of the Samples sheet, prompting you to make a new amplification sheet.
10. Once satisfied that all samples to be amplified have been organized on the “Samples” sheet, check both the initial and duplicate amplification sheets for errors.

All changes, except for the amount of extract submitted during low and high sample submission, should be made in the “Samples” sheet.

**Saving Amplification Sheets on the Network for Additional Samples**

1. Once complete save each amp (initial and dup) in its respective folder.

2. If any samples need to be submitted to amplification with a DNA amount other than the optimal amount, the amount of DNA submitted can be adjusted by changing the value in the DNA column in the amplification sheet.

Please be aware once the DNA concentration or dilution value is manually added to the amplification sheet, the sheet will not be able to calculate the volume of DNA needed for amplification from the quantification value.

All other changes should be made in the “Samples” sheet.

**F. Saving Amp Sheets to the Network for Additional Samples**

1. Amp sheets may be saved as independent sheets for subsequent sample additions by right-clicking the corresponding tab and selecting “move or copy”. In this window, select “(new book)” in the “to book” window and check “create a copy”. Click “OK”. Go to File – Save-As and save into the appropriate folder.

2. Samples may be manually typed into these sheets or copied and pasted special from re-quant sheets or consolidated from additional amp sheets of the same type at the end of each Rotorgene run.

3. When a sheet is full the analyst may fill in the appropriate information (cells shaded blue) and save the sheet as the time and date of the amp.

**Revision History:**
March 24, 2010 – Initial version of procedure.
A. Preparing DNA aliquots for amplification (if applicable)

1. Follow applicable procedures for preparation for testing.

2. For each sample to be amplified, label a new tube. Add DNA and irradiated water or TE as specified by the amplification documentation. (Samples amplified with Identifiler reagents should be prepared with irradiated water.)

3. Prepare dilutions for each sample, if necessary, according to Table 1.

<table>
<thead>
<tr>
<th>TABLE 1: Dilutions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dilution</strong></td>
</tr>
<tr>
<td>0.25</td>
</tr>
<tr>
<td>0.2</td>
</tr>
<tr>
<td>0.1</td>
</tr>
<tr>
<td>0.05</td>
</tr>
<tr>
<td>0.04</td>
</tr>
<tr>
<td>0.02</td>
</tr>
<tr>
<td>0.01</td>
</tr>
<tr>
<td>0.008</td>
</tr>
</tbody>
</table>

a. Centrifuge samples at full speed briefly.

b. Label tubes appropriately for dilutions. Add the correct amount of irradiated water as specified by the amplification documentation and Table 1.

c. Pipette sample up and down several times to thoroughly mix sample.

d. Set the sample aside until you are ready to aliquot it for amplification.
B. Identifiler – Sample and Amplification Set-up

Samples and Controls

1. The target DNA template amount for Identifiler™ 28 cycles is 500 pg. 
The target DNA template amount for Identifiler™ 31 cycles is 100 pg.

To calculate the amount of template DNA and irradiated water (diluent) to add, 
the following formulas are used. The sample concentration is the RotorGene 
quantitation value:

\[
\text{DNA extract added (µL)} = \frac{\text{Target DNA Template Amount (pg)}}{(\text{sample concentration, pg/µL})(\text{dilution factor})}
\]

The volume of diluent to add (µL) = 5 µL – DNA extract added (µL)

For samples with RotorGene values ≤ 100 pg/µL aliquot 5 uL extract.

2. 
   a. For an Identifiler™ 28 cycle amplification, make a 0.5 (1/2) dilution of 
      the ABI Positive (A9947) control at 100 pg/µL (5 µL in 5 µL of 
      water).

      This yields 20 pg/µL of which 5 µL or 250 pg will be used.

   b. For an Identifiler™ 31 cycle amplification, make a 0.2 (1/5) dilution of 
      the ABI Positive (A9947) control at 100 pg/µL (4 µL in 16µL of 
      water).

      This yields 20 pg/µL of which 5 µL or 100 pg will be used.

3. 5 µL of irradiated water will serve as an amplification negative control.

4. Arrange samples in precisely the positions they appear on the sheet.

5. **Witness step.** Have another analyst witness the sample set-up.
Master Mix Preparation

1. Retrieve Identifiler™ primers and reaction mix from the refrigerator and Taq Gold from the freezer. Store in a Nalgene cooler, if desired. Record the lot numbers of the reagents.

2. Vortex or pipette the reagents up and down several times. Centrifuge reagents at full speed briefly. **Do not vortex TAQ GOLD.**

3. Consult the amplification documentation for the exact amount of Identifiler™ primers, reaction mix, and Taq Gold, to add. The amount of reagents for one amplification reaction is listed in Table 2.

<table>
<thead>
<tr>
<th>TABLE 2: Identifiler™ PCR amplification reagents for one sample</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reagent</strong></td>
</tr>
<tr>
<td>Primer mix</td>
</tr>
<tr>
<td>Reaction mix</td>
</tr>
<tr>
<td>AmpliTaq Gold DNA Polymerase (SU/µL)</td>
</tr>
<tr>
<td>Mastermix total:</td>
</tr>
<tr>
<td>DNA</td>
</tr>
</tbody>
</table>

Reagent and Sample Aliquot

1. Vortex master mix. After vortexing, briefly centrifuge or tap master mix tube on bench.

2. Add 8 µL of the Identifiler™ master mix to each tube that will be utilized, changing pipette tips and remixing master mix as needed.

3. Prior to immediately adding each sample or control, pipet each sample or control up and down several times to thoroughly mix. The final aqueous volume in the PCR reaction mix tubes will be 13µL. After addition of the DNA, cap each sample before proceeding to the next tube.

4. After all samples have been added, return DNA extracts to storage and take the rack to the amplified DNA area for Thermal Cycling (continue to section D).
An alternative method for amplification is to use a 96-well plate.

1. Positive Control
   a. If only half a plate of samples are amplified, only one PE is necessary, however, to encompass all of the injections required for a full plate of samples, amplify two or more PEs (10 µL in 10µL of water).

2. Sealing the Plate
   a. If using a PCR plate, place a super pierce strong seal on top of the plate, and place the plate in the plate adapter on the ABgene heat sealer.
   b. Push the heat sealer on top of the plate for 2 seconds.
   c. Rotate the plate and reseal for 2 additional seconds.
   d. Label the plate with “A” for amplification and the date and time. (A011104.1300)

C. Thermal Cycling – all amplification systems

1. Turn on the ABI 9700 Thermal Cycler.
2. Choose the following files in order to amplify each system:

<table>
<thead>
<tr>
<th>Identifier 28</th>
<th>Identifier 31</th>
</tr>
</thead>
<tbody>
<tr>
<td>user: hisens or casewk</td>
<td>user: hisens or casewk</td>
</tr>
<tr>
<td>file: id28</td>
<td>file: id31</td>
</tr>
</tbody>
</table>

3. The following tables list the conditions that should be included in each file. If the files are not correct, bring this to the attention of the Quality Assurance Team and a supervisor.

   Identifiler PCR Conditions for the Applied Biosystems GeneAmp PCR System 9700
9700 Instructions

1. Place the tubes in the tray in the heat block, slide the heated lid over the tubes, and fasten the lid by pulling the handle forward. Make sure you use a tray that has a 9700 label.

2. Start the run by performing the following steps:

3. The main menu options are RUN CREATE EDIT UTIL USER. To select an option, press the F key (F1…F5) directly under that menu option.

4. Verify that user is set to “casewk.” If it is not, select the USER option (F5) to display the “Select User Name” screen.

5. Use the circular arrow pad to highlight “casewk.” Select the ACCEPT option (F1).

6. Select the RUN option (F1).

7. Use the circular arrow pad to highlight the desired STR system. Select the START option (F1). The “Select Method Options” screen will appear.

8. Verify that the reaction volume is set to 13µL for Identifiler. The ramp speed is set to 9600.

9. If all is correct, select the START option (F1).
10. The run will start when the heated cover reaches 103°C. The screen will then display a flow chart of the run conditions. A flashing line indicates the step being performed, hold time is counted down. Cycle number is indicated at the top of the screen, counting up.

11. Upon completion of the amplification, remove samples and press the STOP button repeatedly until the “End of Run” screen is displayed. Select the EXIT option (F5). Wipe any condensation from the heat block with a Kimwipe and pull the lid closed to prevent dust from collecting on the heat block. Turn the instrument off. Place the microtube rack used to set-up the samples for PCR in the container of 10% bleach in the Post-Amp area.

After the amplification process, the samples are ready to be loaded on the fluorescent instruments. They may be stored in the appropriate refrigerator at 2-8°C for a period of up to 6 months.

**NOTE:**

Turn instruments off ONLY when the Main Menu is displayed, otherwise there will be a “Power Failure” message the next time the instrument is turned on. If this happens, it will prompt you to review the run history. Unless you have reason to believe that there was indeed a power failure, this is not necessary. Otherwise, press the STOP button repeatedly until the Main Menu appears.

In case of an actual power failure, the 9700 thermal cycler will automatically resume the run if the power outage did not last more than 18 hours. The history file contains the information at which stage of the cycling process the instrument stopped. Consult the Quality Assurance Team on how to proceed.
E. Amplification Troubleshooting

PROBLEM: No or only weak signal from both the positive control and the test samples

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mistake during the amplification set up such as not adding one of the components or not starting the thermal cycler</td>
<td>Prepare new samples and repeat amplification step</td>
</tr>
<tr>
<td>Thermal cycler defect or wrong program used</td>
<td>Check instrument, notify QA team, prepare new samples and repeat amplification step</td>
</tr>
</tbody>
</table>

PROBLEM: Positive control fails but sample signal level is fine

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mistake during the amplification set up such as not adding enough of the positive control DNA</td>
<td>Prepare new samples and repeat amplification step</td>
</tr>
<tr>
<td>Positive control lot degraded</td>
<td>Notify QA team to investigate lot number, prepare new samples and repeat amplification step with a new lot of positive control</td>
</tr>
</tbody>
</table>

PROBLEM: Presence of unexpected or additional peaks in the positive control

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contamination by other samples, contaminated reagents</td>
<td>Notify QA team to investigate the amplification reagents, prepare new samples and repeat amplification step</td>
</tr>
<tr>
<td>Non-specific priming</td>
<td>Notify QA team to check thermal cycler for correct annealing settings, prepare new samples and repeat amplification step</td>
</tr>
</tbody>
</table>
PROBLEM: Strong signal from the positive controls, but no or below threshold signal from DNA test sample

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
</table>
| The amount of DNA was insufficient or the DNA is severely degraded | Amplify a larger aliquot of the DNA extract  
Concentrate the extracted DNA using a Microcon device as described in the Microcon procedure.  
Re-extract the sample using a larger area of the stain or more biological fluid to ensure sufficient high molecular DNA is present |
| Test sample contains PCR inhibitor (e.g. heme compounds, certain dyes) | Amplify a smaller aliquot of the DNA extract to dilute potential Taq Gold polymerase inhibitors  
Purify the extracted DNA using a Microcon device as described in the Microcon procedure.  
Re-extract the sample using a smaller area of the stain to dilute potential Taq Gold polymerase inhibitors  
Re-extract the samples using the organic extraction procedure |

The decision on which of the above approaches is the most promising should be made after consultation with a supervisor.

Revision History:
March 24, 2010 – Initial version of procedure.
July 16, 2012 – Revised procedure to accommodate LIMS.
December 28, 2012 – YM100 microcons were discontinued by the manufacturer. The manufacturer is now producing the DNA Fast Flow Microcons. All references to the YM100’s have been removed and kept general.
A. Setting Up A 3130x/ Run

1. Go to the computer attached to the instrument.
2. If needed, press “CTRL-ALT-DEL” to login.
3. User should be “Administrator”, password should be left blank.
4. Click OK.
5. Open the 3130x/ Data Collection v3.0 software by double clicking on the desktop Icon or select Start > All Programs > AppliedBiosystems > Data Collection > Run 3130x/ Data Collection v3.0 to display the Service Console.

By default, all applications are off, indicated by the red circles. As each application activates, the red circles (off) change to yellow triangles (activating), eventually progressing to green squares (on) when they are fully functional.

Once all applications are running, the Foundation Data Collection window will be displayed at which time the Service Console window may be minimized.
6. Check the number of injections on the capillary in the 3130xl usage log and in the Foundation Data Collection window by clicking on the ga3130xl > instrument name > Instrument Status. If the numbers are not the same, update the usage log. If the number is ≥140, notify QA. Proceed only if the number of injections that will be running plus the usage number is ≤150.

7. Check the usage log to see when the POP4 was last changed. If it is >7 days, proceed with POP4 change (See Part K. of this section) and then return to Step 9. The POP4 does not need to be changed if it is the 7th day.

8. Check the level of POP4 in the bottle to ensure there is enough for the run (~450 µL for 6 injections). A full piston chamber is approximately 200ul. If not enough, proceed with POP4 change (See Part K. of this section) and then return to Step 9.
9. If it is the first run of the day on the instrument, proceed with steps 10-18. If a run has already been performed on the instrument that day and the “buffer changed” column displays that day’s date, skip to Part B of this section.

10. Close the instrument doors and press the tray button on the outside of the instrument to bring the autosampler to the forward position.

11. Wait until the autosampler has stopped moving and the light on the instrument turns green, and then open the instrument doors.

12. Remove the three plastic reservoirs in front of the sample tray and anode jar from the base of the lower pump block and dispose of the fluids.

13. Rinse, dry thoroughly, and then fill the “water” and “waste” reservoirs to the line with deionized water such as GIBCO®.

14. Make a batch of 1X buffer (45 ml Gibco® water, 5 ml 10X buffer) in a 50 mL conical tube. Record the lot number of the buffer, date of make, and your initials on the side of the tube. Rinse and fill the “buffer” reservoir and anode jar with 1X buffer to the lines.
15. Dry the outside and inside rim of the reservoirs/septa and outside of the anode jar using a Kimwipe and replace the septa strip snugly onto each reservoir.

16. Place the reservoirs in the instrument in their respective positions, as shown below:

   Water Reservoir (Waste)   Water Reservoir (Rinse)
   2                        4

   Cathode reservoir (1X running buffer)   Empty
   1                        3

17. Place the anode jar at the base of the lower pump block.

18. Close the instrument doors.

19. Record lot numbers for POP4 and buffer.
B. Creating a Test Batch

3130xI Test Batch Creation for HSC, Exemplar, and Property Crime Teams

Sample names and run names cannot be longer than 50 characters, and must be in correct 3130 format: -_.(}{]}] only.

Allelic Ladder(s) must be individually added to the test batch. If there are two or more injections of Identifiler samples, Allelic Ladder should be positioned as the first sample of that injection during the plate loading step.

Ensure that the correct System is in the “Sys” column

<table>
<thead>
<tr>
<th>Amplification System/Cycle</th>
<th>Specification</th>
<th>Run Module Code</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifiler 28</td>
<td>Normal</td>
<td>I</td>
<td>1 kV for 22 sec</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>IR</td>
<td>5 kV for 20 sec</td>
</tr>
</tbody>
</table>

Test batch plates should be named indicating the instrument, the year, and the consecutive run number for the multiplex. For example: “Mendel09-026ID”

If samples on the test batch are being rerun, confirm that dilution (if applicable), suffix, comments, or any other necessary information is present.

For rerun normal samples, fill up the end of the injection with any normal reruns before starting a new injection.

Rerun high samples should have a separate injection from samples run under normal conditions.

Using the LIMS drive, drag-and-drop the plate record from the LIMS Share folder to the instrument’s plate record folder.
3130xl Test Batches For High Sensitivity Team

The negative controls may be set up in a separate injection from the samples, and injected using “high” run parameters so that they only need to be run once.

For ID31, samples with less than 20 pg amped may be injected high immediately to reduce the number of reruns necessary.

For ID28, samples with less than 200 pg amped may be injected at rerun parameters immediately as well.

Name the test batch as follows: Instrument name & date Run folders for example: Athena042407_70-76. If the plate is being re-injected, the original plate name is recorded underneath the new name.

Allelic Ladders and Positive Controls will occupy the first, second, ninth and tenth wells of each injection. It is mandatory that there be a ladder and Positive Control included with each injection set for Identifiler.

1. In the “Sys.” column, confirm that the appropriate letter for the correct run or rerun module code is present:

<table>
<thead>
<tr>
<th>Amplification Cycle</th>
<th>Specification</th>
<th>Run Module Code</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifiler 31</td>
<td>Low</td>
<td>L</td>
<td>1 kV for 22 sec</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>N</td>
<td>3 kV for 20 sec</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>H</td>
<td>6 kV for 30 sec</td>
</tr>
<tr>
<td>Identifiler 28</td>
<td>Normal</td>
<td>I</td>
<td>1 kV for 22 sec</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>IR</td>
<td>5 kV for 20 sec</td>
</tr>
</tbody>
</table>

2. Proofread documentation, make corrections and re-save as necessary.

**IMPORTANT:** Remember that all names must consist of letters, numbers, and only the following characters: - _ . ( ){ }[ ] + ^ (no spaces).
C. Foundation Data Collection (Importing Plate Record)

1. Maximize the Foundation Data Collection window.

2. Click + to expand subfolders in the left tree pane of “ga 3130xl”.

3. Click on “Plate Manager”.

4. In the Plate Manager window click on “Import…”

5. Browse for the plate record in D:\AppliedBiosystems\Plate Records. Double click on the file or highlight it and click Open.

6. A window will prompt the user that the plate record was successfully imported. Click OK.
D. Preparing and Running the DNA Samples

1. Retrieve amplified samples from the thermal cycler or refrigerator. If needed, retrieve a passing positive control from a previous passing run.

2. If condensation is seen in the caps of the tubes, centrifuge tubes briefly.

Mastermix and Sample Addition for Identifiler 28 for HSC, Exemplar, and Property Crime Teams:

1. Mastermix preparation:
   a. Prepare one mastermix for all samples, negative and positive controls, and allelic ladders as specified in Table 7.
      (26.625 µL of HIDI + 0.375 µL of LIZ per sample)
b. Obtain a reaction plate and label the side with a sharpie. Place the plate in an amplification tray or the plate base.

c. Aliquot 27 µL of mastermix to each well.

d. If an injection has less than 16 samples, add at least 12 µL of either dH2O, formamide, HiDi, buffer or mastermix to all unused wells within that injection.

Adding Samples:

a. Arrange amplified samples in a 96-well rack according to how they will be loaded into the 96-well reaction plate. Sample order is as follows: A1, B1, C1... A2, B2, C2...etc. Thus the plate is loaded in a columnar manner where the first injection corresponds to wells A1-H2, the second A3-H4 and so on.

b. Witness step. Have another analyst witness the sample set-up.
c. For sample sets being run at normal parameters: Aliquot 1 µL of allelic ladder.

d. For sample sets being run at normal parameters: Aliquot 3 µL of the positive control.

e. Aliquot 3 µL of each sample and negative control.

f. When adding PCR product, make sure to pipette the solution directly into the mastermix and gently flush the pipette tip up and down a few times to mix it.

g. Skip to Part E (Denature/Chill) of this section.

Mastermix and Sample Addition for Identifiler 28 for High Sensitivity Team:

1. Arrange amplified samples in a 96-well rack according to how they will be loaded into the 96-well reaction plate. Sample order is as follows: A1, B1, C1... A2, B2, C2...etc. Thus the plate is loaded in a columnar manner where the first injection corresponds to wells A1-H2, the second A3-H4 and so on.

2. Witness step. Have another analyst witness the sample set-up.

3. Obtain a reaction plate and label the side with a sharpie. Place the plate in an amplification tray or the plate base.

NOTE: HiDi Formamide cannot be re-frozen.

Mastermix for 28 Cycles:

a. Prepare one mastermix for all samples, negative and positive controls, allelic ladders as specified in Table 8

i. Add 26.625 µL of HIDI per sample

ii. Add 0.375 µL of LIZ per sample

iii. Aliquot 27 µL of mastermix to each well
b. If an injection has less than 16 samples, add 12ul of either dH₂O, buffer or formamide/LIZ mix to all unused wells within that injection.

Add samples to the plate, adhering to the following guidelines:

**NOTE:** Multichannel pipettes may be used to load samples. If pipetting from a 96 well PCR plate, pierce the seal.

5. **Adding Samples for 28 Cycles:**

   a. Aliquot 3 µL of each sample and negative control and the positive control.

   b. Aliquot 0.5 µL of positive control or 1 µL of 1/2 dilution (4 µL positive control in 4µL of water) into the wells labeled “PEH”. This is the positive for the “high” injection parameters.

   c. Aliquot 0.7 µL of allelic ladder. If a full plate will be used, mix 6 µL of ladder with 2.4 µL of water and aliquot 1 µL per ladder well.

   d. Alternatively, 1 µL and 0.5 µL of allelic ladder can be used for the normal and the rerun parameters for each injection to account for differences in lots of allelic ladder.

      i. For a full plate, add 3.5 µL of ladder to 3.5 µL of water, mix, and aliquot 1 µL of this dilution.

      ii. For a half plate, add 2 µL of ladder to 2 µL of water, mix and aliquot 1 µL of this dilution.

      iii. A P2 pipet must be used to make 0.7 and 0.5 µL aliquots to avoid making dilutions and to conserve ladder.

   e. Skip to Part E (Denature/Chill) of this section.
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
4. Obtain a reaction plate and label the side with a sharpie. Place the plate in an amplification tray or the plate base.

NOTE: HiDi Formamide must not be re-frozen.

6. Mastermix for 31 CYCLES:
   a. Prepare the following mastermix for samples, and negative controls as specified in Table 8
      i. 44.6 µL of HIDI per sample
      ii. 0.375 µL of LIZ per sample
      iii. Aliquot 45 µL of mastermix to each sample and negative control well
   b. Prepare a separate mastermix for allelic ladders and positive controls
      i. Add 14.6 µL of HIDA to each AL and PE
      ii. Add 0.375 µL of LIZ per AL and PE
      iii. Aliquot 15 µL of mastermix to each Allelic Ladder and Positive Control well

7. If an injection has less than 16 samples, add 12ul of either dH2O, buffer or formamide/LIZ mix to all unused wells within that injection.

8. Add samples to the plate, adhering to the following guidelines:

   NOTE: Multi channel pipettes may be used to load samples. If pipetting from a 96 well PCR plate, pierce the seal.
9. **Adding Samples for Identifiler 31:**
   
a. Aliquot 5 µL of each sample (including pooled) and negative control.

b. Aliquot 1 µL of a 1/10 dilution of positive control into each well labeled “PE”. (Make the 1/10 dilution by mixing 2 uL of Positive Control with 18 uL water). This is the positive for the “normal” injection parameters.

c. Aliquot 1 µL of a 1/20 dilution of positive control into each well labeled “PEH”. (Make the 1/20 dilution by mixing 2 uL of Positive Control with 38 uL water). This is the positive control for the “high” injection parameters.

d. Aliquot 0.5 uL of allelic ladder into each well labeled “AL”. Alternatively, make a 1/2 dilution of ladder and aliquot 1 uL per “AL” well. Make this dilution by mixing 2 uL ladder with 2 uL of water for 1-2 injections, 3 uL ladder with 3 uL of water for 3-4 injections or 4 uL ladder with 4 uL water for 5-6 injections. This is the allelic ladder for the “normal” injection parameters.

e. Aliquot 0.3 uL of allelic ladder into each well labeled “ALH”. Alternatively, make a 3/10 dilution of ladder and aliquot 1 uL per “ALH” well. Make this dilution by mixing 1 uL of ladder with 2.3 uL of water for 1-2 injections, 2 uL of ladder and 4.6 uL of water for 3-4 injections, or 3 uL of ladder with 6.9 uL water for 5-6 injections. This is the allelic ladder for “high” injection parameters.

<table>
<thead>
<tr>
<th>Injection Parameters</th>
<th>Samples and negs</th>
<th>LIZ for samples and negs</th>
<th>HIDl for samples and negs</th>
<th>Allelic Ladder</th>
<th>Positive Control</th>
<th>LIZ for ALs and PEs</th>
<th>HIDI for ALs and PEs</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>5 µL</td>
<td>0.375 µL</td>
<td>44.6 µL</td>
<td>0.5 µL</td>
<td>1 µL of 1/10 dil</td>
<td>0.375 µL</td>
<td>14.6 µL</td>
</tr>
<tr>
<td>N</td>
<td>5 µL</td>
<td>0.375 µL</td>
<td>44.6 µL</td>
<td>0.5 µL</td>
<td>1 µL of 1/10 dil</td>
<td>0.375 µL</td>
<td>14.6 µL</td>
</tr>
<tr>
<td>H</td>
<td>5 µL</td>
<td>0.375 µL</td>
<td>44.6 µL</td>
<td>0.3 µL</td>
<td>1 µL of 1/20 dil</td>
<td>0.375 µL</td>
<td>14.6 µL</td>
</tr>
</tbody>
</table>

10. Proceed to Part E (Denature/Chill) in this section.
E. Denature/Chill - For All Systems After Sample Addition

1. Once all of the samples have been added to the plate, place a new 96-well septa over the reaction plate and firmly press the septa into place.

2. Spin plate in centrifuge at 1000 RPM for one minute.

3. For Denature/Chill:
   a. 9700 Thermal Cycler
      i. Place the plate on a 9700 thermal cycler (Make sure to keep the thermal cycler lid off of the sample tray).
      ii. Select the “denature/chill” program.
      iii. Make sure the volume is set to 30 µL for Identifiler 28, and 50 µL for Identifiler 31. If more than one system is loaded on the same plate, use the higher value.
      iv. Press Run on the thermal cycler. The program will denature samples at 95°C for 5 minutes followed by a chill at 4°C (the plate should be left to chill for at least 5 min).
      v. While the denature/chill is occurring, the oven may be turned on.
   b. Heat Block
      i. Place the plate on a 95°C heat block for 5 minutes.
      ii. Place the plate on a 4°C heat block for 5 minutes.

F. Turning the Oven on and Setting the Temperature

1. In the tree pane of the Data Collection v3.0 software click on GA Instrument > ga3130xl > instrument name > Manual Control

2. Under Manual Control “Send Defined Command For:” click on Oven.

3. Under “Command Name” click on “Turn On/Off oven”.

4. Click on the “Send Command” button.
5. Under “Command Name” click on “Set oven temperature” and Under “Value” set it to 60.

6. Click on the “Send Command” button.

7. Once denatured, spin the plate in centrifuge at 1000 RPM for one minute before placing the reaction plate into the plate base. Secure the plate base and reaction plate with the plate retainer.
G. Placing the Plate onto the Autosampler (Linking and Unlinking Plate)

1. In the tree pane of the Foundation Data Collection v3.0 software click on GA Instrument > ga3130xl > instrument name > Run Scheduler > Plate View

2. Push the tray button on the bottom left of the machine and wait for the autosampler to move forward and stop at the forward position.

3. Open the doors and place the tray onto the autosampler in the correct tray position, A or B. There is only one orientation for the plate. (The notched end faces away from the user.)

4. Ensure the plate assembly fits flat in the autosampler.

When the plate is correctly positioned, the plate position indicator on the Plate View window changes from gray to yellow. Close the instrument doors and allow the autosampler to move back to the home position.
Linking/Unlinking the Plate Record to Plate

5. Type the exact plate name in the Plate ID window and click “Search.” Or, click the “Find All” button and select the desired plate record.

   NOTE: If the plate name is not typed in correctly, your plate will not be found. Instead, a prompt to create a new plate will appear. Click “No” and retype the plate name correctly.

   Click the plate position indicator corresponding to the plate position in the instrument. The plate position (A or B) displays in the link column.

   If two plates are being run, the order in which they are run is based on the order in which the plates were linked.

6. The plate position indicator changes from yellow to green when linked correctly and the green run button becomes active.
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.

7. To unlink a plate record just click the plate record to be unlinked and click “Unlink”.

H. Viewing the Run Schedule

1. In the tree pane of the Foundation Data Collection software, click GA Instruments > ga3130xl > instrument name > Run Scheduler > Run View.

2. The RunID column indicates the folder number(s) associated with each injection (e.g. Run_Einstein_2011-03-10-0018 or Run_Venus_2006-07-13_0018-0019). Note: This RunID may not be indicative of the Run Collection folder depending on results group used.

3. Click on the run file to see the Plate Map or grid diagram of the plate on the right. Check if the blue highlighted boxes correspond to the correct placement of the samples in the injections.

NOTE: Before starting a run, check for air bubbles in the polymer blocks. If present, click on the Wizards tool box on the top and select “Bubble Remove Wizard”. Follow the wizard until all bubbles are removed.
4. Click on green Run button in the tool bar when you are ready to start the run. When the Processing Plate dialog box opens (You are about to start processing plates...), click OK.

5. To check the progress of a run, click on the Capillary Viewer or Cap/ArrayViewer in the tree pane of the Foundation Data Collection software. The Capillary Viewer will show you the raw data of the capillaries you select to view whereas the Cap/Array Viewer will show the raw data of all 16 capillaries at once.

IMPORTANT: Always exit from the Capillary Viewer and Cap/Array Viewer windows. During a run, do not leave these pages open for extended periods. Leave the Instrument Status window open.
The visible settings should be:

- EP voltage 15kV
- EP current (no set value)
- Laser Power Prerun 15 mW
- Laser Power During run 15mW
- Laser Current (no set value)
- Oven temperature 60°C

Expected values are:

- EP current constant around 120 to 160μA
- Laser current: 5.0A ± 1.0

It is good practice to monitor the initial injections in order to detect problems.

Table 11

<table>
<thead>
<tr>
<th></th>
<th>I/L</th>
<th>IR</th>
<th>N</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oven Temp</td>
<td>60°C</td>
<td>60°C</td>
<td>60°C</td>
<td>60°C</td>
</tr>
<tr>
<td>Pre-Run Voltage</td>
<td>15.0 kV</td>
<td>15.0 kV</td>
<td>15.0 kV</td>
<td>15.0 kV</td>
</tr>
<tr>
<td>Pre-Run Time</td>
<td>180 sec</td>
<td>180 sec</td>
<td>180 sec</td>
<td>180 sec</td>
</tr>
<tr>
<td>Injection Voltage</td>
<td>1 kV</td>
<td>5 kV</td>
<td>3 kV</td>
<td>6 kV</td>
</tr>
<tr>
<td>Injection Time</td>
<td>22 sec</td>
<td>20 sec</td>
<td>20 sec</td>
<td>30 sec</td>
</tr>
<tr>
<td>Run Voltage</td>
<td>15 kV</td>
<td>15 kV</td>
<td>15 kV</td>
<td>15 kV</td>
</tr>
<tr>
<td>Run Time</td>
<td>1500 sec</td>
<td>1500 sec</td>
<td>1500 sec</td>
<td>1500 sec</td>
</tr>
</tbody>
</table>
Table 12

<table>
<thead>
<tr>
<th></th>
<th>M</th>
<th>MR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oven Temp</td>
<td>60°C</td>
<td>60°C</td>
</tr>
<tr>
<td>Pre-Run Voltage</td>
<td>15.0 kV</td>
<td>15.0 kV</td>
</tr>
<tr>
<td>Pre-Run Time</td>
<td>180 sec</td>
<td>180 sec</td>
</tr>
<tr>
<td>Injection Voltage</td>
<td>3 kV</td>
<td>3 kV</td>
</tr>
<tr>
<td>Injection Time</td>
<td>10 sec</td>
<td>20 sec</td>
</tr>
<tr>
<td>Run Voltage</td>
<td>15 kV</td>
<td>15 kV</td>
</tr>
<tr>
<td>Run Time</td>
<td>1500 sec</td>
<td>1500 sec</td>
</tr>
</tbody>
</table>

I. Converting Run for GeneScan Analysis

When a run is complete, it will automatically be placed in D:/AppliedBio/Current Runs folder, labeled with either the plate name-date (e.g. Einstein11-025ID-015PPY-2011-03-11) or instrument name, date and runID (e.g. Run_Venus_2006-07-13_0018). Proceed to Section 9 for instructions on how to convert this data for GeneScan analysis.

J. Re-injecting Plates

1. Plates should be re-injected as soon as possible, preferably the same day.

2. If a plate is being re-injected the same day on which it was originally run, it does not require an additional denature/chill step before being rerun.

3. Create a new test batch and plate record using the original documentation as a guide. Select only those samples that need to be rerun by re-assigning “Sys”. For example, assign “IR” for an ID28 sample that needs to be re-run high.

NOTE: See Section 7 for information on which controls need to be run.
5. Follow the instructions for creating a test batch. Re-import the plate record.

6. Re-denature/chill the plate (if needed) as described in Part E.

K. Water Wash and POP Change

Refer to Section A for schematic of 3130xl while proceeding with the water wash and POP change procedure.

1. Remove a new bottle of POP4 from the refrigerator.

2. Select Wizards > Water Wash Wizard and follow the wizard.

3. When the “Fill Array” step has completed, remove the anode buffer jar, empty, and fill with 1x TBE Buffer (~15 mL).
4. Close instrument doors and wait for the steady green light.

5. Click “Finish.”

L. Cleanup Database Utility (QA Team)

1. Open the *Foundation Data Collection Window* of the 3130 software.
2. In the left hand panel, click on “GA Instruments”.
3. Click on “Database Manager”.
4. Click the “Cleanup Processed Plate” button.
5. This will erase the database and reset the run number to 0. Therefore, the next plate run after this process will be labeled run number 1. Verify this information for the usage log.
## TROUBLESHOOTING GUIDE

This section is provided as a guide. The decision on which of the recommended actions is the most promising should be made after consultation with a supervisor.

### PROBLEM: Many artifacts in sample.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary structure present. Sample not denatured properly.</td>
<td>1. Clean pump block and change polymer to refresh the urea environment.</td>
</tr>
<tr>
<td></td>
<td>2. Denature/chill samples.</td>
</tr>
</tbody>
</table>

### PROBLEM: Decreasing peak heights in all samples.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Poor quality formamide or sample environment very ionic.</td>
<td>Re aliquot samples with fresh HIDI.</td>
</tr>
</tbody>
</table>

### PROBLEM: Individual injections run at varying speeds. For example, the scan number where the 100 bp size standard appears differs significantly from one injection to another, usually appearing earlier.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warm laboratory temperatures.</td>
<td>1. Redefine size standard.</td>
</tr>
<tr>
<td></td>
<td>2. If this fails, reinject.</td>
</tr>
</tbody>
</table>
**PROBLEM:** Loss of resolution of peaks.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss of resolution of peaks.</td>
<td>1. Clean pump block and change polymer to refresh the urea environment.</td>
</tr>
<tr>
<td></td>
<td>2. Denature chill samples.</td>
</tr>
</tbody>
</table>

**PROBLEM:** An off ladder peak appears to be a pull up, but it is not exactly the same basepair as the true peak.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Matrix over-subtraction. Usually in the green channel, the true peak is overblown and is split.</td>
<td>Remove off ladder peaks as matrix over-subtraction.</td>
</tr>
<tr>
<td>2. Pull up peaks appear in the blue and the red channels.</td>
<td></td>
</tr>
<tr>
<td>3. In the yellow channel, there is a negative peak at the basepairs of the true peak. However immediately to the right and to the left are off ladder peaks.</td>
<td></td>
</tr>
</tbody>
</table>

**PROBLEM:** Peaks overblown and running as off ladder alleles.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>More than the optimum amount of sample amplified.</td>
<td>1. Rerun samples at lower injection parameters.</td>
</tr>
<tr>
<td></td>
<td>2. Or rerun samples with less DNA.</td>
</tr>
</tbody>
</table>
**PROBLEM:** Pull up peaks.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colors bleeding into other colors.</td>
<td>Run a spectral.</td>
</tr>
</tbody>
</table>

**PROBLEM:** Spikes in the electropherogram.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crystals in the polymer solution due to the polymer warming and congealing from fluctuations in the room temperature.</td>
<td>Change the polymer.</td>
</tr>
</tbody>
</table>

**PROBLEM:** Spikes in electropherogram and artifacts.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arcing: water around the buffer chambers.</td>
<td>Clean chambers; beware of drops accumulating around the septa.</td>
</tr>
</tbody>
</table>

**PROBLEM:** Split peaks.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lower pump block is in the process of burning out due to the formation of a bubble.</td>
<td>Clean the block.</td>
</tr>
</tbody>
</table>

**PROBLEM:** Increasing number of spurious alleles.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
</table>
| Extraneous DNA in reagents, consumables, or instrument.                       | 1. Stop laboratory work under advisement of technical leader.  
2. Implement a major laboratory clean-up.                                      |
GENERAL PROBLEMS

<table>
<thead>
<tr>
<th>Problems</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2. Restart collection software.</td>
</tr>
<tr>
<td>2. 3130xl not cooperating.</td>
<td>3. Restart Computer and Instrument.</td>
</tr>
</tbody>
</table>

Revision History:
March 24, 2010 – Initial version of procedure.
March 29, 2011 – Revised Step H.2 and I due to a change in the Results Group.
July 16, 2012 – Revised procedure to accommodate LIMS.
A. Converting Run for GeneScan Analysis

Prior to importing *.fsa files into GeneScan, the files must have been converted using the HIDDyeBUtility conversion tool.

1. Make sure the run (injection) has completed.
2. On the desktop, click on the shortcut for the RJW conversion program.
3. On the top of the RJW conversion program window, click on the “Choose Starting Directory” button.
4. Browse the Current Runs Folder (located in the D drive, Applied Biosystems folder) for your run folder(s) (e.g., Run_Venus_2006-07-13_0018).
5. Double click on your run folder(s) then hit **Open**. The run folder(s) are now converted and are now ready to be analyzed in **GeneScan**.

**B. Archiving Converted Data and Sample Sheets**

**For the HSC, Exemplar, and Property Crime Teams:**

1. When a run is finished, locate the run folders on the 3130xl instrumental computer. These folders are in the **Current Runs** folder (on the desktop) and have previously been converted.

2. Insert a flash drive into the USB port of the instrumental computer.

3. Copy the run folder(s) onto the flash drive. Eject the flash drive from the instrumental computer and take it over to the network computer.

4. The STR data folders (located in M:\STR\Data\CASEWORK) are organized on the network by instrument name, year, and amplification system. Within these folders they are organized by amplification set (see Example #2 below).

   On the network computer, create a new folder for each run and put it in the appropriate location. Name this folder(s) with the file name according to your sample sheet (e.g. Stripes09-005ID, saved in M:\STR\Data\CASEWORK\Stripes\2009\Identifiler).

   **Example #1:** An Identifiler and a YM1 amplification set were run on Stripes with the following sample sheet name: Stripes09-005ID-003Y. Two run folders will be created with the following names: Stripes09-005ID and Stripes09-003Y

   **Example #2:** Two Identifiler amplification sets were run on Stripes with the following sample sheet name: Stripes09-005ID-003Y. Two folders will be created inside this folder, with the folder names corresponding to each amplification set as follows: Stripes09-005IDA and Stripes09-005IDB.

5. Copy the run folders from the flash drive into their corresponding amplification set folders on the network. Once saved to the network, delete the files from the flash drive.
6. Proceed with GeneScan and Genotyper analysis.

For the High Sensitivity Team:

1. When an injection is complete, the data will automatically be placed in the D:/AppliedBio/Current Runs folder, properly labeled with the instrument name, date and runID (e.g. Run_Venus_2006-07-13_0018).

2. After conversion of the data in each run folder, copy the relevant run folders as well as the sample sheets to a flash drive.

3. Transfer the run files from the flash drive to the appropriate data drive on the network.
   a. The run folders should be stored on the network in the run folder of the instrument on which they were run.
   b. The sample sheets should be stored on the network in the sample sheets folder of the instrument on which they were run.

4. After confirming that the files are on the network, delete the files from the flash drive.

5. Proceed with GeneScan and Genotyper analysis.

C. Backup of Data

All of the 3130xl data, once loaded on the network drive, will be backed up in a process by DoITT, and stored in archives on and off site of the OCME building.

Revision History:
March 24, 2010 – Initial version of procedure.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
A. Access to GeneScan

1. Click on the GeneScan shortcut located on the desktop of the analysis station computer.

2. Create a new GeneScan project by clicking File→New. A dialog box with several icons will pop up. Click on the project icon.

An untitled Analysis Control window opens.
3. To add sample files to the open analysis control window, click on Project from the menu options and select Add Sample Files.

4. When the Add Sample Files dialog window appears, go to M: \ STR Data \ Casework and select the corresponding instrument’s folder. Find the run folders with the samples that you want to add to the project. Once you click on the specific run folder, you will see icons representing each individual sample, all belonging to one injection.

To add samples to a project, take the following action:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a single sample file</td>
<td>Double-click the file OR select the file and click Add</td>
</tr>
<tr>
<td>Select all the sample files</td>
<td>Click Add All</td>
</tr>
<tr>
<td>Add a continuous list of sample files</td>
<td>a. Click the first sample that you want to add. b. Press the Shift key and click the last sample you want to add. Click Add.</td>
</tr>
<tr>
<td>Add a discontinuous list of samples</td>
<td>a. Click the first sample that you want to add b. Press the Control key and then click on the other sample(s) you want to add. Click Add.</td>
</tr>
</tbody>
</table>

5. Click Finish when you have added all of the samples.
B. Analysis Settings

The analysis should then be performed using the following predefined files:

<table>
<thead>
<tr>
<th>System</th>
<th>Size Standard File</th>
<th>Analysis Parameter File</th>
</tr>
</thead>
<tbody>
<tr>
<td>YM1</td>
<td>Ystr.szs</td>
<td>YM1.gsp</td>
</tr>
<tr>
<td>Identifiler</td>
<td>LIZ-250-340.szs</td>
<td>LIZAnalysisParameters.gsp</td>
</tr>
</tbody>
</table>

1. Identifiler Analysis Parameters

Do not change any of the settings except the range or the peak amplitude threshold for Orange (O), which may be lowered to 25 rfu.
2. YM1 Analysis Parameters

Do not change any of the settings except the range or the peak amplitude threshold for Orange (O), which may be lowered to 25 rfu.

![YM1 Analysis Parameters Diagram]

Once the correct parameters have been chosen, the samples can be analyzed by clicking the Analyze button.

When the samples are analyzed, the boxes will change from colored to dark grey in the Analysis Control window. If a sample does not analyze, see Section D: Analysis Troubleshooting.
C. Analysis

To ensure that all the sizing results are correct, check the labeling of the size standard peaks for each sample.

1. To view the analysis results, select Windows from the main menu and click on Results Control.

2. The raw data can be seen in up to 8 display panels, by changing the # of panels to 8. To view each color separately, check Quick Tile to On.

3. Select the first 8 size standard dye lanes by clicking on them and then click Display. Each sample standard will be displayed in its own window. To view all 8 standards, you must scroll through all of the windows. Make sure that all peaks are correctly labeled. Continue checking your size standard for the entire tray by going back to the Results Control window, clicking on Clear All and selecting the next 8 samples.

IMPORTANT: For ABI 3130 runs, the 250bp fragment in the Identifiler LIZ Orange Size Standard may not be labeled as 250. In Identifiler, the 340bp fragment is also not labeled.

Identifiler LIZ Orange Size Standard

YM1 STRs LIZ GS500
Before proceeding with the Genotyper analysis, under File select Save Project As. The project will be named according to the Sample Sheet name. This file will save as a *.prj file in the run folder.

D. Analysis Troubleshooting

The error message for a failed analysis is: “Analysis failed on Dye B, G, Y, R. Repeat the above choosing another scan range.”

If the sample fails to be analyzed, examine the Raw Data. Click to highlight the sample under the Sample File column in the Analysis Control window and go the Sample tool bar and choose Raw Data. Alternatively, click and highlight a sample and hit Ctrl+R or double click on a sample and click on the raw data symbol on the bottom left hand side of the Raw Data window that pops up. If there is no evidence of size standard peaks, the sample fails. Note on the editing sheet that the sample needs to be rerun. If peaks are present take the following steps.

Raw Data Window:
1. Check the height of the size standard
   a. Examine the **Raw Data** to check the peak height of the size standard fragments. The peak height is indicated by the datapoint value of the **Y**, located on the bottom of the Raw Data window, when the cursor is placed on top of the peak. See instructions and diagram above.
   b. In the **Analysis Control** window under the **Parameter** column click and highlight the parameter of the sample that needs to be adjusted and click the small arrow △ on the right side of the cell and select the predefined parameter “**LIZAnalysisParameterOrange25**”.
   c. Reanalyze samples. There should be a ◆ on the size standard column.

2. Change the analysis parameters
   a. It is also possible, that the run was either to fast or to slow. The analysis range may need to be changed. Examine the **Raw Data** to see the scan range. See instructions and diagram above.
   b. Observe where the first size standard is located in the sample by moving the cursor to the peak. Take note of the datapoint value of the **X** located on the bottom of the **Raw Data** window.
   c. From the **Analysis Control** window, go to the **Parameter** column, click and highlight the parameter that needs to be adjusted and click on the small arrow △ on the right side of the cell and select **Define New**.
   d. From here an **untitled** analysis parameter window will appear. Make sure all the default settings are correct as indicated above. Under **Analysis Range** adjust the **start** value to approximately 25 bp less than the datapoint value of the **X** as indicated in step 2b. (eg. X:2400 adjust Start: 2375)
   e. Exit out of the window by hitting X and click **Save**. Save the file in the folder C:\**AppliedBio\Shared\Analysis\Sizecaller\Params** that can only be accessed through the desktop shortcut **AppliedBio** folder.
f. Reanalyze samples. There should be a ♦ on the size standard column.

g. After reanalyzing the samples go back to the Parameter folder and drag the parameter you created to the Archive Parameter Folder. The default predefined analysis parameters indicated above should be the only choice in the drop down menu.

**NOTE:** For Identifiler, if the last two orange size standards, 490 and 500, are not visible, change the size call range to “this range” and adjust the maximum to 450. At least the 100 bp to 450 bp size standards must be apparent.

3. If the baseline of the size standard is noisy, raise the RFU threshold of the red or orange to above the noise level.

a. Alternatively, redefine the size standard. In the Analysis Control window under the Size Standard column click and highlight the size standard of the sample. Click on the small arrow ▲ on the right side of the cell and select Define New. The size standard peaks will appear and at the appropriate peak, type the label in the column (see above for correct values).

**NOTE:** For Identifiler LIZ runs do not define the 250 bp and the 340bp size standards.

b. When you are done defining the new size standard, exit out of the window by hitting X and click Save. Save the size standard file in the folder C:\AppliedBio\Shared\Analysis\Sizecaller\SizeStandards that can only be accessed through the desktop shortcut AppliedBio folder. Name the size standard whatever you wish. Select this size standard for the analysis of all the failed samples.

c. Reanalyze samples. There should be a ♦ on the size standard column.
d. After reanalyzing the samples go back to the SizeStandard folder and drag the size standard you created to the Archive SizeStandards Folder. The default predefined size standards indicated above should be the only choice in the drop down menu.

ATTENTION: all reanalysis results and parameter changes are automatically written to the individual sample files, even if the changes to the project are not saved. Do not reanalyze casework data without a reason.
For 3130x/ instruments, multiple sets of amplifications can be run in one tray. If the amplifications were done in different multiplex systems, it is necessary to perform the Genotyper analysis separately using the appropriate template. For two amplifications in the same system it is optional to process them together or separately.

I. YM1

A. Importing Data and Allele Call Assignment

1. Open the Genotyper macro for the desired amplification system by clicking on the appropriate Genotyper shortcut on the desktop of the analysis station computer.

2. Under File ➔ Import and select From GeneScan File. If the Current Runs folder does not already appear in the window, scroll to find it from the pull-down menu and double-click on it. Double-click on the folder containing the project that was created in GeneScan.

3. Click Add or double-click on the project icon to add the project for analysis. When the project has been added, click Finish.

4. Under View ➔ Show Dye/Lanes window a list of the samples imported from GeneScan analysis can be seen. If samples need to be removed, highlight the lanes for these samples and select Cut from the Edit menu.

5. Under File ➔ Save As, save the Genotyper template to the user’s initials and the casework run file name. (Under File select Save As). For example: “Stars09-001Y JLS” for YM1 runs saved by “JLS.”

6. After importing the project and saving the Genotyper file, run the first Macro by pressing Ctrl+1 or double clicking "kazam".

7. The plot window will appear automatically when the macro is completed. Check the results for the positive control. The plots will also display the orange size standard.
Table 1

<table>
<thead>
<tr>
<th>Multiplex System</th>
<th>Necessary LIZ GS500 standard peaks</th>
</tr>
</thead>
<tbody>
<tr>
<td>YM1</td>
<td>9 fragments from 139-400 bp</td>
</tr>
</tbody>
</table>

Table 2 YM1 Positive Control

<table>
<thead>
<tr>
<th></th>
<th>DYS19</th>
<th>DYS389 I</th>
<th>DYS389 II</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yellow label</td>
<td>14</td>
<td>13</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>DYS390</td>
</tr>
<tr>
<td>Blue label</td>
<td>24</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

8. Fill out an STR 3130xl Control Review Worksheet indicating the status of all controls.

9. Under Analysis → Change labels, select size in bp, peak height and category name. Click Ok.
10. Check all lanes. Labels for extra peaks can be manually deleted by placing the cursor on the peak above the baseline and clicking.

**Shortcut:** If a label was mistakenly deleted, press **Ctrl+Z** and the allele name label will reappear. **Ctrl+Z** will only undo the last action.

11. To zoom into a desired region of an electropherogram, hold the left mouse click down and draw a box around the desired region.

12. Under **View → Zoom → Zoom In (selected area)**

**Shortcut:** Zoom in by holding down the left mouse click button and dragging the cursor across the area to zoom in on. Then, press **Ctrl+R** or Ctrl+ + to zoom in on that region.

13. To revert to the correct scan range, go to **View → Zoom → Zoom To**. Set the plot range to range listed in Table 3. Click **OK**.

**Table 3**

<table>
<thead>
<tr>
<th>System</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>YM1</td>
<td>120 - 410</td>
</tr>
</tbody>
</table>

Compare the orange electropherograms with the other color lanes by:

a. holding down the shift key and clicking on the orange “O” box in the upper left hand corner

b. under **edit** go to **select** +orange

14. Fill out the Genotyper Editing Sheet for each Electrophoresis run indicating the following:

a. no editing required

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
b. sample(s) requiring manual removal of non allelic peaks. Refer to STR Results Interpretation Section.

c. sample(s) requiring rerun and/or re-injection. Refer to STR Results Interpretation Section

Each sample listed on the Genotyper Editing Sheet must be indicated by sample number. The reason for the edit must be indicated using a number code and/or symbol.

15. After the editing has been finished, scroll through the plot window to double-check.

B. Genotyper Table

1. Press Ctrl+2 to create table

2. Compare the sample information in the table with the amplification and the 3130xl run control sheet. If an error is detected at this point it can be corrected as follows:

   a. Open the dye/lane window or “sample info box”

   b. Place the cursor in the sample info box and correct the text

   c. Under Main Menu → Analysis, select Clear Table to clear table

   d. Select the appropriate colors by shift clicking on the dye buttons or using edit.

   e. Run Create Table Macro again

   f. Continue to Step 4 and print according to the directions.
C. Viewing and Printing Electropherograms

1. Controls
   a. Under View Dye Lane Window and select blue and yellow for all lanes containing controls including microcon controls
   b. To select multiple labels, press Ctrl while clicking on the lanes
   c. Go to View and open the Plot Window
   d. Under Analysis Change Labels and select size in bp and category name. Click ok. Save.
   e. Continue to Step 4 and print the controls according to the directions.

2. Evidence Samples
   a. Under View Dye Lane Window and select blue and yellow for all lanes containing casework samples
   b. To select multiple labels, press Ctrl while clicking on the lanes
   c. Go to View and open the Plot Window
   d. Under Analysis Change Labels and select size in bp, peak height and category name. Click ok. Save.
   e. Continue to Step 4 and print according to the directions.

3. Exemplar Samples
   a. Under View Dye Lane Window and select blue and yellow for all lanes containing casework samples
b. To select multiple labels, press Ctrl while clicking on the lanes

c. Go to View and open the Plot Window

d. Under Analysis→Change Labels and select size in bp and category name. Click ok. Save.

f. Continue to Step 4 and print according to the directions.

2. Printing Electropherograms

a. Make sure the file is named properly, including initials.

b. Set Plot window zoom range as shown in Table 4. The active window will be printed so open Table or Plot as needed.

c. Under File→Print→Properties button→Finishing tab→Document, set the parameters below.

<table>
<thead>
<tr>
<th>Table</th>
<th>Plot</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orientation</td>
<td>Portrait</td>
</tr>
<tr>
<td>Scale</td>
<td>100% 2 per page</td>
</tr>
<tr>
<td>Zoom range</td>
<td>n/a</td>
</tr>
</tbody>
</table>

NOTE: The Genotyper printout for YM1 should have a standard format: yellow lanes, then blue lanes. The table should have 2 columns for each locus. The controls are not needed in the table.

d. Click OK, OK.

e. After the printing is finished, under file, quit Genotyper. Click save. Make sure that the Genotyper file is saved in the appropriate Common runs folder.
II. Identifiler, 28 Cycles for High Copy Number

A. Importing data and allele call assignment

1. Open the Identifiler 28 macro by clicking on the Genotyper shortcut on the desktop of the analysis station computer.

2. Under File ➔ Import and select From GeneScan File. If the Current Runs folder does not already appear in the window, scroll to find it from the pull-down menu and double-click on it. Double-click on the folder containing the project that was created in GeneScan.

3. Click Add or double-click on the project icon to add the project for analysis. When the project has been added, click Finish.

4. Under View ➔ Show Dye/Lanes window, a list of the samples imported from GeneScan analysis can be seen. If samples need to be removed, highlight the lanes for these samples and select Cut from the Edit menu.

5. After importing the project and saving the Genotyper file, run the first Macro by pressing Ctrl+9, or double click the ID 28: Identifiler 28 macro.

6. Under File ➔ Save As, save the Genotyper template as the casework run file and initials. For example: “Kastle09-108ID JLS”
7. The plot window will appear automatically when the macro is completed. Check to make sure that the ladders match the allele sequence shown below. Also check the results for the positive control. The plots will display the orange size standard.

**TABLE 5 IDENTIFILER™ POSITIVE CONTROL**

<table>
<thead>
<tr>
<th></th>
<th>D8S1179</th>
<th>D21S11</th>
<th>D7S820</th>
<th>CSF1PO</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Blue (6-FAM)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>10, 11</td>
<td>10, 12</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Green (VIC)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14, 15</td>
<td>8, 9.3</td>
<td>11</td>
<td>11, 12</td>
<td></td>
</tr>
<tr>
<td>19, 23</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Yellow (NED)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14, 15</td>
<td>17, 18</td>
<td>8</td>
<td>15, 19</td>
<td></td>
</tr>
<tr>
<td><strong>Red (PET)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>X</td>
<td>23, 24</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
IDENTIFILER™ ALLELIC LADDER

Table 6

<table>
<thead>
<tr>
<th>Multiplex System</th>
<th>Necessary LIZ GS500 standard peaks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifiler™</td>
<td>12 fragments from 75 - 450 bp</td>
</tr>
</tbody>
</table>

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
8. Fill out an STR 3130xl Control Review Worksheet indicating the status of all controls.

9. Under Analysis \rightarrow Change labels, select size in bp, peak height and category name. Click Ok.

10. Check all lanes. Labels for extra peaks can be manually deleted by placing the cursor on the peak above the baseline and clicking.

   **Shortcut:** If a label is mistakenly deleted, press Ctrl+Z and the allele name label will reappear. Ctrl+Z will only undo the last action.

11. To zoom into a desired region of an electropherogram, hold the left mouse click down draw a box around the desired region.

12. Under View \rightarrow Zoom, select Zoom In (selected area).

   **Shortcut:** Zoom in by holding down the left mouse click button and dragging the cursor across the area to zoom in on. Then, press Ctrl+R or Ctrl + + to zoom in on that region. To zoom out in a stepwise fashion, press Ctrl-.

13. To revert to the correct scan range, go to View \rightarrow Zoom \rightarrow Zoom To. Set the plot range to **range listed in Table 7.** Click OK.

   **Table 7**
<table>
<thead>
<tr>
<th>System</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifiler</td>
<td>90-370</td>
</tr>
</tbody>
</table>

   Compare the orange electropherograms with the other color lanes by either:

   a. holding down the shift key and clicking on the orange “O” box in the upper left hand corner
   b. under **edit** go to select +orange
14. Fill out the Genotyper Editing Sheet for each Electrophoresis run to indicate the following:

   a. no editing required
   b. sample(s) requiring manual removal of non allelic peaks. Refer to STR Results Interpretation Section.
   c. sample(s) requiring rerun and/or re-injection. Refer to STR Results Interpretation Section.

   Each sample listed on the Genotyper Editing Sheet must be indicated by sample number. The reason for the edit must be indicated using a number code and/or symbol.

15. After the editing has been finished, scroll through the plot window to double-check.

B. Viewing and Printing Electropherograms

1. Controls
   a. Under View ➔ Dye Lane Window and select blue, green, yellow, red and orange for all lanes containing the allelic ladder.

   To select multiple labels, press Ctrl while clicking on the lanes
   c. Go to View and open the Plot Window

   d. Under Analysis ➔ Change Labels and select size in bp and category name.

   Click ok. Save.

   e. Repeat steps 1a - c for all lanes containing controls including microcon controls
f. To select multiple labels, press Ctrl while clicking on the lanes

g. Go to View and open the Plot Window

h. Under Analysis→Change Labels and select size in bp, peak height and category name. Click ok. Save.

g. Continue to Step 3 and print the controls according to the directions.

2. Evidence and Exemplar Samples

a. Under View→Dye Lane Window and select blue, green, yellow, red and orange for all lanes containing casework samples

b. To select multiple labels, press Ctrl while clicking on the lanes

c. Go to View and open the Plot Window

d. Under Analysis→Change Labels and select size in bp, peak height and category name. Click ok. Save.

e. Continue to Step 3 and print according to the directions.

3. Printing Electropherograms

a. Make sure the file is named properly, including initials.

b. Set Plot window zoom range as shown in Table 8. The active window will be printed so open Table or Plot as needed.
c. Under File → Print → Properties button → Finishing tab → Document, set the parameters below.

Table 8 Identifiler Print parameters:

<table>
<thead>
<tr>
<th>Plot</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Orientation</strong></td>
</tr>
<tr>
<td><strong>Scale</strong></td>
</tr>
<tr>
<td><strong>Zoom range</strong></td>
</tr>
</tbody>
</table>

d. Click OK, OK.

e. After the printing is finished, ensure that all alleles in the ladder, controls and samples are labeled. Manually enter the base pair size if necessary and initial and date.

f. Under file, quit Genotyper. Click save. Make sure the Genotyper file is saved in the appropriate Common runs folder.

g. Initial all Genotyper pages.

h. List rerun samples on the rerun sheet

i. Place rerun samples into the designated rerun crybox

j. Have a supervisor review the analyzed run

k. For Troubleshooting see Section V- Multiplex Kit Troubleshooting.

C. Genotyper Tables for Identifiler 28 samples

1. Genotyper Table

   a. Select all relevant samples in the main window

   b. Under Analysis → Clear table

   c. Under Analysis → Change Labels select category name
4. Have a supervisor review the analyzed run.

5. For Troubleshooting see Section V- Multiplex Kit Troubleshooting
III. Identifiler – High Sensitivity Testing

A. Importing data and allele call assignment

1. Open the HS Identifiler 10% Macro by clicking on the Genotyper shortcut on the desktop of the analysis station computer.

2. Under File ➔ Import and select From GeneScan File. If the Current Runs folder does not already appear in the window, scroll to find it from the pull-down menu and double-click on it. Double-click on the folder containing the project that was created in GeneScan.

3. Click Add or double-click on the project icon to add the project for analysis. When the project has been added, click Finish.

4. Under View ➔ Show Dye/Lanes window, a list of the samples that were imported from GeneScan analysis can be seen. If samples need to be removed, highlight the lanes for these samples and select Cut from the Edit menu.

5. After importing the project and saving the Genotyper file, run the first Macro by pressing Ctrl+9, or double click the following according to the macro:
   a. ID 28: Identifiler 28
   b. ID 31: HS Identifiler 10%.

6. Under File ➔ Save As, save the Genotyper template as the plate record, the run folder and injection parameter. For example: Venus042507_25L.

7. The plot window will appear automatically when the macro is completed. Check to make sure that the ladders match the allele sequence shown below. Also check the results for the positive control. The plots will also display the orange size standard.
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Table 10

<table>
<thead>
<tr>
<th>Multiplex System</th>
<th>Necessary LIZ GS500 standard peaks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifiler™</td>
<td>12 fragments from 75 - 450 bp</td>
</tr>
</tbody>
</table>

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
8. Fill out an STR 3130xl Control Review Worksheet indicating the status of all controls.

9. Under Analysis ➔ Change labels, select size in bp, peak height and category name. Click Ok.

10. Check all lanes. Labels for extra peaks can be manually deleted by placing the cursor on the peak above the baseline and clicking.

   **Shortcut:** If a label was mistakenly deleted, press Ctrl+Z and the allele name label will reappear. Ctrl+Z will only undo the last action.

11. For samples that need to be viewed in triplicate by color (31 cycles only) under Views ➔ Dye Lane Sorting, the first precedence should be set to Dye Color and the second to File Name, both in ascending order.

12. To zoom into a desired region of an electropherogram, hold the left mouse click down draw a box around the desired region.

13. Under View ➔ Zoom, select Zoom In (selected area).

   **Shortcut:** Zoom in by holding down the left mouse click button and dragging the cursor across the area to zoom in on. Then, press Ctrl+R or Ctrl ++ to zoom in on that region. To zoom out in a stepwise fashion, press Ctrl–.

14. To revert to the correct scan range, go to View ➔ Zoom ➔ Zoom To. Set the plot range to **range listed in Table 11**. Click OK.

   **Table 11**

<table>
<thead>
<tr>
<th>System</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifiler</td>
<td>90-370</td>
</tr>
</tbody>
</table>
Compare the orange electropherograms with the other color lanes by either:

a. holding down the shift key and clicking on the orange “O” box in the upper left hand corner

b. under edit go to select +orange

15. Fill out the Genotyper Editing Sheet for each Electrophoresis run to indicate the following:

a. no editing required

b. sample(s) requiring manual removal of non allelic peaks. Refer to STR Results Interpretation Section

c. sample(s) requiring rerun and/or re-injection. Refer to STR Results Interpretation Section.

Each sample listed on the Genotyper Editing Sheet must be indicated by sample number. The reason for the edit must be indicated using a number code and/or symbol.

16. After the editing has been finished, scroll through the plot window to double-check.

B. Viewing and Printing Electropherograms

1. Controls

a. Under View ➔ Dye Lane Window and select blue, green, yellow, red and orange for all lanes containing the allelic ladder.

b. To select multiple labels, press Ctrl while clicking on the lanes

c. Go to View and open the Plot Window
d. Under **Analysis**→**Change Labels and** select **size in bp** and **category name**. Click **ok**. Save.

e. Repeat steps 1a - c for all lanes containing controls including microcon controls

f. To select multiple labels, press **Ctrl** while clicking on the lanes

g. Go to **View** and open the **Plot Window**

h. Under **Analysis**→**Change Labels and** select **size in bp, peak height** and **category name**. Click **ok**. Save.

g. Continue to Step 3 and print the controls according to the directions.

2. Evidence and Exemplar Samples

a. Under **View**→**Dye Lane Window** and select **blue, green, yellow, red and orange** for all lanes containing casework samples

b. To select multiple labels, press **Ctrl** while clicking on the lanes

c. Go to **View** and open the **Plot Window**

Under **Analysis**→**Change Labels and** select **size in bp, peak height** and **category name**. Click **ok**. Save.

e. To print the electropherograms for 31 cycle samples, select each sample (triplicates (a, b, c) and pooled (abc)) and sort by Dye Color, then File Name. Each sample will have to be printed separately. Follow steps 2a - d.

f. Continue to Step 3 and print according to the directions.
3. Printing Electropherograms

a. Make sure the file is named properly, including initials.

b. Set Plot window zoom range as shown below. The active window will be printed so open Table or Plot as needed.

<table>
<thead>
<tr>
<th>Plot</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orientation</td>
</tr>
<tr>
<td>Scale</td>
</tr>
<tr>
<td>Zoom range</td>
</tr>
</tbody>
</table>

c. Under File → Print → Properties button → Finishing tab → Document, set the parameters above.

d. Click OK, OK.

e. After the printing is finished, ensure that all alleles in the ladder, controls and samples are labeled. Manually enter the base pair size if necessary and initial and date.

f. Under file, quit Genotyper. Click save. Make sure the Genotyper file is saved in the appropriate Common runs folder.

g. Initial all Genotyper pages.

h. List rerun samples on the rerun sheet

i. Place rerun samples into the designated rerun cryobox

j. Have a supervisor review the analyzed run

k. For Troubleshooting see Section V - Multiplex Kit Troubleshooting.
C. Genotyper Tables

1. Identifiler 28 Profile Generation Table
   a. Select all relevant samples in the main window
   b. Under Analysis→Clear table
   c. Under Analysis→Change Labels select category name
   d. Under Table→Set up table→Labels→Options
   e. Set the number of peaks per category to “6”. Next to “Text if >N”, click on “Options”. Set the number of peaks to “6” and the text to “Overflow”
   f. Click OK. Under Table→Append to table. Save.
   g. Click on the table window panel view.
   h. Under Edit→Select All, Copy.

2. Identifiler 31 Profile Generation Table
   a. Ensure that all relevant samples are selected in the main window
   b. Under Analysis→Clear table
   c. Under Analysis→Change Labels, ensure only “category name” is selected
   d. Under Table→Set up table→Labels→Options
   e. Set the number of peaks per category to “6”. Next to “Text if >N”, click on “Options”. Set the number of peaks to “6” and the text to “Overflow”
   f. OK→OK→Table→Append to table
2. Open the Profile Generation spreadsheet macro found in \HIGHSENS\TEMPLATES IN USE\ANALYSIS\ID31 Profile Generation Sheet-STR. Click **Don’t Update**.

3. Paste into cell A12 of “extra sheet” and delete rows containing the Allelic Ladders.
   a. Starting at row 12, ensure that samples are in the following order:
      i. Sample info and Loci names
      ii. Positive controls
      iii. Amp Negatives
      iv. Extraction negatives and Microcon negatives (triple amps)
      v. Samples begin in row 25 (triple amp plus pooled).
      vi. Sample triplicates and pooled samples should be consecutive.
   b. Two rows are to be skipped between each sample (three between each control inserted after row 25). Insert or delete rows if necessary.
      For example: the first sample is in row 25-28, then rows 29 and 30 are skipped, and the second sample is in rows 31-34, and so on.
   c. Alternatively, sample info may be copy and pasted directly into the appropriate rows in the “Copy Geno Triple” sheet of the Excel workbook.

4. Compilation of triple amplifications
   a. On the “extra sheet”, Edit→select all→copy
   b. Paste into cell A1 of the copy geno triple sheet. (The geno db sheet is for double amplifications that would not be utilized for casework.)
5. “NIKE” macros to filter and sort
   a. Macro 4: Select the control and the “n” keys to filter sample sheets 1-14.
   b. Macro 4b: Select the control and the “i” keys to filter sample sheets 15-29.
   c. Profiles macro: Select the control and the “k” keys to sort sample sheets 1-14.
   d. ProfilesB macro: Select the control and the “e” keys to sort sample sheets 15-29.

6. Arrow to the right to the triple chart.
   a. Each amplification replicate is shown in the white rows, and the composite profile containing alleles that repeat in two of the three amplifications is in the row below the 3 amplifications.
   b. The pooled injection is located beneath the composite profile.
   c. Loci with more than 6 alleles will not be accurately reflected. However, the word “overflow” will appear in the cell as a signal to check the alleles on the electropherogram. Additional alleles may be manually entered into the cell.
   d. Print and store table with the electropherogram.

7. The table must be saved in the appropriate folder containing the raw data and the GeneScan project.

8. Have a supervisor review the analyzed run.

9. For Troubleshooting see Section V- Multiplex Kit Troubleshooting
IV.  Re-injection Guidelines – YM1

A.  YM1 Controls

1.  Refer to the following procedure in this manual before making a decision to rerun/re-inject a control:
   a.  Genotyper Analysis Section V – Multiplex Kit Troubleshooting
   b.  STR Results Interpretion Section V – Interpretation of Controls

2.  If a complete injection fails, rerun with the same parameters.

3.  Rerun/ re-inject normal if the following applies:
   a.  Positive Control fails
   b.  Amplification Negative fails
   c.  Extraction Negative fails
   d.  No size standard

NOTE: All reruns/ re-injections must be accompanied by a passing positive control.

B.  YM1 Samples

1.  Rerun normal if the following applies:
   a.  No orange size standard
   b.  New allele/Off-ladder allele
   c.  Overamplified single source samples (rfus >6000) with plateau shaped or misshaped peaks, numerous labeled stutter peaks and artifacts – remove all peaks and rerun with a dilution
d. Overamplified mixed samples (rfus >6000) – remove all peaks and rerun with a dilution

2. Rerun with high parameters if there are peaks below threshold

NOTE: All reruns/ re-injections must be accompanied by a passing positive control.

V. Re-injection Guidelines – Identifiler, 28 Cycles

A. Identifiler 28 Controls

1. Refer to the following sections before making a decision to rerun/ re-inject a control:
   a. Genotyper Analysis Section V – Multiplex Kit Troubleshooting
   b. STR Results Interpretation Section V – Interpretation of Controls

2. If a complete injection fails, rerun with the same parameters.

3. Rerun/ re-inject normal if the following applies:
   a. Positive Control fails
   b. Amplification Negative fails
   c. Extraction Negative fails
   d. No size standard

NOTE: All reruns/ re-injections must be accompanied by a passing positive control.
B. Identifiler 28 Samples

1. Rerun normal if the following applies:
   a. No orange size standard
   b. New allele/ Off ladder allele
   c. Overamplified single source samples (rfus >7000) with plateau shaped or misshaped peaks with numerous labeled stutter peaks and artifacts – remove all peak and run with a dilution
   d. Overamplified mixed samples (rfus >7000) – remove all peaks and run with a dilution or follow steps in section 3 below.

2. Samples may be rerun high on the approved High Sensitivity CEs or samples may be injected high on these instruments initially if appropriate
   a. All relevant controls must be re-injected at the high parameter
   b. For mixed samples at these parameters, overblown peaks (>7000 RFUs) as well as peaks from loci within the same basepair range in the other colors should be removed and deemed inconclusive. However, data from the other loci should be retained. Data from both injections may be used for interpretation. For consistency, confirm that the injections at different parameters generate overlapping loci.

V. Re-injection Guidelines – Identifiler, 31 Cycles

A. Identifiler 31 Controls

1. Refer to the following sections before making a decision to rerun/ re-inject a control:
   a. Genotyper Analysis Section V – Multiplex Kit Troubleshooting
   b. STR Results Interpretation Section V – Interpretation of Controls
2. If a complete injection fails, rerun with the same parameters.

3. Rerun/re-inject normal if the following applies:
   a. Positive Control fails
   b. Amplification Negative fails
   c. Extraction Negative fails
   d. No size standard

   NOTE: For reruns that are lower than the original injection, only a positive control must be re-injected.

B. Identifiler 31 Samples

1. Rerun at the same injection parameters if the following applies:
   a. No orange size standard
   b. New allele/Off ladder allele

2. Samples may be rerun with higher parameters if peaks are below threshold. Samples may be initially injected at a high parameter if appropriate.

   NOTE: All controls must be re-injected for all rerun conditions that are at a higher parameter.

3. Rerun at a lower injection parameter and/or with a dilution if the following applies:
   a. Overamplified single source samples (rfus >7000) with plateau shaped or misshaped peaks with numerous labeled stutter peaks and artifacts
   b. Overamplified mixed samples (rfus >7000)
4. For Mixed samples run at more than one injection parameter or concentration
   a. Remove overblown peaks (>7000 RFUs) as well as peaks from loci within the same basepair range in the other colors and deem these loci inconclusive.
   b. Retain data from the other loci.
   c. Data from both injections may be used for interpretation. For consistency, confirm that the injections at different parameters generate overlapping loci.

VI. Troubleshooting

A. Genotyper Macro 1 produces an error message that reads: “Could not complete your request because no dye/lanes are selected.”
   1. Make sure the ladder was imported from the project.

   **Solution:** If the ladder was not imported into the project, import the ladder and rerun the macro.

   2. Check the spelling of “ladder” and the sample information in the dye/lanes window.

   **Solution:** Spell correctly and/or correct sample information. Then, rerun the macro.

B. Genotyper Macro 1 produces an error message that reads: “Could not complete your request because the labeled peak could not be found”.

This message indicates that the ladder cannot be matched to the defined categories. There are three possibilities:
1. There may be peaks in the ladder that are too low to be recognized by the program.

**Solution:** Two options:

a. **One:** If another ladder in the run is more intense, alter or delete the name of the first ladder in the Genotyper Dye/Lane window. Then, rerun **Macro 1**. Now the macro will use the first backup ladder for the off-set calculation.

b. **Two:** The **minimum peak height** can be lowered for the off-set in the categories window by:

   i. Under View→Show Categories Window. In the “offset” categories the first allele is defined with a scaled peak height of 200 or higher. The high value is meant to eliminate stutter and background.

   ii. Change this to 75 for the 3130xl by clicking on the first category that it highlights.

   In the dialogue box locate the Minimum Peak Height and change it to the appropriate value.

   Click Add, and then click Replace when given the option. This must be done for each locus. Do not use values less than the instrument threshold.

   **DO NOT CHANGE THE MINIMUM PEAK HEIGHT FOR ANY OTHER CATEGORY EXCEPT THE OFF-SET.**

After the macro is rerun, make sure the ladder begins with the correct allele and that the first allele is not assigned to a stutter which might precede the first peak.
2. The first ladder peak of each locus is outside of the pre-defined size range window.

   **Solution:** Expand the search window in the categories window by:

   i. Under **View → Show Categories Window**. In the “offset” categories the first allele is defined with a certain size +/- 7bp.
   
   ii. Change the 7 to 10 or higher, by clicking on the first category which highlights it.
   
   iii. In the dialogue box locate, the +/- box and change the value
   
   iv. Click **Add**, and then click **Replace** when given the option.
   
   v. This can be done for each locus that gave the error message.

3. There are no peaks at all in any of the allelic ladders.

   **Solution:** Rerun all samples with freshly prepared Allelic Ladders.

C. Off Ladder (OL) allele labels

1. A run with a large number of samples may have a high incidence of OL allele labels toward the end of the run. This is due to a shift during the run.

   **Solution:** Try to reanalyze the run by using the second allelic ladder as the off-set reference by:

   i. removing the word “ladder” from the name of the first ladder in the dye lane window.
   
   ii. This ladder will not be recognized by the macro program
   
   iii. Rerun **Macro 1** and evaluate the results
iv. Determine which one of both allelic ladders causes fewer “OL allele?” labels.

v. Complete the Genotyping process using this ladder. Any remaining samples displaying OL alleles have to be rerun.

2. If all or most of the samples have “OL allele?” labels, it may be that the samples were automatically analyzed with an ill-defined size standard.

**Solution**: Redefine the size standard (see GeneScan analysis for 3130xl). Reanalyze the run

D. Incorrect positive control type

The Genotyper has shifted allele positions during the category assignment to the ladder.

Ensure that a sample mix-up did not occur.

Check the ladder and make sure the first assigned allele is assigned to the first real peak and not to a stutter peak, which may precede it. If the stutter peak is designated with the first allele name, the peak height must be raised in the categories window in order to force the software to skip the stutter peak and start with proper allele.

1. Determine the height of the stutter peak by placing the cursor on the peak in question (as if editing).

2. The information displayed on the top of the window refers to the peak where the cursor is located and contains the peak height. Make a note of the peak height.

3. Under **View**→**Show Categories Window** and highlight the first allele in the offset category (e.g., 18 o.s.) of the polymorphism that needs to be corrected.

4. In the dialogue box change the height for the minimum peak height to a few points above the determined height of the stutter.
5. Rerun the macro and then check to make sure everything is correct by looking at the first allele in each locus in the ladder and by comparing the result for the positive control.

E. Lining up unlabeled peaks

1. In order to place samples next to each other for comparison purposes, mark them by double clicking.

2. A black bullet appears in front of the lane number.

3. If this happens accidentally, a lane can be unmarked by either double clicking on it again or, under Edit→unmark.

4. To be able to align an unlabeled allele with a labeled allele in the same run, you must select View→View by Scan.

NOTE: Unsized peaks cannot be placed according to size on the electropherogram. Therefore, when comparing an unlabeled allele (unlabeled because it is too low to be sized, but high enough to be detected visually) to a labeled allele (e.g., in the ladder), you cannot determine the allele type and size by visual comparison while the results are viewed by size.

F. Too many samples

If you see the same sample listed several times in the dye/lanes window or you see more samples than you have imported, you have most likely imported your samples more than once or you have imported your samples into a Genotyper template that already contained other samples.


2. Under Analysis→Clear Table.

3. Re-import your file(s).
G. Typographical error in the sample information and/or sample comment

If you detect a mistake in the sample information, this can be corrected for the Genotyper file by:

1. Opening the dye lane list window
2. Highlighting the lane
3. Retyping the sample information for all colors

NOTE: The short sample name cannot be changed here. It can only be changed on the sample sheet level.

H. Less samples in Table than in Plots

Samples with the same sample information are only listed once in the Table. Add modifier to the sample information (see above) of one of the samples and rerun Macro.

I. Too many background peaks labeled

If peaks are still labeled in the plot even though they are listed as having been removed or they appear to be below the stutter filter threshold, the following mistake could have happened:

1. Instead Analysis→Change labels; the analyst clicked Analysis→Label peaks
2. The Change labels command labels the valid peaks with the allele name and the size in basepairs prior to printing the plot.
3. The Label peaks command labels all peaks above threshold independent of any Macro stutter and background filters.
4. This **Label peaks** command will also re-label peaks that were edited out.

**Solution:** Rerun the macro, repeat the documented editing steps and reprint the Table and the Plot.
I. General Information for Amplification

The Yfiler™ Amplification System from Life Technologies targets sixteen (16) locations on the Y chromosome. The system includes loci with tri-, tetra-, penta- and hexa-nucleotide repeats and utilizes five dyes (6-FAM™, VIC®, NED™ and PET® for samples and LIZ® for the GeneScan™ 500 size standard).

<table>
<thead>
<tr>
<th>LOCUS</th>
<th>REPEAT</th>
<th>Dye Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>DYS456</td>
<td>tetra-nucleotide</td>
<td>6-FAM™ (blue)</td>
</tr>
<tr>
<td>DYS389I</td>
<td>tetra-nucleotide</td>
<td>VIC® (green)</td>
</tr>
<tr>
<td>DYS390</td>
<td>tetra-nucleotide</td>
<td>NED™ (yellow)</td>
</tr>
<tr>
<td>DYS389II</td>
<td>tetra-nucleotide</td>
<td></td>
</tr>
<tr>
<td>DYS458</td>
<td>tetra-nucleotide</td>
<td></td>
</tr>
<tr>
<td>DYS19</td>
<td>tetra-nucleotide</td>
<td></td>
</tr>
<tr>
<td>DYS385a/b</td>
<td>tetra-nucleotide</td>
<td></td>
</tr>
<tr>
<td>DYS393</td>
<td>tetra-nucleotide</td>
<td></td>
</tr>
<tr>
<td>DYS391</td>
<td>tetra-nucleotide</td>
<td></td>
</tr>
<tr>
<td>DYS439</td>
<td>tetra-nucleotide</td>
<td></td>
</tr>
<tr>
<td>DYS635</td>
<td>tetra-nucleotide</td>
<td></td>
</tr>
<tr>
<td>DYS392</td>
<td>tri-nucleotide</td>
<td></td>
</tr>
<tr>
<td>Y GATA H4</td>
<td>tetra-nucleotide</td>
<td>PET® (red)</td>
</tr>
<tr>
<td>DYS437</td>
<td>tetra-nucleotide</td>
<td></td>
</tr>
<tr>
<td>DYS438</td>
<td>penta-nucleotide</td>
<td></td>
</tr>
<tr>
<td>DYS439</td>
<td>hexa-nucleotide</td>
<td></td>
</tr>
</tbody>
</table>

The target DNA concentration for amplification using the Yfiler™ system is 500 pg. The minimum DNA concentration required for amplification in this system is 100 pg (minimum quantitation value of 10 pg/µl). If a sample is found to contain less than 10.0 pg/µL of DNA, then the sample should not be amplified in Yfiler™. It can be re-extracted, reported as containing insufficient DNA, concentrated using a Microcon-100 or possibly submitted for High Sensitivity testing. (see Table 1)
TABLE 1: For Yfiler™

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Desired Template</td>
<td>100.00 pg</td>
</tr>
<tr>
<td>Template volume for amp</td>
<td>10 µL</td>
</tr>
<tr>
<td>Minimum Sample Concentration in 200 µL</td>
<td>10.0 pg/µL</td>
</tr>
<tr>
<td>Minimum Sample Concentration in 200 µL prior to Microconning* to 50 µL</td>
<td>2.5 pg/µL</td>
</tr>
<tr>
<td>Minimum Sample Concentration in 200 µL prior to Microconning** to 20 µL</td>
<td>1.0 pg/µL</td>
</tr>
</tbody>
</table>

* Sample concentration prior to processing with a Microcon 100 and elution to 50 µL
** Sample concentration prior to processing with a Microcon 100 and elution to 20 µL

Since Yfiler™ samples often require further testing in Identifiler, the extraction negative must also have a quantitation value of < 0.2 pg/ul. Thus, if the extraction negative is > 0.2 pg/µL it should be re-quantitated. If it fails again, the sample set must be re-extracted prior to amplification. (see Table 2)

TABLE 2:

<table>
<thead>
<tr>
<th>Amplification System</th>
<th>Sensitivity of Amplification</th>
<th>Extraction Negative Control Threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yfiler™</td>
<td>10 pg</td>
<td>0.20 pg/µL in 10 µL</td>
</tr>
</tbody>
</table>
II. Generation of Amplification Sheets

Refer to the LIMS manual for Forensic Biology for specific procedures within the LIMS system. Any casefile documentation developed outside of the LIMS system should be scanned to a PDF document and attached to the appropriate electronic case record.

Amplification sets are generated by supervisors following review of quantification results. Furthermore, samples may be submitted for amplification through the documented request process.

A. HSC Team Amp from RotorGene values for amplification of evidence samples with Yfiler™.

1. For Yfiler™ samples:
   a. For samples being sent on for Yfiler™ amplification from P30 values, on the “Samples” sheet, change the Calculated Values column to the appropriate letter associated with the P30 value and sample type:

<table>
<thead>
<tr>
<th>Orifice swab, P30 value, 2ng subtraction</th>
<th>Stains P30 value, 0.05 A subtraction</th>
<th>Type this letter in the “Calculated Value” column</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sperm Seen; No P30 ELISA Done</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>1.1 - 3.0</td>
<td>1.1 - 3.0</td>
<td>B</td>
</tr>
<tr>
<td>&gt;0 - 1.0</td>
<td>&gt;0 - 1.0</td>
<td>C</td>
</tr>
</tbody>
</table>
For vaginal swab samples sent for Amylase Positive Extractions, two concentrations must be sent for amplification:

<table>
<thead>
<tr>
<th>Amounts sent to amplification</th>
<th>Type this letter in the Calculated Value column</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DNA Target (µL)</strong></td>
<td><strong>TE^4 (µL)</strong></td>
</tr>
<tr>
<td>4</td>
<td>6</td>
</tr>
<tr>
<td>10</td>
<td>0</td>
</tr>
</tbody>
</table>

b. For samples being sent on for Yfiler™ amplification from Quantification values, the amplification sheet should calculate the appropriate DNA and water amount on the amplification set.

2. Each amplification sheet can hold up to 28 samples. Since there are 54 samples on a full RotorGene run, it is possible that more than one amplification set is necessary. If this is the case, the overflow samples will automatically be transferred into a second amplification set (i.e. “Yfiler™ 2”).

III. PCR Amplification - Sample Preparation

A. Samples amplified with Yfiler™ reagents should be prepared with UV’ed water.

Prepare dilutions for each sample, if necessary, according to Table 3.

**TABLE 3: Dilutions**

<table>
<thead>
<tr>
<th>Dilution</th>
<th>Amount of DNA Template (µL)</th>
<th>Amount of TE^4 (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.25</td>
<td>3 or (2)</td>
<td>9 or (6)</td>
</tr>
<tr>
<td>0.2</td>
<td>2</td>
<td>8</td>
</tr>
<tr>
<td>0.1</td>
<td>2</td>
<td>18</td>
</tr>
<tr>
<td>0.05</td>
<td>2.5</td>
<td>47.5</td>
</tr>
<tr>
<td>0.04</td>
<td>4 or (2)</td>
<td>96 or (48)</td>
</tr>
<tr>
<td>0.02</td>
<td>2 or (1)</td>
<td>98 or (49)</td>
</tr>
<tr>
<td>0.01</td>
<td>2</td>
<td>198</td>
</tr>
<tr>
<td>0.008</td>
<td>4 or (2)</td>
<td>496 or (248)</td>
</tr>
</tbody>
</table>
The target DNA template amount for Yfiler™ is 500 pg.

To calculate the amount of template DNA and diluant to add, the following formulas are used:

\[
\text{Amt of DNA (µL)} = \frac{\text{Target Amount (pg)}}{(\text{Sample concentration, pg/µL})(\text{Dilution factor})}
\]

The amount of diluant to add to the reaction = 10 µL – amt of DNA (µL)

The amplification of exemplars, sperm cell fractions of samples extracted by differential lysis and semen stains, where no epithelial cells were seen during the differential lysis, is based on the quantitation results. Semen positive swabs taken from female individuals that were extracted using the non-differential semen extraction and the swab remains fractions of differential lysis samples are amplified using the amounts specified in Table 4. Amylase positive samples should be amplified based on Table 5.

Table 4: Amount of DNA extract from a non-differential semen extraction or from the swab/substrate remains fraction of a differential lysis sample to be amplified in Yfiler™.

<table>
<thead>
<tr>
<th>P30 result for the 2ng subtraction (Body cavity swabs)</th>
<th>P30 result for the 0.05A units subtraction (Stains or penile swabs)</th>
<th>DNA Volume (µL) to be amplified</th>
<th>TE-4 (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spoon Seen; Not Sent to P30 ELISA</td>
<td></td>
<td>4</td>
<td>6</td>
</tr>
<tr>
<td>≥ 1.1</td>
<td>≥ 1.1</td>
<td>4</td>
<td>6</td>
</tr>
<tr>
<td>&gt; 0 - 1.0</td>
<td>&gt; 0 - 1.0</td>
<td>10</td>
<td>0</td>
</tr>
</tbody>
</table>
Table 5:  Amount of DNA extract to be amplified for Amylase positive samples.**

<table>
<thead>
<tr>
<th>Type of item</th>
<th>DNA Target Volume (µL)</th>
<th>TE⁻⁴ (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orifice swab Initially try two amounts</td>
<td>4</td>
<td>6</td>
</tr>
<tr>
<td>Dried secretions</td>
<td>Based on Quantitation result</td>
<td></td>
</tr>
<tr>
<td>swab (External)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stain</td>
<td>Based on Quantitation result</td>
<td></td>
</tr>
</tbody>
</table>

** RotorGene does not reflect male DNA, especially for vaginal swabs. Try more or less if negative.

B. Male Positive Control

The male positive control for Yfiler™, Control DNA 007, is stored in the refrigerator. The given concentration is 0.10 ng/uL or 100 pg/uL. This sample will be amplified with a target of 250 pg DNA. Make a 0.5 dilution of the Control DNA 007 and add 5 uL of this dilution to 5 uL of UV’ed water.

C. Female Negative Control

The female negative control for Yfiler™, Control DNA 9947A, is stored in the refrigerator. The given concentration is 10 ng/uL or 10,000 pg/uL. This sample will be amplified with a target of 500 pg DNA. Make a 0.01 dilution of the Control DNA 9947A and add 5 uL of this dilution to 5 uL of UV’ed water.

D. Amplification Negative Control

UV’ed water will serve as an amplification negative control.

E. Master Mix Preparation

1. Retrieve Yfiler™ primers and Yfiler™ reaction mix from the refrigerator. Retrieve ABI Taq Gold from the freezer. Store reagents in a Nalgene cooler on bench. Record the lot numbers of the reagents.
2. Vortex or pipet the reagents up and down several times to thoroughly mix the reagents. **Do not vortex Taq Gold** as it may degrade the enzyme.

   After vortexing, centrifuge reagents briefly at full speed to ensure that no sample is trapped in the cap.

3. Consult the amplification documentation for the exact amount of Yfiler™ primers, reaction mix and ABI Taq Gold to add. The amount of reagents for one amplification reaction is listed in Table 6.

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Per reaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yfiler™ PCR Reaction Mix</td>
<td>9.2 µL</td>
</tr>
<tr>
<td>Yfiler™ Primer Set</td>
<td>5.0 µL</td>
</tr>
<tr>
<td>AmpliTaq Gold DNA Polymerase (5 U/µL)</td>
<td>0.8 uL</td>
</tr>
<tr>
<td>Mastermix total in each sample:</td>
<td>15 µL</td>
</tr>
<tr>
<td>DNA</td>
<td>10 µL</td>
</tr>
</tbody>
</table>

**F. Reagent and Sample Aliquot**

1. Vortex master mix to thoroughly mix. After vortexing, briefly tap or centrifuge the master mix tube to ensure that no reagent is trapped in the cap.

2. Add **15 µL** of the Yfiler™ master mix to each tube that will be utilized, changing pipette tips and remixing master mix as needed.

   **NOTE:** Use a new sterile filter pipet tip for each sample addition. Open only one tube at a time for sample addition.

3. Arrange samples in a rack in precisely the positions they appear on the sheet.

4. **Witness step.** Ensure that your samples are properly positioned.
5. Prior to adding sample or control, pipet each sample or control up and down several times to thoroughly mix. The final aqueous volume in the PCR reaction mix tubes will be 25µL. After addition of the DNA, cap each sample before proceeding to the next tube.

6. After all samples have been added, take the rack to the amplified DNA area for Thermal Cycling.

IV. Thermal Cycling

A. Turn on the ABI 9700 Thermal Cycler. (See manufacturer’s instructions).

B. Choose the following files to amplify in Yfiler™:

<table>
<thead>
<tr>
<th>Yfiler™</th>
</tr>
</thead>
<tbody>
<tr>
<td>user: casewk</td>
</tr>
<tr>
<td>file: yfiler</td>
</tr>
</tbody>
</table>
PCR Conditions for the Perkin Elmer GeneAmp PCR System 9700

<table>
<thead>
<tr>
<th>9700</th>
<th>The Yfiler™ file is as follows:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yfiler™</td>
<td>Initial Incubation Step:</td>
</tr>
<tr>
<td>user: casewk</td>
<td>Hold 95°C for 11 minutes</td>
</tr>
<tr>
<td>file: yfiler</td>
<td>Cycle (30 cycles)</td>
</tr>
<tr>
<td></td>
<td>Denature at 94°C for 1 minute</td>
</tr>
<tr>
<td></td>
<td>Anneal at 61°C for 1 minute</td>
</tr>
<tr>
<td></td>
<td>Extend at 72°C for 1 minute</td>
</tr>
<tr>
<td></td>
<td>Final Extension:</td>
</tr>
<tr>
<td></td>
<td>Hold 60°C for 80 minutes</td>
</tr>
<tr>
<td></td>
<td>Final Hold:</td>
</tr>
<tr>
<td></td>
<td>Hold 4°C</td>
</tr>
</tbody>
</table>

C. 9700 Instructions

1. Place the tubes in the tray in the heat block (do not add mineral oil), slide the heated lid over the tubes, and fasten the lid by pulling the handle forward. Make sure you use a tray that has a 9700 label.

2. Start the run by performing the following steps:

3. The main menu options are RUN CREATE EDIT UTIL USER. To select an option, press the F key (F1…F5) directly under that menu option.
4. Verify that user is set to “casewk.” If it is not, select the USER option (F5) to display the “Select User Name” screen.

5. Use the circular arrow pad to highlight “casewk.” Select the ACCEPT option (F1).

6. Select the RUN option (F1).

7. Use the circular arrow pad to highlight the desired STR system. Select the START option (F1). The “Select Method Options” screen will appear.

8. Verify that the reaction volume is set to 25µL for Yfiler™.

9. If all is correct, select the START option (F1).

10. Update usage log.

11. The run will start when the heated cover reaches 103°C. The screen will then display a flow chart of the run conditions. A flashing line indicates the step being performed, hold time is counted down. Cycle number is indicated at the top of the screen, counting up.

12. Upon completion of the amplification, remove samples and press the STOP button repeatedly until the “End of Run” screen is displayed. Select the EXIT option (F5). Wipe any condensation from the heat block with a Kimwipe and pull the lid closed to prevent dust from collecting on the heat block. Turn the instrument off.

**Note:** Place the microtube rack used to set-up the samples for PCR in the container of 10% bleach container in the Post-Amp area in Room 714A.

---

Revision History:
April 1, 2014 – Initial version of procedure.
Refer to the “Identifiler Analysis on the ABI 3130xl Genetic Analyzer” procedures for instructions on how to:
1. set up the 3130xl instrument
2. create, import, and link the plate record
3. troubleshoot

A. Preparation of 3130xl Batch

Ensure that the appropriate System is filled into the “Sys” column.

**Table 1**

<table>
<thead>
<tr>
<th>Amplification (System/Cycle)</th>
<th>Specification</th>
<th>Run Module Code</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yfiler™</td>
<td>Normal</td>
<td>M</td>
<td>3 kV for 10 sec</td>
</tr>
<tr>
<td>High</td>
<td>MR</td>
<td></td>
<td>5 kV for 20 sec</td>
</tr>
</tbody>
</table>

**Mastermix and Sample Addition for Yfiler™**

1. Prepare one mastermix for all samples, negative and positive controls, allelic ladders as specified in the table below (mastermix calculation, add 8.7 µL HiDi + 0.3µL GS 500 LIZ standard per sample).

<table>
<thead>
<tr>
<th># Samples</th>
<th>HiDi Form (8.7 µL per sample)</th>
<th>GS 500 LIZ Std (0.3 µL per sample)</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>156.6</td>
<td>5.4</td>
</tr>
<tr>
<td>32</td>
<td>295.8</td>
<td>10.2</td>
</tr>
<tr>
<td>64</td>
<td>435.0</td>
<td>15.0</td>
</tr>
<tr>
<td>64</td>
<td>574.2</td>
<td>19.8</td>
</tr>
<tr>
<td>80</td>
<td>713.4</td>
<td>24.6</td>
</tr>
<tr>
<td>96</td>
<td>852.6</td>
<td>29.4</td>
</tr>
<tr>
<td>112</td>
<td>991.8</td>
<td>34.2</td>
</tr>
<tr>
<td>128</td>
<td>1131.0</td>
<td>39.0</td>
</tr>
</tbody>
</table>

**NOTE:** HiDi Formamide cannot be re-frozen.

2. Obtain a reaction plate and label the side with the name used for the 3130xl Run ID with a sharpie and place the plate in an amplification tray or the plate base. Aliquot 9 µL of mastermix to each well.
C. Adding Samples:

1. Arrange amplified samples in a 96-well rack according to how they will be loaded into the 96-well reaction plate. Sample order is as follows: A1, B1, C1, D1... G1, H1, A2, B2, C2...G2, H2, A3, B3, C3, etc. Thus the plate is loaded in a columnar manner where the first injection corresponds to wells A1-H2, the second A3-H4 and so on.

2. Have someone witness the tube setup by comparing the tube labels and positions indicated on the sample sheet with the tube labels and positions of the tubes themselves.

3. For samples being run at normal parameters: Aliquot the following:
   - Allelic Ladder: 1 µL
   - Positive/Negative Controls: 1 µL
   - Samples: 1 µL

4. For samples being run at high parameters: Aliquot the following:
   - Allelic Ladder: 1 µL
   - Positive/Negative Controls: 1 µL
   - Samples: 1 µL

5. When adding PCR product, make sure to pipette the solution directly into the formamide and gently flush the pipette tip up and down a few times to mix it.

6. If an injection has less than 16 samples, add at least 9 µL of either dH2O, formamide, HiDi, buffer or mastermix to all unused wells within that injection.

D. Denature/Chill - For Yfiler™ After Sample Addition:

1. Once all of the samples have been added to the plate, place a new 96-well Septa over the reaction plate and firmly press the septa into place.

2. Spin plate in centrifuge at 1000 RPM for one minute.
3. For Denature/Chill:
   a. Place the plate on a 9700 thermal Cycler (Make sure to keep the Thermal Cycler lid off of the sample tray to prevent the septa from heating up.)
   b. Select the “dechillYF” program for Yfiler (95°C for 3 minutes followed by 4°C for 3 minutes). Make sure the volume is set to 10 µL.
   c. Press Run on the Thermal Cycler.
   d. Update usage log.
   e. While the denature/chill is occurring, you can turn on the oven on the ABI 3130xl.

E. 3130xl Settings

3130xl visible settings:  
EP voltage 15kV  
EP current (no set value)  
Laser Power Prerun 15 mW  
Laser Power During run 15mW  
Laser Current (no set value)  
Oven temperature 60°C

Expected values are:  
EP current constant around 120 to 160µA  
Laser current: 5.0A ± 1.0

It is good practice to monitor the initial injections in order to detect problems.

Table 2

<table>
<thead>
<tr>
<th></th>
<th>Y10</th>
<th>YR20</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oven Temp</td>
<td>60°C</td>
<td>60°C</td>
</tr>
<tr>
<td>Pre-Run Voltage</td>
<td>15.0 kV</td>
<td>15.0 kV</td>
</tr>
<tr>
<td>Pre-Run Time</td>
<td>180 sec</td>
<td>180 sec</td>
</tr>
<tr>
<td>Injection Voltage</td>
<td>3 kV</td>
<td>5 kV</td>
</tr>
<tr>
<td>Injection Time</td>
<td>10 sec</td>
<td>20 sec</td>
</tr>
<tr>
<td>Run Voltage</td>
<td>15 kV</td>
<td>15 kV</td>
</tr>
<tr>
<td>Run Time</td>
<td>1500 sec</td>
<td>1500 sec</td>
</tr>
</tbody>
</table>

Revision History:
April 1, 2014 – Initial version of procedure.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
I. General Information for Amplification

The PowerPlex® Y Amplification System from Promega targets eleven (11) locations on the Y chromosome. The system includes loci with tri-nucleotide, tetra-nucleotide and penta-nucleotide repeats.

<table>
<thead>
<tr>
<th>LOCUS</th>
<th>REPEAT</th>
</tr>
</thead>
<tbody>
<tr>
<td>DYS391</td>
<td>tetra-nucleotide</td>
</tr>
<tr>
<td>DYS389I</td>
<td>tetra-nucleotide</td>
</tr>
<tr>
<td>DYS439</td>
<td>tetra-nucleotide</td>
</tr>
<tr>
<td>DYS389II</td>
<td>tetra-nucleotide</td>
</tr>
<tr>
<td>DYS438</td>
<td>penta-nucleotide</td>
</tr>
<tr>
<td>DYS437</td>
<td>tetra-nucleotide</td>
</tr>
<tr>
<td>DYS19</td>
<td>tetra-nucleotide</td>
</tr>
<tr>
<td>DYS392</td>
<td>tri-nucleotide</td>
</tr>
<tr>
<td>DYS393</td>
<td>tetra-nucleotide</td>
</tr>
<tr>
<td>DYS390</td>
<td>tetra-nucleotide</td>
</tr>
<tr>
<td>DYS385</td>
<td>tetra-nucleotide</td>
</tr>
</tbody>
</table>

The target DNA concentration for amplification using the PowerPlex Y system is 500 pg. The minimum DNA concentration required for amplification in this system is 100 pg (minimum quantitation value of 5 pg/ul). If a sample is found to contain less than 5.0 pg/µL of DNA, then the sample should not be amplified in PowerPlex® Y. It can be re-extracted, reported as containing insufficient DNA, concentrated using a Microcon-100 or possibly submitted for High Sensitivity testing. (see Table 1)
TABLE 1: For PowerPlex Y

<table>
<thead>
<tr>
<th>Minimum Desired Template</th>
<th>100.00 pg</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template volume for amp</td>
<td>20 µL</td>
</tr>
<tr>
<td>Minimum Sample Concentration in 200 µL</td>
<td>5.0 pg/µL</td>
</tr>
<tr>
<td>Minimum Sample Concentration in 200 µL prior to Microconning* to 50 µL</td>
<td>1.25 pg/µL</td>
</tr>
<tr>
<td>Minimum Sample Concentration in 200 µL prior to Microconning** to 20 µL</td>
<td>0.50 pg/µL</td>
</tr>
</tbody>
</table>

* Sample concentration prior to processing with a Microcon 100 and elution to 50 µL
** Sample concentration prior to processing with a Microcon 100 and elution to 20 µL

Since PowerPlex® Y samples often require further testing in Identifiler, the extraction negative must also have a quantitation value of < 0.2 pg/µL. Thus, if the extraction negative is > 0.2 pg/µL it should be re-quantitated. If it fails again, the sample set must be re-extracted prior to amplification. (see Table 2)

TABLE 2:

<table>
<thead>
<tr>
<th>Amplification System</th>
<th>Sensitivity of Amplification</th>
<th>Extraction Negative Control Threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>PowerPlex® Y</td>
<td>5 pg</td>
<td>0.20 pg/µL in 20 µL</td>
</tr>
</tbody>
</table>
II. Generation of Amplification Sheets

Refer to the LIMS manual for Forensic Biology for specific procedures within the LIMS system. Any casefile documentation developed outside of the LIMS system should be scanned to a PDF document and attached to the appropriate electronic case record.

Amplification sets are generated by supervisors following review of quantification results. Furthermore, samples may be submitted for amplification through the documented request process.

A. HSC Team Amp from RotorGene values for amplification of evidence samples with PowerPlex Y.

1. For PowerPlex® Y samples:
   a. For samples being sent on for PowerPlex® Y amplification from P30 values, on the “Samples” sheet, change the Calculated Values column to the appropriate letter associated with the P30 value and sample type:

<table>
<thead>
<tr>
<th>Orifice swab, P30 value, 2ng subtraction</th>
<th>Stains P30 value, 0.05 A subtraction</th>
<th>Type this letter in the “Calculated Value” column</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sperm Seen; No P30 ELISA Done</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>1.1 - 3.0</td>
<td>1.1 - 3.0</td>
<td>B</td>
</tr>
<tr>
<td>&gt;0 - 1.0</td>
<td>&gt;0 - 1.0</td>
<td>C</td>
</tr>
</tbody>
</table>
For vaginal swab samples sent for Amylase Positive Extractions, two concentrations must be sent for amplification:

<table>
<thead>
<tr>
<th>Amounts sent to amplification</th>
<th>Type this letter in the Calculated Value column</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNA Target</td>
<td>TE(^{-4})</td>
</tr>
<tr>
<td>8</td>
<td>12</td>
</tr>
<tr>
<td>20</td>
<td>0</td>
</tr>
</tbody>
</table>

b. For samples being sent on for PowerPlex® Y amplification from Quantification values, the amplification sheet should calculate the appropriate DNA and TE\(^{-4}\) target amount on the amplification set.

2. Each amplification sheet can hold up to 28 samples. Since there are 54 samples on a full RotorGene run, it is possible that more than one amplification set is necessary. If this is the case, the overflow samples will automatically be transferred into a second amplification set (i.e. “PowerPlex® Y 2”).

III. PCR Amplification - Sample Preparation

A. Samples amplified with PowerPlex Y reagents should be prepared with TE\(^{-4}\). Prepare dilutions for each sample, if necessary, according to Table 3.

| TABLE 3: Dilutions |
|-------------------|----------------|
| Dilution          | Amount of DNA Template (uL) | Amount of TE\(^{-4}\) (uL) |
| 0.25              | 3 or (2)                   | 9 or (6)                     |
| 0.2               | 2                          | 8                            |
| 0.1               | 2                          | 18                           |
| 0.05              | 2.5                        | 47.5                         |
| 0.04              | 4 or (2)                   | 96 or (48)                   |
| 0.02              | 2 or (1)                   | 98 or (49)                   |
| 0.01              | 2                          | 198                          |
| 0.008             | 4 or (2)                   | 496 or (248)                 |
The target DNA template amount for PowerPlex® Y is 500 pg.

To calculate the amount of template DNA and diluant to add, the following formulas are used:

\[
\text{Amt of DNA (µL)} = \frac{\text{Target Amount (pg)}}{\text{Sample concentration, pg/µL} \times \text{Dilution factor}}
\]

The amount of diluant to add to the reaction = 20 µL – amt of DNA (µL)

The amplification of exemplars, sperm cell fractions of samples extracted by differential lysis and semen stains, where no epithelial cells were seen during the differential lysis, is based on the quantitation results. Semen positive swabs taken from female individuals that were extracted using the non-differential semen extraction and the swab remains fractions of differential lysis samples are amplified using the amounts specified in Table 4. Amylase positive samples should be amplified based on Table 5.

**Table 4:** Amount of DNA extract from a non-differential semen extraction or from the swab/substrate remains fraction of a differential lysis sample to be amplified in PowerPlex® Y.

<table>
<thead>
<tr>
<th>P30 result for the 2ng subtraction (Body cavity swabs)</th>
<th>P30 result for the 0.05A units subtraction (Stains or penile swabs)</th>
<th>DNA Volume (µL) to be amplified</th>
<th>TE⁺(µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sperm Seen; Not Sent to P30 ELISA</td>
<td></td>
<td>8</td>
<td>12</td>
</tr>
<tr>
<td>≥ 1.1</td>
<td>≥ 1.1</td>
<td>8</td>
<td>12</td>
</tr>
<tr>
<td>&gt; 0 - 1.0</td>
<td>&gt; 0 - 1.0</td>
<td>20</td>
<td>0</td>
</tr>
</tbody>
</table>

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Table 5: Amount of DNA extract to be amplified for Amylase positive samples.**

<table>
<thead>
<tr>
<th>Type of item</th>
<th>DNA Target Volume (µL)</th>
<th>TE⁻⁴ (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orifice swab</td>
<td>Initially try two amounts</td>
<td>8 20 12 0</td>
</tr>
<tr>
<td>Dried secretions swab (External)</td>
<td>Based on Quantitation result</td>
<td></td>
</tr>
<tr>
<td>Stain</td>
<td>Based on Quantitation result</td>
<td></td>
</tr>
</tbody>
</table>

** RotorGene does not reflect male DNA, especially for vaginal swabs. Try more or less if negative.

B. Male Positive Control

If using the Promega PowerPlex Y 9948 or Forensic Biology in-house Male Positive Control, remove a tube of MPC from the freezer and thaw. Once thawed, 20 µL of the male positive control may be added directly to the amplification tube.

C. Amplification Negative Control

TE⁻⁴ will serve as an amplification negative control.

D. Master Mix Preparation

1. Retrieve PowerPlex® Y primers, PowerPlex® Y reaction mix and ABI Taq Gold from the freezer and store in a Nalgene cooler on bench. Record the lot numbers of the reagents.
2. Vortex or pipet the reagents up and down several times to thoroughly mix the reagents. **Do not vortex Taq Gold** as it may degrade the enzyme.

After vortexing, centrifuge reagents (except the primers) briefly at full speed to ensure that no sample is trapped in the cap. Primers tubes may be tapped on the benchtop or may be centrifuged at 3000 rpm for 3 seconds if necessary.

3. Consult the amplification documentation for the exact amount of PowerPlex® Y primers, reaction mix and ABI Taq Gold to add. The amount of reagents for one amplification reaction is listed in Table 6.

Table 6 - PowerPlex® Y PCR amplification reagents for one sample

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Per reaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>10X Primer mix</td>
<td>2.5µL</td>
</tr>
<tr>
<td>Gold Star 10X Buffer</td>
<td>2.5µL</td>
</tr>
<tr>
<td>AmpliTaq Gold DNA Polymerase (5U/µL)</td>
<td>0.55uL</td>
</tr>
<tr>
<td>Mastermix total in each sample:</td>
<td>5.55µL</td>
</tr>
<tr>
<td>DNA</td>
<td>20µL</td>
</tr>
</tbody>
</table>

**E. Reagent and Sample Aliquot**

1. Vortex master mix to thoroughly mix. After vortexing, briefly tap or centrifuge the master mix tube to ensure that no reagent is trapped in the cap.

2. Add **5.55 µL** of the PowerPlex® Y master mix to each tube that will be utilized, changing pipette tips and remixing master mix as needed.

**NOTE:** Use a new sterile filter pipet tip for each sample addition. Open only one tube at a time for sample addition.

3. Arrange samples in a rack in precisely the positions they appear on the sheet.

4. **Witness step.** Ensure that your samples are properly positioned.
5. Prior to adding sample or control, pipet each sample or control up and down several times to thoroughly mix. The final aqueous volume in the PCR reaction mix tubes will be 25.55µL. After addition of the DNA, cap each sample before proceeding to the next tube.

6. After all samples have been added, take the rack to the amplified DNA area for Thermal Cycling.

IV. Thermal Cycling

A. Turn on the ABI 9700 Thermal Cycler. (See manufacturer’s instructions).

B. Choose the following files to amplify in PowerPlex Y:

<table>
<thead>
<tr>
<th>PowerPlex Y</th>
</tr>
</thead>
<tbody>
<tr>
<td>user: casewk</td>
</tr>
<tr>
<td>file: powery</td>
</tr>
</tbody>
</table>
PCR Conditions for the Perkin Elmer GeneAmp PCR System 9700

<table>
<thead>
<tr>
<th>Temperature/Action</th>
<th>Time/Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Soak at 95°C</td>
<td>11 minutes</td>
</tr>
<tr>
<td>Soak at 96°C</td>
<td>1 minute</td>
</tr>
<tr>
<td>Ramp 100%</td>
<td></td>
</tr>
<tr>
<td>Denature at 94°C</td>
<td>30 seconds</td>
</tr>
<tr>
<td>Ramp 29%</td>
<td></td>
</tr>
<tr>
<td>Anneal at 60°C</td>
<td>30 seconds</td>
</tr>
<tr>
<td>Ramp 23%</td>
<td></td>
</tr>
<tr>
<td>Extend at 70°C</td>
<td>45 seconds</td>
</tr>
<tr>
<td>For 10 cycles then…</td>
<td></td>
</tr>
<tr>
<td>Ramp 100%</td>
<td></td>
</tr>
<tr>
<td>Denature at 90°C</td>
<td>30 seconds</td>
</tr>
<tr>
<td>Ramp 29%</td>
<td></td>
</tr>
<tr>
<td>Anneal at 58°C</td>
<td>30 seconds</td>
</tr>
<tr>
<td>Ramp 23%</td>
<td></td>
</tr>
<tr>
<td>Extend at 70°C</td>
<td>45 seconds</td>
</tr>
<tr>
<td>For 20 cycles then…</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>30 minute incubation at 60°C.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Storage soak indefinitely at 4°C.</td>
<td></td>
</tr>
</tbody>
</table>

C. 9700 Instructions

1. Place the tubes in the tray in the heat block (do not add mineral oil), slide the heated lid over the tubes, and fasten the lid by pulling the handle forward. Make sure you use a tray that has a 9700 label.

2. Start the run by performing the following steps:

3. The main menu options are RUN CREATE EDIT UTIL USER. To select an option, press the F key (F1...F5) directly under that menu option.
4. Verify that user is set to “casewk.” If it is not, select the USER option (F5) to display the “Select User Name” screen.

5. Use the circular arrow pad to highlight “casewk.” Select the ACCEPT option (F1).

6. Select the RUN option (F1).

7. Use the circular arrow pad to highlight the desired STR system. Select the START option (F1). The “Select Method Options” screen will appear.

8. Verify that the reaction volume is set to 25µL For PowerPlex Y and the ramp speed is set to 9600 (very important).

9. If all is correct, select the START option (F1).

10. Update usage log.

11. The run will start when the heated cover reaches 103°C. The screen will then display a flow chart of the run conditions. A flashing line indicates the step being performed, hold time is counted down. Cycle number is indicated at the top of the screen, counting up.

12. Upon completion of the amplification, remove samples and press the STOP button repeatedly until the “End of Run” screen is displayed. Select the EXIT option (F5). Wipe any condensation from the heat block with a Kimwipe and pull the lid closed to prevent dust from collecting on the heat block. Turn the instrument off.

Note: Place the microtube rack used to set-up the samples for PCR in the container of 10% bleach container in the Post-Amp area in Room 714A.

Revision History:
March 24, 2010 – Initial version of procedure.
March 29, 2011 – Revised Step III.B. Preparation is the same using either the Promega 9948 or in-house made Male Positive Control.
July 16, 2012 – Revised procedure to accommodate LIMS.
April 1, 2013 – The Female Negative Control is no longer being included in the PowerPlex Y kits sold by Promega and is, therefore, removed from the procedures.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
When a run is complete, it will automatically be placed in D:/AppliedBio/Current Runs folder, properly labeled with the instrument name, date and runID (e.g. Run_Venus_2006-07-13_0018).

Prior to importing *.fsa files into GeneScan, the files must have been converted using the conversion tool. Refer to the “STR Data Conversion and Archiving” Section of the STR manual.

A. Access to GeneScan

1. Click on the GeneScan shortcut located on the desktop of the analysis station computer.

2. Create a new GeneScan project by clicking File → New (Ctrl+N). A dialog box with several icons will pop up. Click on the project icon.

An untitled Analysis Control window opens.
3. To add sample files to the open analysis control window, click on **Project** from the menu options and select **Add Sample Files**.

4. When the **Add Sample Files** dialog window appears, find the **Current Run** folder containing the injection folders with the samples that you want to add to the project. Add your samples to the project.
To add samples to a project, take the following action:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a single sample file</td>
<td>Double-click the file OR select the file and click <strong>Add</strong></td>
</tr>
<tr>
<td>Select all the sample files</td>
<td>Click <strong>Add All</strong></td>
</tr>
<tr>
<td>Add a continuous list of sample files</td>
<td>a. Click the first sample that you want to add.</td>
</tr>
<tr>
<td></td>
<td>b. Press the <strong>Shift key</strong> and click the last sample you want to add.</td>
</tr>
<tr>
<td></td>
<td>All the files between the first and last file are selected.</td>
</tr>
<tr>
<td>Add a discontinuous list of samples</td>
<td>a. Click the first sample that you want to add</td>
</tr>
<tr>
<td></td>
<td>b. Press the <strong>Control key</strong> and then click on the other sample(s) you want to add. <strong>Click Add</strong>.</td>
</tr>
<tr>
<td></td>
<td>All the files you selected will be highlighted and selected.</td>
</tr>
</tbody>
</table>

5. Click **Finish** when you have added all of the samples.

B. Analysis Settings

The **Analysis Control** window shows in separate columns the dye lanes, sample file names, size standard options, and analysis parameters to choose for each lane (See options for PowerPlex Y analysis below). Boxes for the red dye lane should be marked with diamonds to indicate that this is the color for the PowerPlex Y size standard.

<table>
<thead>
<tr>
<th>System</th>
<th>Size Standard File</th>
<th>Analysis Parameter File</th>
</tr>
</thead>
<tbody>
<tr>
<td>PowerPlex Y</td>
<td>PowerY.szs</td>
<td>PowerY.gsp</td>
</tr>
</tbody>
</table>

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
PowerPlex Y Analysis Parameters

Do not change any of the settings except the range or the peak amplitude threshold for Red (R).
C. Analysis

To ensure that all the sizing results are correct, check the labeling of the size standard peaks for each sample.

Any case documentation developed outside of the LIMS system should be scanned to a PDF document and attached to the appropriate electronic case record.

1. To view the analysis results, select Windows from the main menu and click on Results Control. The analyzed colors for each lane are shown in dark grey. The white squares mean that this color has not been analyzed.

2. The raw data can be seen in up to 8 display panels by changing the # of panels to 8. To view each color separately, check Quick Tile to On.

3. Select the first 8 size standard dye lanes by clicking on them and then click Display. Each sample standard will be displayed in its own window. To view all 8 standards, you must scroll through all of the windows. Make sure that all peaks are correctly labeled. Continue checking your size standard for the entire tray by going back to the Results Control window, clicking on Clear All and selecting the next 8 samples. Repeat these steps until all of the sample size standards have been checked.

   For PowerPlex Y, at least the 60 – 375 bp size standards must be apparent.

Before proceeding with the Genotyper analysis, under File select Save Project As. The project will be named according to the Sample Sheet name. This file will save as a *.prj file in the run folder.
D. GenoTyper Analysis for PowerPlex® Y

1. Open the Genotyper macro for PowerPlex® Y by clicking on the PowerPlex® Y Genotyper shortcut on the desktop of the analysis station computer. Under File go to Import and select From GeneScan File. Double-click on the folder containing the PowerPlex® Y project that you created in GeneScan. Click Add or double-click on the project icon to add the project for analysis. When the project has been added, click Finish.

2. Under View select Show Dye/Lanes window you will see a list of the samples you have imported from GeneScan analysis. If samples need to be removed, highlight the lanes for these samples and select Cut from the Edit menu.

3. Change the name of the PowerPlex® Y Genotyper template to your initials and the casework run file name (under File select Save As).

   For example: “Stripes04-001PPY EL” for PowerPlex Y runs

4. After importing the project and saving the Genotyper file run the first Macro by simultaneously press Control key and the number 1, or double clicking “Power”.

5. The plot window will appear automatically when the macro is completed. Check to make sure that the ladders that were run match the allele sequence shown below. Also check the results for the positive control.

   Table 1

<table>
<thead>
<tr>
<th>Multiplex System</th>
<th>Necessary LIZ GS500 standard peaks</th>
</tr>
</thead>
<tbody>
<tr>
<td>PowerPlex® Y</td>
<td>15 fragments from 60 - 375 bp</td>
</tr>
</tbody>
</table>
PowerPlex® Y ALLELIC LADDER

[Graph showing allelic ladder for different loci]
# TABLE 2  PowerPlex® Y 9948 Male Positive Control

<table>
<thead>
<tr>
<th>Color (Fluor)</th>
<th>DYS391</th>
<th>DYS389I</th>
<th>DYS439</th>
<th>DYS389II</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue (FL)</td>
<td>10</td>
<td>13</td>
<td>12</td>
<td>31</td>
</tr>
<tr>
<td>Green (JOE)</td>
<td>DYS438</td>
<td>DYS437</td>
<td>DYS19</td>
<td>DYS392</td>
</tr>
<tr>
<td>Yellow (TMR)</td>
<td>DYS393</td>
<td>DYS390</td>
<td>DYS385</td>
<td></td>
</tr>
<tr>
<td></td>
<td>13</td>
<td>24</td>
<td>11, 14</td>
<td></td>
</tr>
</tbody>
</table>
TABLE 2b  Forensic Biology In-House Male Positive Control
(As of August 2, 2010; NIST Traceable)

<table>
<thead>
<tr>
<th>Color (Abbrev)</th>
<th>DYS391</th>
<th>DYS389I</th>
<th>DYS439</th>
<th>DYS389II</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue (FL)</td>
<td>10</td>
<td>13</td>
<td>12</td>
<td>29</td>
</tr>
<tr>
<td>Green (JOE)</td>
<td>10</td>
<td>14</td>
<td>14</td>
<td>13</td>
</tr>
<tr>
<td>Yellow (TMR)</td>
<td>15</td>
<td>25</td>
<td>13, 19</td>
<td></td>
</tr>
</tbody>
</table>

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
F. Viewing samples

1. Check all lanes or Under Views→Show Main Window and highlight the appropriate samples. Under View→Show Plot Window (Ctrl+Y) or click on the plots icon to view the electropherogram.

2. The plot scan range for PowerPlex Y should be set in the plots window, under Views→Zoom To… type 75 and 340 in the dialog box.

G. Editing of Genotyper files

Peaks can be removed if they meet one of the criteria listed in the editing section (12.II of the STR Manual). Labels for extra peaks can be manually deleted by placing the cursor on the peak above the baseline and clicking. This removal must be documented.

Based on the validation and on the Promega PowerPlex® Y System Technical Manual, for PowerPlex Y, known artifacts tend to occur at the following locations and may be edited out as “specific artifacts.”

- **DYS19** and **DYS389II** can display low-level products in the n-2 and n+2 positions.
- **DYS437** and **DYS385** can display low-level peaks in the n-5, n-9 and n-10 positions.
- **DYS393** can display low-level peaks in the n-9 and n-10 position.
At this stage it is also necessary to make decisions about samples that should be rerun with either more or less amount of amplification product.

If a sample displays allele peaks just below the instrument detection threshold there is a distinct possibility that the alleles can be identified after a repeated run with increased amplification product or higher injection parameters. Schedule the sample for a rerun. For PowerPlex Y, use 2 ul of amplified sample with the Rerun Module (3 kV 10 sec).

H. Preparing Samples for Printing

1. Display all samples and the positive and negative controls with basepairs, peak heights, and category names. The relevant allelic ladder is labeled with basepairs and category names only.

2. Highlight all samples except the Ladder and under Analysis ➔ Change Labels. Select peak heights, basepairs, and category names.

3. Highlight the relevant Allelic Ladder under Analysis ➔ Change Labels. Select basepairs and category names.

   Ensure that the view is set to 75 to 340 bp prior to printing.

I. Printing Controls

1. In the main view window, highlight the ladder, and all the controls.

2. Highlight all colors.

3. Make sure that the view is set to 75-340.

4. Under File ➔ Print ➔ Properties button ➔ Finishing tab ➔ Document Options ➔ Pages per Sheet ➔ select “2 pages per sheet” ➔ Orientation ➔ click on “Portrait” ➔ click OK ➔ OK

5. Print to a pdf document, and save into the directory with the original 3130xl run data.

6. Once printed, ensure that all alleles in the ladder are labeled.
J. Printing Samples

To print the electropherograms for samples, select all samples and print following steps 2-5 from the “Printing Controls” section.

K. Create a table by running the Create Table Macro.

1. Double click “Make Allele Table” or press “Control +8”. The table will open once the macro has completed.

2. Compare the sample information in the table with the amplification and the run control sheet. If an error is detected at this point it can be corrected as follows:
   a. Open the dye/lane window or “sample info box”
   b. Place the cursor in the sample info box and correct the text
   c. Clear the table by going to Analysis on the main menu, select Clear Table
   d. Select the appropriate colors by shift clicking on the dye buttons or using edit
   e. Run Create Table Macro again.

3. Before printing the results make sure the file is named properly, including initials. Print the table to a pdf document with the “Pages per Sheet” set to 4 and with the orientation set to Landscape.

4. After the printing is finished, under file ➔ quit Genotyper. Click save. Normally the software will place the Genotyper file to the folder from which the data were imported. Make sure that the Genotyper is saved in the appropriate folder.

5. Pull the rerun samples and list on the appropriate rerun documentation.

6. Have a supervisor review the analyzed run.

Revision History:
March 24, 2010 – Initial version of procedure.
August 2, 2010 – The profile of the in-house Male Positive Control was changed (Table 2b, Page 9)
July 16, 2012 – Revised procedure to accommodate LIMS.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Refer to the “Identifiler Analysis on the ABI 3130xl Genetic Analyzer” procedures for instructions on how to:
1. set up the 3130xl instrument
2. create, import, and link the plate record
3. troubleshoot

A. Preparation of 3130xl Batch
Ensure that the appropriate System is filled into the “Sys” column.

Table 1

<table>
<thead>
<tr>
<th>Amplification System/Cycle</th>
<th>Specification</th>
<th>Run Module Code</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>PowerPlex Y</td>
<td>Normal</td>
<td>Y</td>
<td>3 kV for 5 sec</td>
</tr>
<tr>
<td>High</td>
<td>YR</td>
<td></td>
<td>3 kV for 10 sec</td>
</tr>
</tbody>
</table>

Mastermix and Sample Addition for PowerPlex® Y

1. Prepare one mastermix for all samples, negative and positive controls, allelic ladders as specified in the table below. (Mastermix calculation, add 9.5µL HiDi + 0.5µL ILS 600 standard per sample).

<table>
<thead>
<tr>
<th># Samples</th>
<th>HiDi Form (9.5 µL per sample)</th>
<th>ILS600 Std (0.5 µL per sample)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>171 µL</td>
<td>9 µL</td>
</tr>
<tr>
<td>16</td>
<td>323 µL</td>
<td>17 µL</td>
</tr>
<tr>
<td>32</td>
<td>475 µL</td>
<td>25 µL</td>
</tr>
<tr>
<td>64</td>
<td>627 µL</td>
<td>33 µL</td>
</tr>
<tr>
<td>80</td>
<td>779 µL</td>
<td>41 µL</td>
</tr>
<tr>
<td>96</td>
<td>931 µL</td>
<td>49 µL</td>
</tr>
<tr>
<td>112</td>
<td>1083 µL</td>
<td>57 µL</td>
</tr>
<tr>
<td>128</td>
<td>1235 µL</td>
<td>65 µL</td>
</tr>
</tbody>
</table>

NOTE: HiDi Formamide cannot be re-frozen.

2. Obtain a reaction plate and label the side with the name used for the 3130xl Run ID with a sharpie and place the plate in an amplification tray or the plate base. Aliquot 10µL of mastermix to each well.
C. Adding Samples:

1. Arrange amplified samples in a 96-well rack according to how they will be loaded into the 96-well reaction plate. Sample order is as follows: A1, B1, C1, D1... G1, H1, A2, B2, C2... G2, H2, A3, B3, C3, etc. Thus the plate is loaded in a columnar manner where the first injection corresponds to wells A1-H2, the second A3-H4 and so on.

2. Have someone witness the tube setup by comparing the tube labels and positions indicated on the sample sheet with the tube labels and positions of the tubes themselves.

3. For samples being run at normal parameters: Aliquot the following:

   Allelic Ladder: 1 µL
   Positive/Negative Controls: 2 µL
   Samples: 2 µL

4. For samples being run at high parameters: Aliquot the following:

   Allelic Ladder: 2 µL of a 1/10 dilution
   Positive/Negative Control: 4 µL
   Samples: 4 µL

5. When adding PCR product, make sure to pipette the solution directly into the formamide and gently flush the pipette tip up and down a few times to mix it.

6. If an injection has less than 16 samples, add at least 12µL of either dH2O, formamide, HiDi, buffer or mastermix to all unused wells within that injection.

D. Denature/Chill - For PowerPlex Y After Sample Addition:

1. Once all of the samples have been added to the plate, place a new 96-well Septa over the reaction plate and firmly press the septa into place.

2. Spin plate in centrifuge at 1000 RPM for one minute.
3. For Denature/Chill:
   a. Place the plate on a 9700 thermal Cycler (Make sure to keep the Thermal Cycler lid off of the sample tray to prevent the septa from heating up.)
   b. Select the “dechillppy” program for PowerPlex Y (95°C for 3 minutes followed by 4°C for 3 minutes). Make sure the volume is set to 12 µL.
   c. Press Run on the Thermal Cycler.
   d. Update usage log.
   e. While the denature/chill is occurring, you can turn on the oven on the ABI 3130xl.

E. 3130xl Settings

3130xl visible settings:
- EP voltage 15kV
- EP current (no set value)
- Laser Power Prerun 15 mW
- Laser Power During run 15mW
- Laser Current (no set value)
- Oven temperature 60°C

Expected values are:
- EP current constant around 120 to 160µA
- Laser current: 5.0A ± 1.0

It is good practice to monitor the initial injections in order to detect problems.

Table 2

<table>
<thead>
<tr>
<th></th>
<th>Y</th>
<th>YR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oven Temp</td>
<td>60°C</td>
<td>60°C</td>
</tr>
<tr>
<td>Pre-Run Voltage</td>
<td>15.0 kV</td>
<td>15.0 kV</td>
</tr>
<tr>
<td>Pre-Run Time</td>
<td>180 sec</td>
<td>180 sec</td>
</tr>
<tr>
<td>Injection Voltage</td>
<td>3 kV</td>
<td>3 kV</td>
</tr>
<tr>
<td>Injection Time</td>
<td>5 sec</td>
<td>10 sec</td>
</tr>
<tr>
<td>Run Voltage</td>
<td>15 kV</td>
<td>15 kV</td>
</tr>
<tr>
<td>Run Time</td>
<td>2000 sec</td>
<td>2000 sec</td>
</tr>
</tbody>
</table>

Revision History:
March 24, 2010 – Initial version of procedure.
March 29, 2011 – Revised Step C.3 and C.4: amount aliquotted from positive/negative control and samples is doubled.
July 16, 2012 – Revised procedure to accommodate LIMS.
I. General Information for AmpFL®STR® MiniFiler™ PCR Amplification

The MiniFiler™ PCR Amplification Kit from Applied Biosystems is a miniature STR (miniSTR) test that utilizes reduced size primers to target Amelogenin and eight of the larger STR loci amplified with Identifiler® (D13S317, D7S820, D2S1338, D21S11, D16S539, D18S51, CSF1PO and FGA). The MiniFiler™ amplification results in amplicons that are significantly shorter in length than those produced with Identifiler® (see Figure 1). MiniFiler™ can be used in conjunction with Identifiler® to recover the larger loci that typically drop-out due to sample degradation. It can also be used for samples that may be inhibited and show no amplification with Identifiler®.

Figure 1. Amplicon size reduction of MiniFiler™ compared to the same STR loci in Identifiler®. Image from Applied Biosystems’s “MiniFiler™ Kit Multiplex Configuration,” 2006. http://marketing.appliedbiosystems.com/images/Product_Microsites/Minifiler1106/pdf/MplexConfig.pdf

The target DNA concentration for amplification using the MiniFiler™ system is 500 pg. The minimum DNA concentration required for amplification in this system is 100 pg (minimum quantititation value of 10 pg/µL). If a sample is found to contain less than 10 pg/µL of DNA, then the sample should not be amplified in MiniFiler™. It can be re-extracted, reported as containing insufficient DNA, concentrated using a Microcon DNA Fast Flow or possibly submitted for High Sensitivity testing (see Table 1).
TABLE 1: For MiniFiler™

<table>
<thead>
<tr>
<th>Minimum Desired Template</th>
<th>100 pg</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template Volume for Amp</td>
<td>10 µL</td>
</tr>
<tr>
<td>Minimum Sample Concentration in 200 µL</td>
<td>10.0 pg/µL</td>
</tr>
<tr>
<td>Minimum Sample Concentration in 200 µL prior to Microconning* to 50 µL</td>
<td>2.5 pg/µL</td>
</tr>
<tr>
<td>Minimum Sample Concentration in 200 µL prior to Microconning** to 20 µL</td>
<td>1.0 pg/µL</td>
</tr>
</tbody>
</table>

* Sample concentration prior to processing with a Microcon DNA Fast Flow and elution to 50 µL
** Sample concentration prior to processing with a Microcon DNA Fast Flow and elution to 20 µL

Since MiniFiler™ has a template amplification volume of 10 µL, the extraction negative must have a quantitation value of ≤ 0.1 pg/µL. Thus, if the extraction negative is > 0.1 pg/µL, it should be re-quantitated. If it fails again, the sample set must be re-extracted prior to amplification (see Table 2).

TABLE 2: Amplification System

<table>
<thead>
<tr>
<th>Amplification System</th>
<th>Sensitivity of Amplification</th>
<th>Extraction Negative Control Threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>MiniFiler™</td>
<td>10 pg</td>
<td>0.10 pg/µL in 10 µL</td>
</tr>
</tbody>
</table>
II. Generation of Amplification Sets

Amp sets are generated by supervisors following review of quantification results. Furthermore, samples may be submitted for amplification through sample request documentation.

III. PCR Amplification – Sample Preparation

A. Samples amplified with MiniFiler™ reagents should be prepared with irradiated TE<sup>−4</sup>.

Prepare dilutions for each sample, if necessary, according to Table 3.

<table>
<thead>
<tr>
<th>TABLE 3: Dilutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dilution</td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td>0.25</td>
</tr>
<tr>
<td>0.2</td>
</tr>
<tr>
<td>0.1</td>
</tr>
<tr>
<td>0.05</td>
</tr>
<tr>
<td>0.04</td>
</tr>
<tr>
<td>0.02</td>
</tr>
<tr>
<td>0.01</td>
</tr>
<tr>
<td>0.008</td>
</tr>
</tbody>
</table>

The target DNA template amount for MiniFiler™ is 500 pg.

To calculate the amount of template DNA and diluent to add, the following formulas are used:

\[
\text{Amt of DNA (µL)} = \frac{\text{Target Amount (pg)}}{\text{(Sample concentration, pg/µL)(Dilution factor)}}
\]

The amount of diluent to add to the reaction = 10 µL – amt of DNA (µL)

For samples with RotorGene values ≤50 pg/µL but >10 pg/µL, aliquot 10 µL extract.
B. Positive Control

For MiniFiler™, DO NOT make a dilution of the 100 pg/µL AmpF/STR Control DNA 007. Instead, combine 5 µL of the Control DNA with 5 µL of irradiated TE⁻⁴. This yields a total volume of 10 µL with 500 pg in the amplification.

C. Amplification Negative Control

10 µL of irradiated TE⁻⁴ will serve as an Amplification Negative Control.

D. Master Mix Preparation

1. Retrieve the MiniFiler™ Primer Set and MiniFiler™ Master Mix from the refrigerator and store in a Nalgene cooler on the bench. Record the lot numbers of the reagents.

2. Vortex or pipette the reagents up and down several times to thoroughly mix the reagents. After vortexing, centrifuge reagents at full speed briefly to ensure that no sample is trapped in the cap.

3. Consult the amplification documentation for the exact amount of MiniFiler™ Primer Set and Master Mix to add. The amount of reagents for one amplification reaction is listed in Table 4.

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Per reaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>MiniFiler™ Primer Set</td>
<td>5.0 µL</td>
</tr>
<tr>
<td>MiniFiler™ Master Mix</td>
<td>10.0 µL</td>
</tr>
</tbody>
</table>

TABLE 4: MiniFiler™ PCR amplification reagents for one sample

Document Control Coordinator

ARCHIVED 05/21/14
E. Reagent and Sample Aliquot

1. Vortex master mix to thoroughly mix. After vortexing, briefly tap or centrifuge the master mix tube to ensure that no reagent is trapped in the cap.

2. Add 15 µL of the MiniFiler™ reaction mix to each of the stratalinked PCR tubes that will be utilized, changing pipette tips and remixing reaction mix as needed.

NOTE: Use a new sterile filter pipet tip for each sample addition. Open only one tube at a time for sample addition.

3. Arrange samples in a rack in precisely the positions they appear on the sheet.

4. Witness step. Ensure that your samples are properly positioned.

5. Prior to adding sample or control, pipette each sample or control up and down several times to thoroughly mix. The final aqueous volume in the PCR reaction mix tubes will be 25 µL. After addition of the DNA, cap each sample before proceeding to the next tube.

6. After all samples have been added, take the rack to the amplified DNA area for Thermal Cycling.

IV. Thermal Cycling

1. Turn on the ABI 9700 Thermal Cycler. (See manufacturer's instructions).
2. Choose the following files in order to amplify in MiniFiler™:

<table>
<thead>
<tr>
<th>Minifiler</th>
</tr>
</thead>
<tbody>
<tr>
<td>User: casewk</td>
</tr>
<tr>
<td>File: mini</td>
</tr>
</tbody>
</table>

**PCR Conditions for the Perkin Elmer GeneAmp PCR System 9700**

<table>
<thead>
<tr>
<th>9700</th>
<th>MiniFiler</th>
</tr>
</thead>
<tbody>
<tr>
<td>User: casewk</td>
<td>The mini file is as follows:</td>
</tr>
<tr>
<td>File: mini</td>
<td>Soak at 95°C for 11 minutes</td>
</tr>
<tr>
<td></td>
<td>: Denature at 94°C for 20 seconds</td>
</tr>
<tr>
<td></td>
<td>: 30 Cycles: Anneal at 59°C for 2 minutes</td>
</tr>
<tr>
<td></td>
<td>: Extend at 72°C for 1 minute</td>
</tr>
<tr>
<td></td>
<td>45 minute incubation at 60°C.</td>
</tr>
<tr>
<td></td>
<td>Storage soak indefinitely at 4°C</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3. 9700 Instructions

a. Place the tubes in the tray in the heat block (**do not add mineral oil**). Slide the heated lid over the tubes, and fasten the lid by pulling the handle forward. Make sure you use a tray that has a 9700 label.

b. Start the run by performing the following steps:

c. The main menu options are RUN CREATE EDIT UTIL USER. To select an option, press the F key (F1…F5) directly under that menu option.

d. Verify that user is set to “casewk.” If it is not, select the USER option (F5) to display the “Select User Name” screen.

e. Use the circular arrow pad to highlight “casewk.” Select the ACCEPT option (F1).

f. Select the RUN option (F1).
g. Use the circular arrow pad to highlight the desired STR system. Select the START option (F1). The “Select Method Options” screen will appear.

h. Verify that the reaction volume is set to 25µL for MiniFiler™ and the ramp speed is set to 9600 (very important).

i. If all is correct, select the START option (F1).

j. The run will start when the heated cover reaches 103°C. The screen will then display a flow chart of the run conditions. A flashing line indicates the step being performed, hold time is counted down. Cycle number is indicated at the top of the screen, counting up.

k. Upon completion of the amplification, remove samples and press the STOP button repeatedly until the “End of Run” screen is displayed. Select the EXIT option (F5). Wipe any condensation from the heat block with a Kimwipe and pull the lid closed to prevent dust from collecting on the heat block. Turn the instrument off.

NOTE: Place the microtube rack used to set-up the samples for PCR in the container of 10% bleach container in the Post-Amp area in Room 714A.

Revision History:
March 24, 2010 – Initial version of procedure.
July 16, 2012 – Revised procedure to accommodate LIMS.
December 28, 2012 – YM100 microcons were discontinued by the manufacturer. The manufacturer is now producing the DNA Fast Flow Microcons. All references to the YM100’s have been revised to the “DNA Fast Flow.”

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Refer to the “Identifiler Analysis on the ABI 3130xl Genetic Analyzer” manual for instructions on how to:

1. set up the 3130xl instrument
2. create, import, and link the plate record
3. troubleshoot

A. Preparation of 3130xl batch

Ensure that the appropriate System is filled into the “Sys” column.

Table 1

<table>
<thead>
<tr>
<th>Amplification System/Cycle</th>
<th>Specification</th>
<th>Run Module Code</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>MiniFiler™</td>
<td>Normal</td>
<td>F</td>
<td>3 kV for 10 sec</td>
</tr>
</tbody>
</table>

B. Master Mix and Sample Addition for MiniFiler™

1. Prepare one master mix for all samples, negative and positive controls, and allelic ladders as specified in the table below (master mix calculation: add 8.7 µL HiDi + 0.3 µL LIZ500 standard per sample).

<table>
<thead>
<tr>
<th># Samples + 2</th>
<th>HiDi Form (8.7 µL per sample)</th>
<th>LIZ500 Std (0.3 µL per sample)</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>157 µL</td>
<td>6 µL</td>
</tr>
<tr>
<td>32</td>
<td>296 µL</td>
<td>11 µL</td>
</tr>
<tr>
<td>48</td>
<td>436 µL</td>
<td>16 µL</td>
</tr>
<tr>
<td>64</td>
<td>575 µL</td>
<td>20 µL</td>
</tr>
<tr>
<td>80</td>
<td>714 µL</td>
<td>25 µL</td>
</tr>
<tr>
<td>96</td>
<td>853 µL</td>
<td>30 µL</td>
</tr>
<tr>
<td>112</td>
<td>992 µL</td>
<td>35 µL</td>
</tr>
<tr>
<td>128</td>
<td>1132 µL</td>
<td>40 µL</td>
</tr>
</tbody>
</table>

NOTE: HiDi Formamide cannot be re-frozen.

2. Obtain a reaction plate and label the side with the name used for the 3130xl Run ID with a sharpie and place the plate in an amplification tray or the plate base. Aliquot 9 µL of mastermix to each well.
C. Adding Samples:

1. Arrange amplified samples in a 96-well rack according to how they will be loaded into the 96-well reaction plate. Sample order is as follows: A1, B1, C1, D1... G1, H1, A2, B2, C2...G2, H2, A3, B3, C3, etc. Thus the plate is loaded in a columnar manner where the first injection corresponds to wells A1-H2, the second A3-H4 and so on.

2. Have someone witness the tube setup by comparing the tube labels and positions indicated on the sample sheet with the tube labels and positions of the tubes themselves.

3. Aliquot the following:
   - Allelic Ladder: 1 µL
   - Positive/Negative Controls: 1 µL
   - Samples: 1 µL

4. When adding PCR product, make sure to pipette the solution directly into the formamide and gently flush the pipette tip up and down a few times to mix it.

5. If an injection has less than 16 samples, add 10 µL of either dH2O, HiDi formamide, or master mix to all unused wells within that injection.

D. Denature/Chill – For MiniFiler™ After Sample Addition:

1. Once all of the samples have been added to the plate, place a new 96-well Septa over the reaction plate and firmly press the septa into place.

2. Spin plate in centrifuge at 1000 RPM for one minute.

3. For Denature/Chill:
   a. Place the plate on a 9700 Thermal Cycler (Make sure to keep the Thermal Cycler lid off of the sample tray to prevent the septa from heating up).
   b. Select the “denature/chill” program. Make sure the volume is set to 10 µL.
c. Press Run on the Thermal Cycler. The program will heat denature samples at 95°C for 5 minutes followed by a quick chill at 4°C (this will run indefinitely, but the plate should be left on the block for at least 5 min).

d. Update usage log.

e. While the denature/chill is occurring, you can turn on the oven on the ABI 3130xl.

E. 3130xl Settings

3130xl visible settings:
- EP voltage 15kV
- EP current (no set value)
- Laser Power Prelim 15 mW
- Laser Power During run 15 mW
- Laser Current (no set value)
- Oven temperature 60°C

Expected values are:
- EP current constant around 120 to 160 μA
- Laser current: 5.0A ± 1.0

It is good practice to monitor the initial injections in order to detect problems.

Table 2

<table>
<thead>
<tr>
<th></th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oven Temp</td>
<td>60°C</td>
</tr>
<tr>
<td>Pre-Run Voltage</td>
<td>15.0 kV</td>
</tr>
<tr>
<td>Pre-Run Time</td>
<td>180 sec</td>
</tr>
<tr>
<td>Injection Voltage</td>
<td>3 kV</td>
</tr>
<tr>
<td>Injection Time</td>
<td>10 sec</td>
</tr>
<tr>
<td>Run Voltage</td>
<td>15 kV</td>
</tr>
<tr>
<td>Run Time</td>
<td>1500 sec</td>
</tr>
</tbody>
</table>
March 24, 2010 – Initial version of procedure.
July 16, 2012 – Revised procedure to accommodate LIMS.
A. CREATING A NEW PROJECT

1. Double click on the GeneMapper ID v3.2.1 icon on the analysis station desktop.
2. When prompted, enter your username and password.
3. The program will automatically open a new (blank) project. This main window is called the “Project Window”.
4. Click on File→Add Samples to Project… or Ctrl+K. A new window will open, listing the drives or folders from which to add the samples on the left.
5. Navigate to the proper drive, and choose the folder that contains the run folders or samples that need to be analyzed. Select the run folder(s) or samples and click on Add to List.
6. On the bottom right Click Add. The chosen samples will now populate the project.

Adding by Sample File (.fsa file):

![Adding by Sample File](image)
Adding by Run Folder:
B. ANALYSIS SETTINGS

1. All defined settings must be used and can be referenced in Appendix D. Analysis Method Editor and Appendix G. Default Table and Plot Settings.

2. From the “Table Setting” drop-down menu in the toolbar, select “Analysis View”.

Project Window:

3. If the ladders, positive control, and negative control have not yet been designated, do so now under “Sample Type”.

4. When there is more than one ladder in a project, designate one of the ladders as “Allelic Ladder” in the Sample Type column. Additional allelic ladders within the project should be designated as “Sample”. If the allelic ladder analyzes correctly, the additional ladders should be deleted from the project. If the allelic ladder does not analyze correctly, another allelic ladder in the project or folder may be designated as “Allelic Ladder” and the failed ladder deleted.

Project Window:
5. Fill in the correct analysis method, panel, and size standard following the table below. Once the analysis method, panel, and size standard have been chosen for the first sample, you can fill down the same information by selecting all three columns. Do this by selecting the title row of the columns and then while holding down the left mouse button drag across the three columns, the selected columns will be highlighted blue. Next, click on Edit ➔ Fill Down or Ctrl+D.

<table>
<thead>
<tr>
<th>System</th>
<th>Analysis Method</th>
<th>Panel</th>
<th>Size Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifiler 28 Cycles</td>
<td>ID Analysis</td>
<td>ID28</td>
<td>LIZ-250-340</td>
</tr>
<tr>
<td>Identifiler 31 Cycles</td>
<td>ID Analysis</td>
<td>ID31</td>
<td>LIZ-250-340</td>
</tr>
<tr>
<td>MiniFiler</td>
<td>MiniFiler Analysis</td>
<td>MiniFiler_GS500_v1</td>
<td>LIZ-250-340</td>
</tr>
<tr>
<td>YFiler</td>
<td>YFiler</td>
<td>YFiler_v2</td>
<td>LIZ-YFiler</td>
</tr>
</tbody>
</table>

6. A green arrow in the Status column of each sample means that the data is ready to be analyzed. Click on the green arrow in the toolbar. A “save project” prompt will pop-up asking for the run to be named.

7. Name the project with the same name of the run (and the analyst’s initials if applicable), e.g., “Stripes09-098IDejb” or “HS3030607_78N.” Click OK to start analysis.

8. The progress of the analysis can be seen at the bottom of the project window in the progress status bar. Once analysis is finished the blue progress bar will stop, and the bottom left corner of the screen will read “Analysis Completed.”
C. VIEWING ANALYZED DATA

Samples View – Overall Sample Quality Flags

1. In the Project Window under the Samples tab, the columns to the right side with colored shapes are Process Quality Value (PQV) flags. These flags do not replace our method for editing samples. Each sample must still be viewed and edited. The flags are simply a tool to draw your attention to samples that have analysis problems therefore assisting you with initial analysis, and editing.

2. The Pass (green square) symbol indicates that no problem exists. If a yellow “check” flag, or a red “low quality” flag result in any of the columns, refer to the appendix A – “Quality Flags” for a description of the flags and the problems they identify. Whether a problem is flagged or not, proceed to the sizing section of the manual to individually check each size standard.
D. SIZING

1. Select all of the samples in the Samples tab by clicking on Edit → Select All.

2. Next, click on the Sizing icon and the Size Match Editor window will open.

3. Using the arrow keys, scroll through the samples on the left column and check the sizing for each sample in the Size Matches tab. The sizing is displayed as a plot with the base pairs displayed above each peak. See Appendix F for a reference of size standards.

   a. Identifiler samples are run with LIZ 500 and should not have the 250 bp or 340 bp size standard labeled. At least the 100bp to 450bp peaks must be present for proper sizing.
b. MiniFiler samples are run with LIZ 500 and should not have the 250 bp or 340 bp size standard labeled. At least the 75bp to 400bp peaks must be present for proper sizing.

c. Yfiler™ samples are run with LIZ 500 (LIZ-YFiler) and should not have the 250 bp size standard labeled. At least the 75 – 400 bp peaks must be present for proper sizing.

4. **Red octagon symbol in the SQ column of the project window:**

In some cases you may still be able to use this data by redefining the size standard for that sample. For instructions on how to re-label peaks which have been incorrectly labeled, see the Appendix E – Troubleshooting section of this manual.

5. While still in the Size Match Editor window document that each sample size standard has been inspected by selecting **Edit -> Override All SQ** or **Ctrl+Shift+O**; Click **Apply** and then **OK**. The Size Match Editor window will then automatically close. A blue “X” will appear in the sizing quality check box (SQO) for each sample, signaling that the size standard for each sample has been reviewed.

6. If a green triangle appears in the status column for any of the samples after you applied the SQO, press the green analyze button in the toolbar to finish the sizing quality override.
E. PLOT VIEWS

Samples Plot – Reviewing Ladders, Controls, and Samples

1. First, check the ladders and controls in the project using the following steps. If a project contains more than one allelic ladder, each ladder must be reviewed and pass analysis. Then repeat the steps for the samples. See Appendix F for a reference of allelic ladders and positive controls.

2. If there are two positive controls of the same date and time (i.e. high and normal), you can remove one by selecting it in the Samples tab of the Project Window, then from the pull down menu select Edit → Delete from Project → OK.

3. In the Samples tab of the Project Window, select the sample rows you want to view (i.e. ladders, controls, or samples) then click the plot button to display the plots (Analysis → Display Plots or Ctrl+L). Use the shift key or the ctrl key to select multiple samples.

4. In the “Samples Plot” window toolbar there is a Plot Setting dropdown list. For Identifiler and YFiler, select “Analysis View.” For Minifiler, select “Mini Analysis.” This will label the peaks with base pairs, RFUs and allele name.
5. Adjust the window zoom by right clicking above the plot pane and using the X Axis Zooming dialog box to zoom into a specific range. Alternatively, hover the mouse above the panel, it will change into a magnifying glass that can be used to draw a box around a selected area to zoom in.

6. If you still have “no room for labels”, for example when you have many alleles per locus such as the Allelic Ladder, it may be easier to review the sample in the “Genotypes Plot” as described in Appendix E – Troubleshooting Guide, 3. Genotypes Plot – Locus Specific Quality Flags. The Genotypes Plot is an alternate view option showing each locus in a separate pane. The locus specific quality flags can only be viewed in the Genotypes Plot window.

NOTE: Refer to the Appendix A – “Quality Flags” for a description of the flags and the problems they identify.
F. EDITING

Electronic Editing – First Analysis

1. You can view the sample in the Samples Plot window or the Genotypes Plot window or minimize back and forth between these views to facilitate analysis. Just ensure that you are using the correct view settings (“Analysis View” or “Mini Analysis.”)

2. Left click on the allele in question to select it.

3. To edit the allele you must right click on it while it is highlighted and you will see a list of three choices – Delete Allele(s); Rename Allele(s); History.

4. Select Rename Allele; another drop down menu will appear listing all of the possible choices for alleles at that locus including “?” and Custom.
5. If the sample has been labeled an Off Ladder (OL), choose “?”.
If the peak has been given an allele call, chose that same allele call from the drop-down list.

For example, if a pull-up peak has been labeled a 7, highlight the 7 then right click and rename the allele 7 from the drop-down menu. This is done so that the reviewer can see what the allele was originally called.

6. A dialog box will then prompt you for an Edit Allele Comment. In the box enter the code for the allele edit (see Appendix B for a list of editing codes).

7. Click OK.

8. You will notice on the electropherogram that the peak has been labeled as follows: “changed”, the allele call, base pair, and RFU, followed by the corresponding edit code.
9. If you are removing all the peaks in the entire sample because it needs to be rerun, for example, when a sample is completely overblown, then you can delete all the peaks together without renaming each peak. The rerun is documented in column UD1.
   a. To delete a range of peaks, select the first peak of the range, and while the first peak is still highlighted, drag a box across the range of peaks to select everything. Right click on the selection and click Delete Allele(s). When doing so, a box may pop-up with a message that more than one allele will be deleted. Click OK then enter the edit type in the allele comment box.
   b. If the removed peaks need to be put back in, highlight the necessary samples from the Samples tab in the project window. From the Analysis drop down menu, select “Analyze Selected Samples.” A pop up window will ask for confirmation and state the action cannot be undone. Click OK. Edit the sample(s) appropriately. If this action is done as a change to the original project, there is no need to change the project name. Create new tables and re-export the project.

10. If you mistakenly delete a peak instead of renaming it first try to undo by selecting edit from the drop down menu then select undo. You can undo as many changes as you made while that plot window was open, but if you close and re-open the plot window you will not be able to undo.

11. To revert a deleted peak back to the original allele call, select the peak, right click, then choose add allele call when prompted for an add allele comment leave it blank.
   a. The original allele call will be added to the peak but the word “changed” will still appear in the label.
   b. The word “changed” will not appear in the printed electropherogram, but it will appear in the electronic editing sheet as a sample entry with no edit comment.
c. When the editing sheet is generated, scan through the sheet for any sample entries without edit comments; these are the peaks that were added back in. **Manually remove them from the worksheet before you print.**

12. Once editing has been completed, you can view the edits in the Genotypes table. This table contains all of the alleles, sizes, and edits for all of the samples. Up to 15 edits can be captured per locus.

---

Electronic Rerun Sheet

1. If a sample needs to be rerun, this too is electronically noted. Close the Sample Plots window and return to the Samples tab in the Project Window.

---

**Project Window:**

![Project Window screenshot]

**enter rerun code in UD1**
2. Each sample scheduled for rerun must contain a code in column UD1. The first figure of the code stands for the **sample status**, the second figure stands for the **multiplex system** of the sample, and the third figure stands for the **rerun parameter**. The following are a few examples:
   a. A sample was overblown and all peaks were removed. It should be rerun at a 1/10 dilution in Identifiler. Rerun Code: *ID
   b. An ID28 sample contained an off-ladder allele and needs to be rerun normal in Identifiler. Rerun Code: ^I.
   c. An ID31 sample has a poor size standard and needs to be rerun at the normal parameter. Rerun Code: #IN
   d. A sample has already been rerun once and the second time still produces an off-ladder allele, therefore it will **not** be rerun. Rerun code: ^N/A
   e. An ID31 sample needs to be rerun at two separate parameters: one rerun at normal parameter for a range of peaks removed and another to confirm an off-ladder using rerun high. List both parameters separated by a comma. Rerun code: *IN, ^IH

3. After entering a code, click outside of the cell for the data to export properly.

4. See the Appendixes B and C for a complete list of edit, system, and rerun codes.

**Exporting Data for LIMS**

Any case documentation developed outside of the LIMS should be scanned to a PDF document and attached to the appropriate electronic case record.

1. To export this information for use in the LIMS:
   a. First, in the **Project Window**, make sure the table setting drop down menu is set to “**Casework**”. In this view you will notice an additional category column “Specimen Category” this column should be set to “no export” for all the samples.
   b. Then, Go to **File → Export Combined Table**. This table combines the rerun information from the **Samples** table and the editing information from the **Genotypes** table.

2. Select the appropriate run folder and check the run name contains the initials of the person analyzing the run.

3. The file must be exported as Text-tab delimited (.txt). Ensure this is selected and click “Export Combined Table.”
To make the data available for review, the project needs to be exported from the Oracle database and placed on the network. Once on the network, the reviewer will have to re-import the project into a local Genemapper station before being able to review.

**Exporting a Project**

1. Click on Tools → GeneMapper Manager (Ctrl+M) or click on the GeneMapper Manager icon.
2. Select the project to export and click the “Export” button. A new window will open. Navigate to the 3130xf run folder through the “Save in” drop down box. In the “File name” box type in the name of the run. The “Files of type” box should be defaulted to Java serialized file (*.ser).
G. EDITING - REVIEWER

Importing a Project

1. To import the project, open the GeneMapper Manager and click Import.

2. A new window will open asking for the file name. Navigate to the appropriate run folder, select the project and click Import. The project will be imported into GeneMapper.

3. To open the project you just imported, click File → Open Project (Ctrl + O). Select your project and click Open.
Electronic Editing - Reviewer

1. The reviewer should check the edits on the editing documentation against the electronic data.

2. To display the sample plots, highlight all samples and click the “Plot View” button or click “Analysis à Display Plots”. For more detailed information, refer to Section E “Plot Views”.

3. The software always keeps the original allele assignments and a list of all the changes made. If desired, the allele history can be viewed. See “Appendix E – Troubleshooting Guide, 6. Allele History” for instructions.

4. To change, revert, or add an edit into the documentation, the reviewer should make the correction in the edit table.

5. In the GMID project, to revert an edited peak back to the original allele call, left click on the allele to select it, then right click to Rename Allele; another drop down menu will appear listing all of the possible choices for alleles at that locus. Select the correct allele assignment to re-label the peak. This change will still be added to the history of that allele.

NOTE: Peaks can be selected and deleted together. For example when a sample is overblown and you need to remove many peaks in a range, simply select the first peak of the range, and while the first peak is still highlighted, drag a box across the range of peaks to select all. Press the delete key.

If the reviewing analyst disagrees with the removal of all peaks made during the first analysis, the reviewer should not complete the review. Have the analyzing analyst go back to the project and reanalyze the affected sample(s), re-export the data and create new allele, edit and rerun tables and re-submit for review. The reviewer should then review the entire project again.

6. Once the reviewer approves all the edits, the peaks that are slated to be removed should be deleted by selecting the peaks individually and using the Delete key.
7. A “Delete Allele Comment” box will pop-up. This can be left blank if you agree with the edit. If you made a change to the edit on the editing table, enter the new edit code. Click OK.

8. Once the changed alleles are deleted, the electronic editing sheet cannot be recreated. Therefore, **Re-Save the project as the run name with “Reviewed”** after the analyst’s initials so the original edited project is not lost.

9. Generate the electropherograms using the instructions in the next section, Section H Printing and Electropherogram Generation.

9. Export the new project to the run folder on the network as described in the previous section.

10. Once the project is exported, delete it from the project window in the GeneMapper Manager.

11. Changes to any reviewed project can be saved under the same “reviewed” name. However, the affected pages must be hand initialed by the analyst making the changes.

H. PRINTING AND ELECTROPHEROGRAM GENERATION

The following are the page settings for the printer that can be checked by selecting **File** from the drop down menu, then **Page Setup** while in the **Samples Plot** view.
Printing: ID28, YFiler, and MiniFiler

1. Printing is done separately for the allelic ladders, controls, and samples. All allelic ladders in a project must be printed.

2. In the *Project Window* under the *Samples* tab, select only the rows you want to print.

3. Click the plots button.

4. In the Samples Plot window, select the plot setting from the drop down list according to the system and sample type you need:

<table>
<thead>
<tr>
<th>Print - ID Allelic Ladder</th>
<th>Print - ID Controls</th>
<th>Print - ID 28 Samples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print - YFiler Allelic Ladder</td>
<td>Print - YFiler Controls</td>
<td>Print - ID 31 PE and Samples</td>
</tr>
<tr>
<td>Print - Mini Allelic Ladder</td>
<td>Print - Mini Controls</td>
<td>Print – YFiler Samples</td>
</tr>
<tr>
<td>Print – ID31 Negative Controls</td>
<td>Print - Mini Samples</td>
<td></td>
</tr>
</tbody>
</table>

5. Notice that the font size is reduced to accommodate the print setting. This setting will add the appropriate labels to each peak for printing.

6. Zoom to the appropriate range by using the X-Axis Zooming dialog box to set the plot to the correct range listed in the table below:

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
X-Axis Zooming:

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Zoom from 90 to 370</th>
</tr>
</thead>
<tbody>
<tr>
<td>YFiler</td>
<td>Zoom from 90 to 340</td>
</tr>
<tr>
<td>MiniFiler</td>
<td>Zoom from 68 to 300</td>
</tr>
</tbody>
</table>

7. Select File from the drop down menu, and then print (ctrl+P). Print to PDF format for LIMS. Save the PDF into the same directory as the analysis project. For the ladder, save the file as “Ladders”. For the controls, save the file as “Controls”. For the samples, save the file as “[sample number]” on the plate. For example, if the sample was run as sample #23 on the plate, then the PDF will be saved as “23.pdf”.

8. If the peaks appear unusually small against the baseline in the printed electropherogram, follow the additional instructions in Appendix E - Troubleshooting, 4. Printing, and re-print the affected pages.

**Printing: ID31 Positive Control (PE) and Samples**

1. For ID31 Allelic Ladders and Negative Controls, use the associated ID print views. Continue below for printing the Positive Control and Samples.

2. In the Project Window under the Samples tab, select the replicates of one sample and its corresponding pooled sample (i.e. “trigger_swab_a”, “trigger_swab_b”, “trigger_swab_c”, and “trigger_swab_abc”).

3. Click the plots button.

4. In the Samples Plot window, select the plot setting from the drop down list titled “Print – ID31 PE and Samples”.

5. Notice that in the Samples Plot tool bar only the blue dye is selected. This is because one color will be printed at a time for these sample replicates.

6. Using the X-Axis Zooming dialog box, set the plot to zoom from 90 to 370.

7. Select File from the drop down menu, and then print (ctrl+P). Print to PDF format for LIMS. Save the PDF into the same directory as the analysis project.

8. If the peaks appear unusually small against the baseline in the printed electropherogram, follow the additional instructions in Appendix E. Troubleshooting Guide, 4. Printing, and re-print the affected pages.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
9. In the Samples Plot tool bar, unselect the blue dye by clicking it, and select the green dye. With only the green dye selected repeat steps 6 and 7 for the green dye. Then repeat steps 6 and 7 for the yellow dye and red dyes individually.

10. After all colors have been printed for one triplicate sample, repeat steps 1 through 7 for the next sample in the injection until all samples in that run have been printed.
The **Pass** (green square) symbol indicates that no problem exists. The **Check** (yellow triangle) symbol appears when there are problematic components such as missing size standards, or off-scale data. The **Low Quality** (red octagon) symbol appears when the result falls below the defined threshold.

Whether you identify a size standard problem or not, proceed to the sizing section of the manual to individually check each size standard.

The following flags are visible in the **Project Window** with the “**Samples**” tab selected:

<table>
<thead>
<tr>
<th>Quality Flag in “Samples” tab</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sizing Quality Override</strong> – This check box marks the samples that have had the size standard quality score overridden. This box can also be used to indicate if the size standard has been reviewed.</td>
<td>SQO</td>
</tr>
<tr>
<td><strong>Sample File Not Found</strong> – If the software cannot locate the .fsa files that correspond to a project, a yellow “check” flag is displayed. Re-import the run into the GeneMapper® ID software.</td>
<td>SFNF</td>
</tr>
<tr>
<td><strong>Size Standard Not Found</strong> – A yellow “check” flag is displayed when no size standard is found in the sample. If a size standard has failed, it will be assigned an SQ value of 0.0 and “no sizing data” will be displayed in the “samples plot” window.</td>
<td>SNF</td>
</tr>
<tr>
<td><strong>Off scale</strong> – This flag directs your attention to overblown peaks whose height [RFU] exceeds the range of the collection instrument.</td>
<td>OS</td>
</tr>
<tr>
<td><strong>Sizing Quality</strong> – Values closest to 1.0 are denoted by a green “pass” flag. Questionable data is within the range of 0.25 and 0.75, and indicated with a yellow “check” flag. Low quality data is within the range of 0.0 – 0.25 and denoted by a red flag. If the RFU of the size standard falls below our detection threshold, it will be assigned an SQ value of 0.0, and the corresponding sample will display “no sizing data” in the “samples plot” window.</td>
<td>SQ</td>
</tr>
</tbody>
</table>
These flags are intended to draw your attention to samples that have analysis problems. These flags do not replace our method for editing samples. Each sample must still be viewed and edited. If you identify a problem in a sample that can be edited, proceed to the editing section of this manual.

The following flags are visible in the Plot View with the “Genotypes” tab selected:

<table>
<thead>
<tr>
<th>Quality Flag in “Genotypes” tab</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Allele Display Overflow</strong> – This check box indicates that there are more alleles at this locus than are displayed in the current window view.</td>
<td>ADO</td>
</tr>
<tr>
<td><strong>Allele Edit</strong> – This box is checked when the allelic calls have been edited by the analyst in the plot view page.</td>
<td>AE</td>
</tr>
<tr>
<td><strong>Off scale</strong> – This flag directs your attention to overblown peaks whose height [RFU] exceeds the range of the collection instrument for each locus.</td>
<td>OS</td>
</tr>
<tr>
<td><strong>Out of bin allele</strong> – Displays a yellow “check” flag when peaks are outside of the bin boundary. These peaks are called OL.</td>
<td>BIN</td>
</tr>
<tr>
<td><strong>Peak Height Ratio</strong> – Displays a yellow “check” flag if the ratio between the lower allele height and the higher allele height are below 70%. This value can be set in the Analysis Methods Peak Quality window.</td>
<td>PHR</td>
</tr>
<tr>
<td><strong>Allele Number</strong> – This flag is a useful indicator of mixture samples, locus dropout, and extraneous alleles in the positive and negative controls. A yellow “check” flag is displayed when the number of alleles exceeds the number of expected alleles at a locus for the individual, or if no alleles are found. This number can be set in the Analysis Methods Peak Quality window.</td>
<td>AN</td>
</tr>
</tbody>
</table>
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.

## GENEMAPPER ID – QUALITY FLAGS

<table>
<thead>
<tr>
<th>Quality Flag in “Genotypes” tab</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Concordance – Serves as quality assurance during STR analysis. A yellow “check” flag appears when the designated control sample (positive or negative) does not exactly match the defined alleles at each locus.</td>
<td>CC</td>
</tr>
<tr>
<td>Overlap – It is possible to have two allele size ranges that overlap, therefore a yellow “check” flag is displayed when a peak in the overlapped region is called twice.</td>
<td>OVL</td>
</tr>
</tbody>
</table>

### Revision History:
March 24, 2010 – Initial version of procedure.
<table>
<thead>
<tr>
<th>Reason for Edit</th>
<th>Edit Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pull-ups of peaks in any color caused by a very high peak of another color in the same basepair range of a sample</td>
<td>1</td>
</tr>
<tr>
<td>Shoulder peaks approx. 1-4 bp bigger or smaller than main peak</td>
<td>2</td>
</tr>
<tr>
<td>Split peak due to &quot;N&quot; bands</td>
<td>3a</td>
</tr>
<tr>
<td>Split peak due to matrix over-subtraction</td>
<td>3b</td>
</tr>
<tr>
<td>Stutter in non-mixtures</td>
<td>4a</td>
</tr>
<tr>
<td>Stutter preceding shoulder in a mixture</td>
<td>4b</td>
</tr>
<tr>
<td>&gt;20% stutter w/main peak plateau in non-mixtures</td>
<td>4c</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reason for Edit</th>
<th>Edit Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non specific artifacts</td>
<td>5</td>
</tr>
<tr>
<td>Labels placed on elevated baselines</td>
<td>6</td>
</tr>
<tr>
<td>Spikes or peaks present in all colors in one sample</td>
<td>7</td>
</tr>
<tr>
<td>Dye artifact occurring at constant scan position</td>
<td>8</td>
</tr>
<tr>
<td>Peak outside printed scan range</td>
<td>9</td>
</tr>
<tr>
<td>Initial peak of range removed</td>
<td>-&gt;</td>
</tr>
<tr>
<td>Peak(s) within basepair range affected by overblown peak(s) removed</td>
<td>*</td>
</tr>
</tbody>
</table>

+ This edit is applicable for stutter peaks in non-mixtures in +/-4 bp positions for both Identifiler®, MiniFiler®, and PowerPlex® Y and in +/-3 bp positions at DYS392 and +/-5 bp positions at DYS38 for PowerPlex® Y only.

++ This edit is applicable for stutter peaks preceding a shoulder in a mixture in the -4 bp position for Identifiler and the -3, -4, and -5 bp positions for PowerPlex® Y.

+++ For PowerPlex® Y, this edit is applicable for artifacts in the +/-2 bp position for DYS389II and DYS19, the -9 and -10bp position at DYS393 and the -5, -9, and -10 bp positions at DYS437 and DYS385. For Yfiler™, this edit is applicable for artifacts in the +/-2 bp position at DYS19.

Revision History:
March 24, 2010 – Initial version of procedure.
September 27, 2010 – Updated edit codes and added MiniFiler.
April 1, 2014 – Revised to include information for YFiler.
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Identifiler Analysis Settings:
PowerPlexY Analysis Settings:

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
MiniFiler Analysis Settings:
YFiler Analysis Settings:

Revision History:
March 24, 2010 – Initial version of procedure.
April 1, 2014 – Procedure revised to include information for YFiler.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
1. REDEFINING THE SIZE STANDARD

1.1. PROBLEM: “No Sizing Data” message; red octagon in SQ column

a. Select the flagged sample in the Samples tab of the Project Window as shown in the picture below.

b. From the View drop down menu, select Raw Data - this will show what the sample looks like. If raw data is visible, and after analysis there is “No Sizing Data”, most likely the size standard is mislabeled. If no raw data is visible, the injection for that capillary failed or no sample was loaded in to the well.
Raw data view shows usable data:

Raw data shows poor quality injection, this injection fails:
c. Click on the Size Match Editor icon in the toolbar to open the sizing window. Here you can see the labels that the macro assigned to each peak in the size standard for that sample.

d. Using the magnifying tool, zoom in on the area that appears to be mislabeled.

e. Left click to select the peak that needs to be changed. The peak will be highlighted in blue.

f. Right click on the peak which is mislabeled, a menu pops up, with add, delete or change.
If a peak is labeled which is not supposed to be (the 250 or 340 peaks), select delete and the peak is unlabeled.

To re-label a peak correctly, select change, a dropdown list appears with the choices for that size standard. Choose the correct one. The peak will be re-labeled.

Once all the changes are made, click on Apply to apply the changes. And then Ok to close the window.

From the View drop down menu, select Samples to return to the Samples tab. In the Analysis View table setting, notice that the SQO box for that sample has a blue “X”, the SQ box has turned to a green square, and the status box for that sample has a green arrow. The green arrow indicates that a setting (in this case it’s the size standard) has been modified and it needs to be re-analyzed.
k. Click on the green analyze button in the toolbar to re-analyze that sample with the redefined size standard.

2. ADJUSTING THE ANALYSIS DATA START POINT AND STOP POINT RANGE

2.1. PROBLEM: The data is too far to the left or right of the injection scan range, or the size standard is cut out of the analysis range and therefore labeled incorrectly.

a. From the View drop down menu, select Raw Data.

b. In the raw data view, choose a start point between the dye blob region that appears at the beginning of every injection, and the first required peak of the size standard by hovering the mouse pointer over that peak on the x-axis. At the bottom of the screen you will see that the data point and RFU is displayed for the area you are hovering with the mouse. Try not to include any of the blobs in the beginning of the run as they tend to be very high RFUs and the software uses the highest signal in each color to determine the Y axis cut-off in the plot view.

c. Choose a stop point anywhere after the last peak in the size standard.
d. At a minimum the following size standard peaks must be present for proper analysis:
   - For Identifiler, 100bp to 450bp minus the 250bp and 340bp peaks.
   - For PowerPlexY, 60bp to 375bp.
   - For Minifiler, 75bp to 400bp minus the 250bp and 340bp peaks. (The Analysis Methods peak detector tab must start at 65bp and not 75bp in order to properly size peaks. This is because the 3rd Order Least Squares is the size calling method used.)
   - For Yfiler, 75bp to 400bp minus the 250bp

**NOTE:** If the data in an Identifiler run is too far to the right and the last two peaks of the size standard (490 bp and 500 bp) are cut out of the visible range (as seen in the raw data view), the run can still be analyzed by selecting the size standard named “LIZ-250-340-490-500”. In this case your stop point for the analysis range should be set to 10,000. Additionally, QC should be notified to inspect the instrument as this occurrence is usually indicative of a polymer leak.

e. From the View drop down menu, select Samples to return to the samples tab.

f. Select the analysis method in the project window to highlight it blue, and then double click to open it.

g. The **Analysis Method Editor** window will automatically open to the **Peak Detector** tab.
h. In the **Ranges** section, change the **start point** and **stop point** as necessary. The only other setting that can be changed in this window is the **Peak Amplitude Thresholds** for the color of the size standard. If the size standard produced a low RFU signal this setting can be lowered to 25 RFU only in orange for Identifiler, MiniFiler and Yfiler, and only in red for PowerPlexY.

i. Click **OK**.

j. When you return to the **samples** tab, you will see that the samples have a green arrow in the status column signaling that a setting has been modified and it needs to be re-analyzed.

k. Click on the green analyze button ▶ in the toolbar to re-analyze with the modified setting.

3. **Genotypes Plot – Locus Specific Quality Flags**

3.1. **PROBLEM:** You see “no room for labels” in the panes of the **Samples Plot** window.

a. In the **Project Window** select the **Genotypes** tab, and then click the plot button (Analysis → Display Plots or Ctrl+L). This plot window displays each locus in a separate pane; this is called the “**Genotypes Plot**”. Here you can clearly view each locus with its relevant quality flags. Once you are in the plot view you can toggle between the **Samples Plot** and the **Genotypes Plot** by going to the **Project Window** and selecting the **Samples** tab or **Genotypes** tab.
b. If a locus contains a peak that exceeds the saturation threshold of the 3130xl, a pink line will indicate the affected basepair range in every color, and draw attention to areas where the off-scale peaks have created pull-up.

c. These pink lines can be turned on or off from the plot window by selecting View → “Off-scale peak indicator” from the pull down menu. Ensure that the off scale peak indication is checked on.
**Locus Specific Quality Flags**

- Pull-up from a 7858 RFU peak in the blue CSF locus
- Pull-up from a 7672 RFU peak in the green D3 locus
- Pull-up from an 8559 RFU peak in the blue D8 locus

**d.** Regardless of peak height, if the pink off scale indicator is not triggered, the sample does not need to be rerun.

**e.** If the pink off-scale indicator is triggered, do one of the following (may be team specific):

  **i.** Remove all peaks in the sample and run at a dilution (oversaturated single source samples with plateau shaped or misshaped peaks or mixtures)

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
ii. Remove all peaks in loci containing pink saturation lines and in all other loci within that base pair range. These other loci will also be easily identifiable because they have the pink line indicating where the overblown peak from the other color has interrupted that entire base pair range. Rerun at a lower parameter (if applicable) or with a dilution.

f. The quality flags in the Genotypes window indicate locus specific problems. If a yellow “check” flag, or a red “low quality” flag result in any of the columns, refer to the appendix A – “Quality Flags” for a description of the flags and the problems they identify.

NOTE: The locus specific quality flags can only be viewed in the Genotypes Plot window.

4. PRINTING

4.1. PROBLEM: The peaks in the printed electropherogram appear unusually small.

a. The maximum RFU signal in each color is used to calculate the Y axis cut-off value for the plot display.

b. When the analysis range includes too much of the dye blob region that appears at the beginning of each run, the Y axis cut-off will be very high because the blobs in the beginning of the run generally have high RFUs. As a result, the true peaks will appear really small in the plot display.

c. To adjust the Y axis cut-off, move the mouse pointer over the numbers on the Y axis. Notice that the pointer will turn into a magnifying glass. While holding the left mouse button down you can move the magnifying glass up and down the Y axis and a box will form outlining the area to be zoomed in. Choose a level directly above the tallest peak. When you release the left mouse button, the area will automatically zoom in.

d. If you need to zoom back out to the full range, double click on the Y axis while the mouse pointer is in the magnifying glass form.
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
5.2. **PROBLEM:** There is a confirmed off-ladder in my sample, how do I determine the closest allele call?

   a. Select the ladder with your sample and view the plot by clicking on the **Display Plots** button in the toolbar.

   b. Turn off all colors except the color in which the OL appears using the quick select color buttons in the toolbar.

   c. Turn the bins on by clicking on the **Show Bins** button in the toolbar.

   d. Zoom in to the locus where the OL appears. The bins for that locus will be shaded in grey and you can determine what the true allele would be.

6. **ALLELE HISTORY**

6.1. **PROBLEM:** How do I know the history of an allele that was edited?

   a. Double-click on the allele and a window opens with the allele history of that peak. When an allele is created by the macro, it will read “GeneMapper HID Allele Calling Algorithm” in the comments section. The rest of the table describes the action taken on that peak. In this example allele 15.2 was edited as pull-up. The action column describes what was done to the peak and the comments column contains the editing code.

   ![Allele History](image.png)
b. If when you double click on a peak, a button pops up that reads “add allele call”, it means that the peak was not labeled by the GeneMapper macro.

6.2. PROBLEM: How do I view all deleted peak calls in a project?

Select all the samples in the samples tab of the project window. Click the Samples Plot button to view the electropherogram. In the View dropdown menu, select Allele Changes. Any peak that was called and subsequently deleted will appear with a strike out as depicted below.

![Genemapper Image]

7. SAMPLE HISTORY

7.1. PROBLEM: How can I see the run log for a sample to determine how the run was injected and analyzed?

a. In the project window under the samples tab, select the sample(s) of interest.

b. From the View drop down menu, select Sample Info

c. This view contains all of the information pertaining to the sample including error messages, current settings, run information, data collection settings, and capillary information.
8. TYPOGRAPHICAL ERROR IN SAMPLE

8.1. PROBLEM: There is a typo in the sample name.

In the project window under the Samples tab, click on the sample name in the Sample Name column and correct the error.

9. TABLE ERRORS

9.1. PROBLEM: An error message occurs when making the allele table.

If you get an error message, this means that you have exported the combined table while still in “Analysis View”.

Click “End” or “OK” to close the error window, and close the excel worksheet without saving. Go back to your project in GeneMapper® ID. In the Project Window change the table setting drop down menu to “Casework”. Re-export the combined tables, then re-import into a new excel worksheet.

Revision History:

March 24, 2010 – Initial version of procedure.
September 27, 2010 – Updated procedure in Problem 3.1 to indicate what to do when off-scale indicator is triggered.
April 1, 2014 – Procedure revised to include information for YFiler.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Identifiiler Allelic Ladder
Identifiler Positive Control

<table>
<thead>
<tr>
<th>Color</th>
<th>Marker</th>
<th>Alleles</th>
<th>Allele Sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue</td>
<td>D2S1179</td>
<td>13</td>
<td>30, 10, 11</td>
</tr>
<tr>
<td></td>
<td>D21S11</td>
<td>10, 11</td>
<td>10, 12</td>
</tr>
<tr>
<td>Green</td>
<td>D3S1358</td>
<td>14, 15</td>
<td>8, 9, 3, 11</td>
</tr>
<tr>
<td></td>
<td>TH01</td>
<td>11</td>
<td>11, 12</td>
</tr>
<tr>
<td></td>
<td>D13S317</td>
<td>11</td>
<td>12, 19</td>
</tr>
<tr>
<td></td>
<td>D16S539</td>
<td>19</td>
<td>23, 23</td>
</tr>
<tr>
<td></td>
<td>D2S1338</td>
<td>14, 15</td>
<td>17, 18</td>
</tr>
<tr>
<td></td>
<td>D19S433</td>
<td>14, 15</td>
<td>7, 15</td>
</tr>
<tr>
<td>Yellow</td>
<td>VWA</td>
<td>14, 15</td>
<td>17, 18</td>
</tr>
<tr>
<td></td>
<td>TPOX</td>
<td>8</td>
<td>15, 19</td>
</tr>
<tr>
<td></td>
<td>D18S51</td>
<td>14, 15</td>
<td>8</td>
</tr>
<tr>
<td>Red</td>
<td>AMEL</td>
<td>X</td>
<td>11, 23, 24</td>
</tr>
<tr>
<td></td>
<td>D5S818</td>
<td>11</td>
<td>23, 24</td>
</tr>
<tr>
<td></td>
<td>FGA</td>
<td>11, 23, 24</td>
<td></td>
</tr>
</tbody>
</table>

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
LIZ-250-340

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
MiniFiler Positive Control

<table>
<thead>
<tr>
<th>Color</th>
<th>Locus</th>
<th>Allele 1</th>
<th>Allele 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue (FAM)</td>
<td>D13S317</td>
<td>11</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>D7S820</td>
<td>7</td>
<td>12</td>
</tr>
<tr>
<td>Green (VIC)</td>
<td>AMEL</td>
<td>X</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>D2S1338</td>
<td>20</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>D21S11</td>
<td>28</td>
<td>31</td>
</tr>
<tr>
<td>Yellow (NED)</td>
<td>D16S539</td>
<td>9</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>D18S51</td>
<td>12</td>
<td>15</td>
</tr>
<tr>
<td>Red (PET)</td>
<td>CSF1PO</td>
<td>11</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>FGA</td>
<td>24</td>
<td>26</td>
</tr>
</tbody>
</table>
PowerPlex Y Allelic Ladder

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
PowerPlex Y Male Positive Control – Promega

<table>
<thead>
<tr>
<th>Blue (FL)</th>
<th>DYS391</th>
<th>DYS389I</th>
<th>DYS439</th>
<th>DYS389II</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>10</td>
<td>13</td>
<td>12</td>
<td>31</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Green (JOE)</th>
<th>DYS438</th>
<th>DYS437</th>
<th>DYS19</th>
<th>DYS392</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>11</td>
<td>15</td>
<td>14</td>
<td>13</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Yellow (TMR)</th>
<th>DYS393</th>
<th>DYS390</th>
<th>DYS385</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>13</td>
<td>24</td>
<td>11, 14</td>
</tr>
</tbody>
</table>
PowerPlex Y Male Positive Control – In-House

Blue (FL)  
DYS391 10  
DYS389I 13  
DYS439 12  
DYS389II 29  

Green (JOE)  
DYS438 10  
DYS437 14  
DYS19 14  
DYS392 13  

Yellow (TMR)  
DYS393 15  
DYS390 25  
DYS385 13, 19

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
YFiler Allelic Ladder
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
YFiler Size Standard (LIZ GS500)

Revision History:
March 24, 2010 – Initial version of procedure.
August 2, 2010 – The profile of the in-house Male Positive Control was changed.
April 1, 2014 – Procedure revised to include information for YFiler.
TABLE SETTINGS – ANALYSIS VIEW: SAMPLES SETTINGS

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
TABLE SETTINGS – ANALYSIS VIEW: GENOTYPES SETTINGS (continued)

![Table Setting Editor](image)

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
**TABLE SETTINGS – CASEWORK VIEW: SAMPLES SETTINGS**

![Table Setting Editor](image)

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
TABLE SETTINGS – CASEWORK VIEW: GENOTYPES SETTINGS

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
**Table Settings – Casework View: Genotypes Settings (continued)**

<table>
<thead>
<tr>
<th>Column Settings</th>
<th>Content</th>
<th>Filter</th>
<th>Column</th>
<th>Show</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>Sharp Peak (M)</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>One Basepair Allele (M)</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>Single Peak Artifact (M)</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Split Peak (M)</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Out of Bin Allele</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>Peak Height Ratio</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>Low Peak Height</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>Spectral Pull-up</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>Allele Number</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>Broad Peak</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>Double Peak (SNP)</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>Narrow Bin (SNP)</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>Control Concordance</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>Overlap (HD)</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>Cross Talk</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>Genotype Quality</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>User Defined Column 1</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>User Defined Column 2</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>User Defined Column 3</td>
<td>Show All Records</td>
<td>N/A</td>
<td></td>
</tr>
</tbody>
</table>

**Allele Settings**

- Number of Alleles: 15
- Keep Allele, Size, Height, Area, Data Point, Mutation and Comment together

---

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
PLOT SETTINGS: ANALYSIS VIEW

Analysis View: Sample Header

**Plot Settings Editor**

<table>
<thead>
<tr>
<th>Sample Header Settings</th>
<th>Show</th>
<th>Column</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>Sample File</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Sample Name</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>Panel</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>Sizing Quality Overridden</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Off-scale</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>Sizing Quality</td>
</tr>
</tbody>
</table>

Show | Hide
---|---
OK | Cancel
Analysis View: Genotype Header

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Analysis View: Display Settings
GENEMAPPER ID – DEFAULT TABLE AND PLOT SETTINGS

PLOT SETTINGS: PRINT – IDENTIFILER ALLELIC LADDER

Print – Identifiler Allelic Ladder: Sample Header

Print – Identifiler Allelic Ladder: Genotype Header

Boxes 3 – 20 are unchecked

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Print – Identifiler Allelic Ladder: Sizing Table

Print – Identifiler Allelic Ladder: Labels
Print – Identifiler Allelic Ladder: Display Settings

When opening the plot window:
- Use the display settings last used for this plot
- Use these display settings:

For both sample and genotype plots:
- Panes: 4
- X-Axis: Basepairs
- Y-Axis: Scale individually
- Toolbar
- Show Off-scale

For sample plot only:
- 

For genotype plot only:
- Marker Margin: 5
PLOT SETTINGS: PRINT – IDENTIFILER 28 CONTROLS

Print – Identifiler 28 Controls: Sample Header

Boxes 3 – 20 are unchecked

Print – Identifiler 28 Controls: Genotype Header

Boxes 3 – 20 are unchecked
Print – Identifiler 28 Controls: Sizing Table

Print – Identifiler 28 Controls: Labels

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Print – Identifiler 28 Controls: Display Settings

Plot Settings Editor

When Opening The Plot Window

- Use the display settings last used for this plot
- Use these display settings:

  For both Sample and Genotype plots:
  - Panes: 4
  - X-Axis: Basepairs
  - Y-Axis: Scale individually
  - Toolbar: On
  - Show Off-scale: On

  For Sample plot only:
  - Color scheme: Green, Red, Yellow

  For Genotype plot only:
  - Marker Margin: 5 bp

OK  Cancel

ARCHIVED 05/21/14
Document Control Coordinator
PLOT SETTINGS: PRINT – IDENTIFILER 28 SAMPLES

Print – Identifiler28 Samples: Sample Header

Boxes 3 – 20 are unchecked
Print – Identifiler28 Samples: Sizing Table

Print – Identifiler28 Samples: Labels

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Print – Identifiler28 Samples: Display Settings

When Opening The Plot Window:
- Use the display settings last used for this plot
- Use these display settings:
  
  For both Sample and Genotype plots:
  - Panels: 4
  - X-Axis: Basepairs
  - Y-Axis: Scale individually
  - Toolbar: On
  - Show Off-scale

For Sample plot only:
- Colors:

For Genotype plot only:
- Marker Margin: 5 bp

OK Cancel
PLOT SETTINGS: PRINT – IDENTIFIER 31 POSITIVE CONTROL (PE) AND SAMPLES

Print – ID 31 PE and Samples: Sample Header

![Sample Header Settings](image)

Boxes 3 – 20 are unchecked

Print – ID 31 PE and Samples: Genotype Header

![Genotype Header Settings](image)

Boxes 3 – 20 are unchecked
Print – ID 31 PE and Samples: Sizing Table

Print – ID 31 PE and Samples: Labels

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Print – ID 31 PE and Samples: Display Settings

Plot Settings Editor

When Opening The Plot Window:
- Use the display settings last used for this plot
- Use these display settings:
  - For both Sample and Genotype plots:
    - Panes: 4
    - X-Axis: Basepairs
    - Y-Axis: Scale individually
    - Toolbar
    - Show Off-scale
  - For Sample plot only:
    - [Sample plot settings]
  - For Genotype plot only:
    - Marker Margin: 5 bp

OK  Cancel
PLOT SETTINGS: PRINT – IDENTIFILER 31 NEGATIVE CONTROLS

Print – ID 31 Negative Controls: Sample Header

Boxes 3 – 20 are unchecked

Print – ID 31 Negative Controls: Genotype Header

Boxes 3 – 20 are unchecked
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Print – ID 31 Negative Controls: Display Settings

Plot Settings Editor

When opening the plot window:

- Use the display settings last used for this plot.
- Use these display settings:

For both Sample and Genotype plots:
- Panes: 4
- X-Axis: Basepairs
- Y-Axis: Scale individually
- Toolbar: On
- Show Off-scale: On

For Sample plot only:
- Marker Margin: 5 bp

For Genotype plot only:
- Marker Margin: 5 bp

OK Cancel
PLOT SETTINGS: PRINT – POWERPLEX Y ALLELIC LADDER

Print – PowerPlex Y Allelic Ladder: Sample Header

Boxes 3 – 20 are unchecked

Print – PowerPlex Y Allelic Ladder: Genotypes Header

Boxes 3 – 20 are unchecked
Print – PowerPlex Y Allelic Ladder: Sizing Table

Print – PowerPlex Y Allelic Ladder: Labels

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Print – PowerPlex Y Allelic Ladder: Display Settings

Plot Settings Editor

- **When Opening The Plot Window**
  - Use the display settings last used for this plot
  - Use these display settings:

  - For both Sample and Genotype plots:
    - Panes: 4
    - X-Axis: Basepairs
    - Y-Axis: Scale individually

    - Toolbar
    - Show Off-scale

  - For Sample plot only:
    - Marker Margin: 5 bp

  - For Genotype plot only:
    - Marker Margin: bp

OK  Cancel
PLOT SETTINGS: PRINT – POWERPLEX Y CONTROLS

Print – PowerPlex Y Controls: Sample Header

Boxes 3 – 20 are unchecked

Print – PowerPlex Y Controls: Genotypes Header

Boxes 3 – 20 are unchecked
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
PRINT – POWERPLEX Y CONTROLS: DISPLAY SETTINGS

**Plot Settings Editor**

**General | Sample Header | Genotype Header | Sizing Table | Labels | Display Settings**

**When Opening The Plot Window**
- **Use the display settings last used for this plot**
- **Use these display settings:**

**For both Sample and Genotype plots:**
- **Panels:** 4
- **X-Axis:** Basepairs
- **Y-Axis:** Scale individually
- **Toolbar:**
- **Show Off-scale:**

**For Sample plot only:**
- **Markers:**

**For Genotype plot only:**
- **Marker Margin:** 5 bp

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
PLOT SETTINGS: PRINT – POWERPLEX Y SAMPLES

Print – PowerPlex Y Samples: Sample Header

Boxes 3 – 20 are unchecked

Print – PowerPlex Y Samples: Genotypes Header

Boxes 3 – 20 are unchecked
Print – PowerPlex Y Samples: Sizing Table

Print – PowerPlex Y Samples: Labels

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Print – PowerPlex Y Samples: Display Settings

Plot Settings Editor

When Opening The Plot Window:
- Use the display settings last used for this plot
- Use these display settings:

  For both Sample and Genotype plots:
  - Panes: 4
  - X-Axis: Basepairs
  - Y-Axis: Scale individually
  - Toolbar: on
  - Show Off-scale: on

  For Sample plot only:
  - Display:

  For Genotype plot only:
  - Marker Margin: 5 bp
PLOT SETTINGS: PRINT – YFILER ALLELIC LADDER

Print – YFiler Allelic Ladder: Sample Header

Boxes 3 – 20 are unchecked

Print – YFiler Allelic Ladder: Genotypes Header

Boxes 3 – 20 are unchecked

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Print – YFiler Y Allelic Ladder: Sizing Table

Plot Settings Editor

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Print – YFiler Allelic Ladder: Display Settings

**Plot Settings Editor**

- **General**
- **Sample Header**
- **Genotype Header**
- **Sizing Table**
- **Labels**
- **Display Settings**

**When Opening the Plot Window**

- Use the display settings last used for this plot
- Use these display settings:

  **For both Sample and Genotype plots:**
  - **Panes:** 4
  - **X-Axis:** Basepairs
  - **Y-Axis:** Scale individually
  - **Toolbar**
  - **Show Off-scale**

  **For Sample plot only:**
  - **Marker Margin:** 5 bp

  **For Genotype plot only:**
  - **Marker Margin:** 5 bp
PLOT SETTINGS: PRINT – YFILER CONTROLS

Print – YFiler Controls: Sample Header

Boxes 3 – 20 are unchecked

Print – YFiler Controls: Genotypes Header

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Print - YFiler Controls: Sizing Table

Print - YFiler Controls: Labels

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Print – YFiler Controls: Display Settings

Plot Settings Editor

- General
- Sample Header
- Genotype Header
- Sizing Table
- Labels
- Display Settings

When Opening The Plot Window:
- Use the display settings last used for this plot
- Use these display settings:

For both Sample and Genotype plots:
- Panes: 4
- X-Axis: Basepairs
- Y-Axis: Scale individually
- Toolbar
- Show Off-scale

For Sample plot only:
- [Color options]

For Genotype plot only:
- Marker Margin: 5 bp

OK Cancel
PLOT SETTINGS: PRINT – YFiler SAMPLES

Print – YFiler Samples: Sample Header

Print – YFiler Samples: Genotypes Header

Boxes 3 – 20 are unchecked
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Print – YFiler Samples: Display Settings

Plot Settings Editor

When Opening The Plot Window
- Use the display settings last used for this plot
- Use these display settings:

For both Sample and Genotype plots:
- Panes: 4
- X-Axis: Basepares
- Y-Axis: Scale individually
- Toolbar
- Show Off-scale

For Sample plot only:
- Marker Margin: 5 bp

For Genotype plot only:

OK Cancel
PLOT SETTINGS: MINIFILER ANALYSIS VIEW

MiniFiler Analysis View: Sample Header

[Image of the MiniFiler Analysis View: Sample Header dialog box]
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
MiniFiler Analysis View: Labels

MiniFiler Analysis View: Display Settings

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
PART II

PLOT SETTINGS: PRINT – MINIFILER ALLELIC LADDER

Print – MiniFiler Allelic Ladder: Sample Header

5-20 are blank

Print – MiniFiler Allelic Ladder: Genotype Header

ARCHIVED 05/21/14
Document Control Coordinator
Print – MiniFiler Allelic Ladder: Display Settings

The image shows a screenshot of the "Plot Settings Editor" window with various options for display settings. The window is divided into sections for different types of plots, including "For both Sample and Genotype plots," "For Sample plot only," and "For Genotype plot only." Each section contains options for customizing the appearance of the plot, such as color schemes and axis settings. The screenshot also shows the "OK" and "Cancel" buttons at the bottom.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
PLOT SETTINGS: PRINT – MINIFILER CONTROLS

Print – MiniFiler Controls: Sample Header

![Plot Settings Editor: Sample Header]

Print – MiniFiler Controls: Genotype Header

![Plot Settings Editor: Genotype Header]

5-20 are blank
Print – MiniFiler Controls: Sizing Table

Print – MiniFiler Controls: Labels
PLOT SETTINGS: PRINT – MINIFILER SAMPLES

Print – MiniFiler Samples: Sample Header

Print – MiniFiler Samples: Genotype Header

5-20 are blank
Print – MiniFiler Samples: Sizing Table

Print – MiniFiler Samples: Labels

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
Print – MiniFiler Samples: Display Settings

Revision History:
March 24, 2010 – Initial version of procedure.
September 27, 2010 – Updated default print settings.
April 1, 2014 – Revised to include information for YFiler.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
I. Allele Calling Criteria

Results are interpreted by observing the occurrence of electropherogram peaks for the loci that are amplified simultaneously. The identification of a peak as an allele is determined through comparison to the allelic ladder. An allele is characterized by the labeling color of the locus specific primers and the length of the amplified fragment. See the Appendix for a listing of each locus in each multiplex.

For each locus an individual can be either homozygous and show one allele, or heterozygous and show two alleles. In order to eliminate possible background and stutter peaks, only peaks that display intensity above the minimum threshold based on validation data – 75 Relative Fluorescent Units (RFU’s) – are labeled as alleles.

A. Computer program processing steps for raw data:

1. Recalculating fluorescence peaks using the instrument-specific spectral file in order to correct for the overlapping spectra of the fluorescent dyes.

2. Calculating the fragment length for the detected peaks using the known in-lane standard fragments.

3. For Identifiler 28, Identifiler 31, PowerPlex Y, Minifiler, and YFiler (systems with an allelic ladder) – comparing and adjusting the allele categories to the sizing of the co-electrophoresed allelic ladder by calculating the off sets (the difference between the first allele in a category and the first allele in the allelic ladder at each locus).
4. For, Identifiler 28, Identifiler 31, PowerPlex Y, Minifiler, and YFiler – labeling of all sized fragments that are above threshold and fall within the locus specific size range (see Appendix). Removing the labels from minor peaks (background and stutter) according to the filter functions detailed in the appendix of this manual.

II. Manual Removal of Non Allelic Peaks

Additional non-allelic peaks may occur under the following instances (Clark 1988, Walsh et al. 1996, Clayton et al. 1998), which may be manually edited. Make sure not to remove any labels for potential DNA alleles. All edits must have a reference point on the editing sheet. When in doubt leave the peak labeled for review. Mixture samples must be edited conservatively and only electrophoresis artifacts can be eliminated. Peaks in stutter positions cannot be edited for mixtures, except when masked, (see D4).

A. Pull-up

1. Pull-up of peaks in one color may be due to very high peaks in another color. Pull-up is a spectral artifact that is caused by the inability of the software to compensate for the spectral overlap between the different colors if the peak height is too high.

2. The label in the other color will have a basepair size very close to the real allele in the other color. The peak that is considered an artifact or “pull up” will always be shorter than the original, true peak. It is possible to for a particularly high stutter peak in for example blue or green, to create pull up in red or orange.

3. Spectral artifacts could also be manifested as a raised baseline between two high peaks or an indentation of a large peak over another large peak. Labels placed on such artifacts can be removed and is known as “spectral over-subtraction”.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
B. Shoulder

Shoulder Peaks are peaks approximately 1-4 bp smaller or larger than main alleles. Shoulder Peaks can be recognized by their shape; they do not have the shape of an actual peak, rather they are continuous with the main peak.

C. Split peaks (“N” Bands)

Split peaks are due to the main peak being split into two peaks caused by the Taq polymerase activity that causes the addition of a single “A” to the terminus of the amplified product (“N+1” band). Since allele calling is based on N+1 bands, a complete extra “A” addition is desired.

1. Split peaks due to incomplete non nucleotide template A addition should not occur for samples with low amounts of DNA

2. Split peaks can also be an electrophoresis artifact and attributed to an overblown allele. Additional labels can be edited out.

3. Split peaks may occur in overblown samples or amplicons due to matrix over-subtraction. For example, an overblown green peak may dip at the top where a pull up peak is present in blue and in red. The yellow peak will also display over-subtraction with a dip at the peak’s crest.

D. Stutter — 4bp smaller than the main allele for most systems, or 3, 5, and 8bp smaller than the main allele for PowerPlex Y and 3, 4, 5 and 6bp smaller that the main allele for Yfiler

(Peaks one repeat unit longer or multiple units shorter than the main allele may be stutter, but is rare.)

1. The macro for each system has an automated stutter filter for each locus (see appendix for stutter values)

2. In addition, for single source samples, potential stutter peaks may be removed if they are within 15% of the larger peak for PowerPlex Y, and 20% of the larger peak for Identifiler and Yfiler.

3. Identifiler 31 samples have been shown to occasionally display peaks 4 bp longer than the main allele.
4. If the main allele has an additional label prior to the main allele label (e.g. a shoulder peak, 1bp less in size) this peak will be used for stutter percentage calculation and the stutter might not have been automatically removed. In this case, the stutter peak can also be removed for mixtures.

5. Peaks that are overblown with RFUs above 7000 (and thus their peak height has plateaued), will often have a stutter peak that will be more than 20% of the main peak. If the sample is not a mixture, the stutter peaks for the alleles above 7000 RFUs may be removed.

6. As per the Promega Technical Manual for the PowerPlex Y system, samples with increased signal (>2000 RFU), stutter products are often observed one and occasionally two repeat units below the true allele peak. If the sample is not a mixture, these stutter products can be removed.

E. Non specific artifacts

This category should be used if a labeled peak is caused by a not-previously categorized technical problem or caused by non-specific priming in a multiplex reaction. These artifacts are usually easily recognized due to their low peak height and their position outside of the allele range.

For YFiler™, this edit is applicable for artifacts at the +/- 2bp position for DYS19.

F. Elevated baseline

Elevated or noisy baseline may be labeled. They do not resemble distinct peaks. Sometimes, an elevated baseline may occur adjacent to a shoulder peak.

G. Spikes

1. Generally, a spike is an electrophoresis artifact that is usually present in all colors.

2. Spikes might look like a single vertical line or a peak. They can easily be distinguished from DNA peaks by looking at the other fluorescent colors, including red or orange. For Identifiler™, a spike may appear in the red or green, but not be readily apparent in the other colors. However, you can zoom in and confirm the spike.
3. Spikes may be caused by power surges, crystals, or air bubbles traveling past the laser detector window during electrophoresis.

H. Dye Artifacts

1. Constant peaks caused by fluorescent dye that is not attached to the primers or is unincorporated dye-labeled primers. These “color blips” can occur in any color. Dye artifacts commonly occur in the beginning of the green, blue, and the yellow loci right after the primer peaks (Applied Biosystems 2004 a and b).

2. These artifacts may or may not appear in all samples, but are particularly apparent in samples with little or no DNA such as the negative controls.

I. Removal of a range of alleles

Mixed samples which contain overblown peaks must be rerun. Refer to the GeneMapper ID Analysis Section for more information.

All manual removals of peak labels must be documented. This also serves as documentation for the technical review. Check the appendix for the correct peak assignments to each allelic ladder and the expected genotype of the positive control.

III. Detection of Rare Alleles

A. New Allele/Off-Ladder Allele

1. A peak defined outside the defined allele range or is not present in the allelic ladder.

2. If an OL allele could be a true allele, the sample must be rerun.

3. If multiple samples from the same case within the same run all show the same OL allele, only one sample needs to be rerun to confirm the OL allele.

4. Off-ladder alleles that are within the range of the ladder and are called by the software need not be rerun (i.e., a “19.2” at FGA).
5. If an assigned allele is either larger or smaller than the smallest or largest allele in the ladder, it should be rerun.

6. Use the following table for guidance if off-ladder alleles occur in samples that are injected with the same or different parameters:

Table 1 Retesting Strategies for Rare Alleles

<table>
<thead>
<tr>
<th>Injection 1</th>
<th>Injection 2 at same or higher injection parameter</th>
<th>Course of Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allele called</td>
<td>Allele labeled as “OL”</td>
<td>No rerun necessary report called allele</td>
</tr>
<tr>
<td>Allele labeled as “OL”</td>
<td>Allele called</td>
<td>No rerun necessary report called allele</td>
</tr>
<tr>
<td>Allele not called</td>
<td>Off Ladder</td>
<td>Rerun high</td>
</tr>
<tr>
<td>Allele labeled as “OL”</td>
<td>Allele labeled as “OL”</td>
<td>No rerun necessary report allele relative to position in the allelic ladder</td>
</tr>
</tbody>
</table>

7. After the second rerun, the allele is still off ladder, examine the allele closely. If it is not at least one basepair from a true allele, it is likely not a real off-ladder allele. In this case, a third injection on another instrument may be done to rule out the possibility of migration. If the locus is small and the peak heights are high, the sample may be re-aliquotted and re-injected.

IV. Interpretation of STR Data

A. Allele Table

1. After the assigning of allele names to the remaining labeled peaks, the software prepares a result table where all peaks that meet the above listed criteria are listed as alleles.
2. The allele nomenclature follows the recommendations of the International Society for Forensic Haemogenetics (ISFH), (DNA recommendations, 1994) and reflects the number of 4bp core repeat units for the different alleles.

3. Subtypes displaying incomplete repeat units are labeled with the number of complete repeats and a period followed by the number of additional bases.

4. The Y chromosome allele nomenclature is also based on the number of 4bp core repeats and follows the nomenclature suggested in Evaluation of Y Chromosomal STRs (Kayser et al 1997) and the one used in the European Caucasian Y-STR Haplotype database (Roewer et al 2001).

### B. Electropherograms

1. Capillary electrophoresis plot data containing case specific samples are part of each case record.

2. The table reflects the number and allele assignments of the labeled peaks visible on the electrophoresis plot. **The electrophoresis plots are the basis for results interpretation.**

3. The electrophoresis plot will display peak height information, unlabeled peaks, intensity differences that may indicate the presence of a mixture, and will show all peaks at each locus.

4. Looking at the electrophoresis plots also serves as a control for the editing process.

5. In certain instances it may be necessary to view the electropherogram electronically:

   a. No peak is above the minimum threshold but unlabeled peaks are visible. Refer to GeneMapper ID Analysis Procedure.
FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

STR RESULTS INTERPRETATION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>APPROVED BY</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>04-01-2014</td>
<td>NUCLEAR DNA TECHNICAL LEADER</td>
<td>8 OF 47</td>
</tr>
</tbody>
</table>

b. High peaks and very minor peaks present in the same color lane
   i. Since the RFU scale of the electropherogram is based on the highest peak in each color, alleles at weak loci will not be clearly visible if the loci are imbalanced.
   ii. Access the file for mixture interpretation or allelic dropout detection.
   iii. Go to View menu enter a fixed y-scale for Plot Options, Main Window Lower Panel. Generate the new electropherogram plot documentation. Do not save changes.

c. Plot states “no size data available”
   i. None of the peaks were above threshold
   ii. The original data which may be visible in the raw data file or GeneMapper ID displays visible peaks below the sizing threshold.

d. Distinct unlabeled peak in locus with similar height as “homozygous” allele. Refer to Section III – Detection of Rare Alleles.

V. Interpretation of controls

A. Electrophoresis Controls

1. Allelic Ladder

   Evaluate the allelic ladder for expected results – Refer to GeneMapper ID “References – Allelic Ladders, Controls, and Size Standards” Section.
2. Amplification Positive Control
   
   a. Evaluate the positive control for the expected type using the GeneMapper ID “References – Allelic Ladders, Controls, and Size Standards” Section.

   b. If the positive control has been shown to give the correct type, this confirms the integrity of the electrophoresis run and amplification set.

   c. The amplification positive control may be run at a different (lower or higher) injection parameter or dilution than the corresponding samples and the amplification set can pass.

3. Electrophoresis Run with Failed Positive Control

   a. Electrophoresis Run containing one Positive Control

      i. File out an Electrophoresis Failure Report or a Resolution Documentation and indicate the Positive Control will be rerun.

      ii. Rerest the Positive Control

         a) If the Positive Control passes, then rerun the complete Amplification Set with the retested Positive Control. (The entire amplification set, including the positive control, may be rerun together as determined by the analyst.)

         b) If the Positive Control fails; the Amplification Set fails. Fill out an Electrophoresis Failure Report or a Resolution Documentation and indicate the Amplification Set will be re-amplified.
b. Electrophoresis Run containing more than one Positive Controls

i. use another Positive Control to analyze the run

ii. Complete the STR Control Review documentation indicating the failed Positive Control “will be rerun”

iii. Add the sample number corresponding to the (failed) Positive Control to the Editing documentation

iv. Retest the (failed) Positive Control

a) If the Positive Control passes; the Amplification Set passes

b) If the Positive Control fails; the Amplification Set fails. Complete the STR Control Review documentation indicating the “sample set will be re-amplified”

c. Reruns / Re-injections

An injection set consisting of reruns or re-injections must have at least one Positive Control

Table 2 Interpretation of Electrophoresis Runs

<table>
<thead>
<tr>
<th>Controls / Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allelic Ladder – Pass</td>
<td>Run passes</td>
</tr>
<tr>
<td>Positive Control – Pass</td>
<td></td>
</tr>
<tr>
<td>Allelic Ladder – Pass</td>
<td>Refer to Section 3</td>
</tr>
<tr>
<td>Positive Control – Fail</td>
<td></td>
</tr>
<tr>
<td>Allelic Ladder(s) – Fail</td>
<td>Run fails</td>
</tr>
<tr>
<td>Positive Control – Fail</td>
<td>Fill out Electrophoresis Failure Report/ Resolution Documentation</td>
</tr>
</tbody>
</table>

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
### Table 3 Retesting Strategies for Positive Control

<table>
<thead>
<tr>
<th>Positive Control Result</th>
<th>Course of action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Data Available</td>
<td>Rerun</td>
</tr>
<tr>
<td>- No orange size standard in lane</td>
<td></td>
</tr>
<tr>
<td>No amplification product but orange size standard correct</td>
<td>Rerun</td>
</tr>
<tr>
<td>Rerun with same result</td>
<td>Re-amplify amplification set</td>
</tr>
<tr>
<td>Incorrect genotype</td>
<td></td>
</tr>
<tr>
<td>- Could be caused by ill-defined size standard, other Genotyper problems or sample mix-up</td>
<td>Rerun, if not able to resolve, re-run amplification product</td>
</tr>
<tr>
<td>Rerun fails to give correct type</td>
<td>Re-amplify amplification set</td>
</tr>
<tr>
<td>OL alleles</td>
<td>Rerun amplification product</td>
</tr>
<tr>
<td>- possibly Genotyper problem</td>
<td></td>
</tr>
</tbody>
</table>

### B. Extraction Negative and Amplification Negative Controls

1. PowerPlex Y and Minifiler negative controls, and Identifiler 28 and Yfiler negative controls injected under normal parameters:
   a. Evaluate the extraction negative and/or amplification negative control for expected results
   b. If peaks attributed to DNA are detected in an extraction negative and/or amplification negative control
      i. Retest the extraction negative control and/or amplification negative control
      ii. Refer to Table 4 and/or 5 for Retesting Strategies
### Table 4  Retesting Strategies for Extraction Negative Control

<table>
<thead>
<tr>
<th>Extraction Negative Result</th>
<th>Course of action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No data available</td>
<td>Rerun</td>
</tr>
<tr>
<td>- No orange size standard in lane</td>
<td></td>
</tr>
<tr>
<td>Misshaped orange size standard peaks</td>
<td>Control passes if no peaks are present</td>
</tr>
<tr>
<td>Run artifacts such as color blips or spikes</td>
<td>Edit</td>
</tr>
<tr>
<td></td>
<td>Rerun only if the artifacts are so abundant that amplified DNA might be masked</td>
</tr>
<tr>
<td>Alleles detected – Initial Run</td>
<td>Rerun</td>
</tr>
<tr>
<td>Alleles detected – Rerun</td>
<td>Re-amplify control</td>
</tr>
<tr>
<td>Alleles detected – Re-amplification</td>
<td>Extraction set fails</td>
</tr>
<tr>
<td></td>
<td>All samples must be re-extracted</td>
</tr>
</tbody>
</table>

### Table 5  Retesting Strategies for Amplification Negative Controls

<table>
<thead>
<tr>
<th>Amplification Negative Result</th>
<th>Course of action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No data available</td>
<td>Rerun</td>
</tr>
<tr>
<td>- No orange size standard in lane</td>
<td></td>
</tr>
<tr>
<td>Misshaped orange size standard peaks</td>
<td>Control passes if no peaks are present</td>
</tr>
<tr>
<td>Run artifacts such as color blips or spikes</td>
<td>Edit</td>
</tr>
<tr>
<td></td>
<td>Rerun only if artifacts are so abundant that amplified DNA might be masked</td>
</tr>
<tr>
<td>Peaks detected – Initial Run</td>
<td>Re-run</td>
</tr>
<tr>
<td>Peaks detected – Rerun</td>
<td>Amplification set fails</td>
</tr>
<tr>
<td></td>
<td>Re-amplify amplification set</td>
</tr>
</tbody>
</table>
2. **Identifiler 28 and Yfiler negative controls injected under “high” parameters**
   
a. Evaluate the extraction negative, amplification negative, and/or microcon negative control for expected results

b. If peaks attributed to DNA are detected in a negative control, refer to Table 7 for retesting strategies.
   
i. Re-aliquot and rerun the control at the same injection conditions to confirm failure. If the realiquot still fails, the control (either the original aliquot so one can re-inject the sample plate) or the second aliquot must be re-injected with a lower injection parameter.

   ii. If a negative control fails following injection with “high” parameters but passes with injections under “normal” parameters, data from samples in the amplification set injected with “high” parameters fails accordingly, whereas data from samples injected with “normal” parameters passes.

3. **Identifiler 31 Controls**

   Negative controls can display spurious allele peaks and still pass, unless:

   a. The allele occurs in two of the two or three amplifications, which indicates potential contamination instead of drop-in. If this happens for only one or two loci, the affected loci must be evaluated for all samples. The locus is inconclusive for samples that display the same allele, which is present in the negative control, at this locus.

   b. If more than two repeating peaks are present in a negative control, the amplification or extraction fails.

   c. Even if none of the spurious allele peaks repeat in two amplifications, a control fails if too many spurious alleles are present. The cut off is > 9 drop-in peaks distributed over at least two of the three amplification aliquots for three amplifications.
d. If a negative control fails, it must be realiquotted and rerun at the same injection conditions to confirm failure. If the realiquot still fails, the control (either the original aliquot so one can re-inject the sample plate) or the second aliquot must be re-injected with a lower injection parameter.

e. If a negative control fails following injection with “high” parameters but passes with injections at “optimal” or “low” parameters, data from samples in the amplification set injected with “high” parameters fails accordingly, whereas data from samples injected with “optimal” or “low” parameters passes.

f. Refer to the Table 6 to determine whether data for ID28 and ID31 samples may be used with respect to the pass/fail status of the associated controls at ID28 and ID31 injection parameters.
## TABLE 6  Interpretation of samples and Retesting Strategies for Negative Controls amplified with Identifiler 31.

<table>
<thead>
<tr>
<th>Treatment of E-Neg/M’con Negative Controls</th>
<th>Result</th>
<th>Course of action</th>
<th>Interpretation</th>
<th>Samples may NOT be amped/run in: (All peaks should be removed from electropherograms)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplified in Identifiler 31; Run on H parameters</td>
<td>PASS</td>
<td>None</td>
<td>Identifiler 31, Identifiler 28 and YM1 (any parameter).</td>
<td>N/A</td>
</tr>
<tr>
<td>Amplified in Identifiler 31; <strong>First</strong> run on H parameters</td>
<td>FAIL</td>
<td>Controls should be re-aliquoted and injected at H parameters again</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Amplified in Identifiler 31; <strong>Second</strong> run on H parameters</td>
<td>FAIL</td>
<td>Controls should be re-injected at N parameters</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Amplified in Identifiler 31; Run on N parameters</td>
<td>PASS</td>
<td>None</td>
<td>Identifiler 31 injected at N or L, Identifiler 28 injected at I or IR and YM1</td>
<td>Identifiler 31 injected at H</td>
</tr>
<tr>
<td>Amplified in Identifiler 31; Run on N parameters</td>
<td>FAIL</td>
<td>Controls should be re-injected at L parameters</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Amplified in Identifiler 31; Run on L parameters</td>
<td>PASS</td>
<td>None</td>
<td>Identifiler 31 injected at L, Identifiler 28 injected at I and YM1</td>
<td>Identifiler 31 injected at H and N</td>
</tr>
<tr>
<td>Amplified in Identifiler 31, Run on L parameters</td>
<td>FAIL</td>
<td>Controls may be amped in Identifiler 28 , or YM1</td>
<td>N/A</td>
<td>Identifiler 31, Identifiler 28 and YM1 (any parameter).</td>
</tr>
</tbody>
</table>

H = High injection for Identifiler 31 samples at 6 kV 30 sec  
N = Normal injection for Identifiler 31 samples at 3 kV 20 sec  
L = Normal injection for Identifiler 31 samples at 1 kV 22sec
### TABLE 7  Interpretation of samples and Retesting Strategies for Extraction/Microcon
Negative Controls amplified with Identifiler 28.*

| Treatment of E-Neg/M’con Negative Controls | Result | Course of action | Interpretation | Samples may NOT be amped/run in:  
(All peaks should be removed from electropherograms) |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplified in Identifiler 28; Run on IR Parameters</td>
<td>PASS</td>
<td>None</td>
<td>Identifiler 28 injected at I or IR and YFiler</td>
<td>Identifiler 31</td>
</tr>
</tbody>
</table>
| Amplified in Identifiler 28;  
**First** run on IR Parameters | FAIL   | Controls should be re-aliquoted and injected at IR again | N/A            | N/A                                                                              |
| Amplified in Identifiler 28;  
**Second** run on IR Parameters | FAIL   | Controls should be re-injected at I | N/A            | N/A                                                                              |
| Amplified in Identifiler 28;  
Run on I Parameters | PASS   | None            | Identifiler 28 injected at I and YFiler | Identifiler 31 and Identifiler 28 injected at IR                                |
| Amplified in Identifiler 28;  
Run on I Parameters | FAIL   | Controls may be amped in VM1 as needed | N/A            | Identifiler 31 and Identifiler 28 (all injection parameters)                      |

IR = High injection for Identifiler 28 samples at 5 kV 20 sec  
I = Normal injection for Identifiler 28 samples at 1 kV 22 sec  
* If a negative control is amplified in Identifiler 28 initially, there may not be enough volume for Identifiler 31 amplification.
VI. Reporting Procedures

Evidence samples will be duplicated (single source and mixture samples) according to the concordant analyses and “duplicate rule.” To improve workflow, the Property Crimes and High Sensitivity/Hybrid teams may automatically duplicate evidence samples regardless of DNA concentration.

A. Guidelines for Reporting Allelic Results

1. Items listed in allele typing tables should be limited to samples that are used to draw important conclusions of the case. Genotypes are not reported and should not be inferred, i.e., if only a “7” allele is found; it should be reported as 7. Alleles and/or peaks are listed in the results tables regardless of intensity differences, based on the reporting criteria below.

2. If an allele meets the above reporting thresholds and fulfills the concordant analyses and the duplicate rule as stated in the General PCR Guidelines, then the allele will be evaluated for the report and/or summary table in the file.

3. For samples amplified in Identifiler 31 or Identifiler 28 and run with the 5kV/20sec injection parameter (such as those in the High Sensitivity Team), small loci may be overblown in order to visualize larger loci. In these instances, use the data from an injection with lower parameters for the small loci whereas data from injections with higher parameters may be used for allelic assignments for larger loci. In this manner, a complete or near complete profile may be assigned. Regarding the small loci at high injection parameters, remove the peaks if they are overblown and consider the locus inconclusive at the high injection parameters.

4. If no alleles are detected in a locus, then the locus may be reported as “NEG” (no alleles detected).
B. Previously unreported rare alleles

1. A distinct peak of the same labeling color outside the allelic range could be a rare new allele for this locus. This possibility should be considered if:
   
a. The overall amplification for the other loci displays distinct peaks >75 (or 100 if applicable) and does not show artifacts
   
b. The same color locus closest to the new size peak does not have more than one allele peak, and
   
c. The new size peak is also detected in the duplicate run.

2. All alleles that are not present on the allelic ladder should be identified by their relative position to the alleles in the allelic ladder. The peak label should show the length in base pairs and this value can be used to determine the proper allele nomenclature. A D7S820 allele of the length 274 bp in Identifiler is located between alleles 10 (271 bp) and 11 (275) and has to be designated 10.3. The off-ladder allele should be reported using this nomenclature.

3. Off-ladder alleles which fall outside the range of the allelic ladder at that locus should be reported as < or > the smallest or largest allele in the ladder.

C. Discrepancies for overlapping loci in different multiplex systems

1. The primer-binding site of an allele may contain a mutation.
   
a. This mutation may make the annealing phase of amplification less efficient.
   
b. Alternatively, if the mutation is near the 3’ end, this may completely block extension (Clayton et al. 1998).

2. This mutation may result in a pseudo-homozygote type.
   
a. For a specific set of primers, this is reproducible.
   
b. However, these mutations are extremely rare, estimated between 0.01 and 0.001 per locus (Clayton et al. 1998).
3. If a pseudo-homozygote type for a locus was generated, evidence and exemplar samples amplified with the same primer sequence can be used for comparison.
   a. Identifiler has the same primer sequences as Cofiler and Profiler Plus; however, these sequences differ in Minifiler.
   b. Therefore, the results from amplification with Identifiler may not be reproducible when compared with those of Minifiler.

4. If the same locus is amplified using a multiplex system with primer sequences that differ, it is possible to obtain a heterozygote type in one multiplex and the pseudo-homozygote in the second. The heterozygote type is the correct type and should be reported.

VII. Guidelines for Interpretation of Results

The purpose of these guidelines is to provide a framework which can be applied to the interpretation of STR results in casework. The guidelines are based on validation studies, literature references, some standard rules and experience. However, not every situation can be covered by a pre-set rule. Equipped with these guidelines, analysts should rely on professional judgment and expertise.

A. First evaluate the profile in its entirety to determine whether the sample is composed of one or more contributors.

1. For Low Template (LT-DNA) samples, refer to the interpretation section of the manual for samples amplified with 31 cycles.

2. A High Template DNA (HT-DNA) sample profile can be considered to have originated from a single source if:
   a. Excluding stutter and other explainable artifacts, the sample does not demonstrate more than two labeled peaks at each locus.
   b. The peak height ratio (PHR) at each heterozygous locus is above 60.5% for samples amplified with the AmpFlSTR Identifiler® kit for 28 cycles. Note the PHR of a heterozygous pair is determined by dividing the height of the shorter peak (in RFUs) by the height of the taller peak (in RFUs) and expressing the result as a percentage.
c. If the PHR falls below 60.5% at a locus, consider whether this may be due to a primer binding site mutation, degradation, the amount of template DNA, or extreme allele size differences. Under these circumstances a sample may be considered single source and heterozygote pairs may be assigned even if greater imbalance is observed.

d. If the sample profile complies with the conditions above but three labeled peaks are present at a single locus, the DNA contributor may be tri-allelic at that locus.

3. Samples that do not meet the single source criteria listed above should be considered mixed samples.

4. If an additional allele is present at only one or two loci, these alleles may be the result of a low level mixture detected only at those loci. The source of these allele(s) cannot be determined. The sample may be interpreted according to the guidelines for single source samples.

   a. No conclusions can be drawn regarding the source of these alleles that cannot be attributed to Male or Female Donor X.

   b. Moreover, no comparisons can be made to this allele(s).

B. DNA results may be described in one of three categories, designated as “A”, “B”, or “C”.

1. Samples and/or components of samples with data at all targeted loci should be categorized as “A”. This category includes the following:

   a. Single source samples with labeled peaks at all loci and no peaks seen below the detection threshold.

   b. The major and the minor contributors of mixtures where DNA profiles are determined at all targeted loci including those loci assigned a “Z” if the “Z” designation was due to potential allelic sharing.

   c. The major contributors of mixtures where the DNA profile of the major contributors were determined including those loci assigned a “Z” if the “Z” designation was due to potential allelic sharing, but the DNA profile of the minor contributors were not determined.
d. Mixtures where the DNA profiles of the contributors were not or could not be determined and no peaks were seen below the detection threshold.

2. All samples or components of samples that are not categorized as “A” described above or “C” described below may be considered “B”. This encompasses a wide continuum of samples including the following:
   a. Single source samples with labeled peaks at fewer than all targeted loci and/or peaks below the detection threshold.
   b. The major and/or the minor contributors to mixtures where DNA profiles were determined at less than the targeted number of loci. At least 4 complete loci or at least 5 loci including those assigned a “Z” if the “Z” designation was due to potential allelic sharing or dropout, should have been determined.
   c. Mixtures where the DNA profiles of the major and the minor contributors could not be determined and peaks were noted below threshold, or allelic dropout is suspected.

3. Samples and/or components of samples categorized as “C” should not be interpreted or used for comparison. This category includes the following:
   a. Too few peaks labeled
      i. Single source HT-DNA samples with fewer than eight labeled peaks over four STR loci
      ii. Single source LT-DNA samples with fewer than eight labeled peaks over six STR loci
      iii. Single source YSTR data samples with fewer than four alleles over four YSTR loci
      iv. Mixed samples where after deconvolution of the major contributor, there remain fewer than eight labeled peaks that cannot be attributed to the major component. In this situation, the remaining alleles should not be used for comparison.
      v. Mixed HT-DNA samples with fewer than 12 labeled peaks over six STR loci
      vi. Mixed LT-DNA samples with fewer than 12 labeled peaks over eight STR loci in the composite profile
b. Too many peaks labeled
   i. Mixed HT-DNA samples that show seven or more labeled peaks at two or more STR loci
   ii. Mixed LT-DNA samples that show seven or more labeled peaks at two or more STR loci in the composite profile

c. Other sample characteristics
   i. Excessive number of peaks below the detection threshold seen over many loci
   ii. Mixed HT-DNA samples with template amounts less than 150 pg and mixed LT-DNA samples with template amounts less than 20 pg that show indications of multiple, for example four, contributors such as drastic inconsistencies between replicates.

d. Use the Not Suitable for Comparison/Inconclusive documentation to record the reason for categorizing a sample as category “C”. For mixtures which can be deconvoluted for the major contributor, but are not suitable for comparison to the minor contributor, as described above in 3a iv, document the reason.

NOTE: The interpretation protocols detailed below and in the ID31 interpretation section accommodate samples from categories A and B.

C. Interpretation of single source samples.

1. For LT-DNA samples refer to the interpretation section of the manual for samples amplified with 31 cycles.

2. HT-DNA samples may be used if they fulfill the concordant analysis and duplicate rule. Refer to the “General Guidelines for DNA Casework”.

3. If multiple injections are generated for a given PCR product, and/or if multiple amplifications were performed, for each locus select the injection and/or amplification that shows the greatest number of labeled peaks.

4. For replicate results check for consistency and assign the allele(s). If results are not consistent between the replicates, a locus may be inconclusive or assigned a “Z”.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
5. Peak height imbalance is a feature of heterozygotes. Refer to tables 8a and 8b for OCME Identifiler® validation results. For single source samples, heterozygote pairs may be assigned even if greater than average imbalance is observed. Consider the potential contribution of stutter if one labeled peak is in the stutter position of the other.

6. When a single labeled peak is present, consider the potential for a false homozygote. It is possible that allelic dropout occurred and another allele may be present in the DNA profile so that a “Z” may need to be assigned to the locus.

   a. Apply caution when interpreting samples with labeled peaks below 250 RFU or samples that show a pattern of degradation.
   b. Consider whether the single labeled peak is at a large and/or less efficient locus. In Identifiler, these loci are: CSF1PO, D2S1338, D18S51, FGA, TH01 and D16S539. Consider also whether the single labeled peak is in the last labeled locus of each color. For example, in Identifiler, if CSF has no labeled peaks and a single labeled peak is seen at D7S820, this could be a false homozygote.
   c. Regardless of the height of labeled peaks at other loci, if the peak in question is less than 250 RFU, this could be a false homozygote.

D. Mixture Deconvolution

1. For LT-DNA samples refer to the interpretation section of the manual for samples amplified with 31 cycles.

2. There are several categories of mixtures that may be deconvoluted.
   a. The major contributor is unambiguous.
   b. The major contributor and the minor contributor can be deconvoluted using the specific guidelines described in the following sections.
   c. The major contributor can be deconvoluted using the specific guidelines described in the following sections, but the minor contributor cannot.
   d. The major contributor or the minor contributor can be deconvoluted using an assumed contributor and the specific guidelines described in the following sections.
3. Take the following general guidelines into consideration when evaluating a mixed sample.
   a. For a deduced profile, a locus may be deemed inconclusive for the deduction; however, this data might still be useful for comparison.
   b. Caution should be used when deconvoluting the following types of samples:
      i. Mixtures with DNA template amounts between 100 pg and 250 pg.
      ii. Three person mixtures. These mixtures should only be deconvoluted if one or more contributors are very minor.
      iii. If multiple amplifications are performed, and at a locus, one allele is seen in just a single amplification.
   c. The major contributor may be determined using the specific guidelines in the following sections without using an assumed contributor.
      i. Mixture ratios and potential allele sharing can be used to evaluate genotype combinations; however, the PHRs of the allelic pairs should meet the specific guidelines described in the following sections.
      ii. For potential allele sharing, consider all possible genotype combinations at each locus and chose the one fulfilling the mixture ratio expectation. If there are two or more genotype combinations fulfilling the mixture ratio expectation, the DNA profile at that locus will either include a “Z” or be deemed inconclusive.
   For some samples, the DNA profile of the minor contributor may also be deconvoluted. The DNA profile of the major contributor and the mixture ratio expectation should be used, as well as the specific guidelines described in the following sections. In order to facilitate this process, it may be useful to amplify the sample with more DNA, if sufficient DNA is available.
The DNA profile of an assumed contributor may be used to determine the most likely profile of another contributor. In this situation, the PHRs of the assigned contributors should meet the specific guidelines described in the following sections, taking potential allele sharing into account. Examples of assumed contributors include the following:

i. Examples of assumed contributors include the following:
   1) A victim that is expected to have contributed biological material to the sample, and those DNA alleles are seen in the mixed sample.
   2) An elimination sample such as a boyfriend, family member, or witness, and those DNA alleles are seen in the mixed sample.
   3) A previously determined profile present in another sample within the case, and those DNA alleles are seen in the mixed sample.

ii. The report must state this assumption as follows:
   “Assuming that (insert name A here) is a contributor to this mixture,…” refer to the “STR Comparisons” procedure for further details.

4. The first step in mixture deconvolution is to determine whether the sample meets the concordance policy.
   a. A single amplification that fulfills the concordance policy and is suitable for deconvolution may be used. However, in order to deconvolute samples amplified with less than 250 pg of DNA template, duplication should be attempted with the following exceptions.
      i. If a known donor is assumed to be one of the contributors to a concordant mixture and this known profile is utilized in the deconvolution (refer to section 7d for details), duplication is not required.
      
      ii. Moreover, concordant mixtures used for comparison only do not need to be duplicated.
b. In order to fully resolve components of mixtures with peak heights above 7000 RFUs using Genotyper or at loci which are saturated according to the Genemapper software, samples should be re-injected at a dilution or a lower parameter.

c. If multiple injections of a given PCR product and/or amplifications with varying amounts of DNA are generated for a sample, for each locus select the injection or amplification that shows the greatest number of labeled peaks that are not off scale or oversaturated.
   i. For example, if a small locus is off scale in the first injection but is within range in the second injection, data from the second injection may be used for that locus.
   ii. Similarly, if a large locus generated more data from the first injection than another, the data from the first injection may be used for that locus.

d. If duplicate amplifications are performed with the same DNA template amount follow the specific guidelines below for deconvolution.

5. The second step in analysis is to estimate the number of contributors to the sample.
   a. A minimum number of contributors to a mixed profile can be estimated using the locus or loci demonstrating the largest number of labeled peaks.
   b. At least two contributors:
      i. If there are three or more labeled peaks at a locus, the sample may be considered to have at least two contributors.
         1) Consider whether one of the peaks could be attributed to stutter. If none of the peaks could be stutter, then the sample should be considered a mixture.
         2) A third labeled peak at only one locus may be an indication of a tri-allelic pattern.
      ii. Other indications of a two person mixture include observed peak height ratios between a single pair of labeled peaks at several loci below 60.5%. Tables 8a and 8b illustrate the empirically determined heterozygous PHR for single source samples.
c. **At least three contributors:**
The presence of more than four labeled peaks at a locus indicates that at least three individuals may have contributed to the mixture. When only one locus displays five peaks, consider whether any of the peaks could be attributed to stutter rather than to a third donor.
d. When assessing the number of contributors to a mixture, the presence of peaks below the detection threshold may be considered.

6. **The third step in analysis is to estimate the mixture ratios of the contributors.**
a. For a two-person mixture, identify loci with four labeled peaks. If there are none, evaluate loci with three alleles. For a three-person mixture where there are two major contributors and one very small contributor, select loci with four major labeled peaks to determine the ratio between the two major contributors.
b. If applicable, from those loci, select ones that have amplicons of short, medium, and long length.
c. Calculate the ratio of the sum of the heights of the larger peaks to the sum of the heights of the smaller peaks for each selected locus. For a locus with three alleles (one peak significantly larger than two other peaks), divide the height of the larger peak by the sum of the heights of the smaller peaks.
d. A locus with three peaks of approximately equal heights may indicate a 2:1 mixture. The resultant mixture ratio may be a range across loci. For example, the mixture ratio may range from 3:1 to 5:1.
f. Mixtures, where the tallest peaks in one amplification are not the tallest peaks in another amplification, may be approaching a 1:1 ratio.
g. For high mixture ratios such as 10:1, the estimate may be less extreme than the true ratio since some minor alleles may be below the detection threshold.

7. **Mixed samples whose ratios approach 1:1 should not be deconvoluted unless there is an assumed contributor. However, these mixtures may be used for comparison.**
8. For all mixtures, a homozygote may be assigned if the following conditions are met:
   a. Major component
      i. If two amplifications were performed, the same major peak should be labeled in both amplifications. All other peaks labeled at the locus should be less than 30% of the major peak.
      
      ii. The peak height of the potential homozygote should be above 250 RFU. This suggests that this peak is not a heterozygote, as the other peak in this pair would be above the detection threshold.
      
      iii. Caution should be used when assigning a homozygote to a large and/or less efficient locus. In Identifiler® mixed samples, these loci are CSF1PO, D2S1338, D18S51, FGA, TH01, D16S539, and TPOX. TPOX is a locus prone to primer binding mutations, which is relevant for mixtures that contain a homozygote and a heterozygote that share the same allele. Consider also whether the potential homozygote peak is in the last labeled locus of each color. For example, in Identifiler®, if CSF has no labeled peaks and the potential homozygote peak is seen at D7S820, this could be a false homozygote.
      
      If two or more labeled alleles are present at FGA, and the tallest peak is ≤ 33.2 repeats and another peak is ≥ 42.2 repeats, do not assign a homozygote even if all minor peaks are < 30% of the tallest peak. Rather, assign the tallest labeled peak and a “Z”.
      
      iv. If a homozygote cannot be assigned at a locus, continue to the next step for a two-person mixture or to the step specific for three person mixtures to determine whether to assign a heterozygote or a “Z”.
### STR RESULTS INTERPRETATION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>APPROVED BY</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>04-01-2014</td>
<td>NUCLEAR DNA TECHNICAL LEADER</td>
<td>29 OF 47</td>
</tr>
</tbody>
</table>

b. **Minor Component (for two person mixtures only)**
   
   i. Assign alleles to the major component first. Then, consider the mixture ratio.

   ii. If there is a single labeled peak or a single labeled peak that cannot be attributed to a major contributor at a locus, consider potential allelic sharing and allelic dropout.

   Criteria to assign a homozygote include the following:
   
   1) The peak height of the potential homozygote should be above 250 RFU.
   
   2) Caution should also be used when assigning homozygotes to the last apparent locus in each color and the less efficient loci as described for major contributors.

   3) The presence of peaks below the detection threshold could suggest dropout.

   4) The template amount should be considered.

   iii. If there is a single labeled peak at a locus and if dropout is not suspected, the minor component could share the allele with the major component. If dropout of one allele is suspected, assign the major allele and a “Z”. Alternatively, the locus may be inconclusive.

   iv. If there are two or more labeled peaks at a locus, but only one labeled peak cannot be attributed to the major contributor, if dropout is not suspected, assign the labeled peak as a homozygote. If dropout of one allele is suspected, assign the labeled peak and a “Z”.

9. **For two person mixtures, follow the steps below to determine whether a heterozygote may be assigned.**

   **NOTE:** For two person mixtures, allele sharing may be unambiguous. If that is the case, subtract the contribution of the shared allele prior to the peak height ratio calculations.
a. **Loci with two labeled peaks in an amplification:**
   i. **Major Component**
      1) If the mixture is approximately 2:1, and has one labeled peak in the stutter position, assign the largest peak and a “Z”. If two amplifications are performed, the peak should be the largest peak in both amplifications.
      2) In all cases, consider the PHR for the two highest peaks at each locus for each amplification. To assign a heterozygote:
         a) If two amplifications were performed, one amplification should have a ratio of at least 67% and the average of the ratios from each of the two amplifications should be at least 50%. If only one amplification was performed, the ratio should be at least 67%.
         b) If two amplifications were performed, if the peaks “flip”, meaning that peak A is taller in amp 1 and peak B is taller in amp 2, both peaks may be assigned if the PHR is ≥ 50% in each amplification and the mixture ratio is 3:1 or more extreme. If the peaks flip and these conditions are not met, the locus should be deemed inconclusive since the tallest peak cannot be identified.
         c) Otherwise, assign the tallest peak in both amplifications and a “Z” to indicate the possible presence of another allele.
   ii. **Minor component**
      1) Assign alleles to the major component first, then, consider the mixture ratio and potential allelic sharing. Subtract the height of the smaller allele from the larger allele and consider whether the resulting genotype combinations fulfill the mixture ratio expectation.
2) If the minor peak is in the stutter position, consider the possible contribution of stutter.

3) If the major component is heterozygous, determine whether part of one or both of the major peaks could also be attributed to the minor component.
   a) Evaluate whether dropout could have occurred based on the presence of peaks below the detection threshold, the overall characteristics of the sample, and the efficiency of the loci amplified.
   b) If dropout is suspected, the locus may be inconclusive, or if this fulfills the mixture ratio expectation, the larger labeled peak and a “Z” may be assigned.
   c) If dropout is not suspected, consider potential allelic sharing, the mixture ratio and stutter in order to assign a homozygote or a heterozygote.

4) If the major component is homozygous, refer to section 8b to determine whether the minor component is homozygous. If not, or if it cannot be determined, assign the minor labeled peak and a “Z”, or if there is no evidence of dropout, assign a heterozygote if this fulfills the mixture ratio expectation.

b. Loci with three labeled peaks in each amplification
   i. Major Component
      1) If the mixture is approximately 2:1, and has one labeled peak in the stutter position of another peak, consider the potential contribution of stutter.
         a) At loci with high stutter, if peak imbalance is maximal, one may not be able to deconvolute the locus. However, this situation does not usually repeat in two amplifications.
         b) Therefore, if the allelic sharing is unambiguous in at least one amplification, an allele(s) may be assigned. Refer to the steps below.
2) Identify the two tallest peaks
   a) If the PHR for the height of the shortest peak to the tallest peak is 67% or more, the locus may be deemed inconclusive.
   b) If not, calculate the PHR of the shortest peak to the second tallest peak. If this PHR is less than 67%, proceed. Otherwise, the tallest peak in both amplifications and a “Z” may be assigned to indicate the presence of another allele.
   c) If two amplifications are evaluated, and if, in at least one amplification, the criteria in step b are met and in the other amplification, the same two peaks are at least the tallest peaks, proceed below.

3) In all cases, to assign a heterozygote to the major component, if it is not readily apparent that the two tallest labeled peaks could be a heterozygous pair, calculate the PHR for the two tallest labeled peaks.
   a) If two amplifications were performed, one amplification should have a ratio of at least 67%, and the average of the two ratios should be at least 50%. If a single amplification was performed, the ratio should be at least 67%.
   b) If two amplifications were performed, if the two tallest peaks (A and B) “flip”, meaning that peak A is taller in amp 1 and peak B is taller in amp 2, both peaks may be assigned if the PHR is $\geq 50\%$ in each amplification, and the mixture ratio is 3:1 or more extreme. If the peaks flip and these conditions are not met, the locus should be deemed inconclusive since the tallest peak cannot be identified.
   c) Otherwise, assign the tallest labeled peak in both amplifications and a “Z” to indicate the possible presence of another allele.
d) Note: to evaluate potential allelic sharing, subtract the contribution of the minor allele(s) from the major allele prior to calculating the PHR.

ii. Minor component
   1) If the major component was determined to be heterozygous, consider the peak that cannot be attributed to the major component and evaluate whether dropout could have occurred or whether the minor contributor is homozygous, refer to section 8b.
   2) Consider also the mixture ratio and potential allelic sharing to determine whether one of the major peaks could also be part of the minor component. For example, subtract the height of the smallest allele from the largest allele and consider whether the remaining peak heights fulfill the mixture ratio expectations.
   3) If the major component was determined to be homozygous at a locus, evaluate the PHR for the other two labeled peaks as described above to determine whether they can be considered a heterozygous pair.
      If a minor peak is in the stutter position, consider the possible contribution of stutter.

   c. Loci with four labeled peaks in each amplification:
      i. Major Component
         1) If the mixture is approximately 2:1, and has one labeled peak in the stutter position of another peak, stutter should be considered. In some cases, assign the largest peak in both amplifications and a “Z”.
            a) These situations may occur at loci with high stutter and when peak imbalance is maximal, however this usually will not repeat in two amplifications.
            b) Therefore, if the alleles are unambiguous in at least one amplification, both alleles may be assigned. Refer to the steps below.
2) In all cases, to assign a heterozygote for the major component, if the PHR for the height of the shortest peak to the tallest peak is 67% or more, the locus may be deemed inconclusive. Otherwise, determine the peak height ratio for the two highest peaks at each locus for each amplification.
   a) If two amplifications were performed, the ratio should be at least in one amplification, the ratio should be at least 67% and the average of the ratios from each of the two amplifications should be at least 50%. If a single amplification was performed, the ratio should be at least 67%.
   b) If two amplifications were performed, and the two tallest peaks (A and B) “flip”, meaning that peak A is taller in amp 1 and peak B is taller in amp 2, both peaks may be assigned if the PHR is \( \geq 50\% \) in each amplification, and the mixture ratio is 3:1 or more extreme. If the peaks flip and these conditions are not met, the locus should be deemed inconclusive since the tallest peak cannot be identified.
   c) Otherwise, assign the tallest peak in both amplifications and a “Z” to indicate the possible presence of another allele.

ii. Minor Component
1) After a heterozygote is assigned to the major component, consider the mixture ratio to determine whether the remaining two labeled peaks may be attributed to the minor component.

2) Consider also whether peaks are present below the detection threshold.
## STR RESULTS INTERPRETATION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>APPROVED BY</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>04-01-2014</td>
<td>NUCLEAR DNA TECHNICAL LEADER</td>
<td>35 OF 47</td>
</tr>
</tbody>
</table>

3) If a minor peak is in the stutter position, consider the possible contribution of stutter.

4) Evaluate the PHR for the two minor peaks as described above to determine whether they can be considered a heterozygous pair.

5) The two minor peaks do not have to meet PHR thresholds if there are clearly only two contributors, the two heterozygous pairs are unambiguous in one amplification and any imbalance in the second amplification can be explained by the contributions of stutter and the length of the STR repeat alleles.

### 10. Assignment of a heterozygote for a three person mixture with one clear major contributor and two very minor contributors.

a. Identify the two tallest peaks in both amplifications.
   i. If the PHR for the height of the shortest peak to the tallest peak is 67% or more, the locus may be deemed inconclusive.
   ii. If not, calculate the PHR of the shortest peak to the second tallest peak. If it is less than 67% proceed. Otherwise, the tallest peak in both amplifications and a “Z” may be assigned to indicate the possible presence of another allele.
   iii. If two amplifications are evaluated, and if in at least one amplification the above criteria are met and in the other amplification the same two peaks are the tallest peaks, proceed below.

b. Determine the PHR for the two highest peaks at each locus for each amplification. To assign a heterozygote at any locus:
   i. If two amplifications were performed, the ratio should be at least 67% and the average of the ratios from each of the two amplifications should be at least 50%. If a single amplification was performed, the ratio should be at least 67%.
ii. Alternatively, if the two tallest peaks “flip”, meaning that peak A is taller in amp 1 and peak B is taller in amp 2, a heterozygote may be assigned if both PHRs are \( \geq 50\% \). If the peaks flip and these conditions are not met, the locus should be deemed inconclusive, since the tallest peak cannot be identified.

iii. Otherwise, assign the tallest peak in both amplifications and a “Z” to indicate the possible presence of another allele.

iv. Due to potential allelic sharing, for a locus with all peak heights below 250 RFU, the locus may be inconclusive and even the tallest allele should not be assigned.

c. For three person mixtures with one major contributor and two minor contributors where the ratio is less extreme, approaching 3:1:1 for example, follow the guidelines in step b with the following additional precaution:

At loci with only two labeled peaks and no indication of other peaks, although the PHRs may comply with the guidelines in step 10b, the locus may still be inconclusive due to allelic sharing. However, if one peak is significantly the tallest peak in both amplifications, one may assign that peak and a Z.

11. For three person mixtures with two major contributors and one very minor contributor, follow the two-person rules for deconvoluting loci with two, three or four major labeled peaks at a locus.

a. If only two or three labeled peaks are seen at a locus, potential allelic sharing should be taken into account. This may especially be the situation for peaks in the stutter position. In some situations, only the largest labeled peak and a “Z” may be assigned.

b. Due to potential allele sharing, for a locus with all peak heights below 250 RFU, the locus may be inconclusive and even the tallest labeled peak should not be assigned.
12. In some situations, not all loci will be able to be deconvoluted within a sample profile. These loci may contain multiple allele combinations that fall within the expected peak height ratio. In this case, the major and/or the minor component(s) at those loci will be inconclusive and not used for random match probability calculations.

13. Refer to the CODIS manual for instructions regarding the ability to enter mixed or inconclusive loci into CODIS and the preparation of the DB Profile documentation.

D. Mixtures for comparison only

1. The mixture must fulfill the concordance policy and duplicate rule. Refer to the “General Guidelines for DNA Casework”.
2. Consider all results according to the specific guidelines for sample comparisons described in the STR manual.
   a. If multiple injections of a given PCR product and/or amplifications with varying amounts of DNA are generated for a sample, for each locus select the injection or amplification that shows the greatest number of labeled peaks that are not off scale or oversaturated.
   b. If duplicate amplifications are performed with the same DNA template amount, evaluate all data. However, if for one or both amplifications, multiple injections of the same PCR product were generated, follow the guideline above (D2a).

E. Discrepancies for overlapping loci in different multiplex systems

1. The primer-binding site of an allele may contain a mutation.
   a. This mutation may make the annealing phase of amplification less efficient.
   b. Alternatively, if the mutation is near the 3’ end, this may completely block extension (Clayton et al. 1998).
2. This mutation may result in a pseudo-homozygote type.
   a. For a specific set of primers, this is reproducible.
   b. However, these mutations are extremely rare, estimated between 0.01 and 0.001 per locus (Clayton et al. 1998).
3. If a pseudo-homozygote type for a locus was generated, evidence and exemplar samples amplified with the same primer sequence can be used for comparison.
   a. Identifiler has the same primer sequences as Cofiler and Profiler Plus; however, these sequences differ in Minifiler.
   b. Therefore, the results from amplification with Identifiler may not be reproducible when compared with those of Minifiler.

4. If the same locus is amplified using a multiplex system with primer sequences that differ, it is possible to obtain a heterozygote type in one multiplex and the pseudo-homozygote in the second. The heterozygote type is the correct type and should be reported.

**TABLE 8A (below). Peak Height Ratios per locus:** Peak height ratios were calculated for each locus for 500 pg, 250 pg, 150 pg and 100 pg of DNA amplified with Identifiler® for 28 cycles. The table depicts the average, the minimum and the maximum ratios observed.

<table>
<thead>
<tr>
<th>Locus</th>
<th>500 pg</th>
<th>250 pg</th>
<th>150 pg</th>
<th>100 pg</th>
</tr>
</thead>
<tbody>
<tr>
<td>D8</td>
<td>89.61</td>
<td>83.42</td>
<td>99.8</td>
<td>81.22</td>
</tr>
<tr>
<td>D21</td>
<td>87.18</td>
<td>72.39</td>
<td>99.66</td>
<td>85.95</td>
</tr>
<tr>
<td>D7</td>
<td>79.57</td>
<td>59.67</td>
<td>99.17</td>
<td>73.92</td>
</tr>
<tr>
<td>CSF</td>
<td>77.36</td>
<td>49.02</td>
<td>99.06</td>
<td>71.47</td>
</tr>
<tr>
<td>D3</td>
<td>92.58</td>
<td>66.23</td>
<td>100</td>
<td>82.13</td>
</tr>
<tr>
<td>TH01</td>
<td>83.12</td>
<td>71.59</td>
<td>99.28</td>
<td>73.63</td>
</tr>
<tr>
<td>D13</td>
<td>91.1</td>
<td>60.59</td>
<td>100</td>
<td>87.38</td>
</tr>
<tr>
<td>D16</td>
<td>71.58</td>
<td>53.88</td>
<td>93.84</td>
<td>86.49</td>
</tr>
<tr>
<td>D2</td>
<td>79.2</td>
<td>50.89</td>
<td>99.86</td>
<td>73.93</td>
</tr>
<tr>
<td>D19</td>
<td>86.14</td>
<td>76.59</td>
<td>98.14</td>
<td>80.85</td>
</tr>
<tr>
<td>vWA</td>
<td>84.1</td>
<td>74.74</td>
<td>93.94</td>
<td>84.69</td>
</tr>
<tr>
<td>TPOX</td>
<td>75.95</td>
<td>54.85</td>
<td>93.29</td>
<td>79.85</td>
</tr>
<tr>
<td>D18</td>
<td>87.12</td>
<td>57.71</td>
<td>99.92</td>
<td>84.02</td>
</tr>
<tr>
<td>XY</td>
<td>84.28</td>
<td>78.01</td>
<td>87.52</td>
<td>91.14</td>
</tr>
<tr>
<td>D5</td>
<td>90.17</td>
<td>84.07</td>
<td>98.62</td>
<td>81.11</td>
</tr>
<tr>
<td>FGA</td>
<td>89.71</td>
<td>74.62</td>
<td>97.13</td>
<td>84.22</td>
</tr>
</tbody>
</table>
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.

TABLE 8A (below - continued). Peak Height Ratios per locus: Peak height ratios were calculated for each locus for 500 pg, 250 pg, 150 pg and 100 pg of DNA amplified with Identifiler® for 28 cycles. The table depicts the average, the minimum and the maximum ratios observed.

<table>
<thead>
<tr>
<th></th>
<th>150 pg</th>
<th></th>
<th>100 pg</th>
<th></th>
<th>100 pg</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AVE</td>
<td>MIN</td>
<td>MAX</td>
<td>AVE</td>
<td>MIN</td>
</tr>
<tr>
<td>D8</td>
<td>68.50</td>
<td>44.98</td>
<td>89.49</td>
<td>78.18</td>
<td>49.44</td>
</tr>
<tr>
<td>D21</td>
<td>76.60</td>
<td>45.39</td>
<td>96.45</td>
<td>85.55</td>
<td>55.17</td>
</tr>
<tr>
<td>D7</td>
<td>90.25</td>
<td>76.05</td>
<td>97.21</td>
<td>80.29</td>
<td>54.24</td>
</tr>
<tr>
<td>CSF</td>
<td>77.70</td>
<td>56.40</td>
<td>95.99</td>
<td>74.37</td>
<td>61.68</td>
</tr>
<tr>
<td>D3</td>
<td>84.74</td>
<td>68.18</td>
<td>98.51</td>
<td>75.48</td>
<td>45.18</td>
</tr>
<tr>
<td>TH01</td>
<td>76.20</td>
<td>33.14</td>
<td>99.69</td>
<td>72.26</td>
<td>44.84</td>
</tr>
<tr>
<td>D13</td>
<td>74.92</td>
<td>45.09</td>
<td>97.37</td>
<td>78.52</td>
<td>46.57</td>
</tr>
<tr>
<td>D16</td>
<td>76.73</td>
<td>54.58</td>
<td>100.00</td>
<td>80.15</td>
<td>56.72</td>
</tr>
<tr>
<td>D2</td>
<td>69.25</td>
<td>38.10</td>
<td>95.65</td>
<td>74.59</td>
<td>32.61</td>
</tr>
<tr>
<td>D19</td>
<td>82.93</td>
<td>52.06</td>
<td>96.59</td>
<td>75.58</td>
<td>46.80</td>
</tr>
<tr>
<td>vWA</td>
<td>80.74</td>
<td>53.27</td>
<td>99.43</td>
<td>80.58</td>
<td>54.24</td>
</tr>
<tr>
<td>TPOX</td>
<td>82.56</td>
<td>59.14</td>
<td>92.54</td>
<td>72.75</td>
<td>69.85</td>
</tr>
<tr>
<td>D18</td>
<td>80.64</td>
<td>53.32</td>
<td>99.66</td>
<td>80.25</td>
<td>69.41</td>
</tr>
<tr>
<td>XY</td>
<td>66.82</td>
<td>78.15</td>
<td>96.65</td>
<td>82.37</td>
<td>68.22</td>
</tr>
<tr>
<td>D5</td>
<td>74.71</td>
<td>62.27</td>
<td>81.60</td>
<td>84.66</td>
<td>60.31</td>
</tr>
<tr>
<td>FGA</td>
<td>85.04</td>
<td>72.97</td>
<td>93.75</td>
<td>83.46</td>
<td>60.44</td>
</tr>
</tbody>
</table>
TABLE 8B. Peak Height Ratios over all loci: Peak height ratios were calculated for each locus for 1000pg, 500 pg, 250 pg, 150 pg and 100 pg of DNA amplified with Identifiler® for 28 cycles. The table depicts the average, the minimum and the maximum ratios observed over all loci. The average ratio plus two standard deviations of the mean is also shown.

<table>
<thead>
<tr>
<th></th>
<th>Min</th>
<th>Max</th>
<th>Average</th>
<th>Standard Deviation (StDev)</th>
<th>Average minus 2 StDev</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000pg</td>
<td>74</td>
<td>99</td>
<td>90</td>
<td>3</td>
<td>84</td>
</tr>
<tr>
<td>500pg</td>
<td>49</td>
<td>100</td>
<td>85</td>
<td>6</td>
<td>73</td>
</tr>
<tr>
<td>250pg</td>
<td>42</td>
<td>100</td>
<td>81</td>
<td>5</td>
<td>71</td>
</tr>
<tr>
<td>150pg</td>
<td>33</td>
<td>100</td>
<td>79</td>
<td>6</td>
<td>67</td>
</tr>
<tr>
<td>100pg</td>
<td>33</td>
<td>100</td>
<td>77</td>
<td>8</td>
<td>61</td>
</tr>
</tbody>
</table>

Note that the average minus two standard deviations of the average PHR is a least 67% for 150 pg of DNA and above. The value is 61% for 100 pg. The minimum PHR was seen to be 33% at 100 pg and 150 pg and 42% for 250 pg. Therefore, if a heterozygous pair at a locus in one amplification has a PHR of 33%, then for the PHR to average 50% in both amplifications, the second amplification should have a PHR of at least 67%. Using this guideline, no assignments were incorrect.

VIII. Guidelines for reporting samples amplified with Identifiler for 31 cycles

After samples are amplified in triplicate, the alleles which repeat in at least two of three amplifications are considered part of the Composite (or consensus profile). When data is copied into a profile generation sheet (or table), the composite profile is displayed in a row below the three rows of the replicate amplifications. These are termed “repeating or confirmed alleles”. Only confirmed alleles may be assigned to the most likely DNA profile of a sample interpreted as a single source, whereas only alleles that are detected in all three amplifications may be assigned to the most likely major DNA profile of a mixed DNA sample. However, in order to be assigned to a profile, termed “Assigned Alleles” for single source samples or the “Assigned Major” for mixed samples, the confirmed alleles must meet the criteria described below. Non-repeating alleles may only be used for comparison. These non-repeating alleles may be an allele from a minor contributor or may be a PCR artifact.
1. **Low Template DNA (LT-DNA) Profile Production**

For each case file, a final profile generation sheet should be created from the profile generation sheet(s) from the relevant STR runs. This may include injections from different runs particularly if a replicate sample had required re-injection due to a failed size standard for example.

a. The three individual amplifications and the composite profile should be copied from the STR table for each sample from the case.

i. The a, b, c or pooled injections do not need to be copied.

ii. If a sample was re-injected due to a poor injection, only include the data from the successful run.

iii. If a sample was injected with low, normal and/or high parameters, but the high or low injection yielded the better profile for all loci, the normal injection does not need to be placed in the table.

iv. However, if some loci, for example small loci, were apparent in the normal injection but were deemed inconclusive in the high injection whereas other longer loci were not apparent in the normal injection but were evident in the high injection, the appropriate loci from all injections should be used and combined in the table.

The relevant run names should be listed in the table for each replicate after the sample name.
b. In the row beneath the composite profile, termed the “Assigned Alleles or Assigned Major”, list alleles from the composite profile that can be assigned to the single source profile or to the major component of the mixture profile, respectively. If no such profile can be assigned based on the guidelines below, list “mixture for comparison only” or “inconclusive”, if applicable. Refer to the section of the manual entitled “Allele Confirmation and Profile Determination” for detailed instructions regarding allelic assignment.

c. Copy the chart sheet to a new file.

   i. Right Click on the triple chart sheet

   ii. Select Move or Copy, create a copy, and under “To book” select “newbook”.

   iii. Save the Newbook with the case number to the profile sheets folder in the case management folder within the Highsens data folder on the network.

   iv. Add this sheet to the sample’s case file.

2. Sample Interpretation

   a. Samples or components of samples with less than eight repeating alleles over six autosomal loci will not be interpreted or used for comparison. Samples with more than 6 repeating alleles at at least two loci in the composite profile will also not be used for interpretation or comparison.
b. When examining a triplicate amplification result, one must decide if the sample will be treated as a mixture of DNA or can be treated as a single source DNA profile.

i. Samples with 3 repeating alleles at at least three loci must be interpreted as mixtures.

ii. Samples with 3 repeating alleles at less than 3 loci may be interpreted as single source profiles. Refer to the interpretation section below for allelic assignment.

iii. In some cases, a sample should be interpreted as a mixture even if there are not 3 repeating alleles at at least 3 loci. For example, this may be evident when results at multiple loci are inconsistent among replicate amplifications.

c. A locus in the assigned profiles may be assigned a “Z” to indicate that another allele may be present.

d. ID 31 samples treated as single source DNA profiles are interpreted as follows:

i. The heterozygote type for a locus is determined based on the two tallest repeating alleles in two amplifications. The heterozygote peaks do not have to show a specific peak balance with the following exceptions:

ii. If two repeating alleles are clearly major alleles, any additional repeating alleles, which are consistently minor, are not assigned to the single source profile.

iii. When the same repeating allele is in the plus or minus 4 bp stutter position, and is less than 30% of the major peak in two out of three amplifications, and is less than 50% of the major peak in the third amplification, the allele in the stutter position may not be part of the heterozygote pair. Therefore, a Z is assigned.
iv. If repeating alleles are present, and one allele is consistently major such that all alleles are less than 30% of this allele in all amplifications, the major allele may be assigned a homozygote if the criteria described below are met.

v. Homozygotes must be interpreted carefully.

1) An allele must appear in all three amplifications to be considered a homozygote.

2) The presence of an additional allele in one of the three amplifications can be indicative of allelic dropout.

- But if one allele is clearly the major allele and the minor allele(s) (even if they repeat) are less than 30% of the major allele in all three amplifications, the major allele can be assigned as a homozygote.

- Alternatively, if the non-repeating minor allele(s) are >30% of the repeating major allele, allelic dropout should be suspected and the locus is marked with a Z, to indicate the possibility of a heterozygote.

- For following scenarios, loci should always be assigned a Z:
  - High molecular weight or less efficient loci: CSF1PO, THO1, D16S539, D2S1338, D18S51, and FGA if only one allele could be called
  - The largest locus with repeating alleles in each color
  - All loci in samples amplified with less than 20 picograms in each replicate
3) If alleles in one of three amplifications are completely different from the other two amplifications, the assigned allele call for that locus is inconclusive. For example,

<table>
<thead>
<tr>
<th>Replicate</th>
<th>Example 1</th>
<th>Example 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>b</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>c</td>
<td>11, 12</td>
<td>11</td>
</tr>
<tr>
<td>Composite Profile</td>
<td>8, Z</td>
<td>8, Z</td>
</tr>
<tr>
<td>Assigned Alleles</td>
<td>INC</td>
<td>8, Z</td>
</tr>
</tbody>
</table>

e. **ID 31 Mixture Sample Interpretation**

i. Determine the number of contributors to the mixture. A sample may be considered to have at least three or more contributors if five or more repeating alleles are present in at least two loci. Consider whether the repeating peaks appear to be true alleles or are PCR artifacts.

ii. Determine the mixture ratio. Examination of the profile from the injection of the pooled amplification products is often indicative of the mixture ratio.

iii. Mixture samples with apparently equal contribution from donors can only be used for comparison. Data generated for all replicates may be used for comparison.
iv. Mixtures may be deduced or deconvoluted as follows:

a) Major alleles can be assigned to a major component if they appear in all three amplifications and if they are the major alleles in two out of the three. A heterozygote pair can be called if two out of the three amplifications show allelic balance $\geq 50\%$.

b) Homozygote types must be deduced carefully. If one allele is clearly the major allele and the minor allele(s) (even if they repeat) are less than 30% of the major allele in all three amplifications, the major allele can be assigned as a homozygote.

c) When the shorter allele is within 30 to 50% of the taller allele, in at least two amplifications, it cannot be concluded if the major component is heterozygote or homozygote. In this case, a major peak can be assigned to the major component with a Z.

d) If only one allele could be confirmed, loci should always be assigned a Z in the following scenarios:

- High molecular weight or less efficient loci such as CSF1PO, THO1, D16S539, D2S1338, D18S51 and FGA
  - The largest locus with repeating alleles in each color.
  - TPOX, a locus prone to primer binding mutations- This is relevant for mixtures that contain a homozygote and a heterozygote which share the same allele.
  - All loci in samples amplified with less than 20 picograms in each replicate
### STR RESULTS INTERPRETATION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>APPROVED BY</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>04-01-2014</td>
<td>NUCLEAR DNA TECHNICAL LEADER</td>
<td>47 OF 47</td>
</tr>
</tbody>
</table>

v. Note that mixture ratios may vary between the smaller and the larger loci and in some cases larger loci may not be resolvable particularly if only two alleles are apparent.

vi. When deducing a mixture, if none of the alleles can be assigned to the major component at one particular locus, that locus is not deduced and is called inconclusive in the Assigned Major profile.

vii. The DNA profile of an assumed contributor may be used to determine the most likely profile of another contributor. Alleles that are confirmed but do not belong to the known component may be assigned.

viii. Minor components should not be deduced without an assumed contributor. In these cases, alleles that may be attributed to the minor component(s) should only be used for comparison.

f. In addition to applying the above protocols to the replicates, the pooled sample (which is a combined sample of amplification products from replicates a, b, and c) should be considered. Although the pooled sample is not evaluated independently, if it does not confirm the allelic assignments from the replicates, caution should be exercised.

---

**Revision History:**
- March 24, 2010 – Initial version of procedure.
- September 27, 2010 – Updated procedure to include information for PowerPlex Y; deleted Cofiler and Profiler Plus information.
- April 5, 2011 – Updated procedure with detailed mixture interpretation guidelines. Predominant change is in Section VII. Minor revisions to wording made to Section VIII.2.e.vii. Section VI.C revised to detail the handling of discrepancies for overlapping loci.
- July 16, 2012 – Specific worksheets were removed and replaced with generic terminology to accommodate LIMS.
- April 1, 2014 – Procedure revised to include information for YFiler.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
I. Y-STR Mixtures of Male DNA

Other than at the DYS385 locus, the occurrence of more than one allele peak at one or more Y-STR loci indicates the presence of a mixture of male DNA.

A. In General

If the additional allele peaks are of similar height at one or more loci, the different components are present in similar levels. If only either DYS19 or DYS390 displays two alleles, and the other three loci show single peaks, the presence of an allele duplication event should be considered.

Mixtures of male DNA with different levels of starting DNA will lead to unequal peak heights for the different alleles for one system. If the ratio of the lower peak to the higher peak is consistent for all loci with two allele peaks, the haplotypes of the major and minor component can be inferred. If this is not the case, the possible presence of three contributors must be considered.

It is unreliable to solely use the alleles present at the DYS385 locus to determine whether or not a mixture is present or estimating the ratios of a determined mixture.

C. Possible mixture component masked by -4bp stutter

Peaks within a -4bp position from a main peak and less than 20% of the peak heights are not reported as true alleles. In a mixture the -4bp stutter could mask a real mixture component. Therefore individuals cannot be excluded from being a minor contributor to a mixture if their alleles are in the -4bp position of an allele from another individual.

D. Refer to the “STR Results Interpretation” section. Follow the procedures outlined in the appropriate section.

1. Partial Profiles
2. Detection of Previously Unreported Rare Alleles
3. Samples with High Background Levels
To interpret the significance of a match between genetically typed samples, it is necessary to know the population distribution of alleles at the loci that were typed. If the STR alleles of the relevant evidence sample are different from the alleles of a subject’s reference sample, then the subject is “excluded,” and cannot be the donor of the biological evidence being tested. An exclusion is independent of the frequency of the alleles in the population.

If the subject and evidence samples have the same alleles, then the subject is “included,” and could be the source of the evidence sample. The random match probability, or the probability that another, unrelated, individual would also match the evidence sample, is equal to the frequency of the evidence profile genotypes in the relevant population. Population frequencies are estimated separately for the Asian, Black, Caucasian and Hispanic populations. Additional population frequencies may be used for other population groups. If a source contains more than one frequency for a single population group, then the highest frequency is used for calculations. Allele frequencies are used for all calculations. Profile frequency estimates are calculated according to the National Research Council report entitled The Evaluation of Forensic DNA Evidence (National Academy Press 1996, pp. 4-36 to 4-37).

Spreadsheets are used to automate the calculation of the population specific genotype and profile frequency estimates. The spreadsheets are located in the “POPSTATS” subdirectory on the network and explanations for their use are included with the spreadsheets.

The population allele frequencies of the 13 core CODIS loci and D2S1338 and D19S433 are derived from the FBI and OCME Databases.

I. Random Match Probability for Autosomal STRs

A. Enter the evidence profile alleles in the Identifiler worksheet of the POPSTATS spreadsheet. Off-ladder alleles can be entered as decimals (for example, “12.2”) or as “>” or “<” for values above or below the ladder, respectively.

B. For loci assigned a “Z” to indicate the possible presence of another allele, only one allele is entered in the calculation spreadsheet. In this manner, the locus is not treated as a true homozygote whose statistical values are determined by squaring the allele frequency (p^2). Rather “Z” loci utilize the probability only of the one assigned allele (2p), which allows the second allele to be anything.

C. The overall profile frequency estimate for each group is calculated by multiplying the individual locus genotype frequency estimates together.
D. In the standard scenario, homozygote genotype frequencies are estimated for each population using the formula \( p^2 + p(1-p)\theta \) for \( \theta = 0.03 \) and heterozygote genotype frequencies are estimated using the formula \( 2p\theta p\theta \).

E. Genotype and profile frequencies are also estimated for isolated populations (i.e., “evidence and subject from the same subgroup (isolated village)”) and for relatives using the formulas in the National Research Council Report.

F. For each population, the overall profile frequency estimate under the standard scenario of \( \theta = 0.03 \) unless there is reason to suspect that the “evidence DNA and subject are from the same subgroup” or a relative of the subject left the biological sample.

G. Calculations and allele frequencies are retained in the case file for referral at a later date if necessary.

II. Random Match Probability for YSTRs

A. The frequency for a YSTR haplotype is estimated by counting the number of times the haplotype occurs in each of the population databases and dividing by the total number of individuals in the database.

1. A haplotype that has not been previously observed in the Asian database, which includes 196 individuals, would be reported as “less than 1 in 196 Asians”.

2. A haplotype that has been observed once in the Asian database would be reported as “1 in 196 Asians”.

3. A haplotype that has been observed 5 times in the Asian database is reported as “1 in 39 Asians” (5 in 196 is equal to 1 in 39).
For Y-STR haplotypes, use the US Y-STR database to estimate haplotype frequencies.

1. Using Internet Explorer, navigate to www.usystrdatabase.org

2. Enter the Y-STR alleles from the profile into the drop-down boxes on the screen.

3. To specify a value not listed in the drop-down box, enter the value in the text box next to the drop-down box.

4. The following value types are allowed:
   a) Standard ladder allele such as “12”
   b) Off-ladder allele value such as “22.2”
   c) Off-ladder low- or high-value such as “<15” or “>21”
   d) Null allele: enter “0” if the sample is believed to contain a legitimate null allele, for example, due to a primer binding site mutation.
   e) No data: “*” is the default value. Loci with * are treated as wild cards.

5. Click “Search”

6. Scroll down for the results. The website reports the number of times the haplotype was observed in the database, the observed frequency of the haplotype, and the upper bound of the 95% confidence interval. These values are reported for each of the populations in the database (African American, Asian, Caucasian, Hispanic, and Native American) and for all of the populations combined.

7. Click “Show Details” for a summary table.

8. Adjust the margins of the page by selecting “Page Setup” from the printer menu at the top of the page and changing the top and bottom margins to 0.5, then choosing “OK”.

9. Print the screen by selecting “Print” from the printer menu at the top of the page and selecting a printer.
10. Verify on the printout that the Y-haplotype alleles were correctly entered into the website.

11. If both autosomal and Y-STRs are typed, the results are reported separately.

III. Combined Probability of Inclusion (CPI) for Mixtures

The combined probability of inclusion (CPI) is defined as the probability that a randomly selected individual would be a contributor to a mixture of labeled DNA alleles. In other words, it is the expected frequency of individuals who could be included as potential contributors to the mixture because all of their alleles are labeled in the evidence profile.

CPI can only be used if all of the following circumstances are met:

- When the evidence sample contains a non-deducible mixture.
- When the alleles of the associated known sample are labeled at all of the conclusive loci in the evidence sample.

A conclusive locus is a locus with concordant or repeating alleles. If an evidentiary sample is amplified more than once, loci with concordant alleles (HT-DNA samples) or repeating alleles (LT-DNA samples) are determined. Loci that are designated as “NEG” (for negative) or “INC” (for inconclusive) are not used in the CPI calculation. To avoid the possibility of bias, the determination to deem a locus inconclusive in the evidence profile must be made prior to viewing the comparison sample profile.

CPI is calculated (if necessary) after the DNA profile of the comparison sample(s) is determined to be included in the evidence sample. The CPI is calculated for informative samples. If RMP values have been generated, the CPI may not need to be calculated. The CPI is reported in the evidence report.

The comparison is based on the previously determined allele calls. If any of the alleles of a comparison sample are missing from the evidence profile at conclusive loci, CPI is not appropriate.
A. Computing CPI

1. Open CPI worksheet named “CPI.xls”

2. In cells A9 through P9 of the Data Entry worksheet, enter each allele that is labeled in the evidence profile at conclusive loci, up to 10 alleles per locus. Alleles should be separated by commas and/or spaces. A profile from a PG sheet may be pasted into cells A9 through P9. **All alleles that are labeled at conclusive loci in all amplifications must be entered.**

3. Press the blue “Run CPI macro” button. The CPI for the Black, Caucasian, Hispanic, and Asian populations appears at the bottom of the Results worksheet.

4. Print the results by selecting File > Print while in the Results worksheet. The printout will include the alleles entered and the results.

**Note:**
Off-ladder alleles may be entered in either 15.x format or as “<” or “>”. 5/2N will be used as the frequency for an off-ladder allele.

B. Interpretation

Results are presented for each of the four populations: Black, Caucasian, Hispanic, and Asian. The probability of inclusion is stated in the report.

Combined Probability of Inclusion is the expected frequency of individuals who are carrying only alleles that are labeled in the mixture in question, and if tested could potentially be included as contributors to this mixture. It is the expected frequency of individuals who could be included as potential contributors to the mixture because they do not carry any alleles that are not labeled in the evidence profile.
I. A comparison profile must be available in order to use FST

Whether or not the source of the comparison profile contributed to a mixture is the relevant question. Depending upon the context of the case, a comparison profile may be from a suspect or a victim or may be a single source or deduced profile within a case. Profiles of known contributors to the evidence sample may be used, if available. For the majority of circumstances, a suspect should never be treated as a known contributor. Every attempt must be made to generate a full profile for a known or a comparison sample.

II. Sample Criteria for using the FST

A. FST can be used for the following mixed samples:

1. The DNA profiles of the major and the minor contributors cannot be determined; however, the mixture is suitable for comparison.

2. The DNA profile(s) of the minor contributor(s) cannot be determined but the sample is suitable for comparison. Moreover, the deduced profile of the major contributor is not consistent with the profile of the comparison sample. In this case, the random match probability should be used to calculate the statistical value for the deduced DNA profile of the major contributor and FST should be used for comparisons to the minor contributor(s).

3. Informative mixtures within a case
   a. All informative mixtures with which a comparison sample can be positively associated through a qualitative assessment should be tested using FST. Not all mixtures generate probative results. For example, the DNA profile of a homeowner found on an item within their home is most likely not informative.

   b. Moreover, if no conclusions can be drawn regarding whether a comparison sample contributed to an informative mixture, the LR can be calculated.
c. Exceptions may include multiple samples from the same item if the comparison sample is consistent with the deduced major contributor for which RMP is calculated.

4. **Suspect comparisons**

a. FST should be applied to mixtures to which a comparison sample can be positively associated. If multiple items within a case are positively associated to a suspect, FST should be applied to each mixture, as it may not be feasible to determine in advance which items will be most informative to the case.

b. If multiple swabs are taken from a single item, it may not be necessary to use FST for each one. For example, if Swab A generates a deducible mixture and Swab B from the same item generates a non-deducible mixture, statistics may not be necessary for Swab B if the comparison sample’s profile is consistent with the deduced profile from Swab A, for which RMP can be calculated.

### B. The random match probability (RMP), not FST, will be used for the following samples:

1. Single source profile
2. Deduced major and/or minor profiles
3. If the DNA profile of the major and/or the minor contributors were not determined previously, but the sample could be deconvoluted, an attempt should be made to deduce these profile(s) so that RMP may be used. In this situation, an additional evidence report must be issued.

### C. **Effect of relationships** among the comparison sample, the known, and the unknowns.

1. There is no restriction on the relationship between the known(s) and the comparison sample.
2. FST assumes however that the unknown persons in the model are unrelated to one another and to the known(s) and the comparison sample.
   
a. In the event that it is asserted, for example, that the suspect’s brother is the source of the DNA, FST cannot account for this relationship.
   
b. However, as stated in C1, FST can still be used if the comparison sample (the suspect for example) and the known contributor(s) are related.
   
c. If the unknown contributors are thought to be related, request victim and/or elimination samples.
      i. If a victim or an elimination sample was submitted, and he/she can be qualitatively associated with the evidence, that victim or elimination sample may be used as a known.
      ii. If the victim or elimination sample can be excluded as a contributor, that sample should not be used as a known.
      iii. If no victim or elimination samples were submitted, calculate the LR with no known contributors in the model. The assumption that the unknown person(s) are unrelated must be stated.

D. Partial Profiles

1. Evidence samples may have partial profiles and data fields for these samples may be left blank.

2. However, if a comparison or a known sample is partial, loci that are not complete or blank will be not used in the calculation. In other words, the program will only utilize loci that display allele calls for a comparison or a known sample.
   
a. Known samples should not have partial profiles. If for example, an assumed known is missing two loci, these loci will be omitted from the calculation, even if the evidence and the comparison sample display results. Please consider this when building the hypothesis.
   
b. Comparison profiles may be partial although every attempt should be made to generate a full profile.
III. Hypothesis building

Hypotheses are built based on the data and the relevant question. For the majority of mixture comparisons no more than one, or at most two different scenarios should be calculated.

A. Assuming one or more known contributors

1. If a profile is consistent with the profile of the major contributor to a mixture, the profile may be assumed as a known.

2. Other exemplar DNA profiles which are anticipated to be present on an item and are positively associated with the mixture may be used as a known in the calculation. For some of these samples, an alternative scenario should also be calculated with no known contributors.

   a. For example, if a victim is positively associated to scrapings on his/her own clothing, their own vaginal swab, or to their own car, they may be used as a known and only one scenario may be reported.

   b. However, if a victim is positively associated to a mixture found on an item with a less immediate connection, such as a gun, or another crime scene item, they may be used as a known, but a second scenario without this assumption should also be calculated. In other words, the second scenario should not include the victim as a known in the calculation.

3. Under certain case scenarios, the hypothesis may assume a second suspect as a known contributor. This circumstance is generally very rare, but if encountered another calculation without this assumption of a known contributor must be performed.
B. Effect of the choice of number of contributors

1. The number of contributors invoked to explain the data will have an effect on the likelihood ratio. For a given hypothesis, using the minimum possible number of contributors will usually result in the lowest possible LR.

2. Use all available information, including assumed known contributors, to determine which pair of hypotheses with how many contributors to use. Only in the rare instance where the data support more than one scenario additional calculations may be performed.

IV. User defined factors that affect the drop-out and drop-in rates

A. Drop-out rates vary depending upon the amount of template DNA in a sample. The template amount is entered by the user and the program interpolates the dropout rate based on validation data. Drop-in rates depend on the number of cycles used.

1. If different template amounts were amplified in different replicates, select the replicate with the most information. Alternatively, use both replicates, but select the highest template amount amplified. In this manner, the most conservative drop-out rates are used by FST.

2. If different template amounts were amplified using different cycling parameters, select the run with the most information. Do not combine results across cycle number settings. The program uses different drop-out and drop-in rates for 28 and 31 cycle samples.

3. Drop-out rates are programmed for samples amplified with 28 cycles with template DNA amounts ranging from 101 pg to 500 pg per amplification. Samples amplified with more than 500 pg should be entered as 500 pg. Samples amplified for 28 cycles with 100 pg should be entered as 101 pg.

4. Drop-out rates are programmed for samples amplified with 31 cycles with template DNA amounts of 100 pg per amplification and below. Therefore, for example, a sample amplified with 105 pg for 31 cycles should be entered as 100 pg.
B. Drop-out rates also vary depending upon the number of contributors to a mixture. Generally for a given locus and template amount, the drop-out rate is higher for a three-person mixture than a two-person mixture. This will affect the LR and therefore this section contains supplemental information on how to evaluate the number of contributors.

To determine the number of contributors to a sample, follow the OCME mixture interpretation guidelines.

1. Two-person mixtures

   a. Excluding stutter and other explainable artifacts, HT-DNA mixed samples may show three or more labeled alleles at a locus. Other indications of a two-person HT-DNA mixture include observed peak height ratios between a single pair of labeled peaks below 60.5% at several loci.

   b. For LT-DNA mixed samples may show more than two loci with three or more repeating, labeled alleles. If this is not the case, and multiple loci show inconsistent results among replicate amplifications, the sample may be categorized as a mixture.

   c. If a mixture can be deconvoluted, and fewer than eight alleles remain and could be minor component alleles, the sample should not be evaluated as a two-person mixture with FST. Rather this sample is not suitable for comparison to the minor contributor. Consider unambiguous allelic sharing in this determination.
2. Three-person mixtures

a. HT-DNA samples are considered three-person mixtures if there are five or more labeled peaks in at least two loci over two amplification replicates, excluding stutter and other explainable artifacts. If only one amplification is done, at least one locus must show five or more labeled peaks.

b. LT-DNA samples are considered three-person mixtures as follows:
   i. Five alleles are present at at least two loci in the consensus profile.
   ii. Stutter and other explainable artifacts should be considered when counting the number of alleles at a locus.
   iii. Inconsistencies among the replicates may indicate the presence of a third contributor.

c. For some three-person mixtures additional criteria may be explored. In a Forensic Biology study (Perez et al CMJ 2011:393-405), the characteristics listed in the two tables below were only observed in controlled mixtures with more than two contributors.

<table>
<thead>
<tr>
<th>HT-DNA Mixtures</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>≥2 loci with ≥5 repeating alleles</td>
<td></td>
</tr>
<tr>
<td>≥2 different loci with ≥5 alleles in one replicate</td>
<td></td>
</tr>
<tr>
<td>≥1 locus with ≥5 repeating alleles and ≥1 other locus with ≥5 different alleles</td>
<td></td>
</tr>
<tr>
<td>≥8 loci with ≥4 different alleles</td>
<td></td>
</tr>
</tbody>
</table>

Table 1A. Characteristics of HT DNA mixtures with more than two contributors
**LT-DNA Mixtures**

- ≥ 2 loci with ≥ 5 repeating alleles
- 1 locus with ≥ 5 repeating alleles and 2 other loci with ≥ 5 different alleles
- ≥ 6 loci with ≥ 4 repeating alleles
- ≥ 1 locus with 7 different alleles
- ≥ 2 loci with 6 different alleles
- 1 locus with 6 different alleles and ≥ 3 loci with 5 different alleles
- ≥ 5 loci with five different alleles
- ≥ 8 loci with ≥ 4 different alleles*

*Note that one LT-DNA two-person mixture had 8 loci with 4 or 5 different alleles. The additional alleles could be attributed to stutter.

**Table 1B.** Characteristics of LT-DNA mixtures with more than two contributors.

C. Drop-out rates vary depending upon the approximate mixture ratio of the contributors.

1. If a mixture has no major contributor, the user specifies that the mixture is “non-deducible” and the program will use drop-out rates for 1:1 (or 1:1:1) mixtures.

2. If a mixture has a major contributor whose profile can be deconvoluted according to the OCME mixture interpretation guidelines, the user specifies that the mixture is “deducible”.
   
   a. The deduced profile should have no fewer than 8 alleles over 4 loci (HT-DNA) or 6 loci (LT-DNA), otherwise consider the sample non-deducible.

   b. In this case, FST should only be used if the person of interest is not consistent with the major contributor’s profile.
V. Instructions

In the sections that follow, the user is guided through instructions for setting up files, running the FST program, and interpreting the results.

A. Creating Evidence, Comparison, and Known Contributor Files for FST

Evidence, comparison, and known contributor profiles can be uploaded into FST instead of being entered manually. In order to be uploaded, files must be formatted as tab delimited text files, as shown in Tables 1 and 2 below.

For comparison and known contributor profiles, homozygous alleles must appear twice. Tri-allelic loci may not be entered, as the program assumes that there will be a maximum of two alleles per locus. Incomplete or negative loci should be left blank for comparison and known profiles as well.

To create a text file for a comparison or known contributor profile from an allele table in Excel:

1. Open “Make Suspect or Victim Profile for Upload.xlt”
2. From the allele table, copy one donor’s name and profile. Alleles can be separated by commas and/or spaces.
3. Put the cursor on cell A4 in Sheet1 of “Make Suspect or Victim Profile for Upload.xlt”.
4. Right click, choose “Paste Special”, then “values”, then “OK” to paste profile data into the row.
5. Click anywhere else in the sheet. Then press Ctrl-m to run the macro.
6. Sorted results will appear in Sheet3. Verify that the values in Sheet3 are correct.
7. Save Sheet3 as a tab-delimited text file using the donor’s name or some other identifying information as the file name. Click “OK” and “Yes” when prompted.
8. Close “Make Suspect or Victim Profile for Upload.xlt” (no need to save this time) and re-open it in order to create the next text file. If the file is not closed and re-opened, the next profile will not be sorted properly.
Table 2. Format for uploadable comparison or known contributor profiles.

To create a text file from an evidence table in Excel:

1. Open “Make Evidence File for Upload.xlt”
2. From the evidence table, copy both amplifications for an ID28 sample or all three replicates for an ID31 sample for one item. For ID31 samples, do not copy the pooled sample or the composite profile. Alleles can be separated by commas and/or spaces.
3. Put the cursor on cell A4 in Sheet1 of “Make Evidence File for Upload.xlt”.
4. Right-click, choose “Paste Special”, then “values”, then “OK” to paste evidence profile data into rows 4 and 5 for duplicate amplifications or 4, 5, and 6 for triplicate amplifications.
5. Click anywhere else in the sheet. Click on the green button to run the macro.
6. Sorted results will appear in Sheet3. Verify that the values in Sheet3 are correct.
7. Save Sheet3 as a tab-delimited text file with an appropriate file name. Click “OK” and “Yes” when prompted.
8. Close “Make Evidence File for Upload.xlt” (no need to save this time) and re-open it in order to create the next text file. If the .xlt file is not closed and re-opened, it will not sort the next profile properly.
Table 3. Format for uploadable evidence amplifications with duplicate runs. If triplicate runs were performed, data from the third amplification would appear in rows associated with REPLICATE 3, indicated by a “3” in the second column. Off-ladder alleles are acceptable as a whole number, decimal, or “<” or “>”. The macro limits the number of alleles per locus to 8. Additional alleles must be entered manually.

<table>
<thead>
<tr>
<th>LOCUS</th>
<th>REPLICATE</th>
<th>ALLELE 1</th>
<th>ALLELE 2</th>
<th>ALLELE 3</th>
<th>ALLELE 4</th>
<th>ALLELE 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>D8S1179</td>
<td>1</td>
<td>10</td>
<td>14</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D8S1179</td>
<td>2</td>
<td>10</td>
<td>14</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D8S1179</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D21S11</td>
<td>1</td>
<td>28</td>
<td>29</td>
<td>30</td>
<td>30.2</td>
<td></td>
</tr>
<tr>
<td>D21S11</td>
<td>2</td>
<td>28</td>
<td></td>
<td></td>
<td></td>
<td>30</td>
</tr>
<tr>
<td>D21S11</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D7S820</td>
<td>1</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D7S820</td>
<td>2</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>11</td>
</tr>
<tr>
<td>D7S820</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CSF1PO</td>
<td>1</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>11</td>
</tr>
<tr>
<td>CSF1PO</td>
<td>2</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>11</td>
</tr>
<tr>
<td>CSF1PO</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D3S1358</td>
<td>1</td>
<td>14</td>
<td>15</td>
<td>16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>D3S1358</td>
<td>2</td>
<td>14</td>
<td>15</td>
<td></td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>D3S1358</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Etc...
B. FST Home Screen

Figure 1. Home Screen of Forensic Statistical Tool (FST). After deciding which model to use, as outlined in Part II, parameters are specified and files are uploaded (or profiles are manually entered) through the FST web interface.
Figure 2. Select the appropriate test scenario from the “Comparison Type” drop-down box. Options are listed in Table 3 below. The option selected here is Suspect 1 + Unknown 1 / Unknown 1 + Unknown 2, which is used for a two-person mixture with a suspect profile, but no victim profile. Note: this language will be changed to Comparison + Unknown / Unknown + Unknown when the program has been updated.
### Table 3

Numerator (Prosecutor’s Hypothesis) | Denominator (Defense Hypothesis)
--- | ---
Comparison + Known | Known + Unknown
Comparison + Unknown | 2 Unknowns
Comparison + 2 Unknowns | 3 Unknowns
Comparison + Known + Unknown | Known + 2 Unknowns
Comparison + 2 Knowns | 2 Knowns + Unknown

Please note that additional scenarios are available in the drop down menu, but these are not functional right now.
Figure 4. Specify $\theta$ as 0.0, 0.01 or 0.03. For all routine testing performed at OCME, the default value of $\theta = 0.03$ is to be used.
C. Uploading Files and Running FST

**Figure 5.** Enter the Comparison Profile name (called “suspect” here, to be updated soon) in the appropriate space on the Home Screen, then click “GO” on the bottom of the Home Screen to advance to the Data Entry Screen. Ignore the “BULK” option as this is reserved for quality control purposes.
Figure 6. Evidence, Comparison, and Known File Upload. Enter case information (FB number, suspect number if applicable, and item description) in the appropriate boxes on the top row.

Enter the total amount of template DNA amplified in each replicate on the bottom row rounded up or down as appropriate to three digits. For example, enter 253 pg for sample with a concentration of 50.5 pg/µL (5 µL x 50.5 pg/µL = 252.5 pg). **Important:** If a 100 pg sample is amplified for 28 cycles, enter 101 pg, and if it is amplified for 31 cycles enter 100 pg. If a sample was amplified with two different template amounts, enter the higher template amount.

For mixtures, select “Yes” or “No” in the Deducible drop-down box. For single source samples, the Deducible option is not available.
Verify that the comparison and/or known(s) name(s) entered on the Home screen appear on this screen below the evidence profile entry area.

Click “Upload” in the bottom row to advance to the File Upload Screen. Allele calls may be entered manually, but uploading the profiles is the preferred option.

Figure 7. File Upload Screen. Browse to select Comparison (Suspect), Known (Victim) and Evidence files. Case and sample information may be entered or corrected on this screen, if necessary. If information was entered on the previous screen, verify that it correctly appears on this screen.
Figure 8. If a model including a known contributor was selected, there will be space to upload a known profile on the File Upload Screen.
Figure 9. After browsing to select Comparison, Known, and Evidence files, click “Preview” to view uploaded data. Case and sample information may be entered or corrected on this screen, if necessary.
Figure 10. Profile Preview Screen. Uploaded data will be shown here. If a file was selected in error, click on “Home” in the upper left hand corner to start over. If all information is correct, click “Compare” to run the analysis and generate results in a PDF file.
Figure 11. Results Screen. After clicking “Compare”, a pop-up window will provide the options to save or open the results file. Save the file as xx-xxxxx_sample name_FST in the appropriate folder and place a printout in the case file. Two person mixture results will be instantaneous. Three-person mixture results may require 10-15 minutes. Report the lowest of the four likelihood ratios shown on the bottom of the screen.
D. Interpretation of Results

It is very important that likelihood ratios are reported using the exact wording given below. Even minor deviation from this wording can lead to incorrect interpretation of results. Interpretation is always of the form “The DNA mixture found on [item] is X times more probable if the sample originated from A than if it originated from B. Therefore, there is [limited / moderate / strong / very strong] support that A contributed to this mixture, rather than B.”

Please note that the result is a “ratio” between two likelihoods and cannot be reported for just one hypothesis.

Reporting of the likelihood ratio (LR) depends on the comparison type selected and the value of the LR. Select the lowest value of the four likelihood ratios that appear at the bottom of the results page. This value will determine whether the result supports the prosecutor or the defense hypothesis. This value will also determine which descriptor (limited, moderate, strong, or very strong) to select in the second sentence. Use Table 4 to determine which descriptor to use in the second sentence. Note, only values that are equal to 1.00 should given the qualitative descriptor of “no conclusions”.

If the lowest LR is greater than one, the results are interpreted as shown below, using the example shown in Figure 11, in which the lowest value is 9.45e+09, or 9.45 x 10^9. If the lowest LR is between 10^6 and 10^14, report the result as “million”, “billion” or “trillion”. For example, report 9.45 x 10^9 as 9.45 billion.

In the first report sentence, because the lowest LR in this example is greater than one, the DNA mixture is more probable if the prosecution hypothesis is true than if the defense hypothesis is true. In the second sentence, because 9.45 x 10^9 is greater than 1000, there is very strong support for the prosecutor’s hypothesis over the defense hypothesis.

If the comparison performed was Mr. Smith (suspect) versus Unknown (i.e., a single source sample), interpretation of the value above is:

The evidence profile is 9.45 billion times more probable if the sample originated from Mr. Smith than if it originated from an unknown, unrelated person. Therefore, there is very strong support that the sample originated from Mr. Smith, rather than from an unknown, unrelated person.
Note, the random match probability should be routinely used for single source and deduced profiles.

If the comparison performed was Mr. Smith (suspect) + Unknown versus Two Unknowns (i.e., a two-person mixture with no known contributors), interpretation of the value above is:

The evidence profile is 9.45 billion times more probable if the sample originated from Mr. Smith and one unknown, unrelated person than if it originated from two unknown, unrelated persons. Therefore, there is very strong support that Mr. Smith and an unknown, unrelated person contributed to the mixture, rather than two unknown, unrelated persons.

If the comparison performed was Mr. Smith (suspect) + Mr. Green (victim) versus Mr. Green + Unknown (i.e., a two-person mixture with one known contributor), interpretation of the value above is:

The evidence profile is 9.45 billion times more probable if the sample originated from Mr. Smith and Mr. Green than if it originated from Mr. Green and an unknown, unrelated person. Therefore, there is very strong support that Mr. Smith and Mr. Green contributed to the mixture, rather than Mr. Green and an unknown, unrelated person.

If the lowest likelihood ratio is less than one, the DNA mixture found on the item is more probable if the defense hypothesis is true than if the prosecution hypothesis is true. In this situation, the reciprocal of the lowest LR is reported and the positions of the two hypotheses in the interpretation sentences are reversed. For example, if the four values at the bottom of the results page are:

0.421  8.88e-02  1.49e-02  0.492

the lowest value is 1.49e-02, or 0.0149. The reciprocal of this value is 1 / 0.0149 = 67.114. Report the results to three significant figures as below.

If the comparison performed was Mr. Smith (suspect) versus Unknown (i.e., a single source sample), interpretation of the value above is:

The evidence profile is 67.1 times more probable if the sample originated from an unknown, unrelated person than if it originated from Mr. Smith. Therefore, there is moderate support that the sample originated from an unknown, unrelated person, rather than from Mr. Smith.
If the comparison performed was Mr. Smith (suspect) + Unknown versus Two Unknowns (i.e., a two-person mixture with no known contributors), interpretation of the value above is:

The evidence profile is 67.1 times more probable if the sample originated from two unknown, unrelated persons rather than from Mr. Smith and one unknown, unrelated person. Therefore, there is moderate support that two unknown, unrelated persons contributed to the mixture, rather than Mr. Smith and an unknown, unrelated person.

If the comparison performed was Mr. Smith (suspect) + Mr. Green (victim) versus Mr. Green + Unknown (i.e., a two-person mixture with one known contributor), interpretation of the value above is:

The evidence profile is 67.1 times more probable if the sample originated from Mr. Green and one unknown, unrelated person rather than from Mr. Smith and Mr. Green. Therefore, there is moderate support that Mr. Green and an unknown, unrelated person contributed to the mixture, rather than Mr. Smith and Mr. Green.

If the LR is between $10^{-3}$ and $10^{5}$, the result will not appear in scientific notation. For example, if the results are

$$435.82 \quad 2953.882336.55 \quad 184.43$$

report a value of 184 (lowest value, rounded down to 3 significant figures), stating for example for a two-person mixture with no known contributor, “The evidence profile is 184 times more probable if the sample originated from Mr. X and one unknown, unrelated person than if it originated from two unknown, unrelated persons. Therefore, there is strong support that Mr. X and one unknown person contributed to the mixture, rather than two unknown, unrelated persons.”
If the likelihood ratio is… | Then the evidence provides…
---|---
Less than 0.001 | Very strong support for H\text{d} over H\text{p} 
0.001 to 0.01 | Strong support for H\text{d} over H\text{p} 
0.01 to 0.1 | Moderate support for H\text{d} over H\text{p} 
0.1 to 1.0 | Limited support for H\text{d} over H\text{p} 
1 to 10 | Limited support for H\text{p} over H\text{d} 
10 to 100 | Moderate support for H\text{p} over H\text{d} 
100 to 1000 | Strong support for H\text{p} over H\text{d} 
Greater than 1000 | Very strong support for H\text{p} over H\text{d} 

Table 4. Qualitative interpretation of likelihood ratios. Likelihood ratios provide a measure of the strength of support in favor of one hypothesis over the other. Let H\text{p} represent the prosecution hypothesis, or the hypothesis that the suspect \textit{did} contribute to the sample. Let H\text{d} represent the defense hypothesis, or the hypothesis that the suspect \textit{did not} contribute to the sample. Use the values suggested by Butler (2005, Forensic DNA Typing. Burlington, MA: Elsevier Academic Press, pp 513), as shown here, to describe the strength of support for either H\text{p} or H\text{d}. 

Revision History:
April 5, 2011 – Initial version of procedure. 
January 12, 2012 – Added new section on hypothesis building and clarified several minor points throughout the document. 
Removed section on database comparisons.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
I. Comparison of samples based on Autosomal STR results, Statistical Treatment, and Reporting

The purpose of these guidelines is to provide a framework for sample comparisons in STR casework and a template for reporting. (Refer to the case management manual for further details on reporting.) These guidelines are based on validation studies, literature references, some standard rules and experience. However, not every situation can be covered by a pre-set rule or proposed report wording. Equipped with these guidelines, analysts should rely on professional judgment and expertise.

Any documentation developed outside of the LIMS should be scanned to a PDF document and attached to the appropriate electronic case record.

A. The first step in reporting DNA results is to state the type of testing that was performed and to identify the number of contributors to the sample.

1. The appropriate kit names are Identifiler® and MiniFiler®.

2. The phrase “a DNA profile” versus “a mixture of DNA from at least (n) people” is used to report the number of contributors.

B. For each available comparison sample, the following conclusions can be made:

1. Comparison to a single source profile or to a deconvoluted profile from a mixed sample.
   a. The comparison sample is the source.
   b. The comparison sample could be the source.
   c. The comparison sample is not the source.

2. Comparison to a mixed sample that was not deconvoluted.
   a. The comparison sample could be a contributor to the mixture.
   b. The comparison sample cannot be excluded as a contributor to the mixture.
   c. No conclusions can be drawn regarding whether the comparison sample could be a contributor to the mixture.
   d. The comparison sample is excluded as a contributor to the mixture.
   e. The phrases “could be a contributor”, “cannot be excluded”, and “excluded” are to be used exclusively for conclusions involving mixtures.
3. Statistics
   a. Statistical information is reported in the evidence report.
   b. Not all results require a statistic. For example:
      i. Epithelial cell (EC) fractions from a differential extraction that matches the victim. However, the significance of a match for EC fractions for items not connected to the victim such as a condom or suspect’s clothes should be calculated.
      ii. Mixed samples with expected inclusions within the context of the case
      iii. Mixed profiles not being used for comparison
   c. For single source profiles, or profiles deconvoluted from a mixed sample, the Random Match Probability (RMP) is used. Refer to the “Population Frequencies for STR’s” procedure.
   d. For mixed samples not deconvoluted in their entirety, the cumulative probability of inclusion (CPI) may be used; refer to the “Population Frequencies for STR’s” procedure.
   e. See discussions related to specific sample categories for more information.

C. Single source profiles or deconvoluted profiles from mixed samples

1. Statistics: The random match probability (RMP) should be used for statistical analysis of these profiles. Refer to the “Population Frequencies for STR’s” procedure for details on calculating this value.

2. Source Attribution Threshold:
   a. If the RMP of an evidentiary profile is at least as rare as the source attribution threshold, 1 in greater than 6.80 trillion for all ethnic groups, then the profile may be attributed to the donor of a comparison sample. This threshold was calculated by putting a 99% confidence interval on the probability of not observing that profile in the world population as estimated by The US Census Bureau World Population Clock as of July 2010.
   b. If the RMP does not meet the threshold, source attribution may not be used.
   c. The source attribution statement does not apply to relatives.
3. Evidence report template
   
a. Single source profiles
   
i. If the RMP for the single source DNA profile meets the source attribution threshold and the profile matches the DNA profile of a named individual: “PCR / High Sensitivity PCR DNA typing (using the [insert appropriate test kit name(s)]) was done on the following sample(s). A DNA profile was determined. Based on the random match probability for unrelated individuals, [insert name here] is the source of this DNA.”
   
ii. If the RMP does not meet the source attribution threshold and an association to a named individual was made: “PCR DNA / High Sensitivity PCR DNA typing (using the [insert appropriate test kit name(s)]) was done on the following sample(s). A DNA profile was determined. This DNA profile is consistent with that of (insert name here); therefore, he/she could be the source of this DNA.”

   In the report, provide the RMP for the most discriminating sample. In cases where one sample is more informative than another sample, but its RMP is significantly less discriminating, report the RMP for both samples.
   
iii. If no association has been made between the evidentiary DNA profile and the DNA profile of a named individual: “PCR / High Sensitivity PCR DNA typing (using the [insert appropriate test kit name(s)]) was done on the following sample(s). A DNA profile from a male, Male Donor X, was determined.”
iv. If a statistic is required in the report, state the RMP as follows: “This DNA profile is expected to be found in approximately:”
   1) 1 in greater than 6.80 trillion people (if the RMP meets the source attribution threshold) OR
   2) 1 in 3 significant figures people” (use the most common statistic amongst ethnic groups)

v. In samples that are deemed single source, if alleles are present that cannot be attributed to the DNA donor, the report should state: “No conclusions can be drawn regarding the source of the potential DNA allele(s) that are not from (insert name here / Male Donor X).”

b. Mixed samples with a deconvoluted profile

i. If the RMP meets the source attribution threshold, and the profile matches the DNA profile of a named individual

   1) “PCR / High Sensitivity PCR DNA typing (using the [insert appropriate test kit name(s)]) was done on the following sample(s). A mixture of DNA from at least (n) people was found. Based on the random match probability for unrelated individuals, [insert name here] is a [select major or minor] contributor to this mixture.”

   2) “PCR / High Sensitivity PCR DNA testing (using the [insert appropriate test kit name(s)]) was done on the following sample(s). A mixture of DNA from at least (n) people was found. Assuming that [insert name A here] is a contributor to this mixture, based on the random match probability for unrelated individuals [insert name B here] is also a contributor.”
3) “PCR / High Sensitivity PCR DNA testing (using the [insert appropriate test kit name(s)]) was done on the following sample(s). A mixture of DNA from at least (n) people was found. Based on the random match probability for unrelated individuals [insert name here] is a major contributor to this mixture.” Assuming that [insert name A here] is a contributor to this mixture, based on the random match probability for unrelated individuals [insert name B here] is also a contributor.”

ii. If the RMP does not meet the source attribution threshold and an association was made:
1) “PCR DNA / High Sensitivity PCR DNA typing (using the [insert appropriate test kit name(s)]) was done on the following sample(s). A mixture of DNA from at least (n) people was found. [Insert name here] could be a [select major or minor] contributor to this mixture.”
2) “PCR / High Sensitivity PCR DNA testing (using the [insert appropriate test kit name(s)]) was done on the following sample(s). A mixture of DNA from at least (n) people was found. Assuming that [insert name A here] is a contributor to this mixture, [insert name B here] could be an additional contributor.”
3) “PCR / High Sensitivity PCR DNA testing (using the [insert appropriate test kit name(s)]) was done on the following sample(s). A mixture of DNA from at least (n) people was found. Based on the random match probability for unrelated individuals [insert name here] is a major contributor to this mixture. Assuming that [insert name A here] is a contributor to this mixture, [insert name B here] could be an additional contributor.”
iii. If no association has been made between the evidentiary DNA profile and the DNA profile of a named individual:

“PCR / High Sensitivity PCR DNA typing (using the [insert appropriate test kit name(s)]) was done on the following sample(s). A mixture of DNA from at least (n) people, including at least one [select major or minor if applicable] male, Male Donor X, was found.”

iv. If a statistic is required in the report, state RMP as follows:

“The DNA profile of Male Donor X was determined. This DNA profile is expected to be found in approximately:

1) 1 in greater than 6.80 trillion people (if the RMP meets or exceeds the source attribution threshold) OR
2) 1 in 3 significant figures people” (use the most common statistic amongst ethnic groups)

c. The DNA profile does not match the DNA profile of a named individual:

“PCR / High Sensitivity PCR DNA typing (using the [insert appropriate test kit name(s)]) was done on the following sample(s). A DNA profile from a male, Male Donor X, was determined. This DNA profile is not the same as that of [insert name here]; therefore, he/she is not the source of this DNA.”

ii. “PCR / High Sensitivity PCR DNA typing (using the [insert appropriate test kit name(s)]) was done on the following sample(s). A mixture of DNA from at least (n) people, including at least one [select major or minor] male, Male Donor X, was found. This DNA profile is not the same as that of [insert name here]; therefore, he/she is not the source of this DNA.”
d. In most cases, a partial single source or deduced profile from an unidentified individual should not be compared to mixtures in the case. These comparisons will be done once an exemplar whose profile is consistent with the partial profile is submitted. When no comparisons are made, the report should state: “No comparisons of the DNA profile of Male Donor X were made to DNA mixtures in this case.”

D. Mixed samples that are not deconvoluted in their entirety

1. These samples may include the following:
   a. The DNA profiles of the individual contributors could not be deconvoluted, but the sample may be used for comparison.
   b. The DNA profiles of the individual contributors were not deconvoluted, but the sample may be used for comparison.
   c. The DNA profile of the major contributor was determined, and there are sufficient labeled peaks that cannot be attributed to the major contributor that may be used for comparison.

2. Comparisons to these samples within a case are done as needed. This decision is made on a case by case basis.

3. Comparisons are based on previously determined allele calls at conclusive loci. Loci that are designated as “NEG” for negative or “INC” for inconclusive cannot be used. For LT-DNA samples, conclusive loci must have repeating alleles.

4. All results for the same sample are evaluated and may be used for comparison.

5. If the source of a comparison sample could be a contributor to the mixture
   a. The phrase could be a contributor is used when:
      i. For samples amplified with 28 or 31 cycles, all of the alleles seen in the comparison sample are also labeled in the evidence sample.
ii. If any alleles seen in the comparison sample are not labeled at the conclusive loci in the evidence sample, refer to sections D6, D7, or D8.

b. The cumulative probability of inclusion (CPI) will be calculated (if necessary) after the DNA profile of the comparison sample(s) is determined to be included in the evidence sample profile. The CPI is calculated for informative samples.
   i. For example, if a vaginal swab sperm cell fraction yielded a single source profile, it may not be necessary to calculate a CPI for a mixture consistent with the same single source profile found on another sample in the same case.
   ii. An RMP value may be generated for a major contributor to a mixture, but the comparison sample could be a minor contributor to the mixture. If this is informative, calculate the CPI for this mixture.

c. The CPI is reported in the evidence report. For further details on performing this calculation, refer to the “Population and Statistics Procedures of the Manual.

d. Evidence report template
   “PCR / High Sensitivity PCR DNA typing (using the [insert appropriate test kit name(s)]) was done on the following sample(s). A mixture of DNA from at least (n) people was found.”
   i. Choose one of the following:
   1) “The DNA profiles of the [individual contributors/minor contributor(s)] to the mixture(s) could not be determined; however the results are suitable for comparison. Since all of the DNA alleles seen in the DNA profile of (insert name here / Male Donor X) are also seen in the mixture(s), he/she could be a contributor.”
   2) “The DNA profiles of the [individual contributors / minor contributor(s)] to the mixture(s) were not determined. All of the alleles seen can be explained as a mixture of DNA from [insert name here /Male Donor X /person A and person B].”
iii. If a statistic is required in the report, state:
“The combined probability of inclusion, that is, the probability that a random individual would be included as a possible contributor to the mixture of labeled DNA alleles, is:

1 in (3 significant figures) people”

Report the most common statistic amongst ethnic groups.

6. If an individual cannot be excluded as a contributor to the mixture

a. An individual cannot be excluded as a possible source of DNA in an evidentiary sample if most of the labeled peaks seen in the comparison sample were also seen in the mixture, and the absent (or unlabeled) peak(s) can be explained. Explanations for absent or unlabeled peaks may include any of the following:
   i. Amount of DNA amplified
   ii. Artifacts such as stutter
   iii. Degradation
   iv. Empirically defined locus characteristics – (In-house validation studies of Identifier® demonstrated that the large and/or less efficient loci are: CSF1PO, D2S1338, D18S51, FGA, TH01, D16S539, and in mixed samples also TPOX.)
   v. Length of the STR repeat
   vi. Number of contributors to the sample

b. The phrase cannot be excluded is used when:
   i. For mixed HT-DNA samples, a few visible but unlabeled peaks can be explained as above. However, no more than two alleles can be completely absent or not visible.
   ii. For mixed LT-DNA samples, no more than two alleles can be unlabeled or absent, and explained as above.
   iii. For all samples, if less than 10 loci are detected and two alleles are absent, the comparison may be inconclusive depending upon the characteristics of the sample and the loci from which the alleles are absent (refer to section D7).
c. **Evidence Report Template**
   i. “PCR / High Sensitivity PCR DNA typing (using the [insert appropriate test kit name(s)]) was done on the following sample(s). A mixture of DNA from at least (n) people was found.”
   ii. “The DNA profiles of the [individual contributors/minor contributor(s)] to the mixture(s) could not be determined; however the results are suitable for comparison. Most, but not all, of the DNA alleles seen in the DNA profile of [insert name here or Male Donor X] are seen in the mixture. Since the absence of an allele(s) can be reasonably explained, he/she cannot be excluded as a possible contributor.”

7. **If the comparison sample is excluded as a contributor to the mixture**
   a. The donor of a comparison sample is excluded as a possible contributor to an evidentiary sample if one or more alleles seen in the DNA profile of the comparison sample are not seen in the mixture, and the absence cannot be explained. Explanations for absent or unlabeled alleles may include any of the following:
      i. Amount of DNA amplified
      ii. Artifacts such as stutter
      iii. Degradation
      iv. Empirically defined locus characteristics – (In-house validation studies of Identifier® demonstrated that the large and/or less efficient loci are: CSF1PO, D2S1338, D18S51, FGA, TH01, D16S539, and in mixed samples also TPOX.)
      v. Length of the STR repeat
      vi. Number of contributors to the sample
   b. The phrase **is excluded** is used when:
      i. For HT-DNA samples,
         1) If a sample shows no unlabeled peaks, the unexplained absence of one peak may be indicative of an exclusion.
2) If a sample shows an unlabeled peak(s) and/or dropout is suspected, do the following:
   • Evaluate the results at the efficient loci. The absence of even a single peak may be indicative of an exclusion.
   • Evaluate the results at the less efficient or large loci. If the absence of peaks cannot be explained, this may be indicative of an exclusion.
   • Regardless of the locus, for a mixture with only two contributors, if an allele seen in the comparison sample is not present at a locus with four peaks, this could be indicative of an exclusion.

ii. For LT-DNA samples,
   1) Three or more alleles seen in the DNA profile of the comparison sample are absent at the efficient loci.
   2) Many alleles seen in the DNA profile of the comparison sample are absent at any locus.

c. Evidence report template
   i. “PCR / High Sensitivity PCR DNA typing (using the [insert appropriate test kit name(s)]) was done on the following sample(s). A mixture of DNA from at least (n) people was found.”
   ii. “The DNA profiles of the [individual contributors/minor contributor(s)] to the mixture(s) could not be determined; however the results are suitable for comparison. [Insert name here or Male Donor X] is excluded as a contributor to this mixture.”
8. **Mixed Samples** – No conclusions can be drawn regarding whether the comparison sample could be a contributor to the mixture.

   a. When making a comparison, take into account the following:
      i. Amount of DNA amplified
      ii. Artifacts such as stutter
      iii. Degradation
      iv. Empirically defined locus characteristics – (In-house validation studies of Identifiler® demonstrated that the large and/or less efficient loci are: CSF1PO, D2S1338, D18S51, FGA, and TH01, D16S539, and in mixed samples TPOX.)
      v. Length of the STR repeat
      vi. Number of contributors to the sample

   b. The phrase **no conclusions can be drawn** is used if the criteria for “could be a contributor,” “cannot be excluded” or “excluded” are not met. The factors supporting this statement should be documented in the case file. For example, alleles seen in the comparison sample that are absent in the evidence sample may be recorded in the table of profiles underneath the relevant sample or on another sheet.

   c. **Evidence report template**
      i. “PCR / High Sensitivity PCR DNA typing (using the [insert appropriate test kit name(s)]) was done on the following sample(s). A mixture of DNA from at least (n) people was found.”
      ii. “The DNA profiles of the [individual contributors/minor contributor(s)] to the mixture(s) could not be determined; however the results are suitable for comparison. No conclusions can be drawn regarding whether [insert name here or Male Donor X] could be a contributor to this mixture.”
9. Mixed samples – No comparisons were made at this time.

Evidence report template:

a. “PCR / High Sensitivity PCR DNA typing (using the [insert appropriate test kit name(s)]) was done on the following sample(s). A mixture of DNA from at least (n) people was found.”

b. “The DNA profiles of the [individual contributors/minor contributor(s)] to the mixture(s) [could not be/were not] determined; however the results are suitable for comparison. No comparisons will be done at this time.”

E. Samples which are not suitable for comparison

1. Refer to the Guidelines for interpretation of results in the “STR Results Interpretation” procedure for details on this category of samples.

2. Evidence report template

If too few or too many labeled peaks were detected, for example: “PCR / High Sensitivity PCR DNA testing (using the [insert appropriate test kit name(s)]) was done on the following sample(s); however this sample is not suitable for comparison.”

3. Documentation in the case record

Factors supporting this conclusion should be documented in the case record. Samples which will not be used for comparison in their entirety must be supported with the proper documentation.

For mixtures which can be deconvoluted for the major contributor, but are not suitable for comparison to the minor contributor, record the reasoning either in the allele table documentation or on a separate document.
F. Samples that cannot be reported due to quality control reasons:

Report template: “PCR / High Sensitivity PCR DNA testing (using the [insert appropriate test kit name(s)]) was done of the following sample(s); however, this sample is not suitable for comparison due to quality control reasons.”

G. Suspect file reporting

1. For all files: “PCR DNA typing (using the [insert appropriate test kit name(s)]) was done on the oral swab from [insert suspect name here or on the cigarette butt ‘smoked by’ [insert suspect name here]. A DNA profile was determined.”

2. For files where a direct comparison was made with a specific evidence case:

“This profile was compared to the results in the following case:

FB number Complaint Number Victim Name Report date”

3. Choose one or more of the following. Refer to prior sections to make comparisons and determine which statements are needed.

a. If the RMP of the evidence profile meets the source attribution threshold and the source is determined to be the suspect: “The results are the same as those of Male Donor X. Therefore, based on the random match probability for unrelated individuals, [insert suspect name here or the DNA donor to the cigarette butt] is the source of the DNA detected on the following sample(s):”

b. If the RMP of the evidence profile does not meet the source attribution threshold, and an association to the suspect was made: “The DNA results are consistent with those of Male Donor X to the following sample(s). Therefore, [insert suspect name here or the DNA donor to the cigarette butt] could be the source of that DNA:”

c. If the suspect is not the source of a single source evidentiary profile: “[Insert suspect name or the donor to the cigarette butt] is not the source of the DNA in the following sample(s):”
FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

SAMPLE COMPARISONS

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>APPROVED BY</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>04-01-2014</td>
<td>NUCLEAR DNA TECHNICAL LEADER</td>
<td>15 OF 23</td>
</tr>
</tbody>
</table>

d. If the suspect could be a contributor to a mixture: “Since all of the DNA alleles seen in the DNA profile of [insert suspect name here or the donor to the cigarette butt] are seen in the mixture(s) of DNA detected on the following sample(s), [insert suspect name here] or the DNA donor to the cigarette butt) could be a contributor;”

e. If the suspect cannot be excluded as a contributor to a mixture: “Most of the DNA alleles seen in the DNA profile of [insert name here or the donor to the cigarette butt] are seen in the mixture(s) of DNA detected on the following sample(s). Since the absence of the allele(s) can be explained, he/she cannot be excluded as a possible contributor to the mixture(s);”

f. If the suspect is excluded as a contributor to a mixture or could not be DNA donor to a sample “[Insert suspect name or the donor to the cigarette butt] is excluded as a contributor to the following sample(s) or to all of the samples where comparisons could be made:”

g. If no conclusions can be drawn regarding whether the suspect could be a contributor to a mixture: “No conclusions can be drawn regarding whether [insert suspect name or the donor to the cigarette butt] contributed to the mixture(s) of DNA detected on the following sample(s):”

II. Comparison of samples based on Y STR results, Statistical Treatment, and Reporting

These guidelines address sample comparisons and reporting specific for Y STR analysis. Refer to the autosomal STR comparison section and the case management manual for further details on categorizing samples and reporting in general.

A. The first step in reporting DNA results is to state the type of testing that was performed and to identify the number of contributors to the sample.

1. The appropriate kit name is “PowerPlex YSTR® Kit” or “AmpFlSTR® Yfiler™ PCR Amplification Kit”.

2. The phrase “a DNA profile” versus “a mixture of DNA from at least (n) male individuals” is used to report the number of contributors.
B. For each Y STR based comparison, the following conclusions can be made:

1. Comparison to a single source profile or to a deconvoluted profile from a mixed sample.
   a. The comparison sample could be the source.
   b. The comparison sample is not the source.

2. Comparison to a mixed sample that was not deconvoluted.
   a. The comparison sample cannot be excluded as a contributor to the mixture.
   b. No conclusions can be drawn regarding whether the comparison sample could be a contributor to the mixture.
   c. The comparison sample is excluded as a contributor to the mixture.

3. Statistics
   a. Statistical information is reported in the evidence report.
   b. For single source profiles, or profiles deconvoluted from a mixed sample, the haplotype frequency is determined using the USYSTRDATABASE.COM website.
   c. For mixed samples that could not be deconvoluted no statistics will be reported and "cannot be excluded" is the only applicable verbal predicate.

C. Single source profiles or deconvoluted profiles from mixed samples

1. Statistics: The frequency of a Y-STR profile is based on a haplotype count. Refer to the “Population Frequencies for STR’s” procedure for details on determining this value.

2. Evidence report template:

   a. Single source profiles
      i. If an association to a named individual was made: “PCR DNA typing (using the PowerPlex YSTR® Kit or AmpFISTR® Yfiler™ PCR Amplification Kit) was done on the following sample(s). A DNA profile was determined. This DNA profile is consistent with that of (insert name here); therefore, he or one of his paternal male relatives could be the source of this DNA.”
ii. In the report, provide the haplotype frequency for the most discriminating sample as follows:

“This DNA profile is expected to be found in approximately:

1 in ____________ African American males.
1 in ____________ Asian males.
1 in ____________ Caucasian males.
1 in ____________ Hispanic males.”

iii. If no association has been made between the evidentiary DNA profile and the DNA profile of a named individual: “PCR DNA typing (using the [insert the PowerPlex YSTR® Kit or AmpFlSTR® Yfiler™ PCR Amplification Kit] was done on the following sample(s). A DNA profile from a male, Male Donor X, was determined.”

iv. If a statistic is required in the report, state the haplotype frequency as outlined above.

b. Mixed samples with a deconvoluted profile

If an association to a named individual was made:

1) “PCR DNA typing (using the PowerPlex YSTR® Kit or AmpFlSTR® Yfiler™ PCR Amplification Kit) was done on the following sample(s). A mixture of DNA from at least (n) male individuals was found. [Insert name here] or one of his paternal male relatives could be a [select major or minor] contributor to this mixture.”

2) “PCR DNA typing (using the PowerPlex YSTR® Kit or AmpFlSTR® Yfiler™ PCR Amplification Kit) was done on the following sample(s). A mixture of DNA from at least (n) male individuals was found. Assuming that [insert name A here] is a contributor to this mixture, [insert name B here] or one of his paternal male relatives could be an additional contributor.”
ii. If no association has been made between the evidentiary DNA profile and the DNA profile of a named individual:

“PCR DNA typing (using the PowerPlex YSTR® Kit or AmpFlSTR® Yfiler™ PCR Amplification Kit) was done on the following sample(s). A mixture of DNA from at least (n) males, including at least one deducible component, Male Donor X, was found.”

iii. This phrase can be modified if the haplotypes of both contributors could be deduced.

“PCR DNA typing (using the PowerPlex YSTR® Kit or AmpFlSTR® Yfiler™ PCR Amplification Kit) was done on the following sample(s). A mixture of DNA from at least (n) males, including a major component, Male Donor X1, and a minor component Male Donor X2, was found.”

iv. If a statistic is required in the report, state the haplotype frequency as outlined above.

v. No comparisons to partial minor components (< 4 labeled minor peaks) will be made.

“PCR DNA typing (using the PowerPlex YSTR® Kit or AmpFlSTR® Yfiler™ PCR Amplification Kit) was done on the following sample(s). A mixture of DNA from at least (n) males, including at least one deducible component, Male Donor X, was found. The minor component of this mixture, however, is not suitable for comparison.”

c. The DNA profile does not match the DNA profile of a named individual:

i. “PCR DNA typing (using the PowerPlex YSTR® Kit or AmpFlSTR® Yfiler™ PCR Amplification Kit) was done on the following sample(s). A DNA profile from a male, Male Donor X, was determined This DNA profile is not the same as that of [insert name here]; therefore, he is not the source of this DNA.
### SAMPLE COMPARISONS

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>APPROVED BY</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>04-01-2014</td>
<td>NUCLEAR DNA TECHNICAL LEADER</td>
<td>19 OF 23</td>
</tr>
</tbody>
</table>

ii. "PCR DNA typing (using the PowerPlex YSTR® Kit or AmpFlSTR® Yfiler™ PCR Amplification Kit) was done on the following sample(s). A mixture of DNA from at least (n) males, including at least one deducible component, Male Donor X, was found.” This DNA profile is not the same as that of [insert name here]; therefore, he is not the source of this DNA.”

D. Mixed samples that are not deconvoluted

1. **These samples may be used for comparisons** within a case, to other cases, or to known samples as needed.

2. Comparisons are based on previously determined allele calls at conclusive loci and all results for the same sample are evaluated. Loci that are designated as “NEG” for negative or “INC” for inconclusive cannot be used.

3. An individual cannot be excluded as a possible source of DNA in an evidentiary sample if all or most of the labeled peaks seen in the comparison sample were also seen in the mixture, and the absent (or unlabeled) peak(s) can be explained. No statistics will be provided for this conclusion.

   a. Explanations for absent or unlabeled peaks may include any of the following:
      i. Amount of DNA amplified
      ii. Artifacts such as stutter
      iii. Degradation
      iv. Length of the STR repeat

   b. **Evidence Report Template**
      i. "PCR DNA typing (using the PowerPlex YSTR® Kit or AmpFlSTR® Yfiler™ PCR Amplification Kit) was done on the following sample(s). A mixture of DNA from at least (n) male individuals was found.”
ii. “The DNA profiles of the individual contributors to the mixture(s) could not be determined; however the results are suitable for comparison. All [most but not all] of the DNA alleles seen in the DNA profile of [insert name here or Male Donor X] are seen in the mixture. [Since the absence of the missing allele(s) can be reasonably explained], he or one of his paternal male relatives cannot be excluded as a possible contributor.”

4. Exclusions:
   
a. The donor of a comparison sample is excluded as a contributor to the mixture if one or more alleles seen in the DNA profile of the comparison sample are not seen in the mixture, and the absence cannot be explained.

b. Evidence report template
   
i. “PCR DNA typing (using the PowerPlex YSTR® Kit or AmpFlSTR® Yfiler™ PCR Amplification Kit) was done on the following sample(s). A mixture of DNA from at least (n) male individuals was found.”

ii. “The DNA profiles of the individual contributors to the mixture(s) could not be determined; however the results are suitable for comparison. [Insert name here or Male Donor X] is excluded as a contributor to this mixture.”

5. No conclusions can be drawn:
   
a. The phrase no conclusions can be drawn is used if the criteria for “cannot be excluded” or “excluded” are not met. The factor(s) supporting this statement should be documented in the case file.

b. Evidence report template
   
i. “PCR DNA typing (using the PowerPlex YSTR® Kit or AmpFlSTR® Yfiler™ PCR Amplification Kit) was done on the following sample(s). A mixture of DNA from at least (n) male individuals was found.”
ii. “The DNA profiles of the individual contributors to the mixture(s) could not be determined; however the results are suitable for comparison. No conclusions can be drawn regarding whether [insert name here or Male Donor X] could be a contributor to this mixture.”

6. If no comparisons were made at this time:

Evidence report template
a. “PCR DNA typing (using the PowerPlex YSTR® Kit or AmpFlSTR® Yfiler™ PCR Amplification Kit) was done on the following sample(s). A mixture of DNA from at least (n) male individuals was found.”

b. “The DNA profiles of the individual contributors to the mixture(s) [could not be/were not] determined; however the results are suitable for comparison. No comparisons will be done at this time.”

E. Samples not suitable for comparison

1. Refer to the “STR Results Interpretation” procedure for details on categorizing samples as not suitable or comparison.

2. Evidence report template
   “PCR DNA typing (using the PowerPlex YSTR® Kit or AmpFlSTR® Yfiler™ PCR Amplification Kit) was done on the following sample(s), however this sample is not suitable for comparison.

3. Documentation in file
   Factor(s) supporting this conclusion should be documented in the case record. Samples which will not be used for comparison in their entirety must be supported with the proper documentation.

   For mixtures which can be deconvoluted for the major contributor, but are not suitable for comparison to the minor contributor, record the reasoning either in the allele table documentation or on a separate document.
## SAMPLE COMPARISONS

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>APPROVED BY</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>04-01-2014</td>
<td>NUCLEAR DNA TECHNICAL LEADER</td>
<td>22 OF 23</td>
</tr>
</tbody>
</table>

### F. Samples that cannot be reported due to quality control reasons:

**Evidence Report template:** “PCR DNA typing (using the PowerPlex YSTR® Kit or AmpFISTR® Yfiler™ PCR Amplification Kit) was done on the following sample(s), however this sample is not suitable for comparison.

### G. Suspect file reporting

1. For all files: “PCR DNA typing (using the PowerPlex YSTR® Kit or AmpFISTR® Yfiler™ PCR Amplification Kit) was done on the oral swab from [insert suspect name here or on the cigarette butt ‘smoked by’ [insert suspect name here]. A DNA profile was determined.

2. For files where a direct comparison was made with a specific evidence case:

   “This profile was compared to the results in the following case:

   *FB number   Complaint Number   Victim Name   Report date*

3. Choose one or more of the following. Refer to previous sections to make comparisons and determine which statements are needed.

   a. **Single source and positive association to the suspect:** “The DNA results are consistent with those of Male Donor X to the following sample(s). Therefore, [insert suspect name here or the DNA donor to the cigarette butt] or one of his paternal male relatives could be the source of that DNA:”

   b. **Single source and exclusion:** “[Insert suspect name or the donor to the cigarette butt] is not the source of the DNA in the following sample(s):”

   c. **Mixture and cannot be excluded as a contributor:** “[All/Most] of the DNA alleles seen in the DNA profile of [insert suspect name here or the donor to the cigarette butt] are seen in the mixture(s) of DNA detected on the following sample(s). [Since the absence of the allele(s) can be explained, h/He] or one of his paternal male relatives cannot be excluded as a possible contributor to the mixture(s):”
d. **Mixture and exclusion:** “[Insert suspect name or the donor to the cigarette butt] is excluded as a contributor to the following sample(s) or to all of the samples where comparisons could be made:”

e. **Mixture and no conclusions:** “No conclusions can be drawn regarding whether [insert suspect name] or the donor to the cigarette butt contributed to the mixture(s) of DNA detected on the following sample(s):”

**Revision History:**

March 24, 2010 – Initial version of procedure.
August 30, 2010 – Extensively enhanced (from a five-page document to a 22-page document) to provide guidance on comparisons made using Autosomal and Y STR results.
September 27, 2010 – Added documentation requirements for samples that are not suitable for comparison.
July 16, 2012 – Specific worksheets were removed and replaced with generic terminology to accommodate LIMS.
April 1, 2014 – Procedure revised to include information for Yfiler.
Kinship Analysis tests alternate or competing hypotheses of kinship. In the forensic context, it is useful for determining familial relationships, the identification of unknown bodies, and the identification of the donor of bloodstains when the donor/body is missing or unavailable, and the identification of the biological father or mother of products of conception/babies, which result from a sexual assault or are abandoned. All calculations are performed according to the Parentage Testing Standards of the American Association of Blood Banks. The DNA from the subject/stain in question is compared to the DNA of close biological relatives.

For parent(s)/child comparisons, the loci are first evaluated to determine whether the individual in question can be excluded as a biological relative of the other individual(s) (see below). If the individual cannot be excluded, or for comparisons not involving a parent/child relationship, a PI (traditionally called a paternity index, but this could be a maternity or kinship index), is calculated for each locus using the DNAVIEW program of Dr. Charles Brenner. The formulas for parent/child comparisons are listed in Appendices 6 and 11 of Parentage Testing Accreditation Requirements Manual, 3rd edition, AABB.

If there is an exclusion at a single locus in a parent/child comparison, The PI is calculated according to the formula in Appendix 11 (PI=µ/PE) where

\[ \mu \text{ (locus specific mutation rate) is obtained from Appendix 14 of Parentage Testing Accreditation Requirements Manual, Fourth Edition, AABB and} \]

\[ PE = h^2 (1-2hH^2) \text{ where } H \text{ is the frequency of homozygosity and } h \text{ is the frequency of heterozygosity. PE is calculated by the DNAVIEW program.} \]

An overall CPI (combined paternity index) is calculated by multiplying all of the individual PIs. A probability of paternity (maternity/kinship) is then calculated using Bayes’ theorem and assuming a prior probability of 50%. The individual loci PI, the CPI, and probability of paternity (W) are calculated by the DNAVIEW program. The report printed out from DNAVIEW should be included in the case file as the statistics sheet. The DNAVIEW calculations should be performed for each race.

The Forensic Biology case report should report the results for ONE race, preferably the race of the individual in question (e.g., the race of the tested man in a paternity case). The case report must list the PI for each locus, the race used for the calculations, the CPI, the probability of paternity, and the assumed prior probability. It must also state the final conclusion. The three possible final conclusions are exclusion, inconclusive, or inclusion, of the tested hypothesis of kinship.
Exclusions occur when either 2 or more loci exclude in a parent/child comparison, or when the CPI < 0.1.

Inconclusive occurs when the CPI is between 0.1 and 10, and for individual loci in mixtures of parent/child combinations when there are other peaks visible which could potentially exclude or include but can not be genotyped by the software.

Inclusions occur when either 0 or 1 loci exclude in parent/child combinations, and when for all cases the CPI > 10. The analyst should bear in mind and report the strength of the inclusion based on the CPI. When the CPI is greater than 2000 (probability of paternity > 99.95%, 50% prior probability), the hypothesis of kinship should be accepted (considered proven). When the CPI is between 100 and 2000, the hypothesis is supported by the data. When the CPI is between 10 and 100, the hypothesis should not be rejected, and should be considered a weak inclusion.

Revision History:
March 24, 2010 – Initial version of procedure.
Extraction and Quantitation


Nicklas, J. A., Buel, E. Development of an Alu-based, Real-Time PCR Method for Quantitation of Human DNA in Forensic Samples

Nicklas, J. A., Buel, E. Development of an Alu-based, QSY 7-Labeled Primer PCR Method for Quantitation of Human DNA in Forensic Samples

Office of Chief Medical Examiner, Histology Procedure Manual.


Fluorescent STR technology: methods and validations


FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

REFERENCES

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>APPROVED BY</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>03-24-2010</td>
<td>EUGENE LIEN</td>
<td>3 OF 5</td>
</tr>
</tbody>
</table>


**Genetic markers and theoretical background**


REFERENCES


High Sensitivity Testing


Kinship and Paternity testing


Revision History:
March 24, 2010 – Initial version of procedure.
DNA-View is software created by Dr. Charles Brenner and is used for the performing paternity and kinship analysis. The following instructions are guidelines as to the use of DNA-View and interpretation of the results.

I. Creating a DNA-View Worksheet and Import Record

1. Open up the DNA-View Form

2. On the DNA View Worksheet, fill in a 5-digit Case ID (i.e., if your case is FB04-1345, then the case ID will be 41345). Note the Case ID cannot start with zero.

3. Select the Case Type from the drop down menu: Paternity or Kinship.

4. Fill in Name section with sample names. Don’t use quotes because DNA-VIEW will place double quotes around those sample names at the import step.
5. Assign a Relation to each sample using the designation codes from the Paternity or Kinship table below the spreadsheet (i.e., if the person is a mother, enter M for relation. If the person is a sibling, enter U for relation, if there are additional siblings, enter A, then B. There are only a standard number of designation codes for each relationship. If additional sibling relationships are required, for example, use the designations for Other: X, Y, Z, as needed. This convention also holds true for other relationships in the table).

6. Enter the DNA profiles for each sample. This can be done by typing them in by hand or by copy and pasting directly from an STR profile table.

   For both homozygote and heterozygote profiles, enter both alleles at each locus, separated by a space, not a comma. If there is allelic dropout at a locus, leave the entire locus blank.

7. Once the sheet is completely filled out, save it in the DNAVIEW\WRKST folder. Use the case ID as the file name and “save as” type Microsoft Office Excel Workbook. See below:
8. Click on the **Save Import Sheet** button on the top left corner of the worksheet. This will save the sheet in a format that DNA-View can import. The filename will be the five-digit case ID and the file will be saved in the **DNAVIEW\IMPORT** folder.

9. Exit from Microsoft Excel. Another Microsoft Excel alert will pop-up asking if you want to save the changes. Click **No**.

II. Importing profiles into DNA-View

**YOU CAN ALWAYS RETURN TO THE MAIN MENU FROM ANY STAGE OF THE PROGRAM (AND WITHOUT LOSING MUCH INFORMATION) BY HITTING the Ctrl+C KEYS SIMULTANEOUSLY. THIS MAY COME IN HANDY IF YOU MISTYPE ANY ENTRY.**

**YOU CAN ALSO USE THE MOUSE, SCROLL USING KEYBOARD ARROWS OR TYPE IN COMMANDS TO SELECT FROM THE MENU.**

1. Open DNA-View, select **Import/Export** (by either typing it in the **Command** field or clicking it with a mouse), hit Enter.
2. At next screen, there is field that says Which Import/Export option? select Genotyper import, hit Enter.

3. In the field that says "What subdirectory?", a path (\FBIOLO~3\MPERSONS\DNAVIEW\IMPORT) will already be specified. Hit Enter.

   If the field is blank, see the Troubleshooting section for specifying the subdirectory.

4. Select your Case ID from the list. Hit Enter.
5. At the following window, path with selected Case ID will appear, hit Enter.
6. Now that Case ID has been selected, screen will say **Initializing a new membrane.** **Date of run** will default to the current date, hit **Enter**.

7. **Membrane # or brief id** will list the selected **Case ID** in the format of #####.txt. Hit **Enter**.
8. You will be asked, **Is the above information correct?** Verify the **Date of run** and the **Case ID** and hit **Enter**.

9. You will be asked **Who are you?** The program defaults to **099 Genotyper** (and unless you want to be someone else, such as secret agent, James Bond, or father of inductive reasoning, Francis Bacon) hit **Enter**.

10. The following window displays the entered loci, hit **End** or **Esc**, not **Enter**.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
11. Wait for a few seconds for the DNA profiles to import.
12. Note: A screen may appear that says “There are some samples id’s…” At the bottom of this screen, the program asks Proceed with generation? (N=modify parameters, Y=proceed). Y will appear, hit Enter. If this screen does not appear, do not be alarmed, the import will still work.

If you are using paternity instead of kinship, answer “N” to modify the parameters and type in “paternity.” If the order of races are incorrect or if you only want to test one race, you can change the order here or type in one letter for the race.

13. A green screen will appear, indicating a successful import. At this step, unique identifiers (circled below) are also added to each profile. Hit Esc to quit viewing this screen, and Esc again to get back to main menu.
III. Performing Paternity or Kinship Analysis

1. Select Casework, hit enter.
2. Select **Paternity case**, hit **Enter**. (This will be used whether a paternity or a kinship case is being done).

3. **Select case** should be highlighted. Hit **Enter**.
4. At the next screen, at the field Case # (0 to exit) look for the 5 digit Case ID that was imported. If it is there, Hit Enter. If it is not there, the import step may need to be repeated (Refer to II. Importing profiles into DNA-VIEW).

5. Select immigration/kinship, hit Enter. Verify that the imported case information is correct such as the Case ID and all sample information, including relationships (if not, see section IV.2. for changing case language), and that, in the race(s): field, bcha is indicated. Go to step 8. If bcha is not indicated, the race list needs to be edited. See steps 6-8 for editing race list.
6. Use arrow keys to select **edit race list** in green menu on lower right corner of screen. Hit **Enter**.

bcha: Abbreviation for Blacks, Caucasians, Hispanics, Asians
7. Type **bcha** in the **race(s):** field. Hit **Enter**. The changes will be saved.

8. After editing race list, select **immigration/kinship**, hit **Enter**.
9. **Estimate likely relationships** should be highlighted already. If not, select it and then hit `Enter`.

10. Wait for program to obtain allele frequencies for the four races.
11. The **Estimate likely relationships** screen will display the following information:

   a. DNA profiles for each sample with a corresponding legend (alleles are expressed in letters)
   
   b. A green *likely relationships* table (circled below) that lists PI (paternity indices) and SI (sibship indices) generated from calculations comparing every pair of individuals in the case. The numbers in each cell evaluate the corresponding pair of people as potential parent-children (PI), and as potential siblings (SI). Numbers are omitted if very small. (As per Dr. Charles Brenner’s DNA-VIEW Newsletter #17, [http://dna-view.com/news17.htm](http://dna-view.com/news17.htm))
   
   c. After viewing this information, Hit **Enter**.
12. Select **Add relationship est to report**, hit **Enter** to add the **likely relationships table** to the final report that will be placed in the casefile.

13. Select **Type in (or edit) scenario 1**, hit **Enter**.
14. In the blue field, enter a kinship or maternity/paternity statement that expresses two hypotheses (or ways people are related), then hit Esc, not Enter. See below for examples of Kinship and Paternity scenarios.

a. In the case example featured in the screen captures, there is a typed femur, V, that may or may not be from the mother of the typed daughter, D, son S, and son T

The format for this KINSHIP case is as follows:
1) D,S,T:V/Other+Pa (as seen in screen capture below)
2) This means daughter, D, son, S, and son, T are a product of the typed femur donor, V, or another unknown individual, Other, and some untested man, Pa.

Another option is a case of with a trio of typed individuals, a child, C, a mother, M, and a tested man that may or may not be the father, F

The format for this PATERNITY case is as follows:
1) C:M+F/Other
2) This means that the child, C, is a product of the typed mother, M, and the tested man, F, or another unknown man, Other.
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
15. Select Calculate & report LRs, 4 races, hit Enter.

16. Wait for the program to collect allele frequencies and calculate kinship equations. A series of screens will appear, see examples below.

Wait…
17. A table with cumulative LRs for each race will appear. These are the statistics that will be presented in the Forensic Biology report. **In the field that says Ascii file name for posting (blank if none)**, enter the filename: first letter is a P or K (Paternity or Kinship) followed by the five digit ID number, and ending with .txt (e.g. P91125.txt, K80144.txt). Hit Enter to save the file.
Displayed in this screen capture is the following:

**Cumulative LR**
This is a likelihood ratio, also known as the combined kinship index (CKI) or combined paternity index (CPI) which evaluates the assumptions spelled out in the proposed kinship or paternity scenarios from step 14 and determines which is more genetically likely.

**Posterior probability**
*Posterior probability* is also the relative chance of paternity (mentioned in Forensic Biology paternity report)

**Prior probability**
*Prior probability* is always 50% (both hypotheses equally plausible) for paternity and kinship cases (mentioned in Forensic Biology paternity report)

18. Select Quit from Immigration (should already be highlighted) and hit **Enter**.
19. Select **print report**, hit **Enter**.

20. Select Laserjet and hit **Enter**.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
21. The following screens will appear. Just wait for the file to print.

Keep waiting…A second screen will appear.
22. After you obtain printed report, hit Ctrl+C to get back to the main menu. Select Quit DNA-VIEW and hit Enter. If report is not printing, see Section IV for troubleshooting.

IV. Importing Raw Data

The next step is to convert the raw data to a format that is easier to read and can be pasted into a report. You also have the option to type in the raw data into your report tables by hand.

1. Open the workbook you saved earlier. It can be found in the DNAVIEW\WRKST folder.

2. Click on the Paste Report tab at the bottom of the worksheet

3. Select cell A1. Failure to select this cell may lead to improper results.
4. From the top menu, select Data → Import External Data → Import Data

5. Select the FBIOLOGY_1/DnaView/Casework/reports folder from the Look in: menu
6. This folder contains the ASCII file you saved in Section III Step 17. Change the Files of type select All Files. Select the file and click Open.

7. The Text Import Wizard window will appear. The default settings should be as seen above, correct them if they are not, and click Finish.

8. The Import Data window will appear. Select Properties...
9. The default settings in the **External Data Range Properties** window are correct but you need to select **Overwrite existing cells with new data, clear unused cells**. When the window has the settings shown above click **OK**.

![External Data Range Properties](image)

10. You will be taken back to the **Import Data** window. Make sure **Existing worksheet** is selected and the window below it has =A$1. Click **OK**.
11. The raw data has now been imported and your worksheet should look something like this:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Case</td>
<td>90439 Scenario</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>V</td>
<td>Victim</td>
<td>1280-00019</td>
<td>humerus</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>M</td>
<td>Mother</td>
<td>1280-00021</td>
<td>Jane Doe</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>F</td>
<td>Father</td>
<td>1280-00020</td>
<td>John Doe</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Victor M/F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Black cumulative LR: 1.02E+17
- Posterior probability: 100%
- Assuming priors: 50%

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
</table>
| 8 | Caucasian cumulative LR: 1.03E+14
- Posterior probability: 100%
- Assuming priors: 50% |
| 9 | Hispanic cumulative LR: 2.25E+14
- Posterior probability: 100%
- Assuming priors: 50% |
| 10 | Asians cumulative LR: 6.29E+14
- Posterior probability: 100%
- Assuming priors: 50% |

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
12. Click on the Table tab at the bottom, and you will see a cleaned up version of the data you just imported:

This table has sorted the data you provided in the Allele Entry tab, as well as the raw data from DNA-View, into a format that is easy to read.

13. The top of the sheet has two indicators which let you know the status of the import and the data.
   a. **No data imported** – Data has not been imported
   b. **Import OK** – The import was successful
   c. **Data OK** – The order of the loci in the imported data is usable
d. The following two errors are common when older files are imported:
   • **Imported data not in correct order** – Data has been imported but the order of the loci in the report is not in the correct order to use this table.
   • **Imported data is in Co Pro order** - Data has been imported but the order of the loci in the report is in Co Pro order.

Create a new report in DNA-View to fix this problem.

14. The rest of the table contains all of the information from the DNA-View report.
a. **Cumulative Likelihood Ratios** – listed numerically and with words. The most conservative (lowest) value is indicated. Values are truncated at two significant figures.

b. **Posterior Probability** – listed to two decimal places

c. **Allele table** – names, loci and alleles listed in FBio report format

d. **Paternity/Kinship Index Table** – the paternity/kinship indices of each locus’ genotype is listed below the locus for four major races

15. The allele table and paternity/kinship index table can be copied and pasted directly into the table of the report template. Blank rows should be omitted from the copy. Adjust wording from paternity to kinship as necessary.

V. Troubleshooting DNA-View

1. **Printing problems**
   a. Re-establish communication between DNA-View and the printer
      1) Go to **My Computer** from the Start menu or the desktop icon.
      2) Double click on M: drive.
      3) Double click on FBiology_1 folder.
      4) Double click on the DnaView Casework folder.
      5) Double click on the Printers folder.
      6) A list of MS-DOS batch files appears similar to those depicted below:
      7) Double click on the file that corresponds with your printer. (i.e., If you are trying to print to the printer on the 12th flr, click on Print DNABldg_dna_12fl_1204_hp4350_LPT2)
8) A black screen will appear and disappear quickly, this is normal. See below:

b. Communication has now been established successfully and printing should work.

c. Go back to DNA-View. In the main menu, select Reprint the last report and hit Enter. Wait for the report to print.
2. Changing Language from Kinship to Paternity
   a. This is useful for paternity cases where C is indicated as Sibling #4, instead of Child and F is indicated as Father instead of Tested Man
   b. Change case language from kinship to paternity
      • After selecting case in step III.3., a menu will appear. Use arrows to select language is: kinship. Hit Enter.

   A field will appear that says Use the language of? and four options will appear. Use arrows to select Paternity, then hit Enter.
• Relationships have now been changed from Sibling #4 to Child and Father to Tested Man.

• Language will now be changed to paternity until the next user changes it to kinship.
3. **Deleting records from DNA-View (in case of import problems, etc.)**
   a. Hit Ctrl+C to get to the main menu, select **Casework**, hit **Enter**.
   b. Select **Membrane**, hit **Enter**.
c. Use arrows to highlight case that you want to delete, hit Delete. Screen will say *Trying to delete* membranes. A list will appear with a blank field that says *Delete*, select altogether-- D +R+ definition, hit Enter.

d. Wait for data to be deleted. When successful, a screen that says *Trying to delete membranes* (highlighted in blue) and *expunged* (in green) will appear, then disappear quickly.

e. The import list will then display (not pictured). The case that was deleted will no longer be in the import list. Hit Esc or Ctrl-C to get back to the main menu.
4. **Designating a subdirectory if the subdirectory field is blank**
   
a. Normally, the subdirectory field contains the following pathway:

   ![Image of subdirectory pathway](image)

   b. In order to specify a subdirectory for the screen below, hit **Enter**.

   ![Image of subdirectory screen](image)
c. On the next screen, a list of folders will appear. You will be asked **Which file?** (Esc if done) Select **FBIOLO~3** from the list. Then hit **Enter**.

d. At this screen, hit **Esc**.
e. A list of folders contained in the main Forensic Biology folder will appear. Select **MPERSONS** and then hit **Enter**.

f. This folder has now been added to the path. Hit Esc.
g. A list of folders in the MPersons folder will appear. Select **DNAVIEW** then hit **Enter**.

h. This folder has now been added to the path. Hit **Esc**.
i. A list of folders in the DNAVIEW folder appears. Select IMPORT\ and hit Enter.

j. This folder has now been added to the path. Hit Esc.
The folder has now been added and the subdirectory path is complete. It will be automatically saved by the program. Hit Esc. Hit Esc again to return to the main menu.

5. Interpretation of DNA-View Report

Page 1 features (see sample next page):

a. Case #

b. Sample names with one letter relation code (i.e., M), relationship (i.e., mother), unique identifier, typed subject’s name

c. DNA profiles. Alleles are displayed in letter format. The letters are decoded in succeeding legend.

d. Likely relationships table displays paternity and sibling indices (PI and SI) to numerically evaluate plausibly relationships between each tested subject

e. Kinship/Paternity scenario contains the tested assumption and an alternate hypothesis

f. LR/CPI/CKI is cumulative likelihood ratio (also known as combined paternity index or combined kinship index) or the genetic odds in favor of paternity or kinship. This number will be indicated in Forensic Biology paternity and kinship reports for all 4 races (Blacks, Caucasians, Hispanics, and Asians).

g. Posterior and prior probabilities. Posterior probability is also known as the relative chance of paternity. Prior probability is always 50% (meaning that both hypotheses are equally plausible). Both relative chance of paternity and prior probability are indicated in Forensic Biology paternity reports.
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.
### DNA-VIEW FOR PATERNITY AND KINSHIP ANALYSIS

<table>
<thead>
<tr>
<th>Case 61494 kinship analysis</th>
<th>2006/9/21 16:</th>
</tr>
</thead>
</table>

#### Black

<table>
<thead>
<tr>
<th>Allele</th>
<th>Frequencies</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>D381358 3p STR</td>
<td>0.396</td>
<td>OCME STR database (Hispanics, Asians), FBI database (Blacks, Caucasians)</td>
</tr>
<tr>
<td>VWA 12p13.3 STR</td>
<td>1.01</td>
<td></td>
</tr>
<tr>
<td>FGA 4q STR</td>
<td>0.99</td>
<td></td>
</tr>
<tr>
<td>D6S1179 STR</td>
<td>0.74</td>
<td></td>
</tr>
<tr>
<td>D21611 STR</td>
<td>0.75</td>
<td></td>
</tr>
<tr>
<td>D18S51 18q21.3 STR</td>
<td>0.831</td>
<td></td>
</tr>
<tr>
<td>D5S818 STR</td>
<td>0.46</td>
<td></td>
</tr>
<tr>
<td>D13317 STR</td>
<td>2.35</td>
<td></td>
</tr>
<tr>
<td>D7S820 7q11 STR</td>
<td>6.56</td>
<td></td>
</tr>
<tr>
<td>D16539 16q24 STR</td>
<td>3.79</td>
<td></td>
</tr>
<tr>
<td>TH01 1p15.5 STR</td>
<td>4.34</td>
<td></td>
</tr>
<tr>
<td>TPOX 2p25-p24 STR</td>
<td>28.3</td>
<td></td>
</tr>
<tr>
<td>CSF1PO 5q31-34 STR</td>
<td>8.2</td>
<td></td>
</tr>
</tbody>
</table>

#### Caucasian

<table>
<thead>
<tr>
<th>Allele</th>
<th>Frequencies</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>D381358 3p STR</td>
<td>0.598</td>
<td>OCME STR database (Hispanics, Asians), FBI database (Blacks, Caucasians)</td>
</tr>
<tr>
<td>VWA 12p13.3 STR</td>
<td>2.34</td>
<td></td>
</tr>
<tr>
<td>FGA 4q STR</td>
<td>7.7</td>
<td></td>
</tr>
<tr>
<td>D6S1179 STR</td>
<td>9.72</td>
<td></td>
</tr>
<tr>
<td>D21611 STR</td>
<td>7.35</td>
<td></td>
</tr>
<tr>
<td>D18S51 18q21.3 STR</td>
<td>1.72</td>
<td></td>
</tr>
<tr>
<td>D5S818 STR</td>
<td>2.16</td>
<td></td>
</tr>
<tr>
<td>D13317 STR</td>
<td>2.51</td>
<td></td>
</tr>
<tr>
<td>D7S820 7q11 STR</td>
<td>5.21</td>
<td></td>
</tr>
<tr>
<td>D16539 16q24 STR</td>
<td>7.74</td>
<td></td>
</tr>
<tr>
<td>TH01 1p15.5 STR</td>
<td>13.7</td>
<td></td>
</tr>
<tr>
<td>TPOX 2p25-p24 STR</td>
<td>37.3</td>
<td></td>
</tr>
<tr>
<td>CSF1PO 5q31-34 STR</td>
<td>54.4</td>
<td></td>
</tr>
</tbody>
</table>

#### Hispanic

<table>
<thead>
<tr>
<th>Allele</th>
<th>Frequencies</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>D381358 3p STR</td>
<td>0.56</td>
<td>OCME STR database (Hispanics, Asians), FBI database (Blacks, Caucasians)</td>
</tr>
<tr>
<td>VWA 12p13.3 STR</td>
<td>2.6</td>
<td></td>
</tr>
<tr>
<td>FGA 4q STR</td>
<td>0.91</td>
<td></td>
</tr>
<tr>
<td>D6S1179 STR</td>
<td>12.7</td>
<td></td>
</tr>
<tr>
<td>D21611 STR</td>
<td>10.3</td>
<td></td>
</tr>
<tr>
<td>D18S51 18q21.3 STR</td>
<td>1.46</td>
<td></td>
</tr>
<tr>
<td>D5S818 STR</td>
<td>3.32</td>
<td></td>
</tr>
<tr>
<td>D13317 STR</td>
<td>3.24</td>
<td></td>
</tr>
<tr>
<td>D7S820 7q11 STR</td>
<td>6.85</td>
<td></td>
</tr>
<tr>
<td>D16539 16q24 STR</td>
<td>4.35</td>
<td></td>
</tr>
<tr>
<td>TH01 1p15.5 STR</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>TPOX 2p25-p24 STR</td>
<td>34.5</td>
<td></td>
</tr>
<tr>
<td>CSF1PO 5q31-34 STR</td>
<td>33.6</td>
<td></td>
</tr>
</tbody>
</table>

**Kinship Equations**

- Individual LRs for each locus, all multiplied together to give cumulative LR (CPI/CKI) which goes into FBIO report.

**Allele frequencies** as per OCME STR database (Hispanics, Asians), FBI database (Blacks, Caucasians) JFS 1999; 44(6): 1277-1286.
Page 3 (see sample below):

### Case 61494 kinship analysis

<table>
<thead>
<tr>
<th>Locus</th>
<th>Rdx Read</th>
<th>1280-001250</th>
<th>1280-001250</th>
<th>1280-001250</th>
<th>1280-001250</th>
</tr>
</thead>
<tbody>
<tr>
<td>D9S1358ST</td>
<td>99 1991 15,16</td>
<td>14,17</td>
<td>15,17</td>
<td>16,17</td>
<td>16,17</td>
</tr>
<tr>
<td>VWA ST</td>
<td>99 1991 15,16</td>
<td>13,15</td>
<td>15,16</td>
<td>15,16</td>
<td>15,16</td>
</tr>
<tr>
<td>FGA ST</td>
<td>99 1994 23</td>
<td>23,24</td>
<td>23</td>
<td>23,24</td>
<td>23</td>
</tr>
<tr>
<td>Amelogen ST</td>
<td>99 1990 X</td>
<td>X</td>
<td>X,Y</td>
<td>X,Y</td>
<td>X,Y</td>
</tr>
<tr>
<td>D8S1179ST</td>
<td>99 1992 22,14</td>
<td>14</td>
<td>14</td>
<td>12,14</td>
<td>12,14</td>
</tr>
<tr>
<td>D21S11 ST</td>
<td>99 1983 28,30</td>
<td>28</td>
<td>28</td>
<td>28,30</td>
<td>28,30</td>
</tr>
<tr>
<td>D18S51 ST</td>
<td>99 1994 16,16</td>
<td>14,16</td>
<td>16</td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td>D5S818 ST</td>
<td>99 1985 11</td>
<td>8,11</td>
<td>8,11</td>
<td>8,11</td>
<td>8,11</td>
</tr>
<tr>
<td>D13S317ST</td>
<td>99 1986 11,12</td>
<td>11,13</td>
<td>11,13</td>
<td>11</td>
<td>12</td>
</tr>
<tr>
<td>D7S820 ST</td>
<td>99 1987 8,11</td>
<td>8,11</td>
<td>8,11</td>
<td>8,11</td>
<td>8,11</td>
</tr>
<tr>
<td>D16S739ST</td>
<td>99 1988 9,11</td>
<td>9,13</td>
<td>9,13</td>
<td>11,13</td>
<td>11,13</td>
</tr>
<tr>
<td>TH01 ST</td>
<td>99 1982 7,8</td>
<td>7,8</td>
<td>7,8</td>
<td>7,8</td>
<td>7,8</td>
</tr>
<tr>
<td>TPOX ST</td>
<td>99 1993 7,8</td>
<td>8</td>
<td>7,9</td>
<td>7,11</td>
<td>7,11</td>
</tr>
<tr>
<td>CSF1PO ST</td>
<td>99 1989 8,12</td>
<td>8,10</td>
<td>8,10</td>
<td>10,12</td>
<td>10,12</td>
</tr>
</tbody>
</table>

**Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.**
Identifiler loci and approximate size range

<table>
<thead>
<tr>
<th>Identifiler locus</th>
<th>Color</th>
<th>Size Range 3130x/ GS500 Std.</th>
<th>Allele range in Ladder</th>
</tr>
</thead>
<tbody>
<tr>
<td>D8S1179</td>
<td>Blue</td>
<td>123.0bp ± 0.5bp To 169.0 + 0.5bp</td>
<td>8 to 19</td>
</tr>
<tr>
<td>D21S11</td>
<td>Blue</td>
<td>185.0bp ± 0.5bp To 216.0 + 0.5bp</td>
<td>24 to 38</td>
</tr>
<tr>
<td>D7S820</td>
<td>Blue</td>
<td>255.0bp ± 0.5bp To 291.0 + 0.5bp</td>
<td>6 to 15</td>
</tr>
<tr>
<td>CSF1PO</td>
<td>Blue</td>
<td>305.0bp ± 0.5bp To 342.0 + 0.5bp</td>
<td>6 to 15</td>
</tr>
<tr>
<td>D3S1358</td>
<td>Green</td>
<td>112.0bp ± 0.5bp To 140.0 + 0.5bp</td>
<td>11 to 19</td>
</tr>
<tr>
<td>THO1</td>
<td>Green</td>
<td>163.0bp ± 0.5bp To 202.0 + 0.5bp</td>
<td>4 to 15</td>
</tr>
<tr>
<td>D13S317</td>
<td>Green</td>
<td>217.0bp ± 0.5bp To 244.0 + 0.5bp</td>
<td>8 to 15</td>
</tr>
<tr>
<td>D16S539</td>
<td>Green</td>
<td>252.0bp ± 0.5bp To 290.0 + 0.5bp</td>
<td>5 to 15</td>
</tr>
<tr>
<td>D2S1338</td>
<td>Green</td>
<td>307.0bp ± 0.5bp To 359.0 + 0.5bp</td>
<td>15 to 28</td>
</tr>
<tr>
<td>D19S433</td>
<td>Yellow</td>
<td>102.0bp ± 0.5bp To 135.0 + 0.5bp</td>
<td>9 to 17.2</td>
</tr>
<tr>
<td>vWA</td>
<td>Yellow</td>
<td>134.0bp ± 0.5bp To 206.0 + 0.5bp</td>
<td>11 to 24</td>
</tr>
<tr>
<td>TPOX</td>
<td>Yellow</td>
<td>222.0bp ± 0.5bp To 250.0 + 0.5bp</td>
<td>6 to 13</td>
</tr>
<tr>
<td>D18S51</td>
<td>Yellow</td>
<td>262.0bp ± 0.5bp To 345.0 + 0.5bp</td>
<td>7 to 27</td>
</tr>
<tr>
<td>Amelogenin</td>
<td>Red</td>
<td>106.0bp ± 0.5bp To 112.0 + 0.5bp</td>
<td>X and Y</td>
</tr>
<tr>
<td>D5S818</td>
<td>Red</td>
<td>134.0bp ± 0.5bp To 172.0 + 0.5bp</td>
<td>7 to 16</td>
</tr>
<tr>
<td>FGA</td>
<td>Red</td>
<td>214.0bp ± 0.5bp To 355.0 + 0.5bp</td>
<td>17 to 51.2</td>
</tr>
</tbody>
</table>
Minifiler loci and approximate size range

<table>
<thead>
<tr>
<th>Minifiler locus</th>
<th>Color</th>
<th>Size Range 3130x/GS500 Std.</th>
<th>Allele range in Ladder</th>
</tr>
</thead>
<tbody>
<tr>
<td>D13S317</td>
<td>Blue</td>
<td>90.0bp ± 0.5bp To 139.0 ± 0.5bp</td>
<td>8 to 15</td>
</tr>
<tr>
<td>D7S820</td>
<td>Blue</td>
<td>141.5bp+ 0.5bp To 193.5 ± 0.5bp</td>
<td>6 to 15</td>
</tr>
<tr>
<td>Amelogenin</td>
<td>Green</td>
<td>99.3bp ± 0.5bp To 109.3 ± 0.5bp</td>
<td>X and Y</td>
</tr>
<tr>
<td>D2S1338</td>
<td>Green</td>
<td>110.9bp ± 0.5bp To 179.9 ± 0.5bp</td>
<td>15 to 28</td>
</tr>
<tr>
<td>D21S11</td>
<td>Green</td>
<td>180.6bp ± 0.5bp To 250.6 ± 0.5bp</td>
<td>24 to 38</td>
</tr>
<tr>
<td>D16S539</td>
<td>Yellow</td>
<td>70.0bp ± 0.5bp To 122.0 ± 0.5bp</td>
<td>5 to 13</td>
</tr>
<tr>
<td>D18S51</td>
<td>Yellow</td>
<td>122.4bp ± 0.5bp To 210.4 ± 0.5bp</td>
<td>7 to 27</td>
</tr>
<tr>
<td>CSF1PO</td>
<td>Red</td>
<td>84.6bp ± 0.5bp To 132.6 ± 0.5bp</td>
<td>6 to 15</td>
</tr>
<tr>
<td>FGA</td>
<td>Red</td>
<td>136.8bp ± 0.5bp To 296.4 ± 0.5bp</td>
<td>17 to 51.2</td>
</tr>
</tbody>
</table>
Controlled versions of Department of Forensic Biology Manuals only exist electronically on the Forensic Biology network. All printed versions are non-controlled copies.

## PowerPlex Y loci and approximate size range

<table>
<thead>
<tr>
<th>PowerPlex Y locus</th>
<th>Color</th>
<th>Size Range 3130x/ILS600 Std.</th>
<th>Allele range in Ladder</th>
</tr>
</thead>
<tbody>
<tr>
<td>DYS391</td>
<td>Blue</td>
<td>79.0bp ± 0.5bp To 123.0 ± 0.5bp</td>
<td>6 to 13</td>
</tr>
<tr>
<td>DYS389I</td>
<td>Blue</td>
<td>127.0bp ± 0.5bp To 179.0 ± 0.5bp</td>
<td>10 to 15</td>
</tr>
<tr>
<td>DYS439</td>
<td>Blue</td>
<td>186.0bp ± 0.5bp To 236bp ± 0.5bp</td>
<td>8 to 15</td>
</tr>
<tr>
<td>DYS389II</td>
<td>Blue</td>
<td>245.0bp ± 0.5bp To 301.0 ± 0.5bp</td>
<td>24 to 34</td>
</tr>
<tr>
<td>DYS438</td>
<td>Green</td>
<td>86.75bp ± 0.5bp To 133.0 ± 0.5bp</td>
<td>8 to 12</td>
</tr>
<tr>
<td>DYS437</td>
<td>Green</td>
<td>174.0bp ± 0.5bp To 206.0 ± 0.5bp</td>
<td>13 to 19</td>
</tr>
<tr>
<td>DYS19</td>
<td>Green</td>
<td>216.0bp ± 0.5bp To 272.0 ± 0.5bp</td>
<td>10 to 19</td>
</tr>
<tr>
<td>DYS392</td>
<td>Green</td>
<td>280.0bp ± 0.5bp To 338.0 ± 0.5bp</td>
<td>7 to 18</td>
</tr>
<tr>
<td>DYS393</td>
<td>Yellow</td>
<td>98.0bp ± 0.5bp To 144.0 ± 0.5bp</td>
<td>8 to 16</td>
</tr>
<tr>
<td>DYS390</td>
<td>Yellow</td>
<td>183.0bp ± 0.5bp To 237.0 ± 0.5bp</td>
<td>18 to 27</td>
</tr>
<tr>
<td>DYS385</td>
<td>Yellow</td>
<td>330.0bp ± 0.5bp To 334.0 ± 0.5bp</td>
<td>7 to 25</td>
</tr>
</tbody>
</table>
YFiler loci and approximate size range

<table>
<thead>
<tr>
<th>YFiler locus</th>
<th>Color</th>
<th>Size Range 3130x/ GS500 Std.</th>
<th>Allele range in Ladder</th>
</tr>
</thead>
<tbody>
<tr>
<td>DYS456</td>
<td>Blue</td>
<td>103.0bp ± 0.5bp To 123.0 + 0.5bp</td>
<td>13 to 18</td>
</tr>
<tr>
<td>DYS389I</td>
<td>Blue</td>
<td>142.0bp ± 0.5bp To 170.0 ± 0.5bp</td>
<td>10 to 15</td>
</tr>
<tr>
<td>DYS390</td>
<td>Blue</td>
<td>193.0bp ± 0.5bp To 237.0 ± 0.5bp</td>
<td>18 to 27</td>
</tr>
<tr>
<td>DYS389II</td>
<td>Blue</td>
<td>254.0bp ± 0.5bp To 294.0 ± 0.5bp</td>
<td>24 to 34</td>
</tr>
<tr>
<td>DYS458</td>
<td>Green</td>
<td>137.0bp ± 0.5bp To 161.0 ± 0.5bp</td>
<td>11 to 20</td>
</tr>
<tr>
<td>DYS19</td>
<td>Green</td>
<td>175.0bp ± 0.5bp To 211.0 ± 0.5bp</td>
<td>10 to 15</td>
</tr>
<tr>
<td>DYS385a/b</td>
<td>Green</td>
<td>243.0bp ± 0.5bp To 315.0 ± 0.5bp</td>
<td>7 to 25</td>
</tr>
<tr>
<td>DYS393</td>
<td>Yellow</td>
<td>107.0bp ± 0.5bp To 144.0 ± 0.5bp</td>
<td>8 to 16</td>
</tr>
<tr>
<td>DYS391</td>
<td>Yellow</td>
<td>148.0bp ± 0.5bp To 180.0 ± 0.5bp</td>
<td>7 to 13</td>
</tr>
<tr>
<td>DYS439</td>
<td>Yellow</td>
<td>200.0bp ± 0.5bp To 238.0 ± 0.5bp</td>
<td>8 to 15</td>
</tr>
<tr>
<td>DYS635</td>
<td>Yellow</td>
<td>252.0bp ± 0.5bp To 270.0 ± 0.5bp</td>
<td>20 to 26</td>
</tr>
<tr>
<td>DYS392</td>
<td>Yellow</td>
<td>291.0bp ± 0.5bp To 327.0 ± 0.5bp</td>
<td>7 to 18</td>
</tr>
<tr>
<td>Y GATA H4</td>
<td>Red</td>
<td>122.0bp ± 0.5bp To 142.0 ± 0.5bp</td>
<td>8 to 13</td>
</tr>
<tr>
<td>DYS437</td>
<td>Red</td>
<td>182.0bp ± 0.5bp To 202.0 ± 0.5bp</td>
<td>13 to 17</td>
</tr>
<tr>
<td>DYS438</td>
<td>Red</td>
<td>223.5bp ± 0.5bp To 248.5 ± 0.5bp</td>
<td>8 to 13</td>
</tr>
<tr>
<td>DYS448</td>
<td>Red</td>
<td>276.0bp ± 0.5bp To 324.0 ± 0.5bp</td>
<td>17 to 24</td>
</tr>
</tbody>
</table>
YM1 Genotyper Categories Table for ABI 3130xl

<table>
<thead>
<tr>
<th>Category</th>
<th>Peak Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>DYS19</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Highest peak at 180.70 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>13</td>
<td>Highest peak at 184.70 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>14</td>
<td>Highest peak at 188.80 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>15</td>
<td>Highest peak at 192.60 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>16</td>
<td>Highest peak at 196.70 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>17</td>
<td>Highest peak at 200.50 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>18</td>
<td>Highest peak at 204.50 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>DYS389 I</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Highest peak at 238.60 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>11</td>
<td>Highest peak at 242.60 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>12</td>
<td>Highest peak at 246.50 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>13</td>
<td>Highest peak at 250.70 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>14</td>
<td>Highest peak at 254.70 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>15</td>
<td>Highest peak at 258.70 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>DYS389 II</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>Highest peak at 356.60 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>27</td>
<td>Highest peak at 360.60 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>28</td>
<td>Highest peak at 364.60 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>29</td>
<td>Highest peak at 368.50 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>30</td>
<td>Highest peak at 372.40 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>31</td>
<td>Highest peak at 376.40 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>32</td>
<td>Highest peak at 380.50 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>33</td>
<td>Highest peak at 384.40 ± 1.00 bp in yellow with height ≥75</td>
</tr>
<tr>
<td>DYS390</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Highest peak at 197.90 ± 1.00 bp in blue with height ≥75</td>
</tr>
<tr>
<td>21</td>
<td>Highest peak at 201.90 ± 1.00 bp in blue with height ≥75</td>
</tr>
<tr>
<td>22</td>
<td>Highest peak at 205.80 ± 1.00 bp in blue with height ≥75</td>
</tr>
<tr>
<td>23</td>
<td>Highest peak at 209.90 ± 1.00 bp in blue with height ≥75</td>
</tr>
<tr>
<td>24</td>
<td>Highest peak at 213.90 ± 1.00 bp in blue with height ≥75</td>
</tr>
<tr>
<td>25</td>
<td>Highest peak at 217.90 ± 1.00 bp in blue with height ≥75</td>
</tr>
<tr>
<td>26</td>
<td>Highest peak at 221.90 ± 1.00 bp in blue with height ≥75</td>
</tr>
<tr>
<td>27</td>
<td>Highest peak at 225.90 ± 1.00 bp in blue with height ≥75</td>
</tr>
</tbody>
</table>
Macro Filter functions

<table>
<thead>
<tr>
<th>Locus</th>
<th>Stutter Filter 3130x1 (OCME validation @ 500pg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>D8S1179</td>
<td>11.2%</td>
</tr>
<tr>
<td>D21S11</td>
<td>14.7%</td>
</tr>
<tr>
<td>D7S820</td>
<td>11.0%</td>
</tr>
<tr>
<td>CSF1PO</td>
<td>10.4%</td>
</tr>
<tr>
<td>D3S1358</td>
<td>10.8%</td>
</tr>
<tr>
<td>THO1</td>
<td>7.3%</td>
</tr>
<tr>
<td>D13S317</td>
<td>7.6%</td>
</tr>
<tr>
<td>D16S539</td>
<td>9.7%</td>
</tr>
<tr>
<td>D2S1338</td>
<td>10.9%</td>
</tr>
<tr>
<td>D19S433</td>
<td>19.1%</td>
</tr>
<tr>
<td>vWA</td>
<td>18.1%</td>
</tr>
<tr>
<td>TPOX</td>
<td>3.0%</td>
</tr>
<tr>
<td>D18S51</td>
<td>13.6%</td>
</tr>
<tr>
<td>Amelogenin</td>
<td>none</td>
</tr>
<tr>
<td>D5S818</td>
<td>13.3%</td>
</tr>
<tr>
<td>FGA</td>
<td>24.6%</td>
</tr>
<tr>
<td>Identifier 31 cycles</td>
<td>Allele Filters</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Locus</td>
<td>Stutter Filter 3130x1 (ABI default)</td>
</tr>
<tr>
<td>D8S1179</td>
<td>12%</td>
</tr>
<tr>
<td>D21S11</td>
<td>13%</td>
</tr>
<tr>
<td>D7S820</td>
<td>9%</td>
</tr>
<tr>
<td>CSF1PO</td>
<td>9%</td>
</tr>
<tr>
<td>D3S1358</td>
<td>11%</td>
</tr>
<tr>
<td>THO1</td>
<td>6%</td>
</tr>
<tr>
<td>D13S317</td>
<td>10%</td>
</tr>
<tr>
<td>D16S539</td>
<td>14%</td>
</tr>
<tr>
<td>D2S1338</td>
<td>15%</td>
</tr>
<tr>
<td>D19S433</td>
<td>10%</td>
</tr>
<tr>
<td>vWA</td>
<td>11%</td>
</tr>
<tr>
<td>TPOX</td>
<td>6%</td>
</tr>
<tr>
<td>D18S51</td>
<td>16%</td>
</tr>
<tr>
<td>Amelogenin</td>
<td>none</td>
</tr>
<tr>
<td>D5S818</td>
<td>10%</td>
</tr>
<tr>
<td>FGA</td>
<td>11%</td>
</tr>
</tbody>
</table>
### MiniFiler Allele Filters

<table>
<thead>
<tr>
<th>Locus</th>
<th>Allele Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>D13S317</td>
<td>14 %</td>
</tr>
<tr>
<td>D7S820</td>
<td>11 %</td>
</tr>
<tr>
<td>Amelogenin</td>
<td>None</td>
</tr>
<tr>
<td>D2S1338</td>
<td>18 %</td>
</tr>
<tr>
<td>D21S11</td>
<td>16 %</td>
</tr>
<tr>
<td>D16S539</td>
<td>15 %</td>
</tr>
<tr>
<td>D18S51</td>
<td>18 %</td>
</tr>
<tr>
<td>CSF1PO</td>
<td>14 %</td>
</tr>
<tr>
<td>FGA</td>
<td>15 %</td>
</tr>
</tbody>
</table>
**PowerPlex Y Allele Filters**

<table>
<thead>
<tr>
<th>Locus</th>
<th>Allele</th>
<th>Stutter Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>DYS391</td>
<td>8.39%</td>
<td>3130xl</td>
</tr>
<tr>
<td>DYS389I</td>
<td>8.41%</td>
<td></td>
</tr>
<tr>
<td>DYS439</td>
<td>8.61%</td>
<td></td>
</tr>
<tr>
<td>DYS389II</td>
<td>14.81%</td>
<td></td>
</tr>
<tr>
<td>DYS438</td>
<td>3.49%</td>
<td></td>
</tr>
<tr>
<td>DYS437</td>
<td>7.31%</td>
<td></td>
</tr>
<tr>
<td>DYS19</td>
<td>5.64%</td>
<td></td>
</tr>
<tr>
<td>DYS392</td>
<td>11.10%</td>
<td></td>
</tr>
<tr>
<td>DYS393</td>
<td>11.38%</td>
<td></td>
</tr>
<tr>
<td>DYS390</td>
<td>11.39%</td>
<td></td>
</tr>
<tr>
<td>DYS385</td>
<td>15.43%</td>
<td></td>
</tr>
</tbody>
</table>

For PowerPlex Y, a 6 % general filter is also applied to all loci.
**YFiler Allele Filters**

<table>
<thead>
<tr>
<th>Locus</th>
<th>Stutter Filter 3130x1 (OCME validation @ 500pg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>DYS456</td>
<td>15.77%</td>
</tr>
<tr>
<td>DYS389I</td>
<td>13.65%</td>
</tr>
<tr>
<td>DYS390</td>
<td>13.01%</td>
</tr>
<tr>
<td>DYS389II</td>
<td>20.77%</td>
</tr>
<tr>
<td>DYS458</td>
<td>14.94%</td>
</tr>
<tr>
<td>DYS19</td>
<td>14.28%</td>
</tr>
<tr>
<td>DYS385a/b</td>
<td>14.75%</td>
</tr>
<tr>
<td>DYS393</td>
<td>15.71%</td>
</tr>
<tr>
<td>DYS391</td>
<td>9.32%</td>
</tr>
<tr>
<td>DYS439</td>
<td>11.14%</td>
</tr>
<tr>
<td>DYS635</td>
<td>18.93%</td>
</tr>
<tr>
<td>DYS392</td>
<td>24.30%</td>
</tr>
<tr>
<td>Y GATA H4</td>
<td>14.36%</td>
</tr>
<tr>
<td>DYS437</td>
<td>9.27%</td>
</tr>
<tr>
<td>DYS438</td>
<td>7.66%</td>
</tr>
<tr>
<td>DYS448</td>
<td>7.38%</td>
</tr>
</tbody>
</table>

For YFiler, an 8% general filter is also applied to all loci.

Revision History:
March 24, 2010 – Initial version of procedure.
April 1, 2014 – Procedure revised to include information for YFiler.